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WHAT'S NEW IN THE AWIPS CAVE-D2D USER'S MANUAL

OB 16.1.1

FEATURES, FUNCTIONALITIES, ENHANCEMENTS, AND/OR MODIFICATIONS

AWIPS II Software

Ensemble Tool: The Ensemble Tool provides capabilities to display and manipulate ensemble model
data. The datasets and the Tool are there to help forecasters assess certainty in the forecast, or lack
thereof. This is intended to assist forecasters with interactive decision support in two ways: estimates
of event probability, and alternative scenarios to the official (deterministic) forecast.

Boundary Drawing Tool: Allows the forecaster to enter meso-scale and/or synoptic scale surface
boundaries, to set a boundary in motion after its creation, to adjust location, shape and motion or delete
any active boundary and Save the data (via AWIPS II localization APIs).

Collaboration: Enhancements

Users not logged into Collaboration do not appear in the group lists.

The Collaboration toolbar includes a Display nws-collaboration button that allows users to chat with
the NWS community. By default, the user joins the nws-collaboration room when Collaboration is
launched, and the nws-collaboration tab appears adjacent to the Collaboration tab.

Clicking the Display nws-collaboration icon opens the nws-collaboration room if the user has not
joined the room, or brings the nws-collaboration tab into view if the user has already joined the room.

Additional features have been added to Show chat notification popups, Max chat room history message
age in minutes, automatically float tabs on login, automatically attach new views to existing views and
Months to keep chat logs.

Meteogram: In the Configure Meteogram Dialog the only option available is a selection for the math
function used to calculate the data values that appear in the meteograms.  These functions use the
underlying gridded data that resides inside the node circle (thus the size of the circle matters).  The
default calculation type is “Max” or maximum value. Note: The “Sum” calculation method should not
be used prior to AWIPS build 16.1.2. Max and Min should be largely unaffected by this problem. The
other methods should be OK, but used with care. Please note: The Tracking Meteogram can properly
use lightning data. This was not functioning well prior to 16.1.1.
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Pop-up Menus from Display Panes, Product Legends, and Map Legends: The Pop-Up menu from
the Map Legend has been added.

The following features have been added.

Label : This menu item expands to display a list of various label options associated with the selected
map ID in the Map Legend. Selecting a radio button for a particular label displays the label on the
displayed map. Label Offset: Selecting this option opens the Map Label Offset dialog. Users can adjust
the position of the label based on the coordinate system (the origin existing where X=0 and Y=0).
Negative X values shift labels to the left while positive X values shift labels to the right. Negative Y
values shift labels down while positive Y value shift labels up. Save Map Style : When a map
displayed in the main pane is modified (e.g., by modifying Color, Line Style, Line Width,
Magnification, etc.), the user may save the map style by selecting the Save Map Style menu item from
the popup menu on the Map Legend.  The result is the creation of a localization file (CAVE->Map
Styles->mapstylepreferences.xml).  Each time the map is loaded, the saved characteristics of the map
are displayed.

Load/Save Displays: The Load/Save Displays under the cave menu has been updated to reflect the
Save Editor Display, Save Perspective Display and Load Displays. The Open Perspective Display
under the Load Displays dialog contains 3 filtering options: Show Mine, Show All Users, and Show
All. Also the Expand All and Collapse All buttons expand and contract all directories listed in the Open
Procedure dialog to show and hide the procedures listed under each directory.

The Procedures Dialog Box: The following features have been updated. Original: This radio button
allows you to display cross-sections, variable vs. height displays, point soundings, time-height cross-
sections, or time series graphs saved as a bundle within the procedure using the original location of the
points and baselines used when initially setting up the bundle. Current: This radio button allows you to
display cross-sections, variable vs. height displays, point soundings, time-height cross-sections, or time
series graphs saved as a bundle within the procedure using the present location of the baselines or
points. Alter...: This menu button opens the Alter Bundle on Loading dialog box, which contains
options that allow you to modify how the selected bundle loads. Click on the check button to activate
one or more of the alter options. In cases where an item does not apply (e.g., point/line for a radar PPI),
it makes no difference if it is selected or not.

Thin Client uses the same code installation as CAVE. Depending on the operating system (Windows or
Linux), you start Thin Client by providing the appropriate options to CAVE at CAVE startup.

For Linux, Thin Client consists of two processes:
AlertViz: The error and alert message client.
CAVE: The Common AWIPS Visualization Environment.

AlertViz must be up and running before CAVE is started.

For Windows, Thin Client only requires the CAVE process. The error and alert message client
(AlertViz) is a process that runs within CAVE called Alert View instead of AlertViz.

Note: The Thin client Windows version and the Thin Client Linux version do not support Localization
and Collaboration.

The following guides have been updated. MPE Perspective Users Guide, MPE Implementation Guide,
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MPE FieldGen System Guide, MPE DailyQC System Guide, Dual Pol Products Processing for MPE
and HPE, DailyQC Preprocessor Guide, IHFS Database Purger, Generating Areal FFG and DPA
Decoder, High-resolution Precipitation Estimator (HPE) and High-resolution Precipitation Nowcaster
(HPN) guide has been added.

BMH can be run in Practice Mode, so it does not interfere with the operational BMH
playlist/database/etc. Also, the The [Reboot…] button is enabled upon selection of an existing DAC
Configuration file in the DAC Configuration dialog. 

Alert View is the Windows version of AlertViz. Instead of the AlertViz message bar and pop up dialog,
Alert View is an eclipse view that launches as part of CAVE. By default, Alert View opens when
CAVE is launched and is a docked tab alongside the Map Editor in D2D.

DR 6054: The Attribute Color Threshold (ACT) window should be displayed by the right-clicking on
an attribute name title in the FFMP table. This choice was missing from AWIPS-II implementation for
FFMP.  In AWIPS-II, the ACT is now displayed by clicking the Thresholds button and selecting the
column name from the drop down list. Operational Impact: The ticket states that the right-click on the
table column issue has been fixed in the Eclipse upgrade but it doesn't work on Windows which means
that if we take away the current capability (clicking the button) then the Thin Client FFMP will be
broken. There is a link to the MDL FFMP documentation to get details on how to set the attribute
threshold.  It says to click the column name to bring up the ACT.  It should say to right-click, not just
click.

Guardian AlertViz Popup Message Box insufficient for some Messages: This particular message is so
long that the entire message is not visible in the window (cut off at the bottom) and the buttons to
acknowledge / clear the message are below the bottom of the screen with no way to change the size of
the window. This problem (logical error) has been carried over from Guardian in A1 to AlertViz in A2.
This has been corrected.

In RPG build 17, 2 HCA classes were added: LH (Large Hail) and GH (Giant Hail). Since HCA
product 164 and 165 are also displayable in FSI. FSI made similar changes to display the new HCA
classes properly.

This Design Change Specification is for the next phase in AWIPS II display capability for the
Multiple-Radar / Multiple – Sensor (MRMS) products. MRMS officially went online at NCEP on 1
October 2014, with all IOC products being made available via LDM, and a subset of products via the
SBN. Included in the full suite of LDM products are all 33 altitudes of reflectivity data, which together
make up what is known as the MRMS 3D Reflectivity Cube. An “All-Tilts” display capability for the
3D cube is proposed by this DCS. This is similar to the “All-Tilts” capability for single-radar data, but
the “up-down” feature will move up and down at constant altitude levels in the cube (versus up and
down in elevation angle in single radar data). The following aspects included are:

1. Selections within the MRMS menu for various configurations of cube data to be loaded. The
configurations will be modulated by the number of complete 3D cubes (or volumes) to load and the
selection of altitudes within the cube (e.g., all altitudes, every 1000m, and lowest 5 km). These
parameters will be used to determine the frame load count. Note that because a full 3D cube is
comprised of 33 altitudes of data, just two complete volumes of data will fill 66 frames. Testing will be
carried out to determine the maximum number of frames that the workstation can handle. 2. The data
will be displayed within the Display 2 Dimensions (D2D) perspective within the Common AWIPS
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Visualization Environment (CAVE) of AWIPS II. 3. Once the cube is loaded, the products selection
will be controlled by the up, down, forward, and back arrows on the keyboard, as with single-radar
All-Tilts. The Up Arrow will move up in altitude in the cube. The Down Arrow will move down in
altitude in the cube. Once the top (bottom) of the cube is reached, the next press of the Up (Down)
arrow will change the display to the lowest (highest) altitude data from the same volume scan. The
Forward Arrow will move the data to the next time interval. If the data are at the latest available time,
this arrow will have no effect. The Back Arrow will move the data to the previous time interval. If the
data are at the earliest available time (as specified by the number of frames loaded), this arrow will
have no effect.

A procedure on how the field offices can obtain the data required to build MRMS All-Tilts (as the data
do not come from the SBN) has been developed and field-tested.

Meteorological Phenomena Identification Near the Ground (mPING): This is designed to collect
weather information from the public through their smart phone or mobile device with GPS location
capabilities. Using the free mPING app, anyone can submit a weather observation anonymously. The
data immediately goes into a database at NSSL and is displayed on a map that is accessible to
everyone. mPING was deployed in 2012 and developed through a partnership between NOAA/NSSL,
the University of Oklahoma, and the Cooperative Institute for Mesoscale Meteorological Studies. It can
be accessed from the Obs/mPING menu.

Ingest and Display Extratropical Storm Surge Model (ESTOFS) data - Pacific

Global VIIRS display capability in the CAVE>NCP.

Global MODIS decode and display capability in the CAVE>NCP.

High Resolution Rapid refresh (HRRR) model Output

AWIPS II should be enhanced to handle the SBN ingest, GRIB2 decode, store, display, and ingest by
GFE software for grid preparation of HRRR model output for the following data elements:

Source: http://www.nco.ncep.noaa.gov/pmb/products/hrrr/

Resolution: 15 minute resolution data out to 9 hours for the following data elements and levels.

Data elements
• #005 - Radar Reflectivity (refd) - Reflectivity at 1 km AGL for FHAG1000
• #001 - Composite Radar Reflectivity (refc) - Max refl in model column, dBZ
• #008 - Instantaneous Updraft Helicity - Instantaneous updraft helicity in layer 2-5 km above ground
level for FHAG20005000
• #003 - Radar VIL - Radar-derived vertically int. liquid, kg/m2
• #014 - u Wind Component - u-wind at height above ground for FHAG10
• #015 - v Wind Component - v-wind at height above ground for FHAG10
• #002 - Echo Top - Echo top height of 18dBZ surface

In RPG build 17, ROC will add 2 dual-pol super resolution raw products: SDC and SDP. SDC is the
super resolution correlation coefficient
data array product. It is comparable to product CC. SDP is the super resolution differential phase data
array product. It is the raw
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product used to generate product KDP. AWIPS II will be able to request, ingest and display these two
products.

AWIPS II has been enabled to ingest, process and display the ETSS SHEF products. SHEF-encoded
total water level guidance will be produced at several coastal points in the CONUS and Alaska regions.
This data is dependent on GFS output and will be created four times daily (once for every GFS forecast
cycle). The data are hourly predictions of total water level (surge plus tide) that extend 0 to 96 hours
from forecast time. Individual SHEF messages (one for each point) will be grouped into geographical
basins for AWIPS ingestion. Basins in the CONUS will be given the WMO header SRUS70 KWNO
and basins in Alaska will be given the WMO header SRAK70 KWNO. WMO headers and AWIPS IDs
for each basin are listed below:

SRUS70 KWNO RRWTWE  East Coast SRAK70 KWNO RRWTWC  Gulf of Alaska
SRUS70 KWNO RRWTWG  Gulf of Mexico SRAK70 KWNO RRWTWB  Bering Sea
SRUS70 KWNO RRWTWP  West Coast SRAK70 KWNO RRWTWA  Arctic Alaska

NOTE: Since GFE and Hydro applications are out of scope for the D2D UM, this is not reflected
in the UM)

A new field has been added in the Hydro Database and also a textbox interface to display and edit the
field in HydroBase.

In HydroBase, in Location, in either Add Location or Modify Location, immediately below the exiting
editable Lat/Lon: boxes which show the lat/lon in DD format (both DD and DMS are accepted), add
read-only boxes which display the lat/lon in DMS format.

GFE is configured to display all of the variables shown below.

CONUS Domain - Lambert Conformal

Element Type and Resolution Required Timestep Cycle

Temperature GRIB2 2.5 km 3 hourly to 192 0000 a

Dewpoint GRIB2 2.5 km 3 hourly to 192 0000 a

Probability of Precipitation (12 hour) GRIB2 2.5 km 12 hourly to 192 0000 a

Maximum Temperature GRIB2 2.5 km 24 hourly to 192 0000 a

Minimum Temperature GRIB2 2.5 km 24 hourly to 192 0000 a

Sky Cover GRIB2 2.5 km 3 hourly to 192 0000 a

Wind Speed GRIB2 2.5 km 3 hourly to 192 0000 a

Wind Direction GRIB2 2.5 km 3 hourly to 192 0000 a

Wind Gust GRIB2 2.5 km 3 hourly to 192 0000 a
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Relative Humidity GRIB2 2.5 km 3 hourly to 192 0000 a

Apparent Temperature GRIB2 2.5 km 3 hourly to 192 0000 a

Damage Path Tool:  Damage Path tool will not be available until release 16.2.1.

Password Management (Password Criteria) for Managing the AWIPS User Account: Passwords
for user accounts must have a least fourteen (14) non-blank characters.

AWIPS CAVE-D2D User's Manual

Content and Organizational Changes:.

1. Ensemble Tool: Chapter 17 has been added to reflect the Ensemble Tool. The following
Exhibits have been added.

17.1-2. Launching the Ensemble Tool, 17.1-3. Ensemble Tool on Start-up, 17.1-4. Volume
Browser showing Ensembles as a new source, 17.1-5. GEFS Precipitation display on the
Ensemble Tool, 17.1-6. Ensemble Tool with re-sized legend viewport, 17.1-7. GEFS Surface
Temperature Forecast (The contours for 0F and 40F), 17.1-8. The dialog box to change the color
presentation of the ensemble, 17.1-9. The menu for calculating the mean and other statistics from
the ensemble, 17.1-10. Ensemble mean surface temperature forecast, 17.1-11. Relative
Frequency, 17.1-12. Relative Frequency dialog box with temperature ranges, 17.1-13. The
ensemble relative frequency (Yellow Contour) predicting the temperature, 17.1-14. GEFS
surface temperature time series and 17.1-15. 500mb field forecast from SREF.

2. Boundary Tool: Chapter 18 has been added to reflect the Boundary Drawing Tool. The
following Exhibits have been added.

18.2-1. CAVE D2D Tools menu with Boundary Tool entry, 18.3-1. Boundary Editor GUI,
18.3.2-1. Active Boundaries and 18.3.4-1. Moving Boundary.

3. Collobaration: The following sections have been updated. 16.2.1 Starting the Collaboration
Application, 16.2.2 Creating a Chat Session, 16.2.3 Configuring Your Collaboration Experience,
16.2.4 Creating a Shared Display Session and 16.2.5 Other Session Leader Capabilities.

The following exhibits have been updated.

16.2.1-3. Collaboration Pane, Exhibit 16.2.1-4. Collaboration Toolbar, 16.2.1-5. Collaboration
View Menu, 16.2.1-7. Room Search Dialog, 16.2.1-8. Popup Menu on Public Room, 16.2.1-12.
Collaboration MB3 Popup Menu on Contact List, 16.2.1-13. Invite...Submenu, 16.2.2-1.
Username with Site and Role Displayed, 16.2.2-2. Chat Session with Individual User, 16.2.2-3.
Chat with NWS Community, 16.2.2-4. MB3 Popup Menu from the public room, 16.2.2-6.
Selected Color Combination Applied to the Participants List, 16.2.2-7. Selected Color
Combination Applied to the Conversation Window, 16.2.3-1. Preferences Dialog for Setting the
Collaboration User Interface Preferences, 16.2.3-2. Chat Messages On Separate Line From Time
And Name Example, 16.2.3-3. Always Show the Date on Messages Example, 16.2.3-6.
Preferences Dialog Box for Configuring Significant Words, 16.2.4-1. Session Invitation Dialog
Box, 16.2.4-2. Create Session Dialog Box, 16.2.4-3. Session Leader's Collaboration Screen for a
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Shared Display Session, 16.2.4-4. Shared Display Session Toolbar and 16.2.5-2. Transfer
Leadership MB3 Popup Menu.

4. Meteogram: Section 2.2.6.5 has been updated to reflect the Configure Meteogram Dialog.

5. Section 2.2.8.1, Pop-up Menus from Display Panes, Product Legends, and Map Legends has
been updated to reflect the Display Panes and Pop-up menu from the Map Legends.

Exhibit 2.2.8.1-3. Example of a Pop-up Menu from the Map Legend, has been updated.

6. Section 2.2.6.1, The Load/Save Displays under the cave menu has been updated to reflect the
Save Editor Display, Save Perspective Display and Load Displays. The Open Perspective
Display under the Load Displays dialog contains 3 filtering options: Show Mine, Show All
Users, and Show All.

7. Section 3.1.2, The Procedures Dialog Box has been updated to reflect the new features added
to the Original, Current and Alter buttons.

8. Section 14.1, Starting Thin Client has been updated to reflect the starting of the Thin Client
depending on the operating system (Windows or Linux). In Section 14.2.3, Thin Client Servers
Preferences Dialog Window, the Server Data Dir option has been removed. Section 14.3.2, Thin
Client Capabilities and Limitations has been updated to reflect the inability of Thin Client to
support Localization and Collaboration.

9. In App D, The following guides have been updated. MPE Perspective Users Guide, MPE
Implementation Guide, MPE FieldGen System Guide, MPE DailyQC System Guide, Dual Pol
Products Processing for MPE and HPE, DailyQC Preprocessor Guide, IHFS Database Purger
and Generating Areal FFG and DPA Decoder. Additionally, the following guide has been added..
High-resolution Precipitation Estimator (HPE)/
High-resolution Precipitation Nowcaster (HPN).

10. The Users Guide for Broadcast Message Handler has been updated in APP G.

All the updates below refer to the linked BMH document in APP G.

Section 2.9.5.1.4, Reboot DAC has been added.

The following Exhibits has been added. 2.9.5.1.3-1. DAC Reboot Dialog, 2.9.5.1.3-2. Progress
Information Dialog, 2.9.5.1.3-3.  DAC Configuration Events Dialog, 2.9.5.1.5-1. DAC Failover
Dialog, 2.9.5.1.5-2. Configure DAC Dialog, 2.9.5.1.5-3. Progress Information Dialog and
2.9.5.1.5-4.  DAC Configuration Events Dialog.

Section 2.10 Practice Mode has been added.

The following Exhibits has been added. 2.10.1. BMH Menu Dialog in Practice Mode-System
Dropdown Menu, 2.10.2. Copy Operation data base Dialog, 2.10.3. Progress Information Dialog,
2.10.4. BMH Menu Dialogs in Practice Mode (left) and Operational Mode (right).

Table 2.9.5.1.1-1, Create DAC Configuration Dialog Fields has been updated.

11. A new section 14.3.3, Alert View has been added.
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The following Exhibits has been added. 14.3.3-1. Starting AlertView, 14.3.3-2. Message Pop-up,
14.3.3-3. Alert View Window, 14.3.3-4. Pop-up options, 14.3.3-5. Alert View Style, 14.3.3-6.
Change Alert Dialog and 14.3.3-7. Alert View filtered CAVE Preferences dialog.

12. In section 13.1.3 Flash Flood Monitoring and Prediction: Advanced (FFMPA), DR 6054 note
has been added.

13. Section 2.2.6.15 has been modified to accommodate changes to the Multiple-Radar /
Multiple-Sensor (MRMS) product suite.  Exhibit 2.2.6.15-6, MRMS Reflectivity Products Menu
has been updated and a new Exhibit 2.2.6.15-9 MRMS Merged Reflectivity Cube Menu has been
added.

A new Section 2.2.6.15.1 Multiple-Radar/Mutliple-Sensor (MRMS) Reflectivity "All-Tilts"
feature in 16.1.1 has been added. It discusses the procedures for obtaining MRMS grids via
LDM/LDAD and implementing the Reflectivity "All-Tilts" feature in 16.1.1 since the individual
reflectivity level products won't be shipped over the SBN.

14, Appendix C Managing Your AWIPS User Account has been updated with the new password
policy.

Organizational Changes:
None
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1.0 The AWIPS CAVE-D2D User's Manual

The AWIPS CAVE-D2D User's Manual provides the information needed to utilize the user interface of AWIPS (Advanced Weather Interactive Processing System) for the retrieval and display of weather
data. This introduction provides an overview of the manual's scope, intended audience, and structure.

Note 1: The CAVE menus exhibited in this document include options that may not be available at all field sites. When AWIPS is localized to your site, only those options that are available to your site
will be included on the menu.

The Online Navigation Page enables you to navigate easily and quickly throughout the online document. Using the navigation page makes it easy to find information. From this page you can look up a

term by accessing either NOAA's NWS glossary or the glossary of the Manual. You can return to the navigation page from any page in the manual by clicking the  button.

The  symbol indicates that a separate manual is available for the AWIPS application being discussed. For more information about the application, click on the book symbol to open the

application's user guide. Also, whenever the name of an iconified button is displayed and underlined in blue, such as Open Perspective, it indicates a link to an image of that button.

Note 2: The AWIPS CAVE-D2D User's Manual is an online document that can be opened using any Internet browser. However, no two browsers support online documents in exactly the same way,
and no browser totally supports a document's intended structure. Therefore, the appearance of pages within this manual may differ from browser to browser. Mozilla Firefox best supports the structure
of this manual and is the recommended browser for viewing it.

If you find errors in this manual or would like to make a comment or suggestion, we welcome your feedback. Please write to the AWIPS Documentation Team at: nws.hq.awips.smm.um@noaa.gov.



1.1 Scope

This edition of the AWIPS CAVE-D2D User's Manual describes the AWIPS II implementation of the D2D
(Display 2 Dimensions) Perspective within the CAVE (Common AWIPS Visualization Environment), and the
user interface components (text and graphic displays) that comprise the AWIPS II workspace. The other
perspectives — GFE, Hydro, MPE, and Python (all of which are accessible from the CAVE main display) —
are outside the scope of this manual and are therefore not discussed in any detail.

AWIPS II is being implemented in a series of releases. This version of the AWIPS CAVE-D2D User's
Manual (OB16.1.1 - 21 January 2016) supports AWIPS II Operational Build 16.1.1. As subsequent
maintenance releases of the software are implemented, the AWIPS CAVE-D2D User's Manual will be
updated to reflect the changes associated with the respective release. Every new edition of the Manual
includes a "What's New in the AWIPS CAVE-D2D User's Manual" page. Inserted after the Table of Contents,
the "What's New" page describes new and/or changed features, functionalities, enhancements, and
modifications associated with the newly implemented release. The "What's New" page also describes content
and organizational changes made to the Manual, and any formatting changes made to improve usability. If no
significant changes occurred in the new release, or the User's Manual, the "What's New" page will state that
fact.
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1.2 Intended Audience and Assumed User Skills

This online document is intended for users of the AWIPS workstation. It is assumed that users of this manual have a basic understanding of how to use a mouse to navigate a graphical user interface (GUI).
This includes such operations as opening, resizing, moving, and closing windows, and selecting items from menus.



1.3 Organization of the Manual

The AWIPS CAVE-D2D User's Manual is organized as follows:

The Online Navigation Page enables you to access needed information more quickly, and navigate throughout the manual more efficiently. It also allows you to access the NWS Glossary, in addition

to the glossary in the Manual. Every page in the manual has a  button that links you back to the Navigation Page.

What's New in the AWIPS CAVE-D2D User's Manual describes the features, functionalities, enhancements, and modifications that have been made to the newly released software Operational Build
(OB) since the last OB. It also describes any significant content and organizational changes to the User's Manual, as well as any usability improvements, intended to improve readability and user
comprehension. This section is included in the manual to inform the user of the specific changes that occurred in the release, both in the software and in the document. If no changes occurred to
either, this section would state that fact.

Chapter 1 - The AWIPS CAVE-D2D User's Manual provides an overview of the scope, intended user, and organization of this manual.

Chapter 2 - The AWIPS Workstation and Graphical User Interface provides an overview of the AWIPS workspace and graphical interface; it includes descriptions of all the CAVE menus and
functions for setting up your display, as well as a discussion of activities related to logging onto and exiting the system.

Chapter 3 - Getting Started Using the AWIPS Graphical User Interface describes the menus used in CAVE to work with graphic and image products and data.

Chapter 4 - The AWIPS Workstation and Textual User Interface provides an overview of the AWIPS workspace and text interface, covering viewing, creating, editing, and transmitting text products.

Chapter 5 - Getting Started Using the AWIPS Textual User Interface describes how to retrieve and edit text products, and how to work with text scripts and the alarm/alert feature.

Chapter 6 - WarnGen covers the AWIPS Warning Generation (WarnGen) program and the process of placing WarnGen in Practice Mode so you can use WarnGen without broadcasting the
communication to the public.

Chapter 7 - The Interactive NsharpSkewt (NSHARP) Application covers the Interactive NsharpSkewt application, including sampling and editing the Skew-T and hodograph.

Chapter 8 - Radar Applications covers the radar applications, including dual-polarization technology.

Chapter 9 - Background Applications covers the background applications (the NOAA Climatological Reports Formatter, and the Hourly Weather Roundup).

Chapter 10 - Local Data Acquisition and Dissemination covers the Local Data Acquisition and Dissemination (LDAD) system.

Chapter 11 - AWIPS Quality Control and Monitoring System introduces the AWIPS Quality Control and Monitoring System (QCMS).

Chapter 12 - AWIPS System Monitor provides information on the tool used to monitor AWIPS systems and workstation CPU utilization. This chapter also includes information on how to access
online documents and provides links to important forecaster information.

Chapter 13 - MDL and OHD Applications introduces the NWS-developed applications that are accessible from both the CAVE interface and the AWIPS Start-up menu.

Chapter 14 - Thin Client Remote Access introduces the two versions of the Thin Client component implemented to support NWS enterprise requirements for remote access to baseline AWIPS
capabilities.

Chapter 15 - Alert Visualization provides information on the tool used to alert the user to malfunctions and to signal and data loss. This chapter also includes information on how to configure alerts.

Chapter 16 - Applications Within CAVE provides information on the five applications accessed from the CAVE menu. The first four applications are options listed directly in the CAVE menu. The
fifth application is accessed in the CAVE menu via the Import option.

Appendix A - Glossary provides a glossary of relevant terms.

Appendix B - AWIPS Acronyms and Abbreviations provides a listing of AWIPS acronyms and abbreviations.

Appendix C - Managing Your AWIPS User Account provides information on managing your AWIPS user account, including how to manage your password according to DOC policy.

Appendix D - AWIPS Applications / Interfaces provides a list of AWIPS applications.



2.0 The AWIPS Workstation and Graphical User Interface

Each AWIPS Workstation is comprised of three graphic displays (Graphic Workstation) and one text display (Text Workstation), as shown in Exhibit 2.0-1. The three graphic displays share a common
keyboard, mouse, and central processing unit (CPU - LX). The text display has a dedicated keyboard, mouse, and CPU - XT.

Exhibit 2.0-1. The AWIPS Workstation

This chapter includes the following sections:

Section 2.1: The AWIPS Graphic Workstation

Section 2.2: The AWIPS Graphical User Interface



2.1 The AWIPS Graphic Workstation

The AWIPS Graphic Workstation is located on the right side of the AWIPS Workstation, as shown in Exhibit 2.1-1. It includes the three graphic displays, all controlled by a single dedicated keyboard,
mouse, and its own CPU (LX).

Exhibit 2.1-1. The AWIPS Graphic Workstation

This section discusses the following topic:

The AWIPS Workstation Input Devices — Mouse and Keyboard - Subsection 2.1.1



2.1.1 The AWIPS Workstation Input Devices – Mouse and Keyboard

Each AWIPS Workstation has two input devices: a three-button mouse and a keyboard. Both the Graphic Workstation (LX), which is used to interact with CAVE via the Graphical User Interface (GUI),
and the Text Workstation (XT), which is used to interface with the Textual User Interface (TUI), include a set of the same input devices.

This subsection describes the hardware components (input devices) that comprise the AWIPS Workstation.

Mouse: The three-button mouse, shown in Exhibit 2.1.1-1, performs a number of actions in CAVE. In this manual, each mouse button is referred to by number: Button 1 (B1), Button 2 (B2), and
Button 3 (B3).

Note 1: A two-button mouse with a clickable scroll wheel is also referred to as a three-button mouse. The clickable scroll wheel is the second button (B2).

Exhibit 2.1.1-1. Right Handed Mouse (three-button mouse and a two-button mouse with clickable scroll-wheel)

Most mouse actions are invoked with mouse Button 1. It is the primary activator button for opening and closing menus and making most menu selections. In this manual, subsequent references to a
mouse click refer to Button 1 unless otherwise noted.

For a right-handed mouse (default), Button 1 is on the left. You have the option of changing the mouse orientation.

To change the mouse orientation:

On the GNOME Panel, select the Red Hat button to open the Main menu.1. 

Select System > Preferences > Mouse > Mouse Orientation to set your preferred mouse orientation.2. 

On the GUI the mouse button functions are configurable from the Preferences dialog box under the CAVE menu, as shown in Exhibit 2.1.1-2. Additional mouse button functions are described
in Subsection 3.3.8-Objective 6.5.

Exhibit 2.1.1-2. CAVE Preferences Dialog Box for Mouse Button Configuration

Table 2.1.1-1 lists the default legacy mouse button functions and user interface locations of each mouse button action for all three mouse buttons (B1 through B3). Most of the mouse actions
described are related to features that are covered in detail in upcoming chapters. The procedures described in this manual are written per the default mouse button configuration. However, you
can change the mouse button configuration or add your own shortcuts using the Preferences dialog box.

Note 2: The mouse buttons are user defined, linked to your log-in ID.

Table 2.1.1-1 B1. Legacy Mouse Button 1 (B1) Functions for the CAVE Workspace

Function Mouse Action Cursor Location

Open Dropdown Menus Click B1 On Menu Bar



Create Tear-off Menus Click B1 On Dashed Line of Dropdown Menu

Activate Menu Buttons Click B1 On Toolbar

Make Menu Selection Click B1 In Menu

Iconify Dialog Box Click B1 In Little Square in Title Bar of Dialog Boxes

Zoom Out Click B1 In Main Display Pane and Smaller Monitor Panes

Zoom Out 1:1 Shift + Click
B1

In Main Display Pane and Smaller Monitor Panes

Toggle Product Legend Click B1 On Legend in Main Display Pane

Sample Data Click and Hold
B1

In Main Display Pane and Smaller Monitor Panes with Image
Data, METAR, Ceiling/Vis Plots, or Wind Vector Grids

Drag Slider to Desired Setting Click and Hold
B1

On Slider Bar in Dialog Box

Move Point, Baseline, Distance Speed,
WarnGen Vertex; Select Alert Area

Click and Hold
B1

In Main Display Pane and Smaller Monitor Panes

Pop (bring window to front) Click B1 In Title Bar or frame of Any Window or Dialog Box

Move Click and Hold
B1

In Title Bar of Any Window or Dialog Box

Shade (roll up/unroll) Double-click
B1

In Title Bar of Any Window or Dialog Box

Table 2.1.1-1 B2. Legacy Mouse Button 2 (B2) Functions for the CAVE Workspace

Function Mouse Action Cursor Location

Zoom In Click B2 In Main Display Pane and Smaller Monitor
Panes

Pan Across Zoomed Product Click and Hold B2, Drag
Mouse

In Main Display Pane and Smaller Monitor
Panes

Toggle Product Between Contour and Image
(or Barbs, Arrows, and Streamlines for Wind
Data)

Click B2 On Product Name in Volume Browser

Toggle Tools' Editability Click B2 On Tool Legend in Main Display Pane

Insert/Delete Vertices When Editing Warning
Box

Click B2 On Lines/Vertices of Warning Box in Large
and Small Display Panes

Expand or Compress Section of Color Bar Click and Hold B2, Drag
Mouse, Release to see
change

On Color Bar in Image Colors Editor

Move Window or Dialog Box Without Popping Click and Hold B2, Drag
Mouse

In Title Bar of Any Window or Dialog Box
That Is Partially Covered by CAVE Display

Table 2.1.1-1 B3. Legacy Mouse Button 3 (B3) Functions for the CAVE Workspace

Function Mouse Action Cursor Location

Swap Smaller Monitor Pane with
Main Display Pane

Click B3 In Smaller Monitor Panes

Pop/Push Dialog Boxes Click B3 In Title Bar of CAVE Display or Dialog Box

Toggle All Product Legends Click B3 Over Displayed Product in Main Display Pane

Bring Up Color Table Click B3 On Legend in Main Display Pane

Open Respective Pop-up Menu Click and
Hold B3

On Legends or Over Displayed Products in Main Display Pane and
Smaller Monitor Panes and in 4 Panel

Open Pop-Up Menu in Volume
Browser

Click and
Hold B3

On Product Name in Volume Browser

Toggle Alert Cells Click B3 In Radar Alert Area

Keyboard: Exhibit 2.1.1-3 shows a typical AWIPS Workstation keyboard.

Exhibit 2.1.1-3. AWIPS Workstation Keyboard

Keyboard Shortcuts: Instead of using the mouse pointer for every workstation display manipulation, some functions can be activated by pressing a combination of keyboard keys, called
Keyboard Shortcuts.

Note 3: Keyboard shortcuts are not case sensitive, even though they appear in uppercase on the menus; you can use upper or lowercase letters.

Keyboard shortcuts for menu functions: Keyboard shortcuts can be found to the right of some menu options listed on the CAVE menus. A list of available keyboard shortcuts for
menu functions is provided in Table 2.1.1-2.

Table 2.1.1-2. Keyboard Shortcuts for Menu Functions

Menu Function
Keys or Key

Combinations

File Menu Functions

New Procedure Ctrl + n

Open Procedure Ctrl + o

Delete Procedure - requires acknowledgment Ctrl + d



Copy Display to Procedure(s) Ctrl + b

Open History List Ctrl + h

Open Print Dialog Box Ctrl + p

Exit CAVE - requires acknowledgment Alt + F4

View Menu Function

Clear Main Display Pane Ctrl + c

Options Menu Functions

Turn on Time Options Ctrl + t

Turn on Data Scale Ctrl + s

Open Loop Properties Dialog Box Ctrl + l

Open Image Properties Dialog Box Ctrl + i

Miscellaneous Functions

Open first dropdown menu. Use arrows to scroll through every menu option of each menu. Press
Enter key on keyboard to make a menu selection.

F10

Cursor Location F12

Keyboard shortcuts for large display pane: For functions that manipulate the main D2D display (the Main Display Pane), the keyboard shortcuts are entered using the arrow keys and
the numeric keypad. Table 2.1.1-3 identifies the keyboard shortcuts for the main D2D display functions. You should become familiar with using these keys, because they provide
convenient shortcuts to perform routine display manipulations.

Table 2.1.1-3. Keyboard Shortcuts for Main Display Pane Functions

Functions Key or Key Combinations

Navigation Functions

Step Back, Step Forward (at Current Tilt for All-Tilts Display) Left Arrow, Right Arrow

Step Back, Step Forward Through All Frames Ignoring Any Tilt Considerations Shift + Left Arrow, Shift +
Right Arrow

First Frame, Last Frame in the Collection Ctrl + Left Arrow, Ctrl + Right
Arrow

Step Up, Step Down Through All-Tilts for the Currently Displayed Time Up Arrow, Down Arrow

Increase, Decrease Loop Speed (Turns on Looping) Page Up, Page Down

Zoom Out 1:1 Shift + Mouse Button 1

Toggle/Fade Functions - Num Lock Must Be On

Toggle Image Keypad 0

Toggle Overlays 1-9 Keypad 1- 9

Toggle Overlays 10-19 Ctrl + Keypad 0-9

Image 1/Image 2 Toggle Keypad . (Decimal)

- Single Image: Reduce Brightness, Increase Brightness
- Combined Image: Fade to Image 1, Fade to Image 2

Keypad -, Keypad +

Legend Functions

Legend Cycle:
1. Show Product Legends
2. Show Map Legends
3. Show Valid Time

Keypad Enter

Panel/Combo Rotate Functions

Enter panel/combo rotate mode, showing upper left product with most 'fade'; step to next
panel if already in rotate mode.

Delete

Enter panel/combo rotate mode, showing upper left product with most 'fade'; step to
previous panel if already in rotate mode.

Backspace

Enter panel/combo rotate mode (also true for 2..8); show left-hand image of upper left
panel

1

Show left-hand image of upper right panel 2

Show left-hand image of lower right panel 3

Show left-hand image of lower left panel 4

Show right-hand image of upper left panel 5

Show right-hand image of upper right panel 6

Show right-hand image of lower right panel 7

Show right-hand image of lower left panel 8

Return to 4-panel display End

Keyboard shortcuts for loop and step functions: Table 2.1.1-4 lists the loop and step arrow keys and keypad functions. For more information about looping and stepping through a
display, see the All-Tilts section in Subsection 2.2.6.12, or see the All-Tilts practice module in Subsection 3.3.8-Objective 7.6.

Table 2.1.1-4. Loop and Step Keypad Shortcuts

Button Function

Left Arrow Step Backward in Time at a Fixed Tilt (Single-Tilt Mode)

Right Arrow Step Forward in Time at a Fixed Tilt (Single-Tilt Mode)

Shift + Left Arrow Step Backward Through All Frames Ignoring Any Tilt Considerations (All-Tilts Mode)

Shift + Right Arrow Step Forward Through All Frames Ignoring Any Tilt Considerations (All-Tilts Mode)

Ctrl + Left Arrow Displays First Frame and Returns to the Default Navigation Mode

Ctrl + Right Arrow Displays Last Frame and Returns to the Default Navigation Mode

Ctrl + Down Arrow Displays First Frame of a Tilt or Volume Scan (Single-Tilt and Single-Volume Display Mode)

Ctrl + Up Arrow Displays Last Frame of a Tilt or Volume Scan (Single-Tilt and Single-Volume Mode)

Page Up Start/Speed Up Loop

Page Down Start/Slow Down Loop

Up Arrow Step Upward at the Currently Displayed Time (Single-Volume Mode)

Down Arrow Step Downward at the Currently Displayed Time (Single-Volume Mode)

Shift + Up Arrow No Function



Shift + Down Arrow No Function

Notes:

If you hit the up or down arrow after a standard load, and then hit Page Up or Page Down to
start looping, you'll find that you have an 'uninteresting' loop - that is, a loop of one frame -
until you hit one of the step forward/backward keys. The reason is that using up/down puts you
in loop-within-a-volume (Single Volume) mode, and there's no vertical component to your data.

The default looping behavior immediately after loading is to loop ignoring any tilt
considerations until one of the arrow keys is used. Otherwise, the form of looping depends on
whether you most recently used the left/right or up/down arrows prior to starting the loop.

For All-Tilts, the meaning of first and last frame is bottom and top if you have been using the
up/down motion; oldest and newest if stepping by time; and oldest/lowest and newest/highest if
navigating all frames.



2.2 The AWIPS Graphical User Interface

This section describes the AWIPS Graphical User Interface (GUI) that is displayed on the AWIPS Graphic Workstation. The three graphic displays that comprise the Graphic Workstation share a common
keyboard, three button mouse, and central processing unit (CPU - LX), as shown in Exhibit 2.1-1. The GUI enables forecasters to view many different types of meteorological data on one system.

This section discusses the following topics:

Starting AWIPS and Accessing CAVE - Subsection 2.2.1

Layout of CAVE's Graphical User Interface (GUI) - Subsection 2.2.2

CAVE Perspectives - Subsection 2.2.3

Windows, Tooltips, Menus, Dialog Boxes, and Other CAVE Operational Features - Subsection 2.2.4

Reserved - Subsection 2.2.5

The Menu Bar - Subsection 2.2.6

The Toolbar and CAVE Perspectives Tab Bar - Subsection 2.2.7

Pop-up Menus - Subsection 2.2.8

The Meteorological World of Color - Subsection 2.2.9



2.2.1 Starting AWIPS and Accessing CAVE

This subsection explains how to start AWIPS (starting your user session) and how to access CAVE. It then explains how to exit CAVE and end your user session by returning you to the Login window,
rather than shutting down the Workstation altogether.

Starting AWIPS

Prior to logging into an AWIPS Workstation, you should have the following information, which can be obtained from your System Administrator:

Your AWIPS user account with properly formatted username and password (see Appendix C),1. 

The localization server URL address (Sample format: http://ec:9581/services),2. 

Your three-character site ID (Sample format: BOX).3. 

Whether logging into a Graphic (LX) Workstation or a Text (XT) Workstation, the login windows shown in Exhibit 2.2.1-1 will be the first windows you encounter. Enter your username and click the Log
In button to close the username window and open the password window. Enter your password and click the Log In button to access AWIPS, or the Cancel button to end your activity.

Exhibit 2.2.1-1. AWIPS Username/Password Login Windows

If you are logging into AWIPS for the first time since an AWIPS software update, the Connectivity Preferences dialog box shown in Exhibit 2.2.1-2 may appear after a successful username + password
login.

Exhibit 2.2.1-2. Connectivity Preferences Dialog Box (Fields populated with sample data)

If this dialog opens, enter the information you obtained from your System Administrator to validate your connection to the localization server. Click the OK button after you receive a successful connection
message, which will then close the Connectivity Preferences dialog and open the GNOME desktop shown in Exhibit 2.2.1-3.



Exhibit 2.2.1-3. Default AWIPS GNOME Desktop

Note 1: The default GNOME desktop includes the six shortcut icons shown in Exhibit 2.2.1-3. The desktop is user-based, which enables you to personalize your desktop with additional shortcuts,
or link to your old KDE desktop and move shortcuts from there to your new GNOME desktop.

Selecting the Main Menu icon (Red Hat symbol) on the GNOME Panel opens the Main menu shown in Exhibit 2.2.1-4. From the Main menu you can access the AWIPS Menu. You can also access the
AWIPS Menu by selecting the AWIPS Menu icon on the GNOME Panel. You can access the AWIPS Start-up Menu from the AWIPS Menu.

Exhibit 2.2.1-4. Accessing the Main Menu, AWIPS Menu, and AWIPS Start-up Menu

Accessing CAVE

Alert Visualization (AlertViz) MUST be active before starting CAVE. The AlertViz symbol shown on the GNOME Panel in Exhibit 2.2.1-3 indicates AlertViz is active. Inactive status is indicated by the
absence of the symbol. If AlertViz is not yet active follow the instructions in "Starting AlertViz" below to activate AlertViz before you attempt to start CAVE. If AlertViz is already active, skip to the
instructions for "Starting CAVE."

Starting AlertViz

If the AlertViz symbol is not displayed, open the AWIPS start-up menu and select the Start AlertViz option to start AlertViz, which will display the AlertViz symbol. There are three ways to access
the AWIPS start-up menu:

On GNOME desktop, select AWIPS start-up menu shortcut,

On GNOME Panel, select AWIPS Menu icon > AWIPS start-up menu, or

On GNOME Panel, select Main Menu icon > AWIPS Menu > AWIPS start-up menu.

AlertViz should now be active with the AlertViz symbol displayed on the GNOME Panel. You can proceed with accessing CAVE.

Starting CAVE

There are four ways to access CAVE:



On the GNOME desktop, select the Start CAVE (lx) / TextWS (xt) shortcut icon,

On the GNOME desktop, select the AWIPS start-up menu shortcut icon and then select the Start CAVE (lx) / TextWS (xt) option,

On the GNOME Panel, select the Main Menu icon. When the Main Menu opens, select the AWIPS Menu option and then the Start CAVE (lx) / TextWS (xt) option, or

On the GNOME Panel, select the AWIPS Menu icon. When the AWIPS Menu opens, select the Start CAVE (lx) / TextWS (xt) option.

The CAVE start-up splash screen shown in Exhibit 2.2.1-5 appears while the system is launching CAVE. The blue progress bar, located at the bottom of the splash screen, appears a few seconds
after the screen displays.

Exhibit 2.2.1-5. CAVE Start-up Splash Screen with Launching Progress Indicator

CAVE starts immediately when the system is fully up and running by opening to the default screen of the CAVE perspective being viewed prior to ending the session. The opening screen shown in
Exhibit 2.2.1-6 indicates that the D2D perspective was active when the session ended.

Exhibit 2.2.1-6. Default Screen of CAVE D2D Perspective with CAVE Menu Selected

Exiting CAVE and Exiting AWIPS

Note 2: It is important to exit CAVE before ending your user session (exiting AWIPS).

There are two ways to exit CAVE (both shown in Exhibit 2.2.1-6):

On the CAVE Title Bar, select the X icon, or

On the CAVE menu, select the Exit option.

To end your user session by logging out of AWIPS rather than shutting down the Workstation, select Log Out ... from the Main Menu, as shown in Exhibit 2.2.1-7. The session will automatically close
after selecting the log out option. A confirmation dialog box will only appear if you choose the shut down option. The Workstation will automatically shut down after 60 seconds unless you cancel the
operation.



Exhibit 2.2.1-7. Logging Out of Your Session



2.2.2 Layout of CAVE's Graphical User Interface (GUI)

CAVE Display Components

This is an overview of CAVE's graphical user interface (GUI). From the system point of view, the entire CAVE interface is a window. As such, it can be moved, minimized (iconified), restored, etc., in the
same way as any other window displayed by the system. It is also resizable. The display features introduced here are covered more thoroughly in Subsection 2.2.4. Exhibit 2.2.2-1 illustrates the layout of
the CAVE graphics screen. All the perspectives have been selected, as indicated by the iconified tabs appearing on the CAVE Perspectives Tab Bar. However, only the D2D 5 pane perspective is currently
showing, as indicated by the display, as well as by the highlighted tab.

Exhibit 2.2.2-1. CAVE Graphical User Interface (GUI)

Note: The Multiple Radar/Multiple Sensor (MRMS) item in the menu bar as show in Exhibit 2.2.2-2 is visible to the users. The selections under MRMS has been grayed out on the D2D menu as shown in
Exhibit 2.2.2-3 to disable the system from ingesting the data when it starts coming over the SBN. These will be turned back on in 14.4.1.

Note: MRMS allows users to access products related to the Multiple-Radar / Multiple-Sensor (MRMS) system that was initially developed by the National Severe Storms Laboratory (NSSL), and
subsequently made operational at the National Centers of Environmental Prediction (NCEP). This was originally planned for 14.3.1, but will not be delivered untill 14.4.1. All the D2D Exhibits will be
updated with the new screens once the MRMS is activated.

Exhibit 2.2.2-2. MRMS Menu on D2D



Exhibit 2.2.2-3. Expanded MRMS Menu

The various sections of the graphics screen from Exhibit 2.2.2-1 are described below.

CAVE Screen Layout:

Title Bar: The Title Bar is the top border of the CAVE window. At the center of the bar, CAVE: is followed by the three-character Site ID, and CAVE perspective. For example, in Exhibit
2.2.2-1, the CAVE GUI displayed on the screen is for BOX (Taunton, MA) in the D2D perspective.

Menu Bar: The first row of labels (menu buttons) is the Menu Bar. These menu buttons open dropdown menus that contain a large number of graphic or image products from various data
sources. The menus that display along the Menu Bar are determined by the perspective that is selected.

Toolbar: The second row of labels is the Toolbar, which contains buttons and option menus for manipulating displayed data. The Toolbar can be hidden if desired. The button for WarnGen,
which opens the Warning Generation application, is also located on the Toolbar.

CAVE Perspectives Tab Bar: The third row is the CAVE Perspectives Tab Bar. It always contains the Open Perspective iconified button and at least one iconified tab for the currently
selected perspective (Refer to Subsection 2.2.3).

Main Display Pane: The Main Display Pane is where all data selections are initially displayed and where Toolbar manipulations take place. Products that you select for display always appear
in the large display pane.

Smaller Monitor Panes: The Smaller Monitor Panes are located along the left side of the Main Display Pane. They are only displayed with the D2D perspective (D2D 5 pane has 4 Smaller
Monitor Panes and D2D 3 pane has 2 Smaller Monitor Panes). They are used for both displaying and monitoring data.

Note 1: Swapping Pane Contents: Clicking mouse Button 3 (B3) opens a menu with an option for swapping the contents of the large display pane into the small pane. Data is
automatically updated in these small panes; looping, zooming, and panning are also possible.

Note 2: Pane Size: The size of all panes is adjustable. Click and hold mouse Button 1 (B1) on the pane's border and drag either horizontally or vertically to resize the pane. The size of
the map background adjusts accordingly.

AlertViz Status Bar: Floating along the bottom of the CAVE window is the AlertViz Status Bar. Remember that AlertViz must be active to open CAVE; therefore the AlertViz Status Bar is
always present. The AlertViz Status Bar contains two message windows for displaying an alert when it occurs.

Frames Status Window: The Frames Status Window displays the number of frames that are open, which may or may not be the same number of frames that are selected from the Frames
button on the Toolbar. The window expands to accommodate the number of digits (1 - 64).

System and CAVE Time and Date Status: The System Time and Date is located on the right side of the GNOME Panel below the CAVE window. The CAVE Time and Date is at the bottom
of the CAVE window. System time is the current date and time of day, with the CAVE usually reading the same. However, the forecaster can change the CAVE time and date in order to look at
past data and grid information.

Display Indicator: The Display Indicator is a tab located on the GNOME Panel; it indicates the windows that are curently displayed on the GNOME desktop. For example, in Exhibit 2.2.2-1
only the CAVE:BOX - D2D window is displayed. Multiple tabs indicate multiple windows open on the desktop. Selecting a specific tab moves the corresponding window to the front of the
pack.



2.2.3 CAVE Perspectives

CAVE incorporates a collection of applications that are separate from the legacy AWIPS system. Each application is contained in its own perspective, a user interface that contains different graphical
layouts, tool bars, and menu items unique to the application. The applications incorporated in CAVE consist of applications from the legacy AWIPS system (D2D, GFE, Hydro, and MPE). Also included
are Localization and Other (XML).

The CAVE Perspectives Tab Bar includes the Open Perspective iconified button and at least one iconified tab indicating the currently selected perspective. Selecting the Open Perspective icon drops down
a list of perspectives, as shown in Exhibit 2.2.3-1. When a perspective is selected from the list, an iconified tab for the selected perspective is added to the tab bar to indicate the perspective is opened, and
the tab remains on the tab bar until the perspective is closed. The highlighted tab indicates the perspective that is currently active. The tabs enable the user to move quickly between the different open
perspectives by selecting the tab for the respective perspective.

Exhibit 2.2.3-1. Open Perspective Dropdown Menu

Note: You can also access the list of perspectives from the CAVE menu (Refer to Section 2.2.6.1).

The CAVE perspectives and their respective display screens follow.

D2D (Display 2-Dimensions): This perspective is used to derive gridded forecasts for various meteorological variables and forecast products. There are two D2D display configurations: a 3 pane
perspective consisting of a Main Display Pane and 2 Smaller Monitor Panes (not shown) and a 5 pane perspective consisting of a Main Display Pane and 4 Smaller Monitor Panes, as shown in
Exhibit 2.2.3-2.

Exhibit 2.2.3-2. D2D 5 Pane Perspective

GFE (Graphical Forecast Editor): This perspective is used to derive gridded forecasts for various meteorological variables and forecast products. The GFE perspective displays only a Main
Display Pane (Spatial Editor). Above the Spatial Editor is a GFE Toolbar and a Weather Element block (Grid Manager), as shown in Exhibit 2.2.3-3.



Exhibit 2.2.3-3. GFE Perspective

Hydro: This perspective displays hydrological data. The Hydro perspective displays only a Main Display Pane, as shown in Exhibit 2.2.3-4.

Exhibit 2.2.3-4. Hydro Perspective

Localization: This perspective displays localization data for the other perspectives and CAVE. The Localization perspective displays a Main Display Pane in the middle of the screen to display
mapping, an area on the left side for selecting specific files, and an area on the right side for localization script outlines, as shown in Exhibit 2.2.3-5.



Exhibit 2.2.3-5. Localization Perspective

MPE: This perspective displays hydrological data within the WHFS MPE Data Viewer. The Choose Data Period dialog window enables filtering the information displayed. The MPE perspective
displays only a Main Display Pane, as shown in Exhibit 2.2.3-6.

Exhibit 2.2.3-6. MPE Perspective

Other: This option undocks the CAVE Open Perspective dropdown box and displays it as a floating pallet, as shown in Exhibit 2.2.3-7.

Exhibit 2.2.3-7. Floating Open Perspective Pallet

The Open Perspective floating pallet can be manually relocated to any desired location within the area of the display screen. The National Centers perspective is added to the list of perspectives via
the floating pallet. Selecting NCP opens the National Centers perspective shown in Exhibit 2.2.3-8.



Exhibit 2.2.3-8. National Centers Perspective



2.2.4 Windows, Tooltips, Menus, Dialog Boxes, and Other CAVE Operational Features

This subsection describes some distinctions among CAVE's windows, menus, dialog boxes, and other CAVE operational features, such as the manner in which CAVE responds to system problems.
Understanding these distinctions can help you become more comfortable navigating the CAVE interface. Remember that the menus, tools, and other components that are displayed depend on the selected
perspective.

Special Feature

Tear-off Menus: The parent menus and submenus on the CAVE menu bar, for all perspectives, can be detached from the menu bar or the parent menu, as shown in Exhibit 2.2.4-1. Tear-off
menus are indicated, at the top of the menu, by the presence of a dashed line, or "perforation."

Exhibit 2.2.4-1. Tear-off Menus

Menus can be torn away by clicking on the dashed line. The system responds by making the menu into a separate window, as shown in Exhibit 2.2.4-1. Then the torn-off menu can be moved
out of the way of your viewing area. As with all other windows, it can also be resized and closed, or left open while you access other menus.

Note 1: You can have multiple windows open at the same time, but you cannot make multiple tear-offs of the same menu.

CAVE Navigating Devices

Dropdown Menus: The primary means of navigating CAVE is via the menus, with the majority of those menus being the dropdown type, such as the example shown in Exhibit 2.2.4-2.

Exhibit 2.2.4-2. A Dropdown Menu

Options Menus: Options menus, located on the Toolbar, behave like dropdown menus but display the selected option's label in the menu button. Options menus are denoted with a small down
arrow, as shown in Exhibit 2.2.4-3.

Exhibit 2.2.4-3. An Option Menu (CONUS Selected)



Cascading Options Menus: Some menus lead to other menus, and in turn these menus can then lead to additional menus, etc. This forms a cascading pattern, as shown in Exhibit 2.2.4-4.
These subsequent menus are called submenus, or pull-right second stage submenus. They are indicated by a solid black right-pointing arrowhead located to the right of a parent menu option.
The color of the arrowhead changes from black to white when the option is selected.

Exhibit 2.2.4-4. Cascading Options - Pull-right Second Stage Submenu

In order to remain displayed on the screen, pull-right menus sometimes need to cascade to the left. Also, when these menus are attached to the parent CAVE menu bar, you can open the next
stage of a submenu by moving the mouse cursor over the option that includes a right-pointing arrowhead. Then slide the cursor to the right or left to the submenu for selecting an option.
Detached menus (tear-off) require you to scroll to the option that includes a right-pointing arrowhead and click mouse Button 1 (B1) to open the next stage submenu.

Dialog Boxes (Dialogs): Dialog boxes, or commonly shortened to just “dialog,” are windows that are independent of the main CAVE window. They are typically opened from a menu option
containing an ellipsis (three dots after the menu option), as shown in Exhibit 2.2.4-5.

Exhibit 2.2.4-5. Example of an Ellipsis for Opening a Dialog Box

An example of a dialog box is shown in Exhibit 2.2.4-6. Dialogs enable you to interact with the interface in a specialized way.

Exhibit 2.2.4-6. An Example of a Dialog

Moving dialog boxes: Dialog boxes can be moved in the same way that other windows are moved, that is, by pressing and holding mouse Button 1 (B1) over the window's Title Bar,
then dragging the window to the new location.

Dialog boxes can also be moved in front of other windows (popped) or behind other windows (pushed). This means that it is possible (either intentionally or accidentally) to pop or push
a dialog box relative to the CAVE window. In the latter case, the dialog box will seem to have disappeared. Should this happen, simply go to the parent menu and reselect the item that
has "disappeared," and either click on its icon on the Panel or click with mouse Button 3 on the CAVE Title Bar to push CAVE back, revealing the dialog box.

Minimizing or resizing dialog boxes: Dialog boxes can be minimized or resized in the same way that other windows are minimized or resized, that is, by clicking the appropriate
iconified Minimize or Resize button (if available) in the upper right corner of the window. When minimized, the dialog box "vanishes" from the screen. The dialog box can be restored
by clicking on its icon listed on the top portion of the Panel on the left side of the screen (refer to Exhibit 2.2.2-1).

Closing dialog boxes: Dialog boxes can be closed in the same way that other windows are closed, that is, by clicking the iconified Close button in the upper right corner of the window.
If a Close, Exit, or Cancel button is present on the window, it should always be used to close the dialog box. Some dialog boxes have a menu bar. When a menu bar is present, the "close"
or "exit" option is under the File menu. In this case, the dialog box should always be closed from the File menu option.

Navigation Tools and Rules

Tooltips: Moving the mouse cursor over the items on the Toolbar displays "Tooltips," as shown in Exhibit 2.2.4-7. Tooltips are helpful identifiers of the iconified buttons on the Toolbar. If you
do not want "Tooltips" to appear, they can be toggled off by going to the Help pull-down menu and unchecking the Show tooltips option.



Exhibit 2.2.4-7. Example of a Tooltip

Pop-up Menus: Pop-up menus contain options that are specific to a certain area of the CAVE workspace (main display pane, smaller monitor panes, four-panel layout, or legends), and
specific to the type of product being displayed (graphic plot, contoured graphic, or image). Pop-up menus are built into the CAVE user interface, providing no visual cue of their presence; they
simply pop up when you perform a particular action. All pop-up menus in CAVE are opened by pressing and holding mouse Button 3 in a specific area on the screen, such as the window's title
bar, a dialog box, or on a product legend. For a detailed description of CAVE pop-up menus (refer to Subsection 2.2.8).

General CAVE Menu Navigating Rules: Understanding the following general rules will help you to become more comfortable navigating the CAVE menus:

Menu option selection: To choose a menu option, click the desired option. To close the menu without selecting an option, click anywhere outside the menu. You can save mouse clicks
by pressing and holding mouse Button 3 over the menu button, dragging the mouse cursor through the menu until the desired option is highlighted, and then releasing the button. The
requested action is initiated and the menu closes immediately.

Hovering mouse cursor (left-pointing arrow): When the mouse cursor hovers over the display window or a dialog box, the window's title bar is highlighted, and the window is said to
have focus. Sometimes, when traversing the mouse cursor from screen to screen, the display window fails to get focus; in this case, keyboard shortcuts will not work. You may need to
move the mouse cursor out of and back into the window, or even click on its title bar, to regain focus.

Raised menu item text: If the text of a menu item appears raised from the plane of the menu, that item is highlighted. A highlighted menu item is surrounded by a light gray or purple
box. An item can be highlighted, but it still needs to be selected, by clicking on it, to initiate the action or to display the product.

Menu on-off check boxes: Some menus have small square boxes to the left of the items on the menu. These are on-off checkboxes; that is, they are used to start or stop the indicated
action. If an action is on, the box is checked. To turn the action off, click the checkbox. The checkmark is removed from the checkbox and the action is stopped.

Product data availability: The availability of data is not dependent on scale or projection. All data-selection menus have a valid date and time adjacent to the product name. It means
the item is available and indicates the most currently available version of the product. Whenever the Notification Server is updated, the "time" automatically updates. The format is
(dd.hhmm). When data is not available or is not updating, or the system has not been notified that new data is available, dashes (--.----) appear in place of the date and time.

Other CAVE Operational Displays

Auto Update

As new versions of currently loaded products become available to the system, they are automatically displayed. Auto Update functions in all five display panes. For example, if you are
displaying Meteorological Aviation Report (METAR) station plots and new data is received in the database, the new METARs are plotted on the screen.

Time Matching

By default, when you add overlays to a displayed product, the system matches the valid times to those of the initially displayed product. This feature can be overridden by using the "Load
Modes" function. Time Options also allows you to override standard time matching (refer to Subsection 2.2.6.4).

CAVE Status Messages

When data is missing or incomplete, or there are other problems with the workstation, the Alert Visualization Popup Message Dialog appears announcing an alert (refer to Chapter 15).

Note 2: There are three alert message priority levels: Routine, Significant, and Urgent. Routine and Significant Radar status messages may include announcements from the Radar Product
Generator (RPG) and are often related to the radar applications (refer to Chapter 8).



2.2.5 Reserved



2.2.6 The Menu Bar

This section briefly describes the options available from the CAVE menu bar. The Menu Bar shown in Exhibit 2.2.6-1 is that of the D2D Perspective. The D2D Perspective tab is highlighted, indicating
the selected Perspective. The menu bar consists of menu buttons that open dropdown menus applicable to the D2D Perspective.

Exhibit 2.2.6-1. D2D Perspective Menu Bar Options

Note 1: The actions "Display" and "Load" are used interchangeably in this manual. Both refer to the action(s) the system takes once you have selected one or more products. With the exception of the
Volume Browser, a product is loaded to the large display pane immediately after you have selected it. In the Volume Browser, you must explicitly select Load to have your product(s) displayed. Refer
to Section 3.2 for more information.

Note 2: The descriptions of the D2D Perspective Menu Bar options are presented in the order in which their buttons are displayed along the menu bar, moving from left to right. Keep in mind that
some menu button options require more detailed explanations, which you will find in subsequent sections of this manual.

Note 3: Some dropdown menu (i.e., kxxx, txxx, etc.) vary from site to site.



2.2.6.1 CAVE

Refer to Exhibit 2.2.6.1-1 for a display of the CAVE menu.

Exhibit 2.2.6.1-1. CAVE Dropdown Menu

The CAVE menu includes the following options:

New: The "New" option opens the submenu shown in Exhibit 2.2.6.1-2. This submenu provides users
with the options to create a new Map Projection; open a new Map Editor (tab); start the Text
Workstation application; and initiate and configure the GUI of the AvnFPS application via the Aviation
submenu option.

Exhibit 2.2.6.1-2. CAVE New Option Submenu
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Perspective: The "Perspective" option opens the submenu shown in Exhibit 2.2.6.1-3, which lists the
CAVE Perspectives. A new Perspective can be opened from here, or from the iconic Perspectives
button.

Exhibit 2.2.6.1-3. CAVE Perspective Option Submenu

Data Browsers: The "Data Browsers" option opens the submenu shown in Exhibit 2.2.6.1-4. This
submenu includes one option: the "Product Browser." Click on "Product Browser" to display an
Explorer-type tree structure that lists products by category (GFE, Grid, Lightning, Maps, Precipitation
Rate, QPF, Radar, Redbook, and Satellite).

Exhibit 2.2.6.1-4. Data Browsers Option Submenu with Product Browser Categories

Note 1: The "Product Browser" can be used to view data that might be ingested but for which
CAVE is not localized. For example, it is possible for EDEX to ingest and store radar data that
does not appear on the normal CAVE menus, but can be accessed by the "Product Browser."

Data Delivery: The "Data Delivery" option opens the Data Delivery application. Data Delivery is a
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permission-based application, meaning that the System Manager or User Administrator controls the
user's access to the Data Delivery functionalities. If granted permission to access this application, Data
Delivery allows a user to subscribe to a data source or create an ad hoc request and have the data
delivered in near real time. Whether delivered by subscription or in response to an ad hoc request, the
data can be tailored to a user's specific temporal, geographic, and parameter needs. For a detailed
description of the Data Delivery application, refer to Section 16.1.

Collaboration: The "Collaboration" option offers two main functions: chatting and sharing displays.
Chat allows users to send and receive instant messages or chat with fellow forecasters and offices in a
chat room. Sharing displays adds to the chat room capabilities and allows the room's creator to show a
CAVE map display to other participants in the room. For a detailed description of "Collaboration" and
information on how to create a chat session and share displays, refer to Section 16.2.

Archive: Archive Case Creation: The "Archive Case Creation" option is a component of the
AWIPS-2 Archiver application. The archiver application is a permission-based functionality. It allows a
user to extract stored weather event data and copy it into a user-defined directory to be archived (e.g.,
burned to a DVD). The archived data can later be played back for simulation of weather events using
the WES-2 Bridge. For a detailed description of the AWIPS-2 Archiver application and the "Archive
Case Creation" component, refer to Section 16.3. Archive Retention: The "Archive Retention" option
is a component of the AWIPS-2 Archiver application. The archiver retention functionality and its purge
component, which runs on EDEX, are permission-based functionalities. Access to the "Archive
Retention" option is limited to User Administrators and users identified as a database/purge focal point.
More information on these AWIPS-2 Archiver application functionalities are provided in the System
Manager's Manual.

AWIPS User Administration: Some of the functionalities of certain CAVE applications (currently,
Data Delivery and Localization) are reserved for designated users. User Administrators choose the
"AWIPS User Administration" option to access the screens they use to set permissions and roles for the
reserved functions. Access to the "AWIPS User Administration" option is limited to User
Administrators. Other users who select this option will be denied access and receive the Alert Message
shown in Exhibit 2.2.6.1-5. More information on AWIPS User Administration is provided in the
System Manager's Manual.
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Exhibit 2.2.6.1-5. AWIPS User Administration - Alert Message ("Not a User Administrator")

AWIPS Statistics: The "AWIPS Statistics" option offers two main functions: capturing system
performance and analyzing system performance statistics. The captured data is viewable via a graph or
.csv file. For a detailed description of "AWIPS Statistics," refer to Section 16.4.

Import: The "Import" option opens the submenu shown in Exhibit 2.2.6.1-6, which allows the user to
import GIS Data, BCD File, GeoTIFF, LPI File, SPI File, or Displays.

Exhibit 2.2.6.1-6. CAVE Import Option Submenu

The "GIS Data" option opens the GIS application, which provides the ability to import geospatial data
from varying GIS data sources. The GIS application has been incorporated into CAVE for use with
FX-Net. For a detailed description of the GIS Data application, refer to Section 16.5.

Export: The "Export" option opens the submenu shown in Exhibit 2.2.6.1-7, which allows the user to
save, send, and print captured displays. The displays can then be used in other applications or sent to
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other users for analysis.

Exhibit 2.2.6.1-7. CAVE Export Option submenu

The "Export" submenu also includes a "KML" option, which allows users to save D2D displays or
GFE grids in the KML (Keyhole Markup Language) file format. When zipped (compressed), the KML
file format forms a KMZ file, which can be used in applications such as Google Earth. Selecting KML
in D2D opens the Export KML dialog box shown in Exhibit 2.2.6.1-8.  Selecting KML in GFE opens
the Export KML dialog box shown in Exhibit 2.2.6.1-9.
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Exhibit 2.2.6.1-8. Export KML Dialog Box from D2D

Exhibit 2.2.6.1-9. Export KML Dialog Box from GFE

Note 2: The products loaded in the user's main D2D display pane or selected in GFE Grid
Manager are listed in the "Products" section of the Export KML dialog box. Only checked
products are exported.

The KML dialog box includes options to select frames to export. This includes exporting all frames,
the current/displayed frame, a range of frames, and, in GFE, the selected time range as highlighted in
the Grid Manager. Additional options are available for selection under the  "Other Options" section:

Export Selected: This option displays only for the GFE perspective.  When checked, only the
selected parameters in the Spatial Editor are exported.  When unchecked, all parameters for the
selected time range are exported.

Export Hidden: When selected, all displayed and hidden products listed in the Product Legend
of the Main Display Pane are exported.

Export Maps: When selected, all enabled maps displayed within the Main Display Pane are
exported.

Shade Earth: When selected, a shaded background is applied to the exported product. If loaded
in Google Earth, the earth is overlaid with a black backdrop, and data displays as it would in
D2D with a black background.

Show Background Tiles: When selected, data (such as plot data) displays on top of black tiles
when loaded in Google Earth.
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Load/Save Displays: The "Load/Save Displays" option opens the cascading submenu shown in
Exhibit 2.2.6.1-10, which provides the user with the ability to save or load displays to or from a given
path within the file directory of the workstation.

Exhibit 2.2.6.1-10. CAVE Load/Save Displays Option Submenu

Note 3: The Editor Display references the Main Display Pane, while the Perspective Displays
reference all the display panes (3 or 5).

Save Editor Display…: This option saves the data in the main display pane as an .xml file in the
user-specified location.  Selecting the Save Editor Display… option opens a File Browser
dialog.  Enter a name in the Name textbox, select a desired location, and click OK to save the
bundle.
Save Perspective Displays…: Selecting this option opens the Save Perspective Display As…
dialog.  If previous perspective displays have been saved, they are listed in the dialog.    To save
the perspective display, click the File… button to open the File Browser dialog.  Enter a name in
the Name textbox, select a desired location, and click OK to save the perspective display.
Load Displays…: Selecting this option opens the Open Perspective Display dialog.  From this
dialog, users can load a saved perspective display or import and load a saved editor display.

The Open Perspective Display dialog contains 3 filtering options: Show Mine, Show All Users, and Show
All.  Selecting the Show Mine radio button displays a list of saved perspective displays and imported editor
displays you created, separated by the level in which they were saved (e.g., USER, SITE, Local, etc.).
Selecting the Show All Users radio button displays a list of all users with their saved perspective displays
under their named directory.  Selecting the Show All radio button lists all existing users and their perspective
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displays at all levels (e.g., USER, WORKSTATION, etc.).

The Expand All and Collapse All buttons expand and contract all directories listed in the Open Perspective
Display dialog to show and hide the saved perspective displays and saved editor displays listed under each
directory.  You can also search for a perspective or editor display by typing its name in the textbox at the top
of the Open Perspective Display dialog.  Perspective or editor displays that match the entered text
automatically appear under the directory where they exist.

To open an existing perspective or editor display, double click on the perspective or editor display entry or
highlight it and press the OK button. Once selected, the perspective or editor display and the associated data
displays in D2D.

Saved editor displays do not appear in the Open Perspective display until they have been imported. 
Non-imported saved editor displays can be loaded from the Open Perspective Display dialog by clicking the
File… button, navigating to the location of the .xml file, selecting the file, and clicking OK.  The Local File
System directory appears in the Open Perspective Display dialog listing the file location for the selected file. 
It is at this time the user can import the saved editor display so it permanently appears in the Open
Perspective Display dialog when opened.  Click the Import checkbox to activate this option.  Clicking the OK
button imports the file (if selected) and loads the saved editor display. 
Note: Saved perspective display files and imported saved editor display files appear in the Localization
perspective under CAVE->Perspective Displays.

Note: Saved perspective display files and imported saved editor display files appear in the Localization
perspective under CAVE->Perspective Displays.

Preferences...: The "Preferences" option opens the Preferences dialog box, which allows the user to set
the Base Maps and Server Data directories; set the Database Connection String, Config Directory, and
Log Directory for the Hydro applications; set the Localization Site and/or Server for the workstation;
configure the Mouse operations; change the Performance Levels; set the Radar Server; set the Font
Magnification; and set the Text Workstation hostname.

Exit...(Alt + F4): The "Exit" option allows the user to shut down the CAVE workspace. (You can also
use the "Alt + F4" keyboard shortcut to exit.) When you choose this option, a dialog box appears in the
center of the display screen and asks you to confirm that you really want to quit.
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2.2.6.2 File

The File menu, shown in Exhibit 2.2.6.2-1, includes of the following options:

Exhibit 2.2.6.2-1. File Dropdown Menu

Procedures: The Procedures pull-right submenu, as shown in Exhibit 2.2.6.2-2 enables you to define and customize a sequence of routinely used products or products used for a particular forecast
problem. Refer to Subsection 3.1.1 for more information.

Exhibit 2.2.6.2-2. Procedures Pull-right Menu

Note 1: The Procedures that are under the File menu differ from the Procedures that are under the CAVE menu.

History List (Ctrl + h): A History List is a recall list of all the products loaded to the large display pane since the last restart of the workstation. Products in the history list are used to build
procedures. The History List can also be opened with the "Ctrl + h" keyboard shortcut. Refer to Subsection 3.1.1 for more information.

Print... (Ctrl + p): This menu option does not send anything to the printer, but rather allows you to setup the printing options by opening the Print dialog shown in Exhibit 2.2.6.2-3. The Print dialog
can also be opened with the "Ctrl + p" keyboard shortcut. To change the destination printer from the default (lp1), type the desired printer name in the Printer data entry field. Use lp2 for the color
printer.

Note 2: The Print Icon button on the Toolbar can also be used for default printing. Refer to Subsection 2.2.7

Exhibit 2.2.6.2-3. Print Options Dialog

Capture Window... : This menu option allows you to create screen shots (in PNG format) of objects contained in a framed window.  When you choose this option, the Window Capture dialog
shown in Exhibit 2.2.6.2-4 appears, requiring you to enter a filename. The location where the files are saved defaults to your username. You can enter a different location to store the captured files.

Exhibit 2.2.6.2-4. Window Capture Dialog

Once you type in a unique file name, press the OK menu button and the mouse cursor becomes a crosshair cursor.  Simply click on the desired window and wait a moment for the Window Capture
message box to appear, confirming that the screen capture is complete, and indicating where your file can be found.



2.2.6.3 View

The View dropdown menu, shown in Exhibit 2.2.6.3-1, contains nine options that control the display layout and product animation. All, except the Toolbar option, have corresponding Icon buttons in
the second row of menu options called the Toolbar. Refer to Subsection 2.2.7 for additional information on toolbar options.

Exhibit 2.2.6.3-1. View Dropdown Menu

Clear (Ctrl + C): This option clears the large display pane but retains the map background. You can also use the Ctrl + C keyboard shortcut to clear the large display pane, or the Clear button in
the Toolbar.

Step Back (Left): This menu option reverses the displayed data by one frame. You can also use the LEFT ARROW keyboard shortcut to step back, or the Step Back iconified button on the
Toolbar.

Step Forward (Right): This menu option advances the displayed data by one frame. You can also use the RIGHT ARROW keyboard shortcut to step forward, or the Step Forward iconified
button on the Toolbar. If you hit the UP or DOWN ARROW keys in a standard (not All-Tilts) display, stepping is disabled until you hit either the left or the right arrow key.

First Frame (Ctrl + Left): This option displays the first frame of available data. You can also use the Ctrl + LEFT ARROW keyboard shortcut or the First Frame iconified button on the
Toolbar.

Last Frame (Ctrl + Right): This option displays the last frame of available data. You can also use the Ctrl + RIGHT ARROW keyboard shortcut or the Last Frame iconified button on the
Toolbar.

Looping (Up/Dn;L/R): Check this box to enable animation (Page Up/Page Down buttons turn looping on, LEFT/RIGHT ARROWs turn looping off). You can also use the Loop Properties
Dialog Box or the Looping iconified button on the Toolbar. If you hit the UP or DOWN ARROW keys in a standard (not All-Tilts) display, looping is disabled until you hit either the left or the
right arrow key.

Default Pane Layout: This menu option arranges the display in the D2D 5 pane layout, with a Main Display Pane on the right side of the workstation display and four Smaller Monitor Panes of
equal size along the left side of the display. You can also set the display to the default (5 pane) layout by clicking the 5 pane iconified button on the Toolbar. Refer to Exhibit 2.2.6.3-2 for an
example of the D2D 5 pane layout.

Exhibit 2.2.6.3-2. Default D2D 5 pane Layout

Three Pane Layout: Refer to Exhibit 2.2.6.3-3. This option arranges the display to have one Main Display Pane and two medium-sized Smaller Monitor Panes along the left side of the display.
You can also set the display to the 3 pane layout by clicking the 3 pane iconified button on the Toolbar.



Exhibit 2.2.6.3-3. D2D 3 pane Layout

Toolbar: Check this box to show the Toolbar, namely, the second row of options along the top of the display. You can hide the Toolbar if you need more viewing space by unchecking this
checkbox.



2.2.6.4 Options

The Options menu, as shown in Exhibit 2.2.6.4-1, contains options that enable you to set display preferences such as magnification (graphic font size), density (amount of data displayed), looping speed,
color tables, and time resolution.

Exhibit 2.2.6.4-1. Options Dropdown Menu

Most of these options are available on the Toolbar or in other areas of the user interface, but are redundantly placed in this pull-down menu in case you want to hide the Toolbar. Refer to Subsection 2.2.7
for more information on Toolbar options.

Time Options (Ctrl  + T): This check button enables/disables the ability to select the time interval between frames of real-time or model data. This feature has the added benefit of allowing you to
view extended amounts of data (temporally) but stay within the limits of 64 frames. For example, METAR surface plots, which typically display every hour, can be set to display every three hours
via the Select Valid Time and Time Resolution Dialog Box.

When the Time Options check button is selected, the next product you choose to display in the Main Display Pane launches either the Select Valid Time and Time Resolution dialog box or the Select
Offset and Tolerance dialog box.

When you are loading data to an empty display and the Time Options check button is enabled, the Select Valid Time and Time Resolution dialog box opens.

Valid Time: In this column of dates/times, you may choose the one that will be the first frame loaded onto the Large Display Pane. The Default option is the most recent data.

Time Resolution: This column contains various time increments in which the data can be displayed. Once you make a selection, the Valid Time Column indents the exact times that will
be displayed. The Default resolution displays the most recent frames available.

With the Time Options check button enabled for a display that already contains data, when you choose the data to be overlaid in the Main Display Pane, the Select Offset and Tolerance dialog
box appears, providing the following options:

Offset: This column contains various time increments at intervals before, at, or after the time you selected for the first product that is displayed in the Main Display Pane.

Tolerance: The options in this column refer to how strict the time matching is. "None" means an exact match, while "Infinite" will put the closest match in each frame, regardless of how
far off it is.

Data Scale (Ctrl  + S): This check button enables/disables the ability to display data on its native scale. For example, if you enable Data Scaling and select a product from an alternate radar, the data
will be displayed with that radar in the center of the screen. Other data can be overlaid on this "dynamic" scale until the Main Display Pane is cleared or a non-plan-view product is loaded.

Image Combination (Insert): This check button enables/disables the ability to display two images at once. You can also enable/disable the ability to combine images by using the Toggle Image
Combination iconified button on the Toolbar.

Combined-image displays have been improved by removing the valid time for non-forecast products and removing the date string (time is kept) from the left side of the legend. In particular, this
makes All-Tilts radar legends more usable.

Note 1: If the time of both images is the same, the day-month-year string is shown only for the right-side image (unless it's not loaded, in which case the day-month-year is included on the left).

Display Properties...: This menu option opens the Display Properties dialog box. All the options available in this dialog box are also available on the Toolbar.

Scale: The Scale menu, which defaults to CONUS scale when CAVE is first started is shown in Exhibit 2.2.6.4-2. From this menu you can choose any of the scales defined for your location:
N. Hemisphere, North American, CONUS (Conterminous United States), Regional, State(s), and WFO (Weather Forecast Office).

Exhibit 2.2.6.4-2. Scale Menu with Default CONUS Scale Selected

The selected scale is shown on the toolbar when the Scale menu is closed. In Exhibit 2.2.6.4-2 CONUS is displayed on the toolbar indicating the CONUS scale is currently selected.

Note 2: The Scale menu options vary based on local needs and requirements. Data is not Scale dependent; it can be displayed on any scale.

The CONUS Scale is displayed in the Main Display Pane, and other map backgrounds with different scales are loaded into the four Smaller Monitor Panes. The Scale option menu affects only
the Main Display Pane. A swap is required to change the scale on a Smaller Monitor Pane.

Once data has been loaded, changing the scale will alter the map background. The data displayed will remain displayed. You can also swap the Smaller Monitor Pane showing the desired scale
with the Main Display Pane to change scales.



Load Mode: Also under the Display Properties option is Load Mode, shown in Exhibit 2.2.6.4-3, which provides different ways to display model or real-time data by manipulating previous
model runs and inventories of data sets.

Exhibit 2.2.6.4-3. Load Mode Option Menu

The selected load mode is shown on the toolbar when the Load Mode menu is closed. In Exhibit 2.2.6.4-3 Valid time seq is displayed on the toolbar indicating the Valid time seq load mode is
currently selected.

A description of the Load Mode options follow.

Latest: Displays forecast data only from the latest model run, but also backfills at the beginning of the loop with available frames from previous runs to satisfy the requested number of
frames.

Valid time seq: Displays the most recent data and fills empty frames with previous data. For models, it provides the product from the latest possible run for every available valid time.

No Backfill: Displays model data only from the most recent model run time with no backfilling to fill out a loop. Using this Load Mode prevents the mixing of old and new data.

Previous run: Displays the previous model run, backfilling with frames from previous runs at the beginning of the loop to satisfy the requested number of frames.

Prev valid time seq: Displays the previous model run and fills empty frames with previous model data or analyses.

Prognosis loop: Shows a sequence of n-hour forecasts from successive model runs.

Analysis loop: Loads a sequence of model analyses but no forecasts.

dProg/dt: Selects forecasts from different model runs that all have the same valid times. This load mode is available only when there are no other products loaded in the large display
pane.

Forced: Puts the latest version of a selected product in all frames without time-matching.

Forecast match: Overlays a model product only when its forecast times match those of an initially loaded product. This load mode is available only when another product is already
loaded in the large display pane.

Inventory: Selecting a product when the load mode is set to Inventory brings up a Dialog Box with the available forecast and inventory times from which you can select the product you
want. Inventory loads into the currently displayed frame.

Slot: Puts the latest version of a selected product in the currently displayed frame.

Note 3: Default Load Modes -- Latest Run and Valid Time Sequence are "sticky" default load modes. This means that the current load mode setting automatically defaults back to either
Latest Run or Valid Time Sequence, whichever you used before switching to another load mode.

Frames: Frames is used to select the number of frames of a product you want loaded. The startup default is 12 frames, but whatever number you choose is used until you change it. The
maximum frame count has been increased to 64.
Exception: Family graphics (see Subsection 2.2.6.6) come with a preset frame count, to allow you to see the entire model run.

Note 4: If no frames of data are available, the system sends a message to the General Status Area of the Status Bar. You can also use the Frames Option menu in the Toolbar.

Magnification: You can enlarge or reduce the size of text and symbols on a graphic product using the Mag: option. As you increase magnification, the density of the data presented
automatically decreases. The purpose of this feature is to make text and symbols more visible. Selecting Mag: 0 displays all the site locations without any visible data.

Density: The display features an automatic declutter function, which adjusts the density of station plots and contours for clarity of view. You can override the default setting to adjust the
amount of data presented on the large display pane by using the Density: option. You can also change the density setting from the Toolbar. Lower-density settings decrease the amount of data
displayed; higher settings increase the amount of data. The "Max" density setting displays all available data and therefore disables declutter.

Loop Properties... (Ctrl  + L): Loop Properties is another dialog box that can be opened from the Options menu or from the Loop Properties iconified button on the D2D Toolbar, or by using the
Ctrl  + L  keyboard shortcut. The dialog allows you to adjust the forward and backward speeds, with 0 = off and 10 = maximum speed. You can set the duration of the first and last frame dwell times
to between zero and 2.5 seconds.

You can turn looping on or off by checking the Looping check button. There is also a Looping button located on the Toolbar that enables/disables the animation in the large display pane. Finally, you
can turn looping on and increase/decrease forward speed by pressing Page Up/Page Down  on your keyboard, and turn looping off with the Left  or Right Arrow keys . On the toolbar, you can use
the button to start/stop looping.

Image Properties... (Ctrl  + I): The Image Properties dialog box can be opened here or by using the Image Properties iconified button on the D2D Toolbar, or using using the Ctrl  + I keyboard
shortcut. This dialog box provides options that allow you to change the color table; adjust the brightness, contrast, and alpha of either a single image or combined images; fade between combined
images; and/or interpolate the displayed data.

From this dialog box, you can also access the Image Colors Editor, which enables you to edit and save Image Color Tables. This option is selectable if an image or combined image product is
displayed. If a single image is loaded, the second color table selector and edit button are dimmed. Refer to Subsection 2.2.9 for more information on the Image Colors Editor.



Change Color Table of Image: The Color Table option menus are annotated with a color table name and a small rectangle. These menus provide a list of predefined or default color tables
(enhancement curves) available for use with displayed images.

While any color table can be used with any image, some are specifically designed for use with satellite imagery, some for use with radar imagery, and others for use with gridded data displayed
in image format. (Displaying gridded data as an image is covered in Subsection 3.2.4.)

Brightness Control Slider: The Brightness control slider changes the brightness of the display. Drag the slider (using mouse Button 1) to the desired level of brightness, and then release the
mouse to save and view the change in the display. To adjust the brightness one increment at a time, click adjacent to the slider using mouse Button 1 (this is called a "single step" change). To
adjust brightness to a specific level on the slider bar, place the pointer at the desired location along the slider bar and click mouse Button 2 (this is called a "snap to" change). Brightness can
also be adjusted using the "+" and "-" keyboard shortcuts on the keyboard after the Brightness slider bar has been selected (note the box that appears around the slider bar).

Note 5: All images have default brightness settings, but you may need to adjust them to make overlaid graphics and map backgrounds easier to see against the image.

Contrast Control Slider: The Contrast control slider changes the contrast of the display. Drag the slider (using mouse Button 1) to the desired contrast level, and then release the mouse to
save and view the change in the display. To adjust the contrast one increment at a time, click adjacent to the slider using mouse Button 1 (this is called a "single step" change). To adjust
contrast to a specific level on the slider bar, place the pointer at the desired location along the slider bar and click mouse Button 2 (this is called a "snap to" change). Contrast can also be
adjusted using the "+" and "-" keyboard shortcuts on the keyboard after the Contrast slider bar has been selected (note the box that appears around the slider bar).

Alpha Control Slider: The Alpha control slider changes the alpha level of the display. Drag the slider (using mouse Button 1) to the desired level, and then release the mouse to save and view
the change in the display. To adjust the alpha level one increment at a time, click adjacent to the slider using mouse Button 1 (this is called a "single step" change). To adjust alpha level to a
specific level on the slider bar, place the pointer at the desired location along the slider bar and click mouse Button 2 (this is called a "snap to" change). The alpha level can also be adjusted
using the "+" and "-" keyboard shortcuts on the keyboard after the Alpha slider bar has been selected (note the box that appears around the slider bar).

Note 6: All images have default alpha level settings, but you may need to adjust them to make overlaid graphics and map backgrounds easier to see against the image.

Interpolate: The Interpolate checkbox is located at the bottom of the Image Properties dialog box. To interpolate the displayed data, place the mouse cursor in the checkbox and click mouse
Button 1 to place a checkmark in the box. Then observe the change in the display. To revert the display so that the data is not interpolated, click the Interpolate checkbox to remove the
checkmark. Again, observe the change in the display.

Combine a Second Image: The check button in the lower right corner of the Image Properties dialog box allows you to combine a second image with an image already loaded. Combining
Image Products.)

Edit <product>: A click on the Edit <product> menu button brings up the Image Colors Editor dialog box. The Image Colors Editor allows you to make changes to a default color table for a
displayed image and to save your edits into a new color table. (Default color tables cannot be permanently changed.) Refer to Subsection 2.2.9 for details on how to use the Image Colors
Editor.

Combined Images: If combined images are loaded, the name of one product is displayed above the Fade Slider Bar, and the other name is displayed below the Fade Slider Bar.

Fade Slider Bar: The Fade Slider Bar in the middle of the dialog box lets you adjust how much of each image is visible on the screen. The Fade Slider Bar works the same way as the
Brightness Control Slider.

Note 7: You can fade an image using the "+" or "-" keyboard shortcuts. You can also toggle between the images using the "period" on the keyboard. Refer to Table 2.1.1-3 in
Subsection 2.1.1.

Brightness: This control works in the same manner for combined images as for single images. Refer to the Brightness Control Slider paragraph above.

Contrast: This control works in the same manner for combined images as for single images. Refer to the Contrast Control Slider paragraph above.

Alpha: This control works in the same manner for combined images as for single images. Refer to the Alpha Control Slider paragraph above.

Change Color Table: Both Color Table option menus are selectable. The top Color Table option menu corresponds to the product name displayed above the Fade Slider Bar. Similarly,
the bottom Color Table option menu corresponds to the product listed below the Fade Slider Bar.

Set Time... : This option allows you to set the CAVE clock, located on the bottom of the screen, to an earlier time for reviewing archived data. Selecting this option opens the Set Time dialog shown
in Exhibit 2.2.6.4-4. A description of the Set Time dialog options follow.

Note 8: All times are in Coordinated Universal Time (UTC), also known as Greenwich Mean Time (GMT) or "Z" time.

Exhibit 2.2.6.4-4. Set Time Dialog

Use current real time: This radio button switches the CAVE clock to the current System time. The System clock, or current real time, is located on the bottom of the Panel, left side of the
screen. In this mode the Set time parameter windows on the Set Time dialog box are dimmed.

Set time: This option allows you to set the CAVE clock to a different year, month, day, hour, minute, and/or second. For each element, a pair of "step buttons" allows you to set the option. You
can also click on the entry box and use the keyboard to enter a new value.

Freeze time at this position: This checkbox is only available when Set time is selected. Freeze time at this position stops the clock from ticking and is selected by default. If it is
unchecked, the clock will be set to the specified time and then advance normally.



OK: Applies the newly-selected time to the CAVE clock. If Freeze time is selected, the clock will display yellow text on a black background. If Freeze time is unselected, it will be white on
black.

Cancel: This menu button enables you to close the Set Time dialog box without applying the changes.

Set Background Color...: You can now set the background display color on your workstation. You can also set the background display color for a single pane via mouse Button 3 (B3). The "Set
Background Color for all Panes" dialog is shown in Exhibit 2.2.6.4-5.

Note 9: The background color is affected by the image brightness setting. Also, the sample color and color bar annotation are always white, so samples may be difficult or impossible to read if
you pick a very light background color.

Exhibit 2.2.6.4-5. Set Background Color for All Panes Dialog



2.2.6.5 Tools

Refer to Exhibit 2.2.6.5-1 for a display of the Tools menu.

Note 1: The tools listed on the Tools menu are ordered alphabetically, except for "Feature Following
Zoom" and "Time Of Arrival / Lead Time," which are logically associated with "Distance Speed."

Note 2: Many of the tools listed under the Tools menu can be placed into an editable state. Do not
enable the "Hide Legends" feature if you want to place a tool in an editable state, because access to
editability is by clicking mouse Button 2 (B2) over the Product Legend.

Exhibit 2.2.6.5-1. Tools Dropdown Menu

Az/Ran Overlay

This tool displays a movable azimuth/range radar map overlay. The overlay is in the "editable" state
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when displayed, and can be relocated by positioning the mouse cursor to the center of the overlay and
clicking and holding mouse Button 1 (B1) to drag the map to the desired location.

Baselines

Selecting Baselines displays 10 lines, labeled A-A' to J-J', along which cross-sections can be
constructed from within the Volume Browser (refer to Subsection 3.2.2 for more information).
Baselines come up editable.

Note 3: "Snapping" an Interactive Baseline: If you are zoomed in over an area when you load
Interactive Baselines and no Baselines appear, press mouse Button 3 (B3) to "snap" a Baseline to
where the mouse cursor is. The system chooses a Baseline that has not been recently used. If you
are working with a Baseline, a second click with B3 will return you to the original Baseline, even
if you modified another Baseline in the meantime.

Choose By ID...

Choose By ID, which is a function of DMD (Digital Mesocyclone Display), is a method of selecting
feature locations. The tool is used to monitor the same feature at a certain location. Without the Choose
By ID tool, a monitored feature (over a period of time) could move away from its monitored location
and another feature could move in its place. You can use Choose By ID to set points, baselines, and
"Home" for conventional locations like METARs and RAOBs (Radiosonde Observations), but its
primary use is for the WSR-88D-identified mesocyclone locations. You can also access the Choose By
ID tool from the Tools menu on the Volume Browser (refer to Subsection 3.2.2).

Distance Bearing

Selecting this tool displays six editable lines, each of which shows the azimuth and range of the labeled
end of the line relative to the unlabeled end of the line. You can make the lines editable by clicking B2
over the legend at the lower right of the display. Once in edit mode, a line can be moved as a unit
and/or either of its end points can be adjusted.

Distance Speed

This tool can be used to determine the speed and direction of a storm or any other meteorological
feature of interest. Selecting Distance Speed displays a Centroid Marker to move to the location of the
storm or feature of interest in any two or more frames of displayed imagery (e.g., a satellite or radar
loop). The system then displays a storm track with the direction (degrees) and speed (knots) of
movement.

When you select the Distance Speed option, the Distance Speed dialog box opens. It contains the
following options:

Mode: You have the following selections from this option.

Point: A radio button that allows you to set the Centroid Marker as a single point.

Polyline: A radio button that allows you to set the Centroid Marker as a polyline.
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Legend: You have the following selections from this option.

Time: A radio button that allows you to display time with the Centroid Marker.

Speed: A radio button that allows you to display speed with the Centroid Marker.

Distance Scale

This tool can be used to determine the size of a storm or any other meteorological feature of interest.

Feature Following Zoom

When you zoom in over a small area to be able to view a feature in detail, animation will often cause
the feature to move into and then out of the field of view. This tool allows you to follow a feature of
interest even when zoomed in to a small area.

To use this feature, first, you need to identify the location and motion of the feature, using Distance
Speed or the WarnGen tracker. Once satisfied that the tracking icon is following the feature of interest,
load this tool, and the center of the zoom area will track with the Distance Speed icon. Toggling the
overlay off will resume the standard zooming behavior, and toggling it back on will reinvoke the
feature following zoom.

Estimated Actual Velocity (EAV)

A velocity (V) display from the radar shows only the radial component of the wind, so the indicated
speed depends on the direction of the wind and the azimuth (direction) from the radar. Consider, for
example, a north wind. Straight north of the radar, the full speed of the wind will be seen on the V
product. As one moves around to the east of the radar, the radial component gets smaller, eventually
reaching zero straight east of the radar. If the wind direction is known, then the actual wind speed can
be computed by dividing the observed radial speed by the cosine of the angle between the radar radial
and the actual direction. The EAV tool allows you to provide that angle and use the sampling function
of the display to show the actual wind speed.

Note 4: The EAV is modeled on VR - Shear, but in this case, the vector you draw serves primarily
to establish direction. While the data plotted at the endpoints and in the corner is valid, you'll use
sampling to gather most of the information you seek.

4-D Storm Investigator (FSI)

Using FSI, you can create and manipulate 3-dimensional radar displays. You'll find an overview of FSI
in Section 13.1.

Time Of Arrival / Lead Time

Selecting the Time Of Arrival / Lead Time option displays a tracking line from a feature's initial
starting point in a past frame to its final position in the current frame. Once the final position is set, an
Arrival Point is displayed. You can drag this point anywhere along the line to get the Time Of Arrival /
Lead Time and Distance. You can also change the Mode from Point to Circular Front or Polyline
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anywhere along the line to better represent the feature(s).

Home

Selecting the Home option displays a marker, which is an "X" with the word "Home" next to it.
Clicking on the Home Location Legend with B2 makes the marker editable; drag the "X" or click with
B3 to change its location. When the Home Marker is displayed, use the Sample feature (clock and hold
B1 while moving the pointer around the screen) to display the range in miles and azimuth (in degrees)
of the pointer location relative to the Home location. The Home tool is also useful when selecting radar
data that may be outside of your County Warning Area (CWA). Refer to Subsection 2.2.6.14 for more
details.

LAPS Tools...

Two LAPS tools are available from the LAPS Tools dialog box. The first LAPS tool is the "Data Used
by Current Analysis," and the second tool is the "Configure Analysis Domain."

Data Used by Current Analysis: This tool allows you to select a given data type from the
Select Type Options Menu. Even though Surface is displayed as the Select Type, you still must
reselect it (or another item) to make it happen. After a moment, a report from the most recent
LAPS model run is displayed and provides detailed log information on what data was included in
that model run.

Configure Analysis Domain: This tool provides information on the current map projection and
grid spacing of the LAPS program, and allows the user to relocate the LAPS domain
(constrained so as to contain your CWA). This tool has the following options:

Projection: Only the center latitude and longitude are configurable on AWIPS.

Grid: This area of the tool provides the horizontal and vertical LAPS grid spacing. It is
not configurable on AWIPS.

Settings: This area consists of two reset buttons.

Default: This menu button resets the LAPS model domain to the coordinates that
were used when the current AWIPS software was installed.

Reset: This menu button resets the coordinate settings to those associated with the
current active analysis domain.

LAPS Relocator: Another way to change the domain is to drag the centerpoint using the
Graphical Relocator. By pressing the Load Menu button, the current LAPS grid domain is
displayed on D2D.

Load: This menu button displays the graphical LAPS Relocator onto D2D. It is best
displayed on the State or Local scale. You can drag the centerpoint anywhere within
the dashed rectangular boundary. This boundary ensures that your CWA is still
covered in the LAPS run.

Apply: When you click the Apply button, the display clears and the center location
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you have selected is entered in the lat/lon boxes.

Localize LAPS: This option initiates the process of relocalizing the LAPS run with the
newly defined domain coordinates. A message dialog box appears to warn you that the
process can take about 10 minutes, and you may want to delay the localization to avoid
interrupting the next LAPS model run.

Points

The Points option can be selected either from the Tools menu or from the Points iconified button on
the CAVE-D2D toolbar. When selected, the Points option initially displays a circular 10-point pattern,
labeled A through J on the Map display, as shown in Exhibit 2.2.6.5-2.

Exhibit 2.2.6.5-2. Points Display Pattern (10 Points A - J) and Product Legend

Points are used to generate model soundings, time-height cross-sections, time series, and variable vs.
height plots using the Volume Browser. As with the Baselines, the locations of these Points can be
edited in the following manner:

"Snapping" an Interactive Point: If you are zoomed in over an area when you load Interactive
Points and no Points appear, click B3 to "snap" a Point to where the mouse cursor is positioned.
The system chooses a Point that has not been recently used. If you are currently working with a
Point, then a second B3 click will place another Point at the location of your cursor.

Dynamic Reference Map: When you generate a model sounding, a time-height cross-section, a
time series, or a variable vs. height plot, a small reference map indicating the location(s) of the
plotted sounding(s) is provided in the upper left corner of the Main Display Pane.

Points may be created, deleted, hidden, and manipulated (location, name, font, and color). Points are
not limited in terms of number, location, or designation. Points may also be assigned to different
groups to facilitate their use.
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Once the Points tools have been loaded, the addition, deletion, or manipulation of Points can be
accomplished in three ways:

Create Point Dialog: The Create Point dialog shown in Exhibit 2.2.6.5-3 is opened by clicking
and holding B3 on the map (but not on any exisiting Point) and selecting the "New Point..."
option.

Exhibit 2.2.6.5-3. To Open Create Point Dialog

The Create Point dialog opens with the Lat and Lon text boxes populated with the latitude and
longiture values at the point where you had clicked B3. The latitude and longitude values can be
viewed in "Degrees : Minutes : Seconds," "Degrees : Minutes," or "Degrees Only" (N and S refer
to North and South; W and E refer to West and East).

In the Create Point dialog, you must:

Enter the Point's name

Modify the latitude and longitude values

Assign the Point's color and font use

Assign the Point to a group

Select whether the Point is movable or hidden

Note 5: By default, individual Points do not have an assigned color. They inherit the color
of the Interactive Points layer reflected in the Interactive Points product legend. You can
change the color of the Interactive Points layer by right clicking on the Interactive Points
product legend and selecting a color from the dropdown list. The selected color then
changes all points not having an assigned color to the new color.

Note 6: Points can be assigned to "<No Group>," which will organize them in the root

1. 
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location containing the group names when accessed by the Edit Points dialog (see below).

Edit Point Dialog: The Edit Point dialog shown in Exhibit 2.2.6.5-4 is opened by clicking and
holding B3 on a Point on the map and selecting the "Edit Point..." option. The latitude and
longitude values can be viewed in "Degrees : Minutes : Seconds," "Degrees : Minutes," or
"Degrees Only" (N and S refer to North and South; W and E refer to West and East).

Exhibit 2.2.6.5-4. To Open Edit Point Dialog

In the Edit Point dialog, you can:

Change the Point's name

Change the Point's color and font

Change the Point's group

Change the Point's location

Select whether the Point is movable or hidden

Note 7: Besides the option of selecting the Edit Points dialog, you also have the option of
selecting "Hide Point," "Delete Point," or "Move Point." Once hidden, the Point can be
unhidden using the Points List dialog, where you would uncheck the checkbox under the
"Hidden" column adjacent to the Point that was hidden (see below). If "Delete Point" is
selected, a pop-up opens to confirm whether you want to delete the Point. Selecting the
"Move Point" option moves the Point to wherever you place the cursor on the map.

2. 

Points List Dialog: The Points List dialog shown in Exhibit 2.2.6.5-5 is opened by clicking and
holding B3 on the Interactive Points product legend and selecting the "Edit Points..." option.

3. 
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Exhibit 2.2.6.5-5. To Open Points List Dialog

The Points List dialog lists all the available groups and Points. Groups can be expanded to
review the list of Points assigned to that group by clicking the arrow next to the group name.
Initially, the default set of Points (A-J) are listed in the D2D Group, as shown above. In the
Points List dialog box, Points and groups may be dragged into and out of other groups to create
or disassemble subgroups.

The Points List dialog also includes three columns.

Point Name: Lists the group name and designated Points.

Movable: Checking the checkbox adjacent to the Point disables the Point from being
moved.

Hidden: Checking the checkbox adjacent to the Point hides the Point on the map.

Descriptions of the Points List dialog buttons shown in Exhibit 2.2.6.5-5 follow.

New Group: Creates a new group.

New Point: Opens the Edit Point dialog box.

Edit: Opens the Edit Point dialog box for the selected Point.

Delete: Deletes the selected Point or group.

Close: Closes the Points List dialog box.

Put home cursor...

The Put home cursor tool provides an easy way to locate a METAR observation station, a city and
state, or a latitude/longitude coordinate. For Canada and Mexico, only the METAR observation stations
and latitude/longitude coordinates are accessible. When you select Put home cursor from the Tools
dropdown menu, the Home marker X is displayed and the Put Home Cursor dialog box opens.
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You can use the Home marker, as previously described in the Home Tool, and the new Home location
(station, city/state, or latitude/longitude) is identified in the Put Home Cursor dialog box.

Another way to use this tool is to type in the station, city and state, or latitude and longitude, and select
Go, or hit Enter on the keypad, to move the Home marker to the specified location. The new location's
nearest METAR site, city and state, and latitude and longitude appear in the Put Home Cursor dialog.
The Put Home Cursor dialog contains the following options.

Location Selection: There are three ways to find a desired location. Once you choose the
Station, City/State, or Lat/Lon radio button, an Entry Box is activated next to the respective label
within the Put Home Cursor dialog. Enter the desired location information.

Go: This menu button initiates the search for the desired station, city/state, or latitude/longitude.
The Home marker jumps to the newly specified location.

Radar Display Controls...

Refer to Section 8.5 for information on how to use the Radar Display Controls menu option.

Range Rings

The Range Rings Tool displays adjustable range rings around locations of interest to your local office.
When you select Range Rings from the Tools dropdown menu, the Range Rings legend appears in the
Main Display Pane. The tool comes up editable, and the rangeRing dialog (Exhibit 2.2.6.5-6) opens.
(Clicking B2 over the legend toggles tool editability and closes/opens the rangeRing dialog.) Within
this dialog, you can toggle on/off any of the target locations using the square selectors. Adjust the size
of the radii (in nautical miles) by typing a new value in the entry boxes associated with each location
and pressing the Apply button. You can also add labels at the center of the range ring and/or at any of
the radial distances using the Labels Options menu associated with each location. Using the Movable
Rings, you can add a new location at a specific point by using the Interactive Points Tool, or by typing
in latitude/longitude coordinates. There is no practical limit on the number of new locations you can
add to the display. The list of locations is pre-set but can be customized at a field site.

Exhibit 2.2.6.5-6. rangeRing Dialog

Sunrise/Sunset...

By typing a date, as well as the latitude and longitude of a location into the Sunrise/Sunset Tool dialog
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box, you can obtain the time (for any time zone) of sunrise and sunset, as well as the total length of
daylight for that date. Refer to Exhibit 2.2.6.5-7. Additional features include the ability to calculate the
sunrise/sunset in a different hemisphere, and the azimuthal angles, relative to true north, of the sunrise
and sunset.

Note 8: For an alternate method of entering latitude/longitude, set the location using Home, then
click Set at Home location.

Exhibit 2.2.6.5-7. Sunrise/Sunset Tool

Text Window...

Selecting this option brings up a Text Display window that behaves in the same way, except for scripts,
as a window on the Text Workstation. Refer to Chapter 4 for more information.

Units Calculator...

This handy tool, shown in Exhibit 2.2.6.5-8, converts the units of the first column into differing units
of the second column. The units are grouped into temperature, velocity, distance, time, and atmospheric
pressure. First, simply type the number and select the units of the value you wish to convert in the first-
column entry box. Then in the second column, select the desired units to which you want the original
value converted. The new value will appear in the second column entry box.
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Exhibit 2.2.6.5-8. Unit Calculator

VR - Shear

This tool is used in conjunction with Doppler velocity data to calculate the velocity difference (or
"shear") of the data directly under the end points. As with the Baselines, this feature comes up editable
and the end points can be dragged to specific gates of velocity data. When in place, the speed

difference (kts), distance between end points (nautical miles), shear (s-1), and distance from radar
(Nmi) are automatically plotted next to the end points and in the upper left corner of the Main Display
Pane. A positive shear value indicates cyclonic shear, while a negative value indicates anticyclonic
shear. If either end point is not directly over velocity data, the phrase "no data" is reported for the shear
value. This tool is also useful in determining gate-to-gate shear. Simply place the two end points
directly over adjacent gates of velocity data.

"Snapping" VR Shear: If you are zoomed in over an area when you load VR - Shear, and the
VR - Shear Baseline does not appear, click B3 to "snap" the Baseline to where the mouse cursor
is located.

VR - Shear in 4 Panel: You can use the VR - Shear Tool when the large display is in 4 panel
mode. The VR - Shear overlay is loaded in different colors for each panel. There are actually
four copies of the program running, and each behaves independently. This means that you can
get accurate readings in any one of the four panels — one VR - Shear panel is editable at a time.
To activate, click B2 on the VR - Shear legend in the desired panel and position the query line to
the echoes of interest.

Warngen
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Refer to Chapter 6 for information on how to use WarnGen.

ToolRunner.py script within CAVE

There is a /awips2/cave/etc/textws/python/ToolRunner.py script within CAVE. This script can be
used to run external programs.

ToolRunner.py provides an interface for running tools defined in toolsMenus.xml.

To add a tool to the Tools Menu, do the following:

1) On DX1 open /awips2/edex/data/utility/cave_static/site/GUM/menus/textws/toolsMenus.xml

2) Add the following line prior to line </menuTemplate>

   <contribute xsi:type="command" menuText="Test CCC Tool" 
commandId="com.raytheon.viz.texteditor.launchtool">
         <parameter key="script" value="nameOfTestTool.py"/>
         <parameter key="args" value="arg1=arg1value,arg2=arg2value"/>
   </contribute>

where nameOfTestTool.py is the name of the tool placed in either CAVE_STATIC or
COMMON_STATIC context in textws/python subdirectory (for site CCC it would be /awips2
/edex/data/utility/cave_static/site/CCC/textws/python or /awips2/edex/data/utility
/common_static/site/CCC/textws/python)

and arg1 through argN are the names of arguments for the tool along with their values.

3) Save the file and restart the Text Workstation.

4) Click on Tools Menu -> select Test CCC Tool

Tracking Meteogram Tool (TMT)

The Tracking Meteogram Tool provides a general function wherein the forecaster can produce a
time-trend graph for nearly any grid/image data parameters that have been loaded into the D2D
before the Tracking Meteogram Tool itself.  The User Interface for the Tracking Meteogram Tool
should be intuitive, as it was designed based on other existing tools, such as the Time of Arrival
Tool and WarnGen.

Note: The TMT is in essence a manual tool.  It is up to the forecaster to decide when such a
manual tracking tool provides value to operations and when it detracts from operations.  For
example: in an afternoon where many severe and tornado warnings are being issued, the
forecaster may not have the time that is required to define and maintain the tracks in a way that
ensures they are accurate.

The Tracking Meteogram Tool is launched from the Tools menu, in the D2D perspective in
CAVE.  It resides towards the bottom of the Tools menu list as shown in Exhibit 2.2.6.5-9.
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Exhibit 2.2.6.5-9. Tools menu, showing the TMT entry towards the bottom of the list

The TMT should be loaded *after* one or more data fields have been loaded.  (Time matching
will still be based on the first product loaded into the Editor Pane. The TMT has no valid time
associated to it, so it should never be loaded first.)

Basic Graphical Interactions

Drag me to Feature

When the TMT is first launched, a new “Tracking Meteogram” pane will appear (blank) and a
first track will be created in the parent Editor Pane.  

When a new track is created (first or other), guidance is provided via the “Drag Me To Feature”
message over the movable widget in the Editor Pane which can be moved via click-and-drag as
shown in Exhibit 2.2.6.5-10.  The user is expected to click and drag the widget to the feature of
interest, change the current frame to a time before the launch frame, and click and drag the
widget again to the same feature (at a different time).

The time trend graph will update at steps along the way.
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Exhibit 2.2.6.5-10. The “Drag Me To Feature” icon: the first step in creating a track

The Feature Track consists of a series of:

Circles (aka “nodes”)

Identifiers - Alphabetic (placed in the middle of the nodes)

Active Node

The “Active” Node is the node that exists in the currently viewed frame in the frame sequence
displayed in the Editor Pane.  It will be rendered in a color (which varies according to load order
of graphic layers in the Editor Pane).  Other nodes will not be rendered with color and will be a
very light gray (appearing white against the black background).

The Active Node is the only node that can be manipulated in terms of size and position.

Move:  Click and drag over an Active Node to move it.

Resize:  Use the mouse wheel over an Active Node to change the size of the circle.  (Scroll: up =
bigger, down = smaller)

Key Frame

A “Key Frame” is a node that has been defined or manipulated by the user.  The user can
manipulate any node and turn it into a Key Frame by changing its size and/or location.  The
TMT will linearly interpolate the size and position of all nodes in between Key Frames. A Key
Frame is visually distinguished from other nodes via the use of a thicker line for the circle.  This
thicker line applies to both a Key Frame that is a normal node, and a Key Frame that is an Active
Node. An example is shown below.
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Exhibit 2.2.6.5-11. An example of a single track (without underlying data) with the Active Node in
green, and several Key Frames in thicker lines

Multiple Tracks: Add / Delete

New tracks can be added and old tracks deleted from the Context Menu.  (See the
Context Menu section below.)

The Meteogram

The meteogram itself (time trend graph) will represent the data underlying the nodes
of each track in a graph where the x-axis is always time.  When calculating the
values to be used for the graph, the TMT will use the gridded data that is contained
by each node’s circle and will apply the specified function to that data.  (See the
Configure Meteogram interface section below.)

Each data parameter usable by TMT will be rendered in its own separate graph,
with its own distinct y-axis (label and units).

Each separate track will be represented in the graph by a distinct plot line with its
own distinct color and label/identifier that matches the Identifier used in the
graphical track in the Editor Pane.

Each data point in the graph represents the data underneath a node using a selected
mathematical function. (See the Context Menu below for function options.

A vertical line in the graphs represents the time of the currently viewed frame in the
parent Editor Pane. An example of a single meteogram with a single track’s plot is
shown in Exhibit 2.2.6.5-12.
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Exhibit 2.2.6.5-12. An example of a single meteogram with a single track’s plot.

Context Menu

A right-click-and-hold action in the Editor Pane that contains the TMT will yield a
menu with added selections related to the functions of the TMT (in addition to the
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standard CAVE context entries).  The content of this menu will contain more
selections  when the right-click occurs over an Active Node and/or Key Frame. This
is shown in Exhibit 2.2.6.5-13.

Exhibit 2.2.6.5-13. The TMT Context Menu (a portion of the full CAVE context menu)

Items shaded in light blue in the Exhibit 2.2.6.5-13, are provided only when the click that
produces the menu is over an Active Node and the item in light green is provided when the click
is over both an Active Node and Key Frame.

Basic TMT Context Menu Functions

The basic TMT Context Menu Functions are shown in Table 2.2.6.5-1.

Table: 2.2.6.5-1

Add new tracking meteogram Creates a new “Drag me to feature” widget and eventually a
new track.

Toggle Circles Makes all node circles visible/invisible (except for the Active
Node, which is always visible).

Configure Meteogram . . . Produces a small window that allows for the selection of math
function.  (See below.)

Toggle Meteogram Graphs Hides/Reveals the entire graph window.

Active Node & Key Frame TMT Context Menu Functions

The Active Node & Key Frame TMT Context Menu Functions are shown in Table 2.2.6.5-2.

Table: 2.2.6.5-2

Toggle Arrows Makes all arrow/line segments that connect nodes
visible/invisible.

Disable Line Removes the track’s plot form the graph and makes the
graphical elements in the Editor Pane transparent. (This
selection changes to “Enable Line” when clicked over a
disabled Active Node.)

Delete Line Deletes the track completely.
Snap All Points to this Location Stacks all nodes on top of each other - effectively yielding a

meteogram for a static point.
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Delete Keyframe Changes the node from a Key Frame node back into a normal
node.  Nodes will be re-linearly interpolated, thus it is no longer
used as an anchor for the linear interpolation.

Configure Meteogram Dialog

The “Configure Meteogram Dialog” shown in Exhibit 2.2.6.5-14, is a small window launched
from the Context menu which provides additional configuration options for each data source
(listed separately).  Currently, the only option available is a selection for the math function used
to calculate the data values that appear in the meteograms.  These functions use the underlying
gridded data that resides inside the node circle (thus the size of the circle matters).  The default
calculation type is “Max” or maximum value.   

Note: The “Sum” calculation method should not be used prior to AWIPS build 16.1.2. Max and
Min should be largely unaffected by this problem.  The other methods should be OK, but used
with care.

Exhibit 2.2.6.5-14. The Configure Tracking Meteogram interface, showing the available list of
functions that are applied to the data when plotting in the meteogram graph
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2.2.6.6 Volume

From the Volume Menu, shown in Exhibit 2.2.6.6-1, you can open the Volume Browser, access the Popup SkewT function, or select a specific data model family product.

Exhibit 2.2.6.6-1. Volume Dropdown Menu

The Volume Menu is then divided into three additional sections as follows:

Families: Families are preselected groups of model data that can be displayed with a single product request.

Note 1: Model availability is not scale dependent. ETA grids are now referred to as NAM (e.g., ETA40 would be NAM40).

Model Family Grids are titled with their delivered resolution (e.g., NAM40, GFS80). In some cases, however, higher-resolution components are available, such as NAM precipitation, or
different resolutions are used at different time projections, such as >168 hours on the GFS. The product label will show the actual resolution of each grid used.

4-Panel Families consist of four preselected products, or groups of products, each loaded into one of the four panels into which the Main Display Pane is divided. In the case of 4-Panel
Families, eight fields from a model family are displayed, two per panel. One field is displayed as an image, the other as a contoured graphic.

Comparison Families such as Surface Families for displaying forecast surface products, which allow the user to overlay preselected models for comparison at 500 mb heights and mean sea level
(MSL) pressure.

Std Env Data Package: You can customize a standard set of forecast products localized to your site, as shown in Exhibit 2.2.6.6-2.

Exhibit 2.2.6.6-2. Std Env Data Package Submenu



2.2.6.7 Obs

Refer to Exhibit 2.2.6.7-1 for a display of the Obs menu.

Exhibit 2.2.6.7-1. Obs Dropdown Menu

Several of the data sets in the Obs menu can be interrogated (sampled) for more detailed information by clicking
mouse Button 1 (B1) over a site. These data sets include METAR, Maritime, and Local.

The Obs menu is subdivided into sections that contain related products. These sections are described below.

METAR: This section contains automatically updating METAR observations, ceiling and visibility plots, wind
chill and heat indices, precipitation plots at various time intervals, and quality-checked MSAS observations. The
24hr Chg METAR plot provides the difference between the observed temperature, dewpoint, pressure, and wind
from those observed 24 hours earlier. The calculation of the wind difference involves vector subtraction of the
"u" and "v" components.

Synoptic: This section contains automatically updating Synoptic observations, and 6 hour and 24 hour precip
plots. Note that this section of the menu is not present at most sites.

Local Data: Under the Local data subheading are menu entries for local plots and precipitation plots of various
time intervals, as well as the LDAD Collection/Dissemination application. The QC plot includes quality control
information about LDAD-collected observations. Please refer to Chapter 10 for more information on LDAD
Collection/Dissemination.

Maritime: This section contains buoy and ship report plots, plus SAFESEAS for the Marine WFOs.

MAROB displays include Station Plots.

The Other Maritime Plots cascading menu contains options to display the Fixed and Moving Sea State



plots, MAROB Sea State and Cloud/Vis plots, Maritime Clouds/Visibility plots, as well as the Scatterometer
Winds. 

Sea State plots provide information on the wave period and height and swell period and height. The wave
type, whether a standard wave or a wind wave, is denoted at the origin of the plot by a "+" or a "w",
respectively. An "x" at the plot origin signifies that no wave type was reported. If reported, the directions
of the primary and secondary swells are denoted with arrows labeled "1" and "2", respectively. The
arrows point in the direction the swell is moving. An annotated Sea State station model is shown in
Exhibit 2.2.6.7-2.

Exhibit 2.2.6.7-2. A Moving Sea State Plot

Maritime Clouds/Visibility plots contain a station circle denoting sky coverage and the visibility along
with standard symbols for obstructions to visibility.

Scatterometer Winds are obtained from the ASCAT instrument on EUMETSAT's MetOp-A polar
orbiting satellite. This instrument sends pulses of radiation to the ocean surface and measures the amount
of energy, called backscatter, it receives back. When you sample these observations, the time, satellite ID,
wind direction, and wind speed are provided. With the polar orbiting scanning, a given region will
generally be sampled about every 12 hours. ASCAT Winds (25 km retrieval resolution but interpolated
and displayed at 12.5 km resolution) can be launched from either the CAVE Obs menu or from the
Satellite menu.

As shown in Exhibit 2.2.6.7-3, you can access the Scatterometer Winds  menu options by selecting Obs >
Other Maritime Plots > Scatterometer Winds. The ASCAT Scatterometer Ocean Winds product is
displayable on CAVE at all scales: N. Hemisphere, North America, CONUS, Regional, State(s), and
WFO.



Exhibit 2.2.6.7-3. Obs Menu - Scatterometer Winds

SAFESEAS is the System on AWIPS for Forecasting and Evaluation of Seas and Lakes. It is a set of AWIPS
applications that continuously monitor marine and adjacent overland conditions for specific marine and
weather hazards. SAFESEAS helps make faster, earlier, and higher-quality decisions regarding marine
watches and warnings. SAFESEAS is primarily intended to support any WFO with marine forecast
responsibilities; however, non-marine WFOs also may find its monitoring capabilities to be of practical use.

The SAFESEAS menu option is available under the OBs menu's Maritime section; but only available at
marine WFOs; local WFOs can be reconfigured to include this option. Refer to Exhibit 2.2.6.7-3, which
shows the SAFESEAS menu option.

A table of values is displayed when sampling station plots. The SAFESEAS menu has two Fog Monitoring
products. These products include a Fog Monitoring Table tool and a Fog Monitor Levels color table. For
more information about the Fog Monitor, refer to the Fog Monitor User's Guide. You can access the Fog
Monitor from the Obs menu under the Hazards section and also through the SAFESEAS monitor threat level
CAVE icon on the main menu. This guide opens in Adobe® Reader®.

 Refer to the separate SAFESEAS User's Guide for more information by clicking on the book symbol.

Hazards: The Hazards section covers local and regional plots, marine warnings, local storm reports, lightning
plots, and monitoring of fog and winter weather hazards.



SNOW: the System for Nowcasting Of Winter weather (SNOW) is an application suite for continuously
monitoring surface observations for detecting winter weather threats.

 Refer to the separate SNOW User's Guide for more information by clicking on the book symbol.

Lightning: This menu item provides three options for displaying lightning flash plots over specified 1
minute, 5 minute, 15 minute and 1 hour intervals.

NLDN (National Lightning Detection Network):  The NLDN option plots cloud-to-ground (CG) lightning flashes for specified time intervals across the continental United States. 
NLDN lightning data can be displayed as a grid image displaying the cloud-to-ground density values for a selected resolution (1km, 3km, 5km, 8km, 20km, and 40km).

GLD (Global Lightning Dataset):  The GLD option plots cloud-to-ground (CG) lightning flashes for specified time intervals on a global-scale.  GLD lightning data can also be displayed
as a grid image displaying the cloud-to-ground density values for a selected resolution (1km, 3km, 5km, 8km, 20km, and 40km).

ENI Total Lightning:  In addition to displaying CG lightning flashes, the Total Lightning option also displays Cloud Flash (CF) lightning and Pulses.  CF lightning are lightning flashes
which do not strike the ground such as in-cloud, cloud-to-cloud, and cloud-to-air lightning.  Lightning pulses are electromagnetic pulses that radiate outward from the lightning channel 
ENI total lightning data can be displayed as a grid image displaying the cloud-to-ground, cloud flash, and lightning pulse density values for a selected resolution (1km, 3km, 5km, 8km,
20km, and 40km).

The data is then used to determine the intensity or frequency of lightning flashes accompanying a
thunderstorm for a particular area.

Note: Previously the menu item says "Total Lightning" and forecasters didn't know whose lightning
data that is at first glance. This has been replaced with the specific total lightning networks as
illustrated in Exhibit 2.2.6.7-4.

Previously when total and cloud-to-ground lightning products are loaded from the Obs menu, the
legend text says "X Minute ENTLN Lightning Plot" for the raw points and "X Minute ENTLN
Lightning Xkm Grid". However the pulse and cloud flash are (not) labeled. These were labeled. This
is illustrated with the following example.

Example:

Load Obs->Lightning->Total Lightning->1hr Plot

The resources should be labeled as follows:

1 Hour Cloud to Ground ENTLN Lightning Plot  1 Hour Cloud Flash ENTLN Lightning Plot  1 Hour Pulse ENTLN Lightning Plot  

Load Obs->Lighting->Total Lightning Grid->5km->5min total flash density

The resource should be labeled as follows:

5 Minute Total ENTLN Lightning 5km Grid  



Exhibit 2.2.6.7-4. Lightning Network Data

Fog: This menu option plots the fog threat level and displays the Fog Threat Level Zone/County table. You
can also access the Fog Monitor from the SAFESEAS monitor threat level CAVE icon on the main menu,
only available at marine WFOs.

 Refer to the separate Fog Monitor User's Guide for more information by clicking on the book symbol.

Other Warning Displays: This section of the menu is defined locally, and may not be present at your site.

Local Storm Reports: Local Storm Report (LSR) plots are generated from spotter reports that were entered
into the LSR text database and decoded into the correct point data format. The spotter reports can be
displayed on CAVE on any scale, and use the symbols shown in Exhibit 2.2.6.7-5. Refer to the NWS
JetStream - Online School for Weather for a detailed list of present weather meterological symbols.

The LSR graphical user interface (GUI) is a stand-alone AWIPS application designed to provide forecasters
with an easy and quick way to create, manage, and send the LSR public text product. This text product
contains noteworthy weather events for which the forecaster has either received or sought out real-time



observations.

Exhibit 2.2.6.7-5. Spotter Report Symbols

 Refer to the separate LSR User's Guide for more information by clicking on the book symbol.



2.2.6.8 NCEP/Hydro

The NCEP/Hydro menu, shown in Exhibit 2.2.6.8-1, contains nine sections: SPC, TPC, NCO, HPC, MPC, CPC, AWC, Hydro, and Local Analyses/Statistical Guidance. Each section is further subdivided
into related products, as described below. For more information on hydro products, refer to documentation prepared by the NWS' Office of Hydrology.

Exhibit 2.2.6.8-1. NCEP/Hydro Dropdown Menu

SPC: Storm Prediction Center (SPC) Watches, Severe Weather Plots, SPC Convective Outlooks, and Fire Weather information. Severe Weather Plots are extracted from the STADTS and STAHRY
text products and plotted to time-match the current display. The Severe Weather Plots data set in the NCEP/Hydro Menu can be interrogated (sampled) for more detailed information by clicking
mouse Button 1 (B1) over a site.

TPC: Contains the hurricane submenu, which comprises graphic products that display the Marine/Tropical Cyclone Advisory (TCM), the Public Tropical Cyclone Advisory (TCP), hourly forecasts,
and model guidance.

NCO: Contains Precip & Stability, Temps & Weather, National Centers model, NGM MOS (NGM-based MOS system), and the following Sounding-derived plots submenus.

Precip & Stability: Contains precipitation, radar, and stability products.

Temps & Weather: Contains Max/Min temperature, freezing level, weather depiction, and surface geostrophic wind and relative vorticity plots.

National Centers Models: Contains model guidance from the National Centers.

Sounding-derived plots: Contains options to display model soundings (sometimes called "BUFR soundings" because they are packaged in BUFR format for transmission). These are
soundings extracted directly from the model, including all levels not generated from the pressure-level grids used elsewhere in the system.

Sounding Availability: This option displays the sounding locations (shown with asterisks) available from the latest model run; typically these locations coincide with TAF (Terminal
Aerodrome Forecast) locations. The plot will update with each model run. Because the sounding data is quite voluminous, only soundings over your State(s) scale are saved.

Surface: The Surface Plots, which mimic the METAR Surface Plots, are taken from the model-derived soundings and provide hourly forecast surface plots. Because you cannot see all
forecast projections in a 32 frame loop (e.g., displaying the entire North American Model (NAM) or Global Forecasting System (GFS) run would require 61 frames), you will probably
want to use the Time Options Tool (refer to Subsection 2.2.6.4) to view a subset of the forecast -- perhaps a continuous run of hours or every other hour for the whole run.

Ceiling/Visibility: The "Ceil/Vis Plot" is illustrated in Exhibit 2.2.6.8-2. It shows weather (rain, frz rain, snow) on the right, a stack of three cloud layers above, and visibility below the
METAR station. The cloud layers are defined as low (990mb-640mb), mid (640mb-350mb), and high (<350mb). Each cloud layer shows a coverage circle with clear, sct, bkn, and ovc
options. Next to one of the circles, there may be a cloud base. The cloud base is sent as a pressure, but is plotted in hft MSL based on a Standard Atmosphere conversion. Because the
cloud layers and the cloud base are generated from separate algorithms at NCEP (National Centers for Environmental Prediction), it is possible to have broken or overcast clouds
indicated but no base; alternatively, the base may be shown with a high overcast, while ignoring a mid broken layer. Also, a cloud base is reported if convective precipitation is indicated,
even for only 10-20% cloud cover. As a result, one can see a cloud base associated with scattered clouds.

Exhibit 2.2.6.8-2. Example of a Ceil/Vis Plot

1 Hr and 3 Hr Precip Amt: This option shows hourly amounts for NAM and 3 hour intervals for GFS at each location.

Cloud Layers: This option displays the amount of low, middle, and high cloud cover, each as a standard sky coverage symbol, and weather type as a weather symbol.

HPC: Contains 6-hour QPF (Quantitative Precipitation Forecast) data plus the submenus, described below, for Precipitation and Temps & Weather products.

Precipitation: Contains probabilities of daily precipitation, precipitation accumulation, and probabilities of daily snowfall. In addition, this submenu enables you to display QPF projections for
1 to 3 days in 6 hour increments, 4 to 5 days in 48 hour increments, and 1 to 5 days in 120 hour increments. The HPC Excessive Rainfall product consists of a contour graphic and image of the
excessive rainfall for day 1 (with forecast times of 21, 24, 27, or 30 hours), and days 2 and 3 (both with forecast times of 48 and 72 hours). The HPC product will update the selected forecast
cycle twice per day.

Temps & Weather: Contains daily Max/Min temperature anomalies, daily heat index probabilities, and pressure and frontal analysis.

MPC: Contains the Marine Guidance submenu, which includes marine analyses and model guidance.



Note: The Marine Prediction Center (MPC) is now called the Ocean Prediction Center (OPC).

CPC: Contains threat charts and outlook grids derived from these two submenus:

Threat Charts: Contains drought monitoring data, daily threats assessment, and daily heat index forecasts.

Outlook Grids: Contains temperature and precipitation probabilities.

AWC: Contains CCFP (Collaborative Convective Forecast Product), an aviation product. Formerly located under the Aviation option on the Upper Air menu, CCFP is a strategic forecast of
convection to guide traffic managers in their system-wide approach to managing traffic. The forecast suite consists of 3 forecast maps with selectable lead times (4, 6, and 8 hours), as shown in
Exhibit 2.2.6.8-3. The forecasts are issued by the Aviation Weather Center (AWC) between March 1 and October 30, eleven times per day.

Exhibit 2.2.6.8-3. CCFP Strategic Forecast Aviation Product on the NCEP/Hydro Menu

CCFP is alpha-numeric information suitable for the graphical depiction of forecast areas of significant thunderstorms. The CCFP message covers the CONUS area, and includes information on the
location of thunderstorm areas, and associated information such as storm tops, coverage, confidence, and direction/speed of movement.

Hydro: Contains QPE, QPF, and RFC Flash Flood Guidance submenus. Hydro Applications, such as HydroView and MPE Editor, are loaded from the Perspectives dialog (Hydro and MPE,
respectively) or from the HydroApps menu in the Hydro(View) Perspective (Hydrobase, RiverPro, XDAT, Forecast Service, River Monitor, Precip Monitor, SSHP, and Dam Catalog).

QPE: Makes available mosaic images of RFC-generated Quantitative Precipitation Estimator (QPE) and the Multisensor Precipitation Estimator (MPE) grids, which are displayed using a
'truncated' grid color table that shows zero values in gray to let you see the limits of the site-specified domain. These mosaic images are generated by the RFCs in 1, 6, and 24 hour cycles. The
MPE grids can be displayed as local contours or images.

NESDIS produces two types of Satellite Precipitation Estimates (SPE) based on GOES (Geostationary Operational Environmental Satellite) imagery series: Auto SPEs and Manual
SPEs. Auto SPEs, which can be displayed directly from the QPE submenu, are produced hourly based on the most recent one-hour series of IR GOES imagery. This product is
displayable on any AWIPS scale. The Auto SPE estimates are displayed in units of inches of precipitation that fell during the specified one hour period.

Manual SPEs are accessible through the Manual SPE submenu. You can access the Manual SPE submenu from the QPE submenu. Generation of these products requires substantial
manual intervention by NESDIS personnel; consequently, these products are generated and distributed to AWIPS at variable frequencies, as significant precipitation events warrant (i.e.,
their frequency is variable). The duration (or valid period) of the Manual SPEs is also variable. Whereas the duration of Auto SPEs is always one hour, the duration of the Manual SPEs
ranges from 1 to 12 hours. Furthermore, although each Manual SPE product is mapped to a CONUS grid, the area of analysis is usually regional (focusing on the significant precipitation
event). Apart from these important differences, the Manual SPEs are very similar to the Auto SPEs.

QPF: Displays QPF, which indicate how much precipitation will occur in a particular grid. QPFs, which are issued by the RFCs, display as contours by default. However, from the pop-up
menu you can convert them to image form.

RFC Flash Flood Guidance: Displays County and Zone Flash Flood Guidance (FFG) grids on any scale. The area for which the data is displayed is limited, but the site system manager may
configure a larger area. In addition, 1h, 3h, and 6h mosaic RFC-generated FFG grids can be displayed for both local and other RFC locations.

Local Analyses/Statistical Guidance: Model Output Statistical (MOS) plots derived from the MOS BUFR and Text Bulletins display forecast data for GFS MOS, GFS-Extended MOS, Eta MOS,
and NGM MOS. The plots are accessed by selecting NGM or GFS-LAMP/MOS forecasts under the Local Analyses/Statistical Guidance option.



2.2.6.9 Local

The Local menu is shown in Exhibit 2.2.6.9-1. Each section is further subdivided into related products. A description of each section follows.

Exhibit 2.2.6.9-1. Local Dropdown Menu

LAPS/MSAS Analyses: Contains the LAPS and MSAS analyses described below.

LAPS: The LAPS analysis grid is 10 km and covers an area slightly larger than the WFO scale. The contour intervals are not specifiable, but you can use the Density function to
increase/decrease the number of contours.

To access the LAPS grids1. 

With any scale displayed, from the Local menu, select LAPS/MSAS Analyses > LAPS.

Note 1: You can also access LAPS grids from the Grid menu in the Volume Browser.

The LAPS application runs on px1 as a cron from 20 minutes to 45 minutes after the hour. Because of its size, LAPS does not run if the application server is failed over.

The LAPS modules included in AWIPS are surface, temperature, humidity, cloud, wind, derived parameters, and soil parameters. These modules use a mixture of required and optional data to
prepare their products. If a LAPS module's required data are not present, that LAPS module does not run. If a LAPS module's optional data are not present, that LAPS module will still run.

LAPS uses the following data:

Rapid Refresh (RAP) forecast model data

Satellite imagery (GOES-East or GOES-West)

METAR observations

Profiler data (only used by Midwest sites)

Surface buoy/ship reports

Radar reflectivity

If the required data are present and the optional data are not, the LAPS module runs, creating the LAPS products without the optional data. It is possible for LAPS products to vary from hour
to hour, and from site to site, depending on data availability. See Table 2.2.6.9-1 for further details of required and optional data.

Table 2.2.6.9-1. LAPS Modules with Required and Optional Data

Module Required Optional

surface Surface METAR Observations

Satellite imagery (WV, 11 and 12 IR)
Model Background (RAP or NAM)
Completion of cloud module
Previous run of surface module
Previous run of wind module

cloud

Surface METAR Observations
Satellite imagery (WV, 11 and 12 IR)
Model Background (RAP or NAM)
Completion of surface module
Completion of temp module

Completion of soil module

humid
Model Background (RAP or NAM)
Completion of temp module

Satellite imagery (WV, 11 and 12 IR)
Completion of Surface Module
Completion of Cloud Module

temp
Model Background (RAP or NAM)
Completion of surface module

wind
Model Background (RAP or NAM)
Surface METAR Observations

Profiler (Midwest only)
Completion of surface module
Completion of temp module

soil
Completion of surface module
Completion of temp module

Previous run of soil module

deriv
Completion of temp module
Completion of cloud module

Surface METAR Observations
Completion of cloud module
Completion of humid module
Completion of wind module

MSAS (MAPS): The Mesoscale Analysis and Prediction System (MAPS) Surface Assimilation System (MSAS) was built to exploit the spatial density and temporal frequency of surface data
by providing timely and detailed surface analyses. It currently provides hourly analyses on a 40km grid covering the 48 contiguous states and neighboring areas of Canada and Mexico and uses
persistence (the previous hourly analysis) as the background for the current analysis.

One-hour persistence provides a fairly accurate forecast and allows for the incorporation of previous surface observations into the analysis. More importantly, it assures continuity between
analyses, especially near stations that report less frequently than hourly. Persistence, however, cannot be used in data-void or data-sparse areas such as oceans. In these regions, gridded data
from NCEP's NAM model are used as a background to ensure that the analysis does not stray far from reality. The NAM grids are linearly combined with 1-hour persistence, using weights
calculated to produce a persistence forecast over data-dense areas, a model forecast over data-sparse areas, and a smooth transition between the two areas.

Because rough terrain can complicate the analysis of surface variables, MSAS attempts to obtain analyses with improved spatial continuity from mountainous observations through careful
choice of analysis methods and variables. MSAS incorporates elevation and potential temperature differences in the correlation functions used to model the spatial correlation of the surface



observations. The resulting functions help to take into account physical blocking by mountainous terrain and improve the representation of surface gradients. In addition, MSAS analysis
variables were chosen, whenever possible, so as to minimize the effects of varying terrain. Potential temperature, for instance, is analyzed instead of surface temperature because it varies more
smoothly over mountainous terrain when the boundary layer is relatively deep and well mixed.

The major MSAS pressure variable is sea level pressure, computed at each station from altimeter setting observations. Station pressures calculated from the altimeter settings are reduced to sea
level and the 700mb NAM temperature is used to estimate an effective surface temperature. This reduction generally provides smoother regional, diurnal, and seasonal variation because it
avoids the use of actual surface temperatures, which are often unrepresentative of the surrounding conditions. Moreover, additional data are available for analysis of the MSAS reduction
because more stations report altimeter setting than report sea level pressure.

MSAS utilizes most surface observations contained in its domain. These include METARs, surface reports from fixed buoys, and the NOAA Profiler Network, as well as surface observations
from any local mesonets ingested through the LDAD system (refer to Chapter 10). Observations failing the automated quality control checks implemented by the Quality Control and
Monitoring System (QCMS) (refer to Chapter 11), or listed in the QCMS subjective reject list, are not ingested or analyzed by MSAS.

To access MSAS Grids:1. 

From the Local menu, select LAPS/MSAS Analyses > MSAS (MAPS).

To access MSAS Observations1. 

In addition to MSAS gridded output, AWIPS has the ability to display the observations used in each MSAS analysis. The displays consist of color-coded observation plots.
Pressing mouse Button 1 on any observation gives the station ID associated with the observation. Observations ingested by MSAS, but not used due to Quality Control (QC)
failures, are distinctly colored. Pressing mouse Button 1 on these observations invokes the display of a small QC table indicating which QC checks have failed. Exhibit 2.2.6.9-2
shows an example of a MSAS QC table.

Exhibit 2.2.6.9-2. Example of a MSAS QC Table Accessible Through the CAVE NCEP/Hydro Menu

The observation either failed (F) the automated checks or was labeled bad (B) through the subjective intervention procedures. See Chapter 10 on the AWIPS QCMS for more
information on the QC procedures.

LAMP/MOS Forecasts: Contains the GFSLAMP, and MOS forecast options as shown in Exhibit . Descriptions of these options follow. Note: Previously, there were two entries that reference IFPS
under the Local =- LAMP/MOS Forecast menu in D2D: IFPS 3hr, IFPS 12hr. These are 3hr and 12hr plots of GFE grid forecasts. In AWIPS II, IFPS is becoming an obsolete term, as everything is
now created from the "GFE" perspective. So this has been deleted.

Exhibit 2.2.6.9-3. LAMP/MOS Forecast Menu

GFSLAMP: The Localized Aviation MOS Program (LAMP) is referred to here as GFSLAMP. GFSLAMP consists of a series of programs to analyze hourly weather data, run simple
numerical models, evaluate statistical forecast equations, and display the resulting information. The statistical forecasts are produced by multiple linear regression equations that combine
information from the central GFS-MOS guidance, local model output, and the most recent hourly surface observations. GFSLAMP guidance updates each hour by using the latest observational
information and also furnishes forecasts for hourly projections for over 1500 stations in the CONUS, Hawaii, Alaska, Puerto Rico, and the Virgin Islands with a record of hourly data.

GFSLAMP provides hourly forecasts for up to 25 projections at locations currently receiving GFS-MOS guidance.

The three simple numerical models used in GFSLAMP provide advective forecasts of sea level pressure, saturation deficit, and variables such as surface temperature and cloud amount. These
models are driven by NCEP's GFS model.

Two types of GFSLAMP plots are available within CAVE. They are GFSLAMP Station Plot and GFSLAMP Ceiling and Visibility Station Plot. Each can be accessed by selecting a
GFSLAMP option from the Local > LAMP/MOS Forecasts submenu.

Each GFSLAMP plot displays its forecast data in station model plot format.

Note 4: You can also access GFSLAMP grids from the Grid menu in the Volume Browser. Refer to Section 3.2 for more information about accessing grids in the Volume Browser.

Accessing the GFSLAMP Time Series: The GFSLAMP time series can be accessed through the volume browser. See Subsection 3.2.2 for information on displaying time series plots



through the volume browser.

Using Various Load Modes: All load modes are supported for the GFSLAMP station and GFSLAMP ceiling and visibility plots.

MOS: Model Output Statistics. These plots are derived from the MOS BUFR Bulletins. The previous MOS plots were derived from the MOS Text Bulletins.

Note 5: The MOS Plots are accessed by selecting NGM or GFS-LAMP/MOS forecasts under the Local Analyses/Statistical Guidance heading of the NCEP/Hydro dropdown menu.

The plots display forecast data for GFS MOS, GFS-Extended MOS, and NGM MOS. Submenus under each model reveal the element choices. These displays include:

Station Model Plots (Wind, T, Td, Sky Cover, Wx)

MaxT/MinT (°F)

Ceiling (agl) / Visibility (ft × 100) (Categorical)

Probabilities Submenu (6h/12h PoP, 6h/12h Tstorm, 6h/12h Svr-Tstorm, Conditional precipitation types; %)

QPF 12h (Categorical mid-points; inches)

QPF 6h (Categorical mid-points; inches)

Snowfall (6h/12h/24h, Categorical; inches)

You can access the MOS forecasts from the Volume Browser. Refer to Section 3.2 for more information about accessing GFSLAMP guidance through the Volume Browser.



2.2.6.10 Upper Air

The Upper Air dropdown menu, shown in Exhibit 2.2.6.10-1, is located on the CAVE menu bar. It provides access to upper air plots, profiler data, radar plan-view and perspective displays of winds, and
aircraft and rawinsonde data. Nearby Radiosonde Observations (RAOB) are also included on the menu to provide easy viewing of upper air data.

Exhibit 2.2.6.10-1. Upper Air Dropdown Menu

Aircraft: The Aircraft option on the Upper Air menu provides access to the following products:

PIREP plots: The Aircraft data includes Low-, Mid-, and High-level Pilot Weather Report (PIREP) observations. The display plots the temperature, aircraft identifier, wind speed and
direction, significant weather, and the flight level (in feet). Pilot reports are critical for air safety. Pilots reports on the conditions they are experiencing show up in a matter of minutes on
AWIPS. Weather conditions can change quickly, and there is nothing like having a pilot report to provide a bird's eye view of what it is really like up there. PIREPs may validate forecast
conditions, or they may describe real-time weather that varies from them.

MDCRS plots: Meteorological Data Collection and Reporting System (MDCRS) data includes plan-view plots for various 5kft layers and ascent/descent soundings. Using the availability
plots (Upper Air menu under MDCRS plots) and ACARS Airports from the Maps menu button, as shown in Exhibit 2.2.6.10-2, you can locate airports that have available soundings. ACARS
Airports provides an illustration of locations of airports, but it is not necessary to use it. The "+" sign means a temperature sounding and the "*" means a temperature and dewpoint sounding.
To see a sounding at a location, simply press the Points menu button. Several points from letters of the alphabet will appear on the map display. To view a sounding, drag one of the
points/letters to a "+" or "*" location. From the menu bar press Volume and then Browser. From the Volume Browser select MDCRS for Source, Sounding for Fields and select the letter/point
on the desired location for Points. Click on your selection in the Product Selection List and then press the Load button to view the sounding.

Exhibit 2.2.6.10-2. ACARS Airports Option on Maps Dropdown Menu

A zoomable inset map (NW corner) is available to show the location of the sounding. When you zoom in by clicking mouse Button 2 (B2), the flight track of the ascent/descent sounding is
shown on the map. In addition, you can sample the flight track to see the time and elevation. To zoom out, click mouse Button 1 (B1). This inset map (and also those on var vs. height displays,
cross sections, and cell trends) can be suppressed by setting the global density (i.e., from the tool bar) at less than 1.

Aviation: The Aviation pull-right menu provides access to aviation products and qualifying information:

Convection SIGMET: SIGMET (Significant Meteorological Information) is an alpha-numeric message describing specific aviation hazard conditions between the surface and 45,000
feet (FL450). A SIGMET includes information about the location of the hazard using VOR locations. SIGMETs are produced on an as-needed basis at the AWC and are distributed on
the SBN. See Exhibit 2.2.6.10-3 for an example.

Exhibit 2.2.6.10-3. Example of a SIGMET Message

Plots associated with significant weather conditions include icing severity and significant weather turbulence, as shown in Exhibits 2.2.6.10-4 and 2.2.6.10-5.



Exhibit 2.2.6.10-4. Aviation Icing Severity Plot

Exhibit 2.2.6.10-5. Aviation Turbulence Plot

AIRMET: AIRMET (Airmen's Meteorological Information) is an alpha-numeric message describing specific aviation hazard conditions between the surface and 45,000 feet (FL450),
but not requiring the issuance of a SIGMET. An AIRMET includes information about the location of the hazard using VOR locations. AIRMETs are produced every 6 hours at the AWC
for the CONUS area, and are distributed on the SBN. See Exhibit 2.2.6.10-6 for an example.

Exhibit 2.2.6.10-6. Example of an AIRMET Message

NCWF: NCWF (National Convective Weather Forecast) is information suitable for the graphical depiction of hazardous convection. The NCWF contains both GRIB and BUFR output.
The GRIB output delineates the current convection. The BUFR output includes hazardous convection area polygons, movement arrows, and storm top and speed text information.

RAOB: RAOB data is plotted on the standard Skew-T log-p thermodynamic diagram. A small reference map indicating the location(s) of the plotted sounding(s) is provided in the upper left corner
of the main display pane, as shown in Exhibit 2.2.6.10-7. If you overlay another Skew-T whose location is far from the original sounding location, the reference map updates to show both locations,
as shown in Exhibit 2.2.6.10-7.

Exhibit 2.2.6.10-7. Skew-T Reference Map Indicating Locations of Plotted Soundings

The Interactive NsharpSkewt Program plots and derives quantities on a Skew-T log-p diagram and on a hodograph. You can edit the Skew-T and hodograph data and obtain instantaneous
information on the modified data. To start the Interactive NsharpSkewt Program refer to Chapter 7.

Also plotted on the standard Skew-T log-p thermodynamic diagram is the lifted parcel trajectory, displayed on zoom factors greater than 1. For a 12Z sounding, the parcel trajectory is computed
based on a surface parcel temperature represented by the forecast maximum temperature for that sounding. At all other observation times, the surface parcel temperature is represented by an average
temperature and dewpoint through the lowest 50 mb of the sounding. For the 00Z soundings, the temperature and dewpoint are represented as a low-level (50 mb) mean. For the 12Z soundings, the
forecast maximum temperature is used as the "modified" parcel temperature, with the surface dewpoint temperature as the parcel dewpoint. The parameters affected by these modified values are



noted with asterisks in the second column of the parameters list on the sounding plot.

The MDPI (Microburst-Day Potential Index) and the WINDEX (Wind Index) determine whether the environment is favorable for microburst development. The MDPI utilizes vertical profiles of
environmental equivalent potential temperature, while the WINDEX predicts the maximum expected gust possible for a given environmental sounding. For a full description of these equations and
the optimal index values, refer to the following website:

http://www.wdtb.noaa.gov/workshop/psdp/Roeder/sec2.htm



2.2.6.11 Satellite

The Satellite menu provides access to various types of satellite imagery received via the Satellite Broadcast Network (SBN). Imagery products from the Geostationary Operational Environmental (GOES)
East/West satellites, Himawari and the Polar Operational Environmental Satellites (POES) imagery products are available from the Satellite menu, which is shown in Exhibit 2.2.6.11-1.

Exhibit 2.2.6.11-1. Satellite Dropdown Menu

POES Imagery

The POES Imagery section of the Satellite menu contains selectors for IR Window, Visible, 3.7µ, and 11-3.7µ products. These are viewable on all scales.

Precipitation Products Submenus

Below the POES Imagery section of the Satellite menu are four submenus: Sounder Imagery; Derived Products Imagery; Derived Products Plots; and NPP Products. Descriptions of the submenus follow.

Sounder Imagery: The products available from the Sounder Imagery submenu, which is shown in Exhibit 2.2.6.11-2, are based purely on the imager instruments aboard the GOES East (GE) and
GOES West (GW) satellites.

Exhibit 2.2.6.11-2. Sounder Imagery Submenu

Derived Products Imagery: A variety of precipitation products are accessible from the Derived Products submenu, which is shown in Exhibit 2.2.6.11-3. These products are derived from one or
more of the various satellites (e.g., DMPS, POES, GOES, and GPS). Descriptions of the products follow.



Exhibit 2.2.6.11-3. Derived Products Imagery Submenu

The Blended Rain Rate (formerly Rainfall Rate) product is produced hourly to gather recent rain rate retrievals from passive microwave instruments on six polar-orbiting satellites. The
blended rain rate eliminates the bias between those data sets and provides a unified, meteorologically significant rain rate field to weather forecasters.

The GOES products derived from the GOES satellite include Lifted Index, Total Precip Water (TPW), Cloud Amount, Cloud Top Height, Skin Temperature, and Low Cloud Base. Because the
imagery from these products is based on the GOES sounder instrument, several important differences exist between these products and the other (imager-based) imagery. The main differences
are that the resolution is no finer than 10 km, the product update frequency is driven by the sounder instrument (AWIPS receives a set of GOES East/West composite derived product images
once per hour), and the aerial coverage is based on that of the sounder scans, which is somewhat less than the aerial coverage provided by the imager. Descriptions of the products follow.

Lifted Index is a common measure of instability. Its value is obtained by computing the temperature that air near the ground would have if it were lifted to some higher level (usually
around 18,000 feet), and comparing that temperature to the actual temperature at that level. The more negative the value, the more instability there is.

Total Precip Water is the vertically integrated water vapor content in a column extending from the earth's surface to the top of the atmosphere.

Cloud Amount provides an hourly update of cloud amounts within a geostationary satellite field of view. You can loop through the display to identify increasing/decreasing cloud
conditions and trends.

Cloud Top Height is the height of the cloud in thousands of feet (base - top).

Skin Temperature is the sea surface temperature of the ocean surface water.

Low Cloud Base provides nighttime images of fog and low stratus clouds derived from a combination of two GOES IR channels. This product identifies cloud ceilings of <1000 feet and
is generated hourly starting between 2042 and 2142 GMT, and ending between 1510 and 1610 GMT the next day. This product is beneficial to the warning and forecast processes
specific to aviation and terminal forecasting.

The Total Precip Water (TPW) value can also be derived from the data sources of DMSP, SSM/I (Defense Meteorological Satellite Program Special Sensor Microwave / Imager), and POES
AMSU (POES Advanced Microwave Sounding Unit) satellites, which are accessed from the DMSP SSM/I, and POES AMSU sections of the submenu.

Variations of TPW ("Blended Total Precip Water" and "Percent of Normal TPW") are selectable under the AMSU and SSM/I + GPS section.

The Blended Total Precip Water product is a blend of the various data sources of AMSU, SSM/I, and GPS satellites, and can be over water or land.

The Percent of Normal TPW product is calculated at various times (hourly, monthly, seasonally, etc.) to determine departures from the normal. From the information obtained, forecasters
can predict the chances of having a below average, normal, or above average precipitation in the upcoming months.

Derived Products Plots: Products and additional submenus for narrowing your product search are accessible from the Derived Products Plots submenu, which is shown in Exhibit 2.2.6.11-4.
Descriptions of the submenus and products follow.



Exhibit 2.2.6.11-4. Derived Products Plots Submenu

The GOES High Density Winds submenu has options to display satellite-derived multi-layer winds plots from the IR, Visible, and three Water Vapor channels. In addition, you can display
individual layers that display a composite of all the satellite channels. Refer to Exhibit 2.2.6.11-5.

Exhibit 2.2.6.11-5. Derived Products Plots - GOES High Density Winds

MTSAT High Density Winds cover the Western Pacific. Refer to Exhibit 2.2.6.11-6.



Exhibit 2.2.6.11-6. Derived Products Plots - MTSAT High Density Winds

Scatterometer Winds are obtained from the ASCAT instrument on EUMETSAT's MetOP-A polar orbiting satellite. This instrument sends pulses of radiation to the ocean surface and
measures the amount of energy, called backscatter, it receives back. When you sample these observations, the time, satellite ID, wind direction, and wind speed are provided. With the polar
orbiting scanning, a given region will generally be sampled about every 12 hours.

ASCAT winds (25 km retrieval resolution but interpolated and displayed at 12.5 km resolution) are launchable from both the CAVE Satellite menu, shown in Exhibit 2.2.6.11-7, and the
Obs menu, shown in Exhibit 2.2.6.11-8. The ASCAT instrument generates ocean surface wind retrievals. The ASCAT Scatterometer Ocean Winds product is displayable on CAVE at all
scales.

Exhibit 2.2.6.11-7. Derived Products Plots - Scatterometer Winds



Exhibit 2.2.6.11-8. Obs Menau- Scatterometer Winds

The SSM/I Point Data plot displays data collected over the course of a day for calculating ocean wind speeds. Refer to Exhibit 2.2.6.11-9.

Exhibit 2.2.6.11-9. Derived Products Plots - SSM/I Point Data

The GOES and POES Sounding Data Availability Plots displays the locations where GOES and POES temperature and moisture profiles are available. These soundings are displayed on a
Skew-T/log P chart using the Points tool and the Volume Browser. Soundings from the GOES satellites are made only in relatively cloud-free areas, whereas POES systems produce temperature and
moisture soundings in clear and cloudy atmospheres. Each hour, NESDIS provides the latest soundings from GOES East and West. Although the GOES East and West sounders yield soundings over
a broad area, the default AWIPS configuration retains soundings only from within each site's Regional CAVE scale domain. POES soundings are generated approximately every 12 hours and have
more global coverage.

Himawari: The products available from the Himawari submenu, shown in Exhibit 2.2.6.11-10, are provided by the Japanese Meteorological Agency’s Himawari 8 satellite. The main instrument
aboard satellite is the Advanced Himawari Imager (AHI). This is a 16-channel multispectral imager that captures visible light and infrared images of the Asia-Pacific region. The instrument has
similar spectral and spatial characteristics to the Advanced Baseline Imager (ABI) used by the GOES-R satellites. This data is centered over Japan and covers most of the Pacific Region.  As a result,
this data will be of value primarily for WFOs within the Pacific Region. Most CONUS sites will not find the data useful.



Exhibit 2.2.6.11-10. Himawari

NPP Products: NPP products are accessible from the NPP Products submenu, which is shown in Exhibit 2.2.6.11-11. A description of NPP products follows.

Exhibit 2.2.6.11-11. NPP Products Submenu with VIIRS CONUS Regional Imagery Product Selected

Note 1: NPP, which stands for National Polar-orbiting Partnership (formerly National Polar-orbiting Operational Environmental Satellite System (NPOESS) Preparatory Project), is an earth-
observing NASA satellite. It is more precisely named Suomi NPP, named after Meteorologist Verner E. Suomi.

The NPP Products submenu displays VIIRS (Visible Infrared Imager Radiometer Suite) and Soundings products. A description follows.

VIIRS Products: VIIRS is one of five instruments onboard the NPP satellite. VIIRS' mission is to collect radiometric imagery in visible and infrared wavelengths of the Earth's surface; this
includes observing fires, ice, ocean color, vegetation, clouds, and land and sea surface temperatures, and supplying high-resolution images and data used by meteorologists to assess climate
change and improve short-term weather forecasting.

The VIIRS submenu option provides VIIRS imagery and moderate band satellite displays for the CONUS, Alaska, and Pacific regions. The same options, shown in Table 2.2.6.11-1, apply for
each of these regions.

Table 2.2.6.11-1. VIIRS Imagery Specs for CONUS, Alaska, and Pacific Regions

Bands Wavelength Type Product

Imagery Band 1 0.64u Reflectivity

Imagery Band 2 0.865u Reflectivity

Imagery Band 3 1.61u Reflectivity

Imagery Band 4 3.74u Brightness Temp

Imagery Band 5 11.45 Brightness Temp

Moderate Band 6 0.746u Reflectivity

Moderate Band 9 1.378u Reflectivity

Moderate Band 13 4.05u Brightness Temp

Moderate Band 15 10.763u Brightness Temp

Moderate Band 16 12.013u Brightness Temp



Day/Night Band 0.7u Reflectivity

Note 2: The CONUS imagery is provided as overall CONUS imagery and focused on either the East CONUS or the West CONUS regions.

Note 3: When opening NPP Products imagery data, you should set the appropriate scale for viewing the selected region.

In addition to accessing the NPP Product VIIRS data via the Satellite menu, the VIIRS Imagery data can also be accessed using the Product Browser. The Product Browser is accessed by
selecting CAVE > Data Browser > Product Browser, as shown in Exhibit 2.2.6.11-12.

Exhibit 2.2.6.11-12. Selecting VIIRS Imagery Data via the Product Browser

Soundings Products: The Soundings submenu option enables the user to select the NUCAPS (NOAA Unique CrIS/ATMS Processing Systems) Sounding Availability product. This product,
derived from processing of CrIS/ATMS data, provides cloud cleared radiances and trace gas that enable increased accuracy in the development of the vertical profile of temperature and water
vapor retrievals. An example of this product is shown in Exhibit 2.2.6.11-13, which depicts the NUCAPS sensor track for a typical path as it crosses the CONUS. By clicking on the individual
dots, the forecaster is able to retrieve the sounding for the selected point.



Exhibit 2.2.6.11-13. NUCAPS Sounding Availability Track Over CONUS

Additional imagery products are available under the "NH/NA/US every image" and "4 Sat Composite" sections of the Satellite menu, which is shown in Exhibit 2.2.6.11-1. Descriptions of the types of
imagery products available under these sections follow.

NH/NA/US every image

The NH/NA/US every image products are based on imagery from the current series of GOES satellites. This menu section is oriented toward the larger scales (i.e., Northern Hemisphere [NH], North
American [NA], and CONUS [US]). Selecting satellite imagery from this menu section loads every available image for display. This is a change from the legacy AWIPS system, in which data was scale
dependent. Because data is not scale dependent in AWIPS II, every available satellite image is available and displays on any scale. The satellite products under the "NH/NA/US every image" section
display the same data as the satellite products at the top of the Satellite menu. Note that larger-scale imagery (i.e., from the NH and NA scales) is ultimately limited in frequency not by AWIPS but rather
by the availability of scans from the GOES satellites. Large-scale northern hemispheric imager scans are produced only every 30 minutes. A complete "full disk" (i.e., most of the Western Hemisphere)
image is scanned only once every 3 hours per spacecraft.

GOES East and GOES West each feature a five-channel imager, and apart from the exceptions noted above, all imagery available on the satellite menu is based on either one or two imager channels from
one or both GOES satellites. The current series of GOES satellites consists of nine spacecraft, with pre-launch designators I-Q and post-launch designators of 8-16 (the latter designator assigned when the
spacecraft achieves geosynchronous orbit). At any given time, two satellites of this series will be operational, one situated over the equator at 75W longitude (called GOES East) and the other situated over
the equator at 135W longitude (called GOES West). The imagers on this series of satellites are similar, but not identical. The primary differences involve the availability of one of two long-wave channels
(12u or 13u) and the resolutions of certain channels.

The GOES imager instruments operate in various modes, which affect the frequency and coverage of some imagery provided to AWIPS. The default mode is referred to as "Routine" mode, and the imagers
most often scan in this mode. The other common imager mode is "Rapid Scan" mode. NESDIS switches the GOES East and West imagers (independently), chiefly between these two modes and usually in
response to NWS requests. In routine mode, the imager scans four CONUS sectors per hour; in rapid-scan mode, the imager typically scans eight CONUS sectors per hour. Satellite imagery is generally
displayed at all intervals for all scales (i.e., 15-minute intervals in routine mode and generally 5-10 minute intervals in rapid-scan mode). A set of menu options is available in the "NH/NA/US every
image" section of the satellite menu.

4 Sat Composite

The 4 Sat Composite products are based on imagery from four geostationary satellites: GMS; GOES West; GOES East; and METEOSAT. These composites are disseminated via the SBN's OCONUS
channel and are therefore unavailable to most CONUS sites.

A Water Vapor/Infrared (WV/IR) combination product is available in this menu. In this product, the IR Window (11 micron) data replaces water vapor pixels where the cloud top temperature is below -35
C. Other menu entries display images that are differences between two channel images. For example, the selection of the 11u-3.9u menu entry will display the temperature difference between a channel 4
image and a channel 2 image (both from the same time period).



2.2.6.12 kxxx

The kxxx is a site-specific menu that provides access to Weather Surveillance Radar-1988 Doppler (WSR-88D) radar products. The menu is shown in Exhibit 2.2.6.12-1.

Exhibit 2.2.6.12-1. kxxx Dropdown Menu

Note 1: With the upgrade to dual-polarization technology, the kxxx menu options have been rearranged to accommodate the dual-pol products. Note that all legacy options are still available but have
been relocated on the menu or moved to submenus.

Note 2: Variations in the menu options may exist because of your site configuration. However, all WSR-88D radars are equipped with the dual-pol products.

kxxx products:

Best Res Z+SRM8 and Best Res Z+V Combinations: The radar combination products Z+SRM and Z+V are precombined formats of the reflectivity and storm relative motion or velocity,
displayed together via a single menu selection. SRM products include the storm motion vector information, which is plotted in the upper left corner of the Main Display Pane.

4-Panel Z+SRM/ZDR+V/KDP+HC/CC+SW: This section of the kxxx menu enables you to load multiple base and dual-pol products, which are then simultaneously displayed. The label of
this section of the menu describes the format for loading the products: Z+SRM in the upper left quadrant, ZDR+V in the upper right quadrant, KDP+HC in the lower left quadrant, and
CC+SW in the lower right quadrant. Primary dual-pol base data analysis is best accomplished using the All Tilts base data option (4 panel all tilts with 8 products loaded), though you may
use the single tilts (e.g., 0.5 base data) for longer time duration loops.

To load 4 panel displays containing multiple elevation angles of the same product, you would select the kxxx four panel option and then select the desired set of 4 panels from the kxxx four
panel submenu.

All Tilts: The kxxx menu accommodates several radar tilt angles. Instead of having a menu item for each tilt angle, "tilt bins" have been set up internally. Each bin includes a range of
tilts, as outlined in Table 2.2.6.12-1.

Table 2.2.6.12-1. Tilt Bins for Radar Menus

Primary Tilt Tilt Range Primary Tilt Tilt Range

0.0 0.0 - 0.3 7.5 6.7 - 8.0

0.5 0.4 - 0.7 8.7 8.1 - 9.5

0.9 0.8 - 1.1 10.0 9.6 - 11.0

1.5 1.2 - 1.6 12.0 11.1 - 13.0

1.8 1.7 - 2.0 14.0 13.1 - 15.6

2.4 2.1 - 2.6 16.7 15.7 - 17.9

3.4 2.7 - 3.6 19.5 18.0 - 22.0

4.3 3.7 - 4.6 25.0 22.1 - 27.5

5.3 4.7 - 5.6 32.0 30 - 60

6.0 5.7 - 6.6 - -

All Tilts allows you to step or animate in either space or time. Selecting one of the All Tilts buttons will load all the tilts available from the latest volume scan. It will continue to load tilts
from previous volume scans until it has loaded as many frames as indicated on the frame count menu. Auto updates will add higher tilts from the latest volume scan, replacing a tilt from
the oldest volume.

After loading an All Tilts display, Shift  + LEFT ARROW  and Shif t  + RIGHT ARROW  and looping will take you through the frames in the order in which the system loaded them
(without regard to volume scan or tilt). The UP ARROW  and DOWN ARROW  will step the display up or down in a volume scan allowing the tilts to change for a fixed time. The
RIGHT ARROW  and LEFT ARROW  will step the display forward or backward through time at a fixed tilt. Once you have set the mode of motion (vertical or time), the
Page Up/Page Down  keys will start and adjust loop speed. To switch from vertical to time mode or from time to vertical mode, press the desired arrow key.



CAUTION: If you hit the up or down arrow key in a standard (not All-Tilts) display, looping and stepping are disabled until you hit either the left or right arrow key or one of the
stepping buttons on the menu. Once an arrow key (Left, Right, Up, Down) has been pressed, the stepping/animation controls on the main window toolbar and the Page Up/Page Down

keys will function in that same mode. For example, assume the UP ARROW  or DOWN ARROW  key is pressed; the menu controls will now operate through the tilts at a fixed time, e.g.,
you can go to the lowest tilt by selecting the First Frame iconified button.

Note 3: Ctrl  + LEFT ARROW  and Ctrl  + RIGHT ARROW  are still the keyboard shortcuts for First Frame and Last Frame; however, you will be returned to the standard (not
All-Tilts) display. To proceed to the first or last frame while in the All-Tilts special mode, use Ctrl  + UP ARROW  or Ctrl  + DOWN ARROW .

Best Res Base Products: This section is divided into two parts, as shown on Exhibit 2.2.6.12-1. The upper part lists individual kxxx products: four kxxx base products, as shown in Exhibit
2.2.6.12-2, and three dual-pol products (ZDR, CC, and KDP). Refer to Section 8.6 for a detailed description of the dual-pol products.

Exhibit 2.2.6.12-2. Best Res Base kxxx Products

The lower part includes submenus for accessing multiple products and applications. The following describes the submenus grouped in the lower part of the Best Res Base Products section.

kxxx Precip: In addition to the QPE dual-pol products, this submenu includes the legacy precip products, which include Storm Total, One Hour, Three Hour, and User Selectable
precipitation products. A suite of snowfall products is also available on the kxxx Precip submenu. All are available for request (OTR, RMR), and the first four can be added to an RPS
(Routine Product Set) list. All of these products are available on any scale.

kxxx Derived Products: The kxxx Derived Products submenu includes Layer Reflectivity, Cross Section, and Other products displayed on any scale. Derived products include
precipitation, storm (mesocyclone, hail, tornado), and wind derivations.

kxxx Algorithm Overlays: The kxxx Algorithm Overlays submenu includes legacy algorithm overlays and the ML dual-pol overlay.

kxxx four panel: The kxxx four panel submenu includes menu entries for Z+V, Z+SRM 8- and 4-bit, and some other combinations that are presented in 4-panel mode, with a different
elevation angle or product in each panel.

kxxx Data Quality: The kxxx Data Quality products, accessible by a pull-right submenu, include Clutter Filter Control and reflectivity and velocity clutter probability products.

kxxx 4-bit/Legacy Prods: The kxxx 4-bit/Legacy Prods submenu uses generic selectors that load 8-bit (256 level) data, with legacy 4-bit (16 level) and 3-bit (8 level) data filling in
when no 8-bit data is available.

Radar Applications: The Radar Applications submenu is shown in Exhibit 2.2.6.12-3. It provides access to all the radar applications and radar tools. All except VR-Shear are discussed
in Chapter 8. VR-Shear is described in this section.

Exhibit 2.2.6.12-3. kxxx Radar Applications Submenu Options (Applications and Tools)

VR-Shear: This tool is used in conjunction with Doppler velocity data to calculate the velocity difference (or "shear") of the data directly under the end points. As with the Baselines,
this feature comes up editable and the end points can be dragged to specific gates of velocity data. When in place, the speed difference (kts), distance between end points (nautical miles),

shear (s-l), and distance from radar (Nmi) are automatically plotted next to the end points and in the upper left corner of the large display pane. A positive shear value indicates cyclonic
shear, while a negative value indicates anticyclonic shear. If either end point is not directly over velocity data, the phrase "NO DATA" is reported for the shear value. This tool is also
useful in determining gate-to-gate shear. Simply place the two end points directly over adjacent gates of velocity data.

"Snapping" VR-Shear: If you are zoomed in over an area when you load VR-Shear and the VR-Shear Baseline does not appear, press mouse Button 3 (B3) to "snap" the Baseline
to where the mouse cursor is located.

VR-Shear in 4-Panel: You can use the VR-Shear Tool when the large display is in 4-panel mode. The VR-Shear overlay is loaded in different colors for each panel. There are
actually four copies of the program running, and each behaves independently. This means that you can get accurate readings in any one of the four panels; one VR-Shear panel is



editable at a time. To activate, click mouse Button 2 (B2) on the VR-Shear legend in the desired panel and position the query line to the echoes of interest.



2.2.6.13 txxx

The txxx menu, as shown in Exhibit 2.2.6.13-1, is a site-specific menu that provides access to the displays for a Terminal Doppler Weather Radar (TDWR). The TDWR is a high-quality, dedicated
meteorological surveillance radar that is deployed near many large airports in the United States. TDWRs, in contrast to the WSR-88Ds, provide a finer resolution, have more sweeps per scan, a maximum
elevation angle up to 60 degrees, and repeated patterns and elevations within a scan. They also use multiple pulse repetition frequencies (PRF). Each TDWR has a different set of elevation angles that
depend on the distance between the TDWR and the associated airport. TDWRs operate on the C-band wavelength, making the signal more susceptible to beam attenuation, velocity aliasing, and range
folding.

Exhibit 2.2.6.13-1. txxx Dropdown Menu

Note 1: Variations in the menu options may exist because of your site configuration, so you should spend some time exploring the vast array of radar products within this menu.

txxx Products

Best Res Z+SRM8 Combo and Best Res Z+V Combinations: The radar combination products Z+SRM and Z+V are precombined formats of the reflectivity and storm-relative motion or
velocity, displayed together via a single menu selection. Storm Relative Motion (SRM) products include the storm motion vector information, which is plotted in the upper left corner of the
Main Display Pane. The "tilt bins" that have been internally set up apply to both the kxxx and txxx radars. Thus, for All Tilts Z+SRM8 and the txxx Hi Z+SRM8 tilts menu options, refer to
Subsection 2.2.6.12.

Best Res Base Products: This section of the txxx menu is divided into two parts, as shown on Exhibit 2.2.6.13-1. The upper part lists the individual txxx base products (Reflectivity (Z),
Velocity (V), Storm Rel Vel 8-bit (SRM8), and Spectrum Width (SW)). The lower part includes submenus for accessing multiple products and applications. The following describes the
submenus grouped in the lower part of the Best Res Base Products section.

txxx Precip: This txxx Precip submenu includes Storm Total, One Hour, Three Hour, and User Selectable precipitation products. A suite of snowfall products is also available on the
txxx Precip submenu. All are available for request (OTR, RMR), and the first four can be added to an RPS (Routine Product Set) list. All of these products are available on any scale.

txxx Derived Products: The txxx Derived Products submenu includes Layer Reflectivity, Cross Section, and Other products displayed on any scale. Derived products include
precipitation, storm (mesocyclone, hail, tornado), and wind derivations.

txxx Algorithm Overlays: Opens the txxx Algorithm Overlays submenu for overlaying multiple products.

txxx four panel: The txxx four panel submenu includes menu entries for Z+V and Z+SRM8. It also includes specific elevation angles (for Hazardous mode), rather than the standard
bin-representing tags. Each TDWR's menu reflects the actual tilt angles in its Hazardous mode VCP. For Monitor mode, tilts are displayed from the closest Hazardous mode angle menu
selector.

txxx Data Quality: The txxx Data Quality products, accessible by a pull-right submenu, include Clutter Filter Control and reflectivity and velocity clutter probability products.

txxx 4-bit/Legacy Prods: The txxx menu uses generic selectors that load 8-bit (256 level) data, with legacy 4-bit (16 level) and 3-bit (8 level) data filling in when no 8-bit data is
available.

Radar Applications: The Radar Applications submenu is shown in Exhibit 2.2.6.13-2. It provides access to all the radar applications and radar tools. All except VR-Shear are discussed
in Chapter 8. VR-Shear is described in this section.

Exhibit 2.2.6.13-2. txxx Radar Applications Submenu Options (Applications and Tools)

VR-Shear: This tool is used in conjunction with Doppler velocity data to calculate the velocity difference (or "shear") of the data directly under the end points. As with the Baselines,
this feature comes up editable and the end points can be dragged to specific gates of velocity data. When in place, the speed difference (kts), distance between end points (nautical miles),

shear (s-l), and distance from radar (Nmi) are automatically plotted next to the end points and in the upper left corner of the large display pane. A positive shear value indicates cyclonic
shear, while a negative value indicates anticyclonic shear. If either end point is not directly over velocity data, the phrase "NO DATA" is reported for the shear value. This tool is also
useful in determining gate-to-gate shear. Simply place the two end points directly over adjacent gates of velocity data.

"Snapping" VR-Shear: If you are zoomed in over an area when you load VR-Shear and the VR-Shear Baseline does not appear, press mouse Button 3 (B3) to "snap" the Baseline



to where the mouse cursor is located.

VR-Shear in 4-Panel: You can use the VR-Shear Tool when the large display is in 4-panel mode. The VR-Shear overlay is loaded in different colors for each panel. There are
actually four copies of the program running, and each behaves independently. This means that you can get accurate readings in any one of the four panels; one VR-Shear panel is
editable at a time. To activate, click mouse Button 2 (B2) on the VR-Shear legend in the desired panel and position the query line to the echoes of interest.



2.2.6.14 Radar

The Radar dropdown menu shown in Exhibit 2.2.6.14-1, allows users to access radar related products and applications. With the exception of RCS, VCS, and SWA products, all products that can be
requested from your local radar can now also be requested from non-associated radars.

Exhibit 2.2.6.14-1. Radar Dropdown Menu

The Radar menu provides access to the following options:

10km Radar Coded Message: This mosaic is derived from the reflectivity information in Radar Coded Messages (RCM). The mosaic is created centrally and disseminated via the SBN at
approximately 00:10 and 00:40 each hour. The reflectivity fields have been given automated quality control to identify and remove echo features due to nonprecipitation targets, chiefly migrating
birds, aircraft, and insects. However, some small nonprecipitation features may pass all quality-control checks, especially when they are located underneath cold, dense clouds or near actual
precipitation. True precipitation features are only rarely removed. Boxes within the mosaic grid that are more than 230 km from the nearest reporting radar are black with no data pixels at the
out-of-range spots.

FAA Radars: Most field sites have access to one or more FAA radars, which can provide fill-in coverage for the WSR-88D network. If a field site doesn't have access to an FAA radar, the Radar
menu will not include the FAA radar options. FAA radars for this menu are set up as part of your localization process.

FAA radar locations (along with WSR-88Ds and TDWRs) appear on the WSR-88D's map. There are two kinds of FAA radars: (1) The ASR-11 (IDs beginning with 'e') has a fan beam spanning 4.5
deg in elevation and 1.4 deg azimuth, making a product similar to an 88D composite reflectivity; and (2) the ARSR-4 (IDs beginning with 'f') is a phased-array radar (the product we receive is
somewhat like a hybrid scan comprising the four lowest beams). These appear at the top of the Radar menu, just above the Mosaic section. As shown in Exhibit 2.2.6.14-2, products for each radar
include a reflectivity image (Z) and a unit status graphic; these generally update once per minute. The FAA radar data is also included in the Hybrid Scan Refl mosaic.

Exhibit 2.2.6.14-2. ASR-11 and ARSR-4 FAA Radar Menus

Mosaic: Mosaics available via this menu use data from up to nine nearby radars. Additional optional mosaics on cascading menus provide a limited list of radar products from a predefined set of
WSR-88D radars within a given region. Your System Manager or site Administrator can set up such mosaics by: /awips2/edex/data/utility/common_static/site//radar/radarInUse.txt. A
mosaicInfo.txt table will only work while logged on to an AWIPS workstation.

Dual Pol: Dual-polarization radar data involves alternating between sending vertically and horizontally polarized pulses. Whereas doppler allows the radar to be sensitive to the motion of the targets,
dual-polarization allows the radar to be sensitive to the shape of the targets. The greatest impacts of this technology will be improved values for accumulated precipitation, improved hail detection,
and improved detection of non-meteorological targets. Refer to Section 8.6 for further details.

Dial Radars: Dial radars for this menu are set up as part of your localization process. A comprehensive menu of radar products is available for each dial radar, as shown in Exhibit 2.2.6.14-3.



Exhibit 2.2.6.14-3. Dial Radars and Radar Products

Applications: Radar applications are discussed in detail in Chapter 8. Radar tools are identified in Exhibit 2.2.6.14-4.

Exhibit 2.2.6.14-4. Radar Tools

Precipitation Processing System Products (PPR) added to ASR/ARSR Menu

PPS (Precipitation Processing System) products are available on the ASR/ARSR SPG as shown in Exhibit 2.2.6.14-5.



Exhibit 2.2.6.14-5. PPS products in ASR/ARSR menu



2.2.6.15 Multiple-Radar/Mutliple-Sensor (MRMS) Dropdown Menu

The MRMS dropdown menu shown in Exhibit 2.2.6.15-1, allows users to access products related to the
Multiple-Radar / Multiple-Sensor (MRMS) system that was initially developed by the National Severe
Storms Laboratory (NSSL), and subsequently made operational at the National Centers of Environmental
Prediction (NCEP).

Exhibit 2.2.6.15-1. MRMS Dropdown Menu

The MRMS Menu provides access to the following submenus:

Hail Products:  These products have been developed to improve the diagnosis of hail in
thunderstorms.  The choices are shown in Exhibit 2.2.6.15-2.

Exhibit 2.2.6.15-2. MRMS Hail Products Menu

Lightning Products:  These products have been developed to improve the detection and prediction of
lightning. The choices are shown in Exhibit 2.2.6.15-3.
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Exhibit 2.2.6.15-3. MRMS Lightning Products Menu

Precipitation Products:  These products have been developed to improve the estimation of
precipitation accumulation. The choices are shown in Exhibit 2.2.6.15-4.  There are also four
submenus included in the Precipitation Products Menu, one of which is shown in Exhibit 2.2.6.15-5.

Exhibit 2.2.6.15-4. MRMS Precipitation Products Menu

Exhibit 2.2.6.15-5. MRMS QPE - Radar Only Products Menu

Reflectivity Products: These products have been developed to improve the diagnosis of severe
thunderstorms for warning decision making. The choices are shown in Exhibit 2.2.6.15-6.  There are
also four submenus included in the Reflectivity Products Menu.  They are the Echo Tops Menu, shown
in Exhibit 2.2.6.15-7, the Isothermal Reflectivity Menu, shown in Exhibit 2.2.6.15-8, the Merged
Reflectivity Cube Menu, shown in Exhibit 2.2.6.15-9, and the Thickness Menu, shown in Exhibit
2.2.6.15-10.
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Exhibit 2.2.6.15-6. MRMS Reflectivity Products Menu

Exhibit 2.2.6.15-7. MRMS Echo Tops Products Menu

Exhibit 2.2.6.15-8. MRMS Isothermal Reflectivity Products Menu

file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users Manual/OB16...

3 of 6 1/28/2016 12:02 PM



Exhibit 2.2.6.15-9. MRMS Merged Reflectivity Cube Menu
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Exhibit 2.2.6.15-10. MRMS Thickness Products Menu

Velocity Products:  These products have been derived from multiple-radar Doppler velocity data to
improve storm diagnosis for severe thunderstorms and tornado warning decision making. The choices
are shown in Exhibit 2.2.6.15-11. 

Exhibit 2.2.6.15-11. MRMS Velocity Products Menu

2.2.6.15.1 Multiple-Radar/Mutliple-Sensor (MRMS) Reflectivity "All-Tilts" feature in 16.1.1.

This section discusses procedures for obtaining MRMS grids via LDM/LDAD and implementing the
Reflectivity "All-Tilts" feature in 16.1.1 since the individual reflectivity level products won't be shipped over
the SBN.

MRMS_All_Tilts_Instructions

A link for the instructions to walk you step-by-step through configuring your Local Data Acquisition and
Dissemination (LDAD) system to bring in MRMS Merged Reflectivity data at individual levels, so that they
can be used in an All-Tilts display, is shown below.

MRMS All-Tilts Configuration Steps

file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users Manual/OB16...

5 of 6 1/28/2016 12:02 PM



The Python script and three sample configuration files referenced in the above instructions will be available
at a URL location that has yet to be determined at the time of this publication.  The URL information will
eventually be made available within the 16.1.1 Release Notes at: 

https://docs.google.com/spreadsheets/d/1wv3ygGxfI9g9LTsxyNtwipkGhoCDqxuPor3dwbL-
lW8/edit#gid=34

Until that time, users can also download the following PDF files, and cut and paste the content into text files,
and rename them by stripping off the .pdf extension.

preProcessMRMS.py.pdf

LDADinfo.txt.pdf

ldmd.conf.pdf

pqact.conf.pdf
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2.2.6.16 SCAN, Maps, and Help Menus

SCAN

The System for Convection Analysis and Nowcasting (SCAN) dropdown menu shown in Exhibit 2.2.6.16-1, is located on the CAVE-D2D menu bar. SCAN is an integrated suite of multi-sensor
applications that detect, analyze, and monitor convection and generate short-term probabilistic forecast and warning guidance for severe weather automatically within AWIPS. SCAN also provides
forecasters with severe weather guidance and supplements forecaster event monitoring with multi-sensor, automated event monitoring. Refer to Subsection 13.1.2 for a more information on SCAN.

Exhibit 2.2.6.16-1. SCAN Dropdown Menu

The SCAN menu also includes the Flash Flood Monitoring and Prediction (FFMP) application, which allows forecasters to compare precipitation accumulations derived from radar and other sources with
flash flood guidance. FFMP operates by accumulating precipitation over hydrologic basins on various spatial scales. Refer to Subsection 13.1.3 for a more information on FFMP.

Maps

The Maps menu shown in Exhibit 2.2.6.16-2, is located on the CAVE-D2D menu bar. The Maps menu lets you choose one or more map backgrounds for the displayed product. The content of this menu
varies somewhat from site to site.

Exhibit 2.2.6.16-2. Maps Dropdown Menu

Help

The Help menu shown in Exhibit 2.2.6.16-3, contains a checkbox that enables/disables the Tooltips. Information on the workstation software is also accessible from this menu.



Exhibit 2.2.6.16-3. Help Dropdown Menu



2.2.7 The D2D Toolbar and CAVE Perspectives Tab Bar

This subsection contains brief descriptions of each menu and iconified button displayed along the second and third rows of the CAVE GUI. The D2D Toolbar is along the second row, while the CAVE
Perspectives Tab Bar is along the third row. Refer to Exhibit 2.2.7-1, which displays the menu and options for the selected D2D Perspective.

Note 1: Remember that the menus and the button included on the first and second rows of the CAVE GUI are perspective dependent. Refer to Subsection 2.2.3.

Exhibit 2.2.7-1. D2D Toolbar and CAVE Perspectives Tab Bar

Certain iconified buttons on the toolbar are check buttons. These buttons are recessed when they are in the "on" position, as shown in Exhibit 2.1.7-1 for the "Pan" button. If Tooltips is selected (a
checkbox option under the Help menu) tooltips appear as you slowly move the mouse pointer over the iconified Toolbar button. Other buttons on the Toolbar dropdown provide a list of options. A
description of each option follows.

Toolbar Menus and Buttons

Load Modes

The Load Modes menu, shown in Exhibit 2.2.7-2, provides different ways to display model or real-time data by manipulating previous model runs and inventories of data sets. Load Modes are defined
in Subsection 2.2.6.4.

Exhibit 2.2.7-2. Load Modes Menu with Default Valid Time Seq Mode Selected

Scale

The Scale menu, shown in Exhibit 2.2.7-3, controls the viewing area of the Main Display Pane. You can choose one of six scales: N. Hemisphere, North American, CONUS, Regional, State(s), and
WFO.

Exhibit 2.2.7-3. Scale Menu with Default CONUS Scale Selected

Note 2: For River Forecast Centers the "State(s)" option on the Scale menu would be changed to "RFC." The other options would remain unchanged.

Note 3: When CAVE is first started, the CONUS Scale (for CONUS sites) is displayed in the Main Display Pane.

Note 4: Changing the scale affects the product graphically displayed on the Main Display Pane by rerendering the image to the new scale.

Clear

The Clear button clears the Main Display Pane of all products. The map background remains. For X-Y displays (e.g., cross sections, time-height displays, variable vs. height displays, soundings, and
time series displays), the entire tab/display is removed from the display when the Clear button is executed while one of these charts is displayed.

The D2D Toolbar includes 14 iconified buttons, as shown in Exhibit 2.2.7-4. The function of each button is described below.



Exhibit 2.2.7-4. D2D Toolbar Iconified Buttons

(1) Pan

This iconified button, which resets when selected (as shown here), allows you to move freely around the map background in the Main Display Pane. Click and hold down mouse Button 1 to move the
map.

(2-5) Stepping

Stepping consists of four iconified buttons, which enable you to display the first frame in the loop (2), display the previous frame in the loop (3), display the next frame in the loop (4), or display the
last frame in the loop (5).

(6) Loop

This iconified button automatically changes the display as it sequentially steps through each frame in the loop.

(7) Loop Properties

This iconified button opens the Loop Properties dialog box, as described in Subsection 2.2.6.4.

(8) Toggle Image Combination

This iconified button enables/disables the ability to display two images at one time, combining the two products as one in one product legend.

(9) Image Properties

This iconified button opens the Image Properties dialog box, as described in Subsection 2.2.6.4.

(10) Print

This iconified button prints the contents of the large display pane on the default printer. See Subsection 2.2.6.2 for guidance on how to change printer destination.

(11) Points

This iconified button displays the Interactive Points Tool, as described in Subsection 2.2.6.5.

(12) Baselines

This iconified button displays the Interactive Baselines Tool, described in Subsection 2.2.6.5.

(13) Five-Pane Layout

Clicking this iconified button arranges the display to have one Main Display Pane and four Small Monitor Panes. Refer to Exhibit 2.2.6.3-2.

(14) Three-Pane Layout

Clicking this iconified button arranges the display to have one Main Display Pane and two medium-sized Smaller Monitor Panes. Refer to Exhibit 2.2.6.3-3.

(15) Open Perspective

Clicking this iconified button drops down a list of perspectives. Refer to the description below and Exhibit 2.2.7-5.

Also located on the Toolbar are three additional menus and a WarnGen button. A description of each follows.

Frames

The Frames menu is used to select the number of frames of a product you want loaded. The default is 12 frames. The maximum is 64 frames.

Magnification

The Magnification menu enlarges or reduces the size of the text and symbols on a graphic product. As you increase magnification, the density of the data automatically decreases. The purpose of this
feature is to make the text and symbols more visible. Magnification 0 is a special case. For station plots, only the location of the station is shown, and stations with data are in the overlay color, while
those without data are gray. You can still sample the data in this mode. For grids, you can see the grid resolution by displaying wind and setting magnification to zero.

Density

The Density menu adjusts the amount of data presented on the Main Display Pane. Higher density settings increase the amount of data.

WarnGen

The yellow WarnGen button, located on the right side of the Toolbar, activates the Warning Generator function. Refer to Chapter 6 for more information. The background color of the CAVE-D2D
screen and the WarnGen dialog box changes to reflect the mode setting for WarnGen's functionality: no color change for Operational Mode; black for Test Mode; and yellow for Practice Mode.



CAVE Perspectives Tab Bar Menus and Buttons

Perspective Button and Tabs

Exhibit 2.2.7-4 shows the Open Perspective iconified button on the far left with the tabs for each perspective, in the order selected, right to left. When a tab is showing, it indicates the perspective is
open. The highlighted tab (D2D in this case) indicates the active perspective, with the other perspectives, non-highlighted tabs, running in the background. The forecaster can quickly switch to another
perspective by selecting the desired perspective's tab, which would then, in this case, change the D2D to non-highlighted and the selected perspective's tab to highlighted.

Use the Open Perspective iconified button to drop down the list of perspectives, as shown in Exhibit 2.2.7-5. An iconified tab for the respective perspective that is opened is listed from right to left in
the order in which the perspective was opened. The iconified tab will remain displayed until the perspective is closed. You can toggle between perspectives by selecting the desired perspective's tab.
The D2D tab is highlighted, indicating it is the active display, and no other perspective is open. The Other option undocks the CAVE Perspective dropdown box and displays it as a floating Open
Perspective pallet, adding "National Centers" and "XML" to the list perspectives.

Exhibit 2.2.7-5. List of Perspectives with D2D Perspective Active

D2D Map Tabs

To help users identify the data displayed in each Map tab when multiple tabs are present, users have the ability to name each Map tab displayed in D2D (Exhibit 2.2.7-6).  Exhibit 2.2.7-7 shows the
dropdown menu that appears when clicking MB3 on the Map tab. 

Exhibit 2.2.7-6. Renamed Map Tabs

Exhibit 2.2.7-7. Map Tab MB3 Popup Menu

By selecting the Rename Tab option, a Rename Tab dialog opens with a textbox populated with the current Map tab name (Exhibit 2.2.7-8).

Exhibit 2.2.7-8. Rename Tab Dialog

Users can enter a name in the textbox and click the OK button to display the new name in the tab.  These names persist when saving and loading perspective displays containing renamed tabs.  In
addition, when copying bundles into a Procedure dialog, the renamed map tab title appears in the Procedure dialog.  Similarly, the bundle name in the Procedure dialog appears as the map tab title when
loaded into the main pane (Exhibit 2.2.7-9).



Exhibit 2.2.7-9. Bundles Loaded into D2D carry over the Bundle Name into the Map Tab

Note: This functionality is only available in the D2D perspective



2.2.8 Pop-up Menus

Pop-up menus contain options that are used by forecasters to make on-the-fly changes to visual features of the display or to displayed products in order to improve interpretations of the displayed
information.

The options listed on a pop-up menu depend on the current display. For example, if the Product Legends are visible, a "Hide Legends" option will be listed on the pop-up menu. If Product Legends are
hidden, "Show Product Legends" will be listed instead.

Pop-up menus are opened by clicking and holding mouse Button 3 (B3) in a specific area of the display, over a selected Product Legend, or over an editing element. Selecting an option either initiates an
action or opens a dialog.

Options have unique names and might be listed on more than one pop-up menu. However, regardless of where the option is listed, the function associated with the name is the same, but it's application
depends on the pop-up menu's source.

Examples of pop-up menus and a description of their options are described in Subsections 2.2.8.1 and 2.2.8.2.



2.2.8.1 Pop-up Menus from Display Panes, Product Legends and Map Legends

Examples of pop-up menus exhibited over the display area of a Single Panel Layout are shown in Exhibit
2.2.8.1-1. Examples of pop-up menus exhibited over the display area of a Four Panel Layout are shown in
Exhibit 2.2.8.1-2.  Examples of pop-up menus exhibited from Map Legends are shown in Exhibit 2.2.8.1-3. 
Pop-up menus that are opened by selecting from a Product Legend contain options that apply only to that
specific product and do not affect any other displayed products. Pop-up menus that are opened over the Main
Display Pane or over one of the Smaller Monitor Panes affect only that particular pane and all the product
overlays in that pane.

Exhibit 2.2.8.1-1. Example of Pop-up Menus on Single Panel Layout
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Exhibit 2.2.8.1-2. Example of a Pop-up Menu on Four Panel Layout with Top-Right Panel Active
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Exhibit 2.2.8.1-3. Example of a Pop-up Menu from the Map Legend

Descriptions of the options listed on the pop-up menus shown in Exhibits 2.2.8.1-1, 2.2.8.1-2 and 2.2.8.1-3,
as well as options not shown in the three examples, follow (alphabetically listed).

All-Panel Sample

This checkbox enables sampling of the current full-screen image (see Rotate Panels, below), plus up to
seven hidden images.

Blinking

This menu option contains a checkbox that toggles the blinking of a graphic. It is possible to have several
graphics blink simultaneously.

Note 1: Looping must be turned off for a specified range to blink.

Change Blinking...

This menu option opens the Image Blinking dialog. It is used to set up the blinking parameters for a single or
combined image.  If a combined image is displayed, the pop-up menu will include the name of each image
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for which you can choose to change the blinking.

Control Color of All Images

This option is available when the four panel layout is displayed in the Main Display Pane and one of the
panels is enabled for controlling its image (denoted with a green "I"). This menu option allows you to make
changes to the images in all four panels.

Control Color of This Image

This option, available only in the four panel layout, allows you to choose one of the four panels that may
contain an image and make changes to that image. When this option is selected, a large green "I" appears in
the lower left corner of the chosen panel, and the Image Properties dialog appears automatically. Within this
dialog box, you can adjust the brightness using the slider bar or edit the image by clicking on the image label
within the Image Properties dialog box, which opens the Image Controls Editor. To combine an image in this
panel with another image, you need to click B3 over the panel and choose the Load to this Panel option. Then
select the additional image to combine into the panel.

Density

This is a cascading menu that provides data density settings for a selected graphic overlay. These settings are
the same as those in the Density option menu in the Toolbar (see Subsection 2.2.7). However, the density
setting chosen from the Toolbar applies to all the overlays in the Main Display Pane, while the density setting
chosen from the pop-up menu applies only to the one overlay on which you opened the pop-up menu. The
present density setting of the overlay is indicated with the radio button turned on (yellow).

Display Product

This menu option contains a checkbox that toggles the visibility of the selected graphic or image overlay.
Clicking B1 on the legend performs the same action.

Editable

This pop-up menu option applies to editing elements of WarnGen and any of the tools that require editing
(Baselines, Points, Home, etc.). You can also enable or disable editing of WarnGen and the tools by clicking
the legend with mouse Button 2 (B2).

Edit Colors...

If you click and hold B3 over an image legend, the pop-up menu contains the Image Color Editor, discussed
in Subsection 2.2.9, from which you can change the color table. This option is made available in the pop-up
menu whenever a single or combined image or multicolored graphic (e.g., time-series Profiler data) is
displayed. If a combined image is displayed, the pop-up menu will include the name of each image for which
you can choose to edit.

Four Panel Layout
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This menu option, available only on the Main Display Pane, divides the Main Display Pane into the four
panels, as shown in Exhibit 2.2.8.1-2. If you select this option when data is displayed on the Main Display
Pane, the data is redrawn in the upper left panel.

Label

This menu item expands to display a list of various label options associated with the selected map ID in the
Map Legend.  Selecting a radio button for a particular label displays the label on the displayed map.

Label Offset

Selecting this option opens the Map Label Offset dialog.  Users can adjust the position of the label based on
the coordinate system (the origin existing where X=0 and Y=0).  Negative X values shift labels to the left
while positive X values shift labels to the right.  Negative Y values shift labels down while positive Y value
shift labels up.

Lat/Lon Readout

This is a checkbox that toggles the ability to sample latitude and longitude coordinates at the mouse pointer.

Line Style

This is a cascading menu that provides line style settings for a selected graphic overlay. The options are
Default, Solid, Dashed, or Dotted. By default, data with values less than zero is automatically displayed in
dashed lines. Any text or symbols contained in a graphic are not affected by the changes to line style.
However, wind barbs and arrows are affected.

Line Width

This is a cascading menu that provides four line-width settings for a selected graphic overlay. Any text or
symbols contained in a graphic are not affected by the changes to line style. However, wind barbs and arrows
are affected.

Load as Arrows

This menu option displays a gridded vector product (such as wind) using arrows and is available whenever
vector fields are displayed. When selected, the wind arrows product is overlaid on the display.

Load as Barbs

This menu option displays a gridded vector product (such as wind) using wind barbs. This option is made
available in the pop-up menu whenever vector fields are displayed. When selected, the wind barbs product is
added to the display.

Load as Contours
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This option overlays the selected image field as a contoured graphic.

Load as Image

This menu option overlays the selected contoured graphic overlay as an image. When you load a graphic as
an image with this option, the contoured graphic is still displayed.

Load as Image and Combine

This menu option displays the selected contoured graphic overlay as an image and combines the new image
with an already-displayed image. This option is available in the pop-up menu when there is at least one image
displayed. To better distinguish and manipulate the combined images, use the options available in the
Imaging... dialog box, which is opened from the Image Properties iconified button on the Toolbar.

Load as Streamlines

This menu option displays a gridded vector product (such as wind) using streamlines. This option is made
available in the pop-up menu whenever vector fields are displayed. When selected, the wind streamlines
product is added to the display.

Load to All Panels

This menu option is available when the four panel layout is displayed in the Main Display Pane and one of
the panels is enabled for loading (marked with a yellow "L"). It allows you to load the next overlay into all
four panels.

Load to This Panel

This menu option, available only in the four panel layout, allows you to choose one of the four panels for
your next product selection. When this option is selected, a large yellow "L" appears in the lower left corner
of the chosen panel. Any subsequent product loads overlay only in the chosen panel and not in the other three
panels.

Magnification

This is a cascading menu that provides magnification settings for selected graphic overlays. These settings
are the same as those in the Magnification option menu on the Toolbar (see Subsection 2.2.7). However, the
magnification setting chosen from the Toolbar applies to all the overlays in the main display pane, while the
magnification setting chosen from the pop-up menu applies only to the one overlay on which you opened the
pop-up menu. The present magnification setting of the overlay is indicated with the checkbox turned on
(yellow).

Rotate Panels

When in Four Panel Layout, this option brings the upper left panel into the full main pane, with a large cyan
plus sign in the lower left corner as a cue. If you have combined images, the 'left-hand' image will be
displayed. Subsequent selections of Rotate Panels cycle through the panels–UL, UR, LR, LL.
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Note 2: This function is usually controlled by keyboard shortcuts. Delete is equivalent to Rotate
Panels, while End returns you to four panel mode. Keyboard keys 1 through 8 go directly to a
component of interest. (See Table 2.1.1-3.)

Restore Skipped Frames

This menu option, available only on the Main Display Pane, recovers all frames that were temporarily
removed. This option appears in the menu once you have skipped any frames from the loop.

Sample

"Sample" is a menu option with a checkbox that toggles the capability for continuous sampling for all image
data, as well as METAR and ceiling/visibility plots and the Home Tool. Sampling 'on' is equivalent to holding
mouse Button 1 (B1) down all the time (using the Legacy AWIPS mouse functionality).

Note 3: The hidden images' samples show a reduced amount of information, while the in-view image
uses a standard sample preceded by an equals sign.

Sampling for this Product

When you click and hold mouse Button 1 (B1) (using the Legacy AWIPS mouse functionality) over an
image and some plotted data (including METARs, LDAD, marine, severe weather reports, MSAS QC
information, and Skew-Ts), the data value or report will be displayed next to the pointer. You can disable this
sampling readout by unselecting the Sampling for this Product button from the product legend.

Save Map Style

When a map displayed in the main pane is modified (e.g., by modifying Color, Line Style, Line Width,
Magnification, etc.), the user may save the map style by selecting the Save Map Style menu item from the
popup menu on the Map Legend.  The result is the creation of a localization file (CAVE->Map
Styles->mapstylepreferences.xml).  Each time the map is loaded, the saved characteristics of the map are
displayed. 

Set Background Color...

This menu option opens the Choose Pane Background Color dialog, which allows you to set the
background display color. Note that the background color is affected by the image brightness setting, and that
the sample color is always white; therefore, samples may be difficult or impossible to read if you pick a very
light background color.

Note 4: Like the Image Color Editor (Subsection 2.2.9), the Set Background Color dialog has a Color
Wheel, HSB and RGB radio buttons, RGB or HSB slider bars, and a Color Swatch.
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Set Color

The Set Color option allows you to change the color of a single-colored graphic overlay or map background.
Once you choose one of the nine colors from the pop-up menu, the selected overlay immediately appears in
the new color. If the overlay needs to be displayed in a color other than one provided in the pop-up, the Set
Backgroound Color option opens the Set Background Color dialog.

Shade

This menu item expands to display a list of various label options associated with the selected map ID in the
Map Legend.  When a radio button for a particular label is selected, a colormap is applied to the map
displayed in the main pane.

Show/Hide Legends

This menu option reveals and conceals both product legends and map background legends and is the default
action if you click mouse Button 3 (B3) on the Main Display Pane or one of the panels in the Four Panel
Layout. Once you toggle off the product legends, the valid time and date of the first loaded product remain in
the lower right corner of the Main Display Pane.

Show Map/Product Legends

This menu option toggles between making product legends or map legends visible on the Main Display Pane
or one of the panels in the Four Panel Layout.

Note 5: If both product and map legends are hidden, the "Show Product Legends" and "Show Map
Legends" options will be listed on the pop-up menu.

Single Panel Layout

This menu option, available only in the four panel layout, reverts the four panel layout to the single Main
Display Pane. Any products loaded in the panel where you selected this pop-up menu option are then
redisplayed in the single Main Display Pane. Products displayed in the other three panels are not redisplayed.

Skip This Frame

This menu option, available only over the Main Display Pane and only when the actual number of loaded
frames is greater than one, temporarily removes (skips) the currently displayed frame from the loop. You can
restore this frame by selecting the Restore Skipped Frames menu option. Keep in mind that once a frame is
removed from the loop, you can no longer step to it.

Note 6: Not available if looping is toggled on.

Skip Previous Frames
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This menu option, available over the Main Display Pane only, allows you to skip all previous (earlier) frames
of data from a loop. If the current frame is the first frame, then this option is not available.

Note 7: Not available if looping is toggled on.

Skip Subsequent Frames

This menu option, available over the Main Display Pane only, allows you to skip all subsequent (later) frames
of data from a loop. If the current frame is the last frame, then this option is not available.

Note 8: Not available if looping is toggled on.

Swap with Large Pane

The Swap with Large Pane menu option exchanges the contents of a Smaller Monitor Pane with that of the
Main Display Pane. When the contents of the Main Display Pane are swapped to the Smaller Monitor Pane,
the Rotate Panels and Four Panel Layout options become available.

Unload

This menu option permanently removes a selected graphic or image overlay from the display. The product is
restored only by reloading.

Unload All Products

This menu option removes all graphics and image products from the Main Display Pane. To redisplay a
product, it must be reloaded into the Main Display Pane.

Unload Graphics

This menu option removes all displayed graphics from the Main Display Pane. To redisplay a graphic, you
must reload it into the Main Display Pane. If one or two images are displayed with the graphics, they remain
in the Main Display Pane when the graphics are removed.

Zoom

This menu option opens a cascading menu that contains eight zoom factors. The position of the cursor before
the pop-up menu was invoked determines the center of the display once you zoom in. When zooming on
plan-view data, the zoom factors are expressed as display widths in kilometers. For non-plan-view data
(skew-Ts, profiler time series, etc.), the zoom factors are given as magnification factors.
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2.2.8.2 Pop-up Menus for Editing

The sample of pop-up menus shown in Exhibit 2.2.8.2-1 are generated by selecting options from the Tools Menu. The selected editing tools are listed in the Product Legend area and their editing elements
(baselines, points, home, etc.) are displayed. Clicking mouse Button 1 (B1) on a selected tool listed in the Product Legend area makes the tool's elements editable. Only one tool can be editable at a time.
In Exhibit 2.2.8.2-1 "Interactive Points" is currently shown as editable. Selecting another editing option listed in the Products Legend area would move the "Editible" designation to the newly selected
editing tool.

Exhibit 2.2.8.2-1. Example of Pop-up Menus for Editing

A description of the options listed on the pop-up menus shown in Exhibit 2.2.8.3-1, as well as options not shown, follow (alphabetically listed).

Note 1: Any options that are listed on the pop-up menus that have already been described in Subsection 2.2.8.1 are not repeated here. Refer to Subsection 2.2.8.1 for a description of those options.

Note 2: For editing purposes, clicking mouse Button 1 (B1) on a Tools Legend toggles between hide and show for the displayed element; and clicking mouse Button 2 (B2) on a Tools Legend
toggles the "Editable" function ON and OFF for that tool.

Add Vertex

This menu option lets you add a vertex without clicking and holding B1 on the editable element's segment and dragging to form a new vertex. Selecting the "Add Vertex" option adds a vertex at the cursor
location in the identified element's segment. The cursor's position over an element before the pop-up menu was invoked identifies the element.

Delete Entire Element

This menu option lets you delete an entire element. The cursor's position over an element before the pop-up menu was invoked marks the element that is to deleted.

Delete Vertex

This menu option removes the vertex where the mouse pointer was located when you opened the pop-up menu. This option is available only when a tool is displayed.

Move Vertex

This menu option lets you drag a vertex without clicking and holding down B1 to move the vertex. The cursor's position over a vertex before the pop-up menu was invoked marks the vertex that moves.
After selecting the option, move the cursor, without holding any button and move the vertex to the desired location. When location found, click any mouse button.

Move Entire Element

This menu option lets you drag an entire element without clicking and holding B1. The cursor's position over an element before the pop-up menu was invoked marks the element that moves. After
selecting the option, move the cursor, without holding any button and move the vertex to the desired location. When location found, click any mouse button.

Select Area

This menu option, available only when you are using the Alert Area Editor, allows you to delineate an alert area using a stretch box. The upper left corner of the box is located at the location of the cursor
when the Select Area option is chosen. Stretch out the box to the desired size and click any mouse button to finish drawing the box.

Select Location

This menu option allows you to change the location of the selected element by clicking B3 on the desired location. This option is available only when you are using WarnGen or the Alert Area Editor.

Note 3: The other tools, such as Point shown in Exhibit 2.2.8.2-1, function the same as vertex, which in Exhibit 2.2.8.2-1 was invoked by selecting the Baselines tool.





2.2.9 The Meteorolgical World of Color

RESERVED

For information about controlling color in AWIPS, proceed to Subsection 2.2.9.1.



2.2.9.1 Controlling Color in AWIPS

Subsection 2.2.9 described how the "false colored" satellite and radar images are colored according to an unofficial, but conventional color palette. However, in AWIPS the forecaster is able to control
certain features to enhance the visibility of a displayed satellite or radar image; or reveal additional weather information by manipulating certain image properties.

Changing the color of a display's background and the color of a meteorological image, are both used for obtaining weather information for analysis and forecasting.

Note 1: The forecaster can also configure a Workstation's properties for enhancing or customizing the usability of the workstation for themselves, by configuring the colors for prioritizing alerts.

AWIPS Color Editors

There are two color editors, one for changing a display's background color, and the other for changing the color of the displayed meteorological image. The background color of the Main Display Pane
and/or the Smaller Monitor Panes is changed via the Set Background Color dialog shown in Exhibit 2.2.9.1-1. The Imaging dialog shown in Exhibit 2.2.9.1-2 is used to change the color of the displayed
meteorological image.

Exhibit 2.2.9.1-1. Set Background Color Dialog

Exhibit 2.2.9.1-2. Image Properties (Imaging...) Dialog

To change the background color of the Main Display Pane (Single Panel or Four Panel Layout) and/or Smaller Monitor Panes, open the Set Background Color dialog. There are two ways of
opening the Set Background Color dialog:

From the Menu bar, select Options > Set Background Color.... Selecting this option changes the background color of all the panes.1. 

To change the color of a specific pane, click and hold mouse Button 3 (B3) on the Main Display Pane (Single Panel or Four Panel Layout), or on one of the Smaller Monitor Panes to open a
pop-up menu for selecting the Set Background Color... option, as shown in Exhibit 2.2.9.1-3. Selecting this option only changes the background color of the pane selected to open the dialog.

Exhibit 2.2.9.1-3. Pop-up Menus for Opening Set Background Color Dialog

Note 2: The two or four Smaller Monitor Panes are independent of each other, in that changing the background color of any one of the Smaller Monitor Panes does not effect the
background color of any other pane, or of the Main Display Pane. However, when changing the color of one of the panels of a Four Panel Layout of the Main Display Pane, all the
background colors of the other three panels change to that color.

2. 

To change the color of a displayed meteorological image on the Main Display Pane (Single Panel or Four Panel Layout) and/or Smaller Monitor Panes, open the Imaging... dialog. There are five
ways of opening the Imaging... dialog:

From the keyboard, use the combination Ctrl+I shortcut keys,1. 

From the Menu bar, select Options > Image Properties...,2. 

From the Toolbar, select the Image Properties iconified button, or3. 

On a Four Panel Layout, click and hold B3 over one of the panels that is populated with at least one product, to open a pop-up menu. Select the Control Color of This Image option, which
opens the Imaging... dialog and adds the green "I" symbol in the lower-left corner of the panel, as shown in Exhibit 2.2.9.1-4. If the "I" symbol is already visible on one of the panels, the
Control Color of All Images option will be available on the menu. Selecting the "...All Images" option opens the Imaging... dialog and removes the green "I" symbol.

4. 

On a Single Panel or Four Panel Layout, click and hold B3 over a Product Legend to open a pop-up menu and select the Imaging... option to open the Imaging... dialog for editing only the
color of the selected product, as shown in Exhibit 2.2.9.1-5.

5. 



Exhibit 2.2.9.1-4. Control Color of This Image - Four Panel Layout

Exhibit 2.2.9.1-5. Imaging... Dialog from Product Legend - Single Panel Layout

An example of how using the Imaging... dialog to change the color of the displayed image can reveal additional weather information that would not be that clearly visible otherwise is shown Exhibit
2.2.9.1-6.

Exhibit 2.2.9.1-6. Changing Color to Reveal Additional Weather Information

Color Editing Controls

A description of the controls for changing the features and colors of displayed product(s) images follow. Refer to Exhibit 2.2.9.1-7 for accessing advanced Imaging... dialog color functions.



Exhibit 2.2.9.1-7. Accessing Imaging... Dialog Color Wheel

Use Color Model: Red, Green, Blue (RGB) and Hue, Saturation, and Brightness (HSB) radio buttons allow you to choose the color model.

HSB/RGB Slider Bars: These slider bars allow you to make incremental changes in the components of the color displayed in the Color Swatch. These values can be set using the slider bar, by
typing a value in the entry box to the right of the slider, or by using the up and down arrow keys.

Color Wheel: The box on the right side of the dialog box contains the Color Wheel. The Color Wheel Centroid (a circle with a dot in the middle) can be dragged anywhere within the circle to
change the color displayed in the Color Swatch (more on this later in this section). Moving the Centroid around the circle also changes the HSB or RGB values. In HSB mode, brightness cannot be
changed by dragging the Centroid.

Red, Green, Blue: The red, green, and blue values in the RGB mode all range from 0 to 255 and reflect the amount, or intensity, of each color present in the displayed color. Changing these
values moves the Color Wheel Centroid across the Color Wheel, but not necessarily along a radial.

Alpha: The Alpha values in both the RGB mode and the HSB mode range from 0 to 255 and reflect the amount, or intensity, of blending of the displayed color. Changing the Alpha values
does not move the Color Wheel Centroid across the Color Wheel, but it modifies the contrasting colors in the Color Swatch box.

Hue: Values for hue range from 0 to 359 and determine the amount of color tint. Changing hue values moves the Color Wheel Centroid around the circumference of the Color Wheel. Try
dragging the Hue Slider Bar (to change the hue value) and notice the movement of the Centroid.

Saturation: Saturation values are given in percent (0-100) and determine the amount of white (the higher the value, the less white) present in the color. Changing saturation values moves the
Color Wheel Centroid along a radial of the Color Wheel. Change the saturation values and note the movement of the Centroid.

Brightness: As with saturation, brightness values are also given in percent (0-100). Brightness determines the amount of black present in the color. The higher the values, the less black
present. Brightness can also be thought of as the intensity of the color.

Color Swatch: To the right of the Color Wheel is the Color Swatch. Moving the Color Wheel Centroid changes the color in the swatch. Also, clicking anywhere in the top half of the Color Bar
(located in the middle of the dialog box) fills the top Color Swatch with the corresponding color; clicking anywhere in the lower half of the Color Bar fills the bottom Color Swatch.

Set: These buttons, located in both the upper and lower portions of the Image Colors Editor, insert a narrow line of color into the current Color Bar at the location of the Color Pointer. The color
inserted is the one displayed in the corresponding (i.e., upper or lower) Color Swatch.

Fill: These buttons replace the colors contained within the range specified by the Color Pointers in the Color Bar with the colors in the upper or lower Color Swatch.

Color Bar: The Color Bar contains the color table of the current image and is located in the middle of the dialog box.

The arrowhead Color Pointers along the top and bottom halves of the Color Bar can be dragged to delineate a range of the color table, that is, the portion of the Color Bar contained between the top
and bottom arrows. The Color Pointers move independently of one another, but they cannot move past each other. When aligned, they move in unison and delineate a single point along the Color
Bar.

As the Color Pointers are dragged along the Color Bar, they display the image values corresponding to the color pointed to. For example, if an infrared satellite image is displayed, moving the Color
Pointer shows the temperature values corresponding to the colors in the Color Bar. As the Color Pointers are moved, they are filled with the color they are pointing to.

To either side of the Color Bar are left- and right-pointing arrows. These are used to move the Color Pointers along the Color Bar an increment at a time. The > and < move one image value at a time
(i.e., 256 steps through the color bar), while >> and << move one color band at a time. In the case illustrated, there is no difference in behavior between the two. For a 4-bit radar color table, the <<
moves to the next of the 16 colors.

Edit Controls: At the bottom of the dialog box are the Edit Controls.

Interpolate: This button fills the specified range of values with intermediate colors. In both RGB and HSB modes, each component is interpolated. For RGB, the effect is more or less one of
moving across the color wheel in a straight line from the upper color to the lower; in HSB, the centroid motion is along an arc or spiral. (In fact, the RGB interpolation is not necessarily a
straight line across the color wheel, as one can see from the example in Objective 2 of Module 5 in the next section.)

Undo: This button allows you to successively undo changes made to the color table.

Redo: This button successively redoes the last edit that was undone.

Revert: This button returns the Color Bar (and the displayed image) to its original state.

Save: This button saves changes that you have made to a color table. If you are editing a read-only color table, or one that is owned by another user, this menu button is disabled.



Save As...: This menu button opens the Save As dialog box in which you can enter a name for your color table. The color table is saved in a folder containing the customized color tables for
the current user. If the new name of the color table is the same as the name of an existing color table in this folder, a dialog box opens and asks you if you want to overwrite the existing color
table.

Office Save As...: With this menu button, you can save a newly edited color table so that it is accessible on every workstation in your office. A dialog box asks you to enter a name for your
color table and then lets you save it or cancel the command.

Delete...: This button allows you to delete an edited color table. A confirmation dialog box opens to confirm your request. This menu button is disabled if you are editing a read-only color
table or a color table that is owned by another user.

For practice on how to use the color editing functions described in this subsection, refer to Subsections 3.3.3 through 3.3.7.



3.0 Getting Started Using the AWIPS Graphical User Interface

This chapter introduces you to the CAVE workspace for working with graphic and image products. It includes practice modules for getting you familiar with the Graphics Workstation and the CAVE
environment.

This chapter includes the following sections:

Section 3.1: Working with Graphic and Image Products

Section 3.2: Working with Model Data Using the Volume Browser

Section 3.3: Practice Modules (Tutorials) for AWIPS Graphical User Interface



3.1 Working with Graphic and Image Products

Products are presented in two formats in the CAVE workspace: graphics and images. Graphic products are presented as either contoured or plotted data. Image products are presented as continuous fields.
Examples of graphic products include contours of temperature or other model data, plots of METAR or local-scale observational data, or Radiosonde Observation (RAOB) soundings. Examples of image
products include satellite and radar data, as well as image presentations of other (usually contoured) data fields such as temperature, heights, and vorticity.



3.1.1 The Procedures Cascading Menu

Procedures are user-generated lists of graphics and/or image products, which enable you to define, customize, and save a sequence of products. Procedures provide a convenient way to display commonly
used products or products that are needed for a certain weather scenario. If, for example, you display 24 frames of IR satellite imagery overlaid with METAR plots, you can save for future use this
grouping of products (a "bundle"), along with other bundles, as a Procedure.

Bundles contain not only all the products you overlaid onto the display, but also the display parameters (frame count, looping speed, color tables, and graphics control settings). You can then label your
Procedure to reflect its contents or with your own name. This allows you to save your color, line width, and line style preferences. When you display the bundle, your preferences are already applied.

When you use the Points or Baselines tools to generate model soundings, cross-sections, time series, etc., and save these bundles in a Procedure for future use, you have the choice to display the data with
the original position of the point or baseline that you used when you set up the bundle, or you can use the current position, which is likely to be in a different location than it was when you set up the
bundle.  You can also alter the model grid, radar, or point/baseline at load time.

You open the Procedures cascading menu from the File button on the Menu Bar, as shown in Exhibit 3.1.1-1.

Exhibit 3.1.1-1. Procedures Cascading Menu

The New, Open, and Delete menu options each activate dialog boxes needed to open, build, edit, save, name, and delete Procedures. These dialog boxes are described in the next section. The Copy Display
to Procedure(s) option copies the current bundle into any open Procedure.



3.1.2 The Procedures Dialog Box

New... (Ctrl+N)

The File > Procedures > New... (Ctrl+N) option opens the Procedure - (untitled) dialog box, as shown in
Exhibit 3.1.2-1. When first opened, the dialog box's display window is empty. The buttons on the Procedure
dialog box are used to control the bundles in a procedure, as described below.

Exhibit 3.1.2-1. Procedure Dialog Box

Up/Down: These buttons move the selected bundle up or down within the procedure. Movement
'wraps' from top to bottom and vice versa.

Rename...: Clicking this button opens a dialog box which allows you to type a new name for the
selected bundle.

Original: This radio button allows you to display cross-sections, variable vs. height displays, point
soundings, time-height cross-sections, or time series graphs saved as a bundle within the procedure
using the original location of the points and baselines used when initially set up the bundle.

Current: This radio button allows you to display cross-sections, variable vs. height displays, point
soundings, time-height cross-sections, or time series graphs saved as a bundle within the procedure
using the present location of the baselines or points.

First/Next: This menu button loads the bundles sequentially from the top (first) bundle to the last (and
will wrap back to the top). The currently displayed bundle is highlighted.

Load: This menu button displays the highlighted bundle in the Main Display Pane. You can also
double-click on the bundle to load it.

Alter...: This menu button opens the Alter Bundle on Loading dialog box, which contains options that
allow you to modify how the selected bundle loads. Click on the check button to activate one or more
of the alter options. In cases where an item does not apply (e.g., point/line for a radar PPI), it makes no
difference if it is selected or not.

Radar: Select this check button to display data from a different radar.
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Note 1: The list of radars from which to choose are those that appear within the menus - main menu plus
Radar menu.

Point/Line: These option menus allow you to modify existing cross-section, variable vs. height,
point sounding, time-height cross-section, or time series bundles.

Original Location: Select this option to display data using the point or baseline location
in effect when the bundle was originally stored.

Current Location: This option lets you display a data using the present location of the
point or baseline.

D2D Points/Line-[x]: You can select any of the points or baselines listed from which to
display data.

Radar: Select this check button to display data from a different radar.

Note 1: The radars available to choose are those that appear on the menus - main menu plus
Radar menu.

Grid: . This menu allows you to select an alternate grid source for a bundle that contains grid
data.

Note 2: Once you alter a bundle and display it, you override the information in the bundle with new information. The
new information in the bundle can then be saved as a new bundle within a procedure.

Note 3: Refer to Subsection 3.3.5 for a practice module on altering a Procedure.

Copy In: This button copies the current contents in the Main Display Pane into the procedure as a
bundle.

Copy Out: This button copies the selected bundle from one procedure into other open procedures. At
least one other Procedure dialog must be open to enable this button.

Delete: This button deletes a highlighted bundle from a procedure.

Save: If this is a new, unsaved procedure, this button opens the Save Procedure As… dialog, providing
a standard interface to name and save your procedure. For an existing procedure, the Save button
updates the procedure without any further interaction. The Save button becomes enabled any time you
make a change (add, delete, move, or rename bundles). It good practice to save changes as you make
them.

Save As...: This button opens the Save Procedure As… dialog allowing you to save a copy of the
procedure with a different name.
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Close: The Close button does not automatically save changes you have made to your procedure. 
However, if unsaved changes have been made, it will prompt you to save your changes. Clicking Yes
saves the changes and closes the Procedure dialog.  Clicking No closes the Procedure dialog without
saving any changes.  Clicking Cancel returns the user to the Procedure dialog without taking any
action.

Open... (Ctrl+O)

The Open... (Ctrl+O) option opens the Open Procedure dialog.

The Open Procedure dialog contains 3 filtering options: Show Mine, Show All Users, and Show All. 
Selecting the Show Mine radio button displays a list of procedures you created. Selecting the Show All Users
radio button displays a list of all users with their saved procedures under their named directory.  Selecting the
Show All radio button lists all existing users and procedures at all levels (e.g., USER, WORKSTATION,
etc.).

The Expand All and Collapse All buttons expand and contract all directories listed in the Open Procedure
dialog to show and hide the procedures listed under each directory.  You can also search for a bundle by
typing the procedure name in the textbox at the top of the Open Procedure dialog.  Procedures that match the
entered text automatically appear under the directory where they exist.
To open an existing procedure, double click on a procedure or highlight it and press the OK button. Once
selected, the procedure dialog opens labeled with the selected procedure's name.

Delete... (Ctrl+D)

The Delete... (Ctrl+D) option opens the Delete Procedure dialog box, allowing you to delete any procedure
that you own.

OK: Once you have identified and selected the procedure you want to delete, click the OK button or
double-click the procedure to delete it. A confirmation dialog appears to confirm the deletion of the
procedure.  Clicking Yes deletes the selected procedure and closes the Delete Procedure dialog. 
Clicking No returns the user to the Delete Procedure dialog without deleting the procedure.

Note 4: Once deleted, a procedure cannot be restored.

Cancel: This closes the Delete Procedure dialog box without deleting any procedures.

Copy Display to Procedure(s) (Ctrl+B)

This Copy Display to Procedure(s) option copies the products that are currently in the Main Display Pane
into any open procedure dialog.

The History List Dialog Box

The History List dialog box is opened from the File dropdown menu or by using the "Crtl+H" keyboard
shortcut. It contains the most recent bundles that were displayed in the Main Display Pane with the most
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recently loaded bundle appearing at the top of the History List.

Procedures may be built from the bundles contained in the History List. If you swap panes or clear the Main
Display Pane, a blank space appears temporarily in the History List.

The buttons on the History List dialog box are described below.

Load: The Load button displays the highlighted bundle in the Main Display Pane; you can also
double-click on the name to load it. A copy of this bundle is added to the top of the History List.

Copy Out: This button copies the selected bundle into any open Procedure dialog boxes.

Alter Bundle...: This menu button opens the Alter Bundle On Loading dialog box, which contains
options that allow you to modify how an existing bundle displays. These options are as described
above.

Close: This button closes the History List.
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3.2 Working with Model Data Using the Volume Browser

The Volume Browser provides access to numerical models, other gridded data, and selected point data sources, such as RAOB, METAR, and Profiler. Through the Browser interface, you can choose the
data source(s), field(s), plane(s), and point(s), and generate a customized list of model graphics or images for display. This chapter introduces the features and functionality of the Volume Browser.



3.2.1 The Volume Browser Dialog

The Volume Browser dialog can be accessed from the Volume menu.

The Volume Browser window is divided into four areas:

The Menu Bar along the top

The Data Selection Menus

The Product Selection List

The Load Buttons (Diff and Load) to load items from the Product Selection List

Each area is then subdivided into menu components, described in Subsections 3.2.2 through 3.2.5.

The menu bar along the top of the Volume Browser window has dropdown lists that contain options for controlling all the various menu choices of the Volume Browser. Exhibit 3.2.1-1 shows the Volume
Browser dialogwhen initially opened.

Exhibit 3.2.1-1. Standard (Default) Volume Browser Dialog



3.2.2 The Volume Browser Menu Bar

The dropdown menus in the Volume Browser menu bar contain options for controlling and manipulating the Volume Browser or the products chosen through the Volume Browser.

File: The File dropdown menu, shown in Exhibit 3.2.2-1, contains the following options:

Exhibit 3.2.2-1. Volume Browser Menu Bar - File Dropdown Menu

Clone: Duplicates the Product Selection List's highlighted products into a separate dialog box.

Exit: Closes the Volume Browser dialog box. Any product selections you may have made in the Volume Browser before exiting remain when you re-open the Volume Browser.

Edit: The Edit dropdown menu, shown in Exhibit 3.2.2-2, contains the following options:

Exhibit 3.2.2-2. Volume Browser Menu Bar - Edit Dropdown Menu

Clear All: Removes all list entries you have made in the Volume Browser.

Clear Sources: Removes any model sources from the Sources list.

Clear Fields: Removes any model fields from the Fields list.

Clear Planes: Removes any model planes from the Planes list.

Select None: Deselects and empties all of the products in your Product Selection List but leaves the selections you made in the Source, Fields, and Planes menus.

Select All: Generates a Product Selection List of all possible products based on the selections made in the Source, Fields, and Planes menus.

Find (Ctrl+F): Checking this box activates the search function.

Tools: The Tools dropdown menu, shown in Exhibit 3.2.2-3, contains the following options:



Exhibit 3.2.2-3. Volume Browser Menu Bar - Tools Dropdown Menu

Baselines: Editable lines that determine the cross-section coordinates of the gridded model data. These baselines are the same as those mentioned in Subsection 2.2.6.5 Tools and are available
in the Volume Browser for user convenience.

Points: Editable locator dots that are used to generate model soundings, time/height sections, and time series from gridded model data. These points are the same as those mentioned in
Subsection 2.2.6.5 and are available in the Volume Browser for user convenience.

Choose By ID... : A function of the Digital Mesocyclone Display (DMD) and a method of selecting feature locations. The tool is used to monitor the same feature at a certain location. Without
the Choose By ID tool, a monitored feature (over a period of time) could move away from its monitored location and another feature could move in its place. You can use Choose By ID to set
points, baselines, and "Home" for conventional locations like METARs and RAOBs, but its primary use is for the 88D-identified mesocyclone locations. You can also access the Choose By ID
tool and menu from the Tools menu on the Main menu; refer to Subsection 2.2.6.5.

Settings: Settings allow you to choose whether you want the data to be presented in Plan view (horizontal), Cross section (vertical slice), Time height, Var vs Hgt, Sounding, or in a Time series
perspective. You can also choose the temporal direction of Time-height Cross section.

The Settings category consists of a one, two, or more dropdown menus, which are labeled with the selected menu option. The number of additional Volume Browser dropdown menus, if any, depend
on the setting that was first selected. For example, selecting Plan view adds the Time (Animate in Time or Animate in Space) dropdown menu setting, as shown in Exhibit 3.2.2-4. However,
selecting Sounding does not add any additional dropdown menus.

Exhibit 3.2.2-4. Volume Browser Menu Bar - Settings (Plan View and Time) Dropdown Menus

The Volume Browser is a dynamic dialog box. After you choose the first setting, additional option menus specific to that setting appear to the right on the Volume Browser menu bar. The Fields and
Planes dropdown menus change with each setting as well. Because of this relationship, the additional dropdown menus are listed here under the Settings general category.

Plan view: The default option for the Volume Browser. From the Plan-view perspective, data are plotted onto horizontal surfaces. The Plan view Planes are discussed in the planes section that
follows. The additional options menu that appears in the Volume Browser menu bar allows you to choose whether you want the Plan view data to Animate in Time or Animate in Space.
Exhibits 3.2.2-1, -2, -3, and -4 show Plan view and Time (Animate in Time) settings. Exhibit 3.2.2-5 show Cross section and Time settings.

Cross section: Allows you to view gridded data as vertical slices along specific baselines. You need to use either the Interactive Baseline Tool or the predefined latitude/longitude baselines to
specify the slice you wish to see. One of the additional options menus that appear in the Volume Browser menu bar allows you to choose whether you want the cross-section data to animate in
time or space, while the other options menu allows you to adjust the vertical resolution. Descriptions of these options follows. (Note that the Fields and Planes submenu labels have changed
after selecting "Cross section.") Exhibit 3.2.2-5 shows the Volume Browser menus as they appear when the Cross section setting is chosen.

Exhibit 3.2.2-5. Volume Browser - Cross Section Menu State

Time height: Used in conjunction with the Interactive Points Tool to enable you to view a time height cross section of a full run of gridded model data for a specific location. Additional
options menus in the Volume Browser menu bar allow you to choose the direction in which you want the data to be plotted, and to adjust the vertical resolution. Exhibit 3.2.2-6 shows the
Volume Browser menus as they appear when the Time height setting is chosen. (Note that this illustrates the case of no local sources.)



Exhibit 3.2.2-6. Volume Browser - Time Height Menu State

<left: Used when generating a time height cross section. Data are plotted with the latest data on the left and the earliest data on the right.

>right: Used when generating a time height cross section. Data are plotted with the latest data on the right and the earliest data on the left.

Var vs Hgt: Enables you to view a profile of a meteorological model field as it changes through height, which is displayed in millibars. By using the Interactive Points Tool, you can select one
or more locations from which to plot the data. Exhibit 3.2.2-7 shows the Volume Browser menus as they appear when the Var vs Hgt setting is chosen.

Exhibit 3.2.2-7. Volume Browser - Var vs Hgt Menu State

Sounding: Works in conjunction with the Interactive Points Tool to enable you to generate a Skew-T chart for a specific location, as shown in Exhibit 3.2.2-8, no additional menus appear in
the Volume Browser when the Soundings setting is chosen.

Exhibit 3.2.2-8. Volume Browser - Sounding Menu State

Time series: Used in conjunction with the Interactive Points Tool to enable you to plot gridded data on a time versus data value graph for a specified point. Exhibit 3.2.2-9 shows the Volume
Browser menus as they appear when the Time series setting is chosen.

Exhibit 3.2.2-9. Volume Browser - Time Series Menu State



Animate in Time: The default option for the Volume Browser. It allows you to view model data through time.

Animate in Space: Allows you to loop through a series of predefined latitude or longitude cross-sectional slices at a fixed time.



3.2.3 Data Selection

All the data available through the Volume Browser are stored in gridded format and generated as graphic or image presentations on the fly. The specific product you want to display graphically is defined
by your selections from the Volume Browser dialog box, as shown in Exhibit 3.2.3-1.

Note 1: The combinations of the selected menus, submenus, and options define the available Sources, Fields, and Planes and thus define the specific product you want to graphically display. Refer to
Subsection 3.2.2 for a listing of menu options and their combinations and availability.

Exhibit 3.2.3-1. List of Volume Browser Product Sources

Note 2: Grids are named (titled) with their delivered resolution, such as NAM40 and GFS90. In some cases, however, higher-resolution components are available, such as GFS precipitation, or
different resolutions are used at different time projections, such as >168 hours on the GFS. Once displayed, the product legend will show the actual resolution of each grid used.

The product descriptions that follow will help you understand how the combination of menu selections displays specific information.

Note 3: Menus are not scale-dependent, which means that the contents do not change with a change in the selected scale. Items listed in green font indicate that the items are available in the database.
Once a Source is selected the database is sorted and the available items in the Fields and Planes menus are shown in green. Once an available product is selected, it appears in a dimmed gray color in
the menu.

Sources submenus: The Sources section consists of three, and sometimes four submenus.

Note 4: The links provide a generic view of the type of items available for the selected combination. The available options, defined by the green box, may vary depending on the specific Volume
Browser menu/submenu combination. Note that Volume and SfcGrid are only partial lists of the total options available, denoted by the down-pointing arrow at the bottom of the list.

Volume: The Volume menu encompasses everything traditionally thought of as grids, including model output and ensembles, plus radar. Click here for Volume.

SfcGrid: The SfcGrid submenu comprises surface or near-surface data, such as MSAS, winds and waves, and sea surface temperature. Click here for SfcGrid.

North American Mesoscale (NAM) Grids: The NAM model is a regional mesoscale model using enhanced terrain and improved parameterization of surface and precipitation
processes. It produces forecasts out to 84 hours at 00, 06, 12 and 18UTC. The NAM Downscaled NWP (Numerical Weather Prediction) Grid (DNG) products (NamDNG5) are available
from the Volume Browser. These NAM grid fields include T, Td, Tmin, Tmax, wind, precip, categorical rain, cloud, snow water equiv, visibility, and geometric height for 3-hour to
84-hour incremental projections.

Multisensor Precipitation Estimator (MPE) Grids: Grids produced by the MPE algorithm are available for display from the Grid menu on the State(s) and WFO scales. MPE grids are
displayed using a 'truncated' grid color table that shows zero values in gray to let you see the limits of the site-specified domain.

Ocean Prediction Center and Tropical Analysis Branch (OPC-TAFB) Grids: On any scale you can access the OPC grids from the Grid menu in the Volume Browser. The grids are
generated twice daily and cover the Northeast-Pacific (grid OPCWave-NE-PAC), the tropical Pacific (OPCWave-TE-PAC), and the Western Atlantic/Caribbean (OPCWave-W-ATL).
The grids consist of analysis, 24-hr, and 48-hr forecasts of significant wave heights.

TPC Tropical Cyclone Gridded Probabilistic Wind (TPCWindProb) Grids: On any scale you can access cumulative and incremental TPCWindProb grids from the Grid menu.
These fields include cumulative and incremental probabilities of 34kt, 50kt, and 64kt surface winds. Selectors for these probabilities are found in a TPC Guidance submenu on the
Sfc/2D menu in the Fields column. Also from the Grid menu, you can access GFS fields, which include Low, Middle, and High Cloud Base pressure; 0.5, 1.0, 1.5, and 2.0 PV Surfaces;
and ICEG (ice accretion). A GFS Ice Accretion and Visibility Guidance NH lat-lon grid (232) dataset with 3h intervals from 3-24h, 6h from 30-72h, and 12h from 84-168h, is available
from the GFSGuide, located in the Grid menu.

Graphical Forecast Editor (GFE) Grids: MakeD-2DFile is a feature offered by the GFE that allows you to generate a file, which then can be viewed by D2D. To view GFE-generated
grids in D2D, select Products > Scripts... from the GFE's main menu bar. Once the dialog appears, select MakeD-2DFile and click Run/Dismiss. After about 20 seconds, the file is



available for display in D2D via the Volume Browser. To view it, select GFE as the model from the Sources menu on the Volume Browser, any one of the scalar weather elements listed
below as the Field, and Surface as the Level followed by Load.

The program stores the first 24 hours of the gridded forecast by default. Currently, the set of GFE weather elements stored in the file is limited to the following scalars:

Temperature (T)

Dewpoint (Td)

Relative Humidity (RH)

Probability of Precipitation (PoP)

Minimum Temperature (MinT)

Maximum Temperature (MaxT)

Quantitative Precipitation Forecast (QPF)

Rapid Refresh (RAP) Grids: On any scale level, you can access RAP13 and RAP40 grids from the Grids menu on the Volume Browser. RAP replaced Rapid Update Cycle (RUC) for
all models, with the exception of RUC80, which had been decommissioned. RAPs cover a much larger domain compared to RUCs. Like the RUC, the RAP will be run 24 times per day,
once for each hour.

Real-time Global Sea Surface Temperature Analyses (RTG_SST and RTG_SST_HR) Grids: On any scale, you can access the RTG_SST analysis grid. On all displayable scales,
you can also access the Real-time Global RTG_SST_HR analysis grid found on the Grid menu of the Volume Browser.

The RTG_SST analysis grid displays a 1/2-degree resolution temperature grid. The RTG_SST_HR analysis grid displays a 1/12-degree resolution temperature grid. The grids are
transmitted via the SBN. The high-resolution SST will make the grid an invaluable tool used to aid and improve the digital marine forecasts.

High-resolution Precipitation Estimator (HPE/BiasHPE): The High-resolution Precipitation Estimator (HPE) provides approximately 1km x 1km rain rate and 1-hour rainfall amount
mosaics every 5 minutes over part of a 1/4 Hydrologic Rainfall Analysis Project (HRAP) grid covering a WFO's (or an RFC's) area of responsibility in standard AWIPS format.
These gridded datasets can be viewed in D2D and used by the Flash Flood Monitoring and Prediction Advanced (FFMPA) system. In the Volume Browser, HPE/BiasHPE data are
accessible from the SfcGrid > HPE/BiasHPE > Precip submenu.

Note 5: Applicable fields include Temperature, Model Terrain (RTG_SST only), Convective Available Potential Energy (CAPE), and Convective Inhibition (CIN); the only
applicable plane is Surface. Although the Surface plane is automatically selected after clicking the desired RTG grid, you can select Temperature or Model Terrain from the Basic
menu in the Fields column, and CAPE (Pos Buoy En), or CIN (Neg Buoy En) from the Sfc/2D > Convective submenu.

Real Time Mesoscale Analysts (RTMA) Grids: The RTMA grids are available from the Grids menu of the Volume Browser for all scales. The National Centers for Environmental
Prediction/Environmental Modeling Center (NCEP/EMC) produces hourly RTMA grids of T, Td, u, v, sky cover, and precip. These are displayed via the Grid menu on the Volume
Browser, and also are integrated with GFE.

1. Surface Pressure  
2. Surface Pressure Analysis Uncertainty  
3. RTMA Terrain Height NCEP generates the RTMA. 

These products are being disseminated to AWIPS (via the NWSTG and NCF/SBN). 

NCEP produces RTMA for four geographical regions:

1. CONUS  
2. Alaska  
3. Hawaii  
4. Puerto Rico However, the baseline AWIPS configuration does not yet have the necessary elements (i.e., GRIB2 decode, netCDF store, D-2D display, GFE) in place for the three new RT

Capabilities to ingest, display and process the Real-Time Mesoscale Analysis (RTMA) at 2.5 km horizontal resolution in the CAVE volume browser and in GFE was added in this
release.

WAVEWATCH III (WW3) Grids: Enhancements to WW3 are designed to significantly improve guidance near the shore. Specifically, the enhanced WW3 brings 5 to 10 km resolution
wave guidance to within 4 km (or less) of the shore, and includes shallow-water wave physics. WCwave10, WCwave4, WNAwave, WNAwave10, and WNAwave4 are displayed via the
SfcGrid menu on the Volume Browser.

Note 6: WC (West Coast), WNA (Western North Atlantic)

Short Range Ensemble Forecast (SREF) Products: The SREF product suite is available from the Grids menu of the Volume Browser for all scales. NCEP will generate SREF products
on three grids — CONUS 212 (40 km), Alaska 216 (45 km), and Hawaii 243 (0.4 deg lat/lon) — four times daily (0300, 0900, 1500, and 2100 UTC model cycles). Guidance is available
for three-hour projections of 3 to 84 hours after model run time. This implementation consists of guidance for the means, spreads, and probabilities of several parameters.

Point: Both surface, such as Metar, and Column (soundings, profiler, VWP) data populate the Point menu. Click here for Point .

Fields submenus: The Volume Browser Fields submenus contain all available data fields and are divided into several pull-down submenus. Related fields are grouped together within these submenus.
Remember that as you change a selection in the Settings options submenu, the options in the Fields pull-down submenus change as well. Each possible Setting/Fields combination follows.

Fields submenus with Plan view - Time: When you choose Plan view and Time Settings, the data are presented on a Plan-view surface and animate in time. The Plan view - Time submenus appear
in the following order:

Basic: Basic fields are fields that can be calculated directly from state variables without finite differencing. Click here for Basic.

Wind: Wind-related fields are grouped here. Click here for Wind.



Derived: Derived fields are atmospheric measures that require horizontal finite differencing calculations before plots are made. Click here for Derived.

Sfc/2D: The fields on this menu cannot be defined in three dimensions; they are mostly valid for the earth's surface. Click here for Sfc/2D.

European Centre for Medium-Range Forecasts (ECMWF) Grids: You can access the ECMWF-HiRes grid or ECMWF-LowRes grid from any scale. In addition to standard heights,
winds, temperatures, etc., you can display 3-hour and 6-hour maximum and minimum temperatures from the Sfc/2D > ECMWF-HiRes submenu.

Note 7: Redistribution of one-degree ("Hi-Res") ECMWF grids from AWIPS is prohibited. The one degree ECMWF grids are intended for use only in the conduct of official duties
within NWS offices and at designated AWIPS test and support sites.

Note 8: The ECMWF grids should be considered "data of opportunity," which means that the availability and timeliness of the ECMWF grids could, at times, be somewhat
inconsistent or inferior (i.e., relative to other scheduled NOAA operational products). The potential for somewhat-degraded availability and timeliness is related to the external
nature of the data source and the characteristics of some of the intermediate product dissemination legs.

Gridded MOS Grids: You can access the Gridded MOS (GMOS) grids from any scale, though the grids are clipped to your region. GMOS is a synoptic-scale guidance package
available on a meso-scale (i.e., 5 km NDFD) grid. The available fields found on the Sfc/2D > MDL MOS menu consist of guidance for maximum and minimum temperature; 6-
and 12-hr probability of precipitation (POP); 3-, 6- and 12-hr probability of thunderstorms; and 24-hr snowfall amount. Additional MOS fields include temperatures, winds, cloud
cover, and QPF. GMOS coverage for Alaska is shown in Exhibit 3.2.3-2.

Exhibit 3.2.3-2. Alaska Gridded MOS Coverage

Other: This menu includes miscellaneous atmospheric fields that can be defined in three dimensions. Click here for Other.

Radar: Many of these fields will not be available until the WSR-88D dual-polarization capability is enabled. Click here for Radar.

Ensemble: The Ensemble menu contains options for selecting the ensemble model members output for height, temperature, relative humidity, wind, mean sea level pressure, precipitation, and
minimum and maximum temperatures. In addition, you can display the mean and standard deviation of these model fields. Click here for Ensemble.

Fields submenus with Plan view - Space: The fields available in these menus are presented in Plan view at a fixed time, and animate through the volume. The Fields choices are reduced to Basic,
Derived, and Other. Click here for Basic, here for Derived, and here for Other.

Fields submenus with Cross Section - Time or Space: When you choose the Cross Section option from the Settings options menu, with animation in either Time or Space, the following fields are
available:

Basic: The Basic fields for Cross Sections are slightly different from those of Basic Plan view fields. Click here for Basic.

Derived: The Derived Fields submenu for Cross Sections is identical to the Plan view Derived Fields. Click here for Derived.

Other: The Other Fields submenu for Cross Sections is identical to the Plan view Derived Fields. Click here for Other.

Fields submenus with Time Height - < left or right >: As with Plan view - Space, the Time Height Fields choices are Basic, Derived, and Other. Click here for Left or Right.

Fields submenus with Var vs Hgt: The Var vs Hgt field choices are Basic, Derived, and Other. Click here for Basic, here for Derived, and here for Other.

Fields submenus with Sounding: The Var vs Hgt field choices are Basic, Derived, and Other. Click here for Basic, here for Derived, and here for Other.

Thermo: The "Thermo" pull-down menu includes options to generate a sounding using model thermodynamics and winds, model thermodynamics with profiler winds, or model BUFR data
for all model levels (up to 50 levels) and going through all forecast times for a specific BUFR sounding site. GOES BUFR data can also be used to generate a sounding. The vertical resolution
of a GOES BUFR sounding is somewhat coarse, but the temporal resolution makes this a useful and more real-time product. Click here for Wind.

Combined VAD Wind Profile (VWP)-model soundings (via the Volume Browser) are available for each volume scan, with the model data time-interpolated to the Velocity Azimuth Display
(VAD) winds time. Model winds are used above the top of the VAD stack to complete the profile. (Note that the model data are from the grids, not the point soundings.)

Fields submenus with Time Series: For Time Series, the Fields menus available are Basic, Derived, Sfc/2D, and Other. Click here for Basic, here for Derived, here for Sfc/2D, and here for Other.

Planes submenus: The Planes submenus contain different surfaces onto which gridded data can be plotted. The available menus depend on what is chosen in the Settings options submenu or the other
options submenus on the Volume Browser menu bar. Each possible Settings combination follows.

Planes submenus with Plan view - Time: When Plan view and Time are selected from the Settings options menus in the Volume Browser menu bar, several submenus become available in the Planes
menu.

Pres: In the Pressure submenu, mandatory pressure levels are available, while significant pressure levels are accessible at 25-millibar increments in two cascading menus. Click here for Pres.

Theta: The Theta submenu contains potential temperature surfaces at 5K intervals between 250K and 350K, plus theta-e from 315 to 340K. Click here for Theta.



Hgt: The Height submenu contains heights in meters or feet above ground level (AGL), including Flight Levels (FL) for Aviation. Click here for Hgt.

Temp: Temperatures from -40C to +30C are available. This menu was designed to support temperature-based radar CAPPIs, but many datasets can be interpolated to these levels. Click here
for Temp.

Tilts: These tilt angles are used for radar displays. Click here for Tilts.

Misc: The Miscellaneous submenu contains levels that do not fit elsewhere. Click here for Misc.

Lyrs: The Layers submenu contains various layers of interest. Click here for Lyrs.

Planes submenus with Plan view - Space: If you select Plan view and Space from the Settings menus, only one submenu becomes available in the Planes menu.

Coordinate: From the Coordinate submenu you can choose all pressure (mb) or all isentropic (K) levels, or all tilts. Plan-view data animated in space are plotted on all available pressure,
isentropic, or tilt surfaces, and animate through the stack at a fixed time.

Planes submenus with Cross Section - Time: When Cross Section and Time are selected from the Settings options menus, three different submenus become available in the Planes menu. The
Vertical Representation pull-down menu is made available in the Volume Browser menu bar to adjust the vertical axis of a cross-sectional plot.

Lon: The Longitude submenu contains a selection of longitude lines. The contents of this submenu change depending on the scale and the location. Click here for Lon.

Lat: The Latitude submenu contains a selection of latitude lines. The contents of this submenu change depending on the scale and the location. Click here for Lat.

Specified: The Specified submenu contains the baseline labels that can be edited from the Tools pull-down menu in the Volume Browser. Click here for Specified.

Planes submenus with Cross Section - Space: If you select Cross Section and Space from the Settings options menus, two submenus become available in the Planes Menu. The Vertical
Representation menu is made available in the Volume Browser menu bar to adjust the vertical axis of a cross-sectional plot.

Lon: The Longitude submenu has a single choice, All Lon, that lets you select all available longitude lines. Cross-sectional data animated in space are plotted on all available longitude lines as
vertical slices, and animate latitudinally across the model domain at a fixed time. Click here for Lon.

Lat: The Latitude submenu also has a single choice, All Lat, that lets you select all available latitude lines. Cross-sectional data animated in space are plotted on all available latitude lines as
vertical slices, and animate longitudinally across the model domain at a fixed time. Click here for Lat.

Planes submenus with Time Height - < Left or Right >: For the Time Height setting, one submenu becomes available in the Planes Menu. The Vertical Representation pull-down menu is made
available in the Volume Browser menu bar to adjust the vertical axis of a time-height cross-sectional plot.

Planes submenus with Points:

The Point submenu contains labels for 10 different points (labeled Tsect A - J) from which time-height cross-sections can be generated onto the display, and points (labeled Sounding A - J) for
which model soundings can be generated onto the display. The left or right settings determine whether the data are plotted in increasing model valid times to the left (48 hr to 0 hr, for example)
or the right (0 hr to 48 hr, for example). Click here for Point.

Planes submenus with Sounding: When you select the Sounding setting, one submenu becomes available in the Planes menu.

Planes submenus with Time Series: For the Time Series setting, you can choose a point from the Points options menu in the Volume Browser menu bar in addition to one or more levels from one of
the Planes submenus. Labels are included on the y-axis to identify the displayed parameter, and you can sample the data in a time series.

Pres: In the Pressure submenu, mandatory pressure levels are available, while significant pressure levels are accessible at 25-millibar increments in two cascading menus. Click here for Pres.

Theta: The Theta submenu contains potential temperature surfaces at 5K intervals between 250K and 350K, plus theta-e from 315 to 340K. Click here for Theta.

Hgt: The Height submenu contains heights in meters or feet above ground level (AGL), including Flight Levels (FL) for Aviation. Click here for Hgt.

Temp: Temperatures from -40C to +30C are available. Many datasets can be interpolated to these levels. Click here for Temp.

Tilts: These tilt angles are used for radar displays. Click here for Tilts.

Misc: The Miscellaneous submenu contains various levels and layers. You can generate Meteograms using the METARs from the Source menu and choosing a point location with the
Interactive Points Tool. The result is a "stacked" time series with the observed variables plotted within each time series graph. Note that variables with like units may be displayed together on
the same graph, but with different colors, as shown in Exhibit 3.2.3-3. Click here for Misc.

Exhibit 3.2.3-3. An Example of the Meteogram Time Series Plot

Lyrs: The Layers submenu contains various layers of interest. Click here for Lyrs.



3.2.4 Using the Volume Browser Product Selection List

Once you have made selections from the Sources, Fields, and Planes menus, the list of available products is generated in the middle section of the Volume Browser, as shown in Exhibit 3.2.4-1. By default,
the products are highlighted and ready to load.

Exhibit 3.2.4-1. Volume Browser Product Selection List

With the pointer, you can select or deselect the products you want to display.

Graphic or Image: By clicking on a product in the Product Selection List with mouse Button 2 (B2), you can choose whether to display the product as a graphic or an image. When changing a
graphic product to an image, the abbreviation "Img" appears in the product label of the Product Selection List. You can display multiple graphics, and there is no practical limit to the number you can
display at one time.

For vector data, such as winds, clicking B2 once on the product name in the Product Selection List changes the depiction from wind barbs to streamlines. Clicking B2 on the product name of a vector
product a second time generates arrows.

Note: For products that can be displayed in only one format, clicking B2 has no effect.

Components of the Product Selection List: The Product Selection List is divided into three columns.

Times: Provides the date and model run time of selected products.

Product Selection List: Provides the names of the selected products, including the model name, the plane, the field, and associated units.

Inventory: Provides information on the completeness of selected products. The minus (-) and plus (+) signs indicate the valid times of a model run (i.e., 0-hour, 6-hour, 12-hour, etc.). The plus
sign (+) indicates those valid times are in the database; the minus sign (-) indicates the valid time is missing from the database. To obtain more detailed information about the inventory of a
product, as shown in Exhibit 3.2.4-2, select the Show Detailed Inventory option from the Product Information pop-up menu.

Exhibit 3.2.4-2. Detailed Inventory Information

Product Information Pop-up Menu: The Select Forecast Times window shown in Exhibit 3.2.4-2 was opened by clicking and holding mouse Button 3 (B3) over a product name in the Product
Selection List. This pop-up menu has several options besides Show Detailed Inventory:

Change Product Graphic to Image: Another way to change the product from a graphic to an image or vice versa. For wind products, you can display wind barbs, arrows, or streamlines.

Load This Product Now: Another way to generate the product on the display. This is convenient if you have a lengthy Product Selection List and wish to display a single product.

Load as Graphic and Image: Generates the product on the display as both a graphic and an image. For wind products, you can display wind barbs, arrows, or streamlines.

Show Detailed Inventory: Opens a pop-up box containing inventory information about the selected product. Refer to Exhibit 3.2.4-2 above.





3.2.5 Manipulating the Product Selection List

The File and Edit menus in the Volume Browser menu bar provide several options, such as Clone (File menu), and Clear and Select (Edit menu), that you should use to manipulate your Product Selection
List. Refer back to Exhibit 3.2.2-1 and Exhibit 3.2.2-2 respectively.

Along the bottom of the Volume Browser there are two buttons that are used to load the selected products.

Note: Products: <#> Selected for loading: <#>, located in the lower-left corner of the Volume Browser, is not a menu button, but rather a label that tells you how many products you have in your
Product Selection List and how many you have selected for loading. Refer back to Exhibit 3.2.2-1, which has no products listed and therefore Products: 0 and Selected for loading: 0; and Exhibit
3.2.4-1, which lists 3 products that are all highlighted indicating they are all selected, thus Products: 3 and Selected for loading: 3.

Diff: The Difference (Diff) menu button generates a difference field between two (and only two) fields that are highlighted in the Product Selection List.  This new field can then be saved in a
Procedure.

IMPORTANT: Beware! Using the Difference option can generate nonsensical fields.

Load: The Load button generates the images or graphics you have selected from your Product Selection List and displays them in the large display pane. Once the Load button is selected, the items
in the Product Selection List are deselected.



3.3 Practice Modules (Tutorials) for AWIPS Graphical User Interface

This section gets you started (hands-on) working on the Graphics Workstation and with the Graphical User Interface of the CAVE environment.

This section includes the following practice modules:

Reserved - Subsection 3.3.1

Reserved - Subsection 3.3.2

Practice Module (Tutorial): Using the Image Properties - Imaging Functionality - Subsection 3.3.3

Practice Module (Tutorial): Using the Image Properties - Color Editing Functionality to Change Colors of Displayed Image - Subsection 3.3.4

Practice Module (Tutorial): Using the Image Properties - Color Editing Interpolation Functionality - Subsection 3.3.5

Practice Module (Tutorial): Using the Image Properties - Color Editing Functionality to Color a Specific Temperature - Subsection 3.3.6

Practice Module (Tutorial): Using the Image Properties - Saving, Retrieving, and Editing Your Customized Color Table - Subsection 3.3.7

Reserved - Subsection 3.3.8

Reserved - Subsection 3.3.9

Reserved - Subsection 3.3.10



3.3.1 Reserved



3.3.2 Reserved



3.3.3 Practice Module (Tutorial): Using the Image Properties - Imaging Functionality

Objective: Use the Imagery dialog's presets to quickly change the imagery of the selected satellite product, and then manipulate the image's tonal values for improving the visible features of the
image.

Refer to Exhibits 3.3.3-1 and 3.3.3-2 when performing the steps included in this tutorial. The numbers shown on the exhibit correspond to the numbered steps. Callouts are provided to aid in identification
of components.

Exhibit 3.3.3-1. Using the Image Properties - Imaging Functionality (Part 1 of 2)

Exhibit 3.3.3-2. Using the Image Properties - Imaging Functionality (Part 2 of 2)

1  Open CAVE-D2D and select the CONUS scale.

2  Select Satellite > IR Window to display the product on the Main Display Pane. Note the Color Bar appears at the top of the display.

3  Open the Imaging dialog box. There are three ways to open the Imaging dialog:

3a  Ctrl + I keyboard shortcut;

3b  Image Properties Toolbar button; or

3c  Select Options > Image Properties.

4  Select the Imagery Presets button to drop down a list of images for the IR Window product.

5  Current imagery is Sat > IR > CIRA (IR Default), which is also the label shown on the Imagery Presets button (Sat/IR/CIRA (IR Default)).

6  Select fog > fog. Note the label on the Imagery Presets button now shows fog/fog for the selected imagery. Also note the displayed product's color has changed, as has the corresponding Color

Bar.

7  Use the Color Curves Adjustment Controls to fine-tune the quality of the displayed image to aid in interpreting the product information. Move the Brightness, Contrast, and Alpha sliders (shown

under the imagery presets dropdown list) to change the image's tonal values. Note that the Color Bar also changes to match the display.





3.3.4 Practice Module (Tutorial): Using the Image Properties - Color Editing Functionality to Change Colors of Displayed Image

Objective: Use the Imaging Color Editor dialog to change the colors of the displayed image so as to easily and quickly see features of special interest.

Refer to Exhibit 3.3.4-1 through Exhibit 3.3.4-4 when performing the steps included in this tutorial. The numbers shown on the exhibit correspond to the numbered steps. Callouts are provided to aid in
identification of components.

Exhibit 3.3.4-1. Using the Image Properties - Color Editing Functionality with RGB Color Model

Exhibit 3.3.4-2. Using the Image Properties - Color Editing Functionality with HSB Color Model

Exhibit 3.3.4-3. Changing Lower Color Swatch



Exhibit 3.3.4-4. Satellite 4 Panel Product Display

1  Open CAVE-D2D and then open the Imaging dialog box. Make sure the IR Window satellite product is selected and the Sat/IR/CIRA (IR Default) imagery is displayed. Refer to the tutorial in

Subsection 3.3.3.

2  Open the Color Editing dialog box. There are two methods available for opening the Color Editing dialog:

2a  On the Imaging dialog box, select the Edit... button, which bares the name of the satellite product as its label.

2b  Clicking mouse Button 3 (B3) on the Product Legend.

3  Make sure the RGB color model radio button is selected.

4  Click mouse Button (B1) on the green color on the top half of the Color Bar.

5  Select the Fill button on the top half of the dialog.

5a  The Color Swatch on the top half of the dialog is now filled with the green color.

5b  The Color Wheel Pointer moves to the corresponding green color.

5c  The Upper Color (Red, Green, Blue, and Alpha) sliders changed according to the RGB and Alpha code for the particular shade of green.

6  Using B1, drag the top arrow Color Pointer to align with the left edge of the red band on the Color Bar. Use the incremental fine tuning controls if necessary to be more precise in your alignment.

7  Using B1, drag the bottom arrow Color Pointer to align with the right edge of the red band on the Color Bar. Use the incremental fine tuning controls if necessary to be more precise in your

alignment.

8  Select the Fill button on the top half of the dialog. Note the following changes:

8a  The band on the Color Bar that was red, between the two Color Pointers, is now green.

8b  The top and bottom arrow Control Pointers turn green.

8c  The corresponding Color Bar on the display changes to match the Color Bar on the Color Editor dialog.

8d  The corresponding color on the image on the Main Display Pane changes from red to green.

8e  The Undo button becomes active for undoing the last step (Step 7).

Note: You can only change two colors for the selected product/image using the Imaging Color Editor, as illustrated by the Upper Color and Lower Color sections of the dialog.

9  Use the Lower Color section of the Imaging Color Editor dialog to change the second color. Follow Steps 3 through 8d to change the RGB of the lower color swatch to R=28, G=44, and B=255.

Then follow Steps 6 through 8d to change any other color of the displayed image to the lower color swatch.

10  Change the color model from RGB to HSB by selecting the HSB color model radio button. Note the Color Curves Adjustment Controls change from Red, Green, and Blue sliders to Hue,

Saturation, and Brightness sliders. Move the sliders to improve the image color to make the features more perceptually relevant to your eyes.

11  Select the Revert button at the bottom of the dialog to restore the display's Color Bar and image to their original state. The Color Editor dialog box settings remain unchanged.

12  Set up a Satellite > 4-panel product display.

13  Select a panel for color editing by clicking mouse B3 anywhere in the panel to open a pop-up menu.



14  On the pop-up menu click B1 on the Control Color of All Images option. Note the following:

14a  A green colored "I" appears in the lower-left corner of the selected panel.

14b  The Imaging dialog box opens with buttons labeled according to the selected satellite product.

15  Open the Color Editing dialog box and change the color of the displayed image for the selected panel. Refer to Steps 3 through 10.

16  Select the Revert button at the bottom of the dialog to restore the panels Color Bar and image to their original state. The Color Editor dialog box settings remain unchanged.



3.3.5 Practice Module (Tutorial): Using the Image Properties - Color Editing Interpolation
Functionality

Objective: Use the interpolation function to change from a sharp boundary line of two colors to a
gradually blended transition area.

Refer to Exhibits 3.3.5-1 and 3.3.5-2 when performing the steps included in this tutorial. The numbers shown
on the exhibit correspond to the numbered steps. Callouts are provided to aid in identification of components.

Exhibit 3.3.5-1. Using the Imaging Dialog Interpolation Function on the Original Color Table
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Exhibit 3.3.5-2. Using the Color Editing Interpolation Function on the Changed Color Table

1  Open CAVE-D2D and then open the Imaging dialog box. Make sure the IR Window satellite

product is selected and the Sat/IR/CIRA (IR Default) imagery is displayed. Refer to the tutorial in
Subsection 3.3.3.

2  Observe the displayed image as you turn interpolation on and off by checking the unchecking the

Interpolate checkbox. Note the sharp boundary lines associated with interpolation off as compared to
the gradually blended transition with interpolation on. Zoom into the display for a better view of the
change.

3  Open the Color Editing dialog box and set up an upper and lower color similar to that shown in

Exhibit 3.3.5-2. Refer to the tutorial in Subsection 3.3.4.

4  Move the Upper Color Pointer and Lower Color Pointer to define the left and right boundary lines

of the two colors you want to blend.

5  Select the Interpolate button to gradually blend the two colors (green and blue) over the defined

area. Note the following:
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5a  The Color Editing dialog Color Bar and the display Color Bar change to show the two

colors (green and blue) now blended.

5b  The displayed image shows the two colors (green and blue) now blended for the defined

area. Note that areas not included in the defined transition area (gray to green) remain
uninterpolated.

6  Select the Undo button to go one step back (Step 4) and return to the defined area without

interpolation selected.

7  Select the Redo button to go one step forward (Step 5) and return to the interpolation.

Note: You could also turn interpolation off or on by repeatedly clicking the Interpolate button off
and on.

8  Select the Revert button to return all the color changes to their original default state (shown in

Exhibit 3.3.5-1).
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3.3.6 Practice Module (Tutorial): Using the Image Properties - Color Editing Functionality
to Color a Specific Temperature

Objective: Use the Imaging Color Editor dialog to designate a particular color to represent a specific
temperature or temperature range.

Refer to Exhibits 3.3.6-1 and 3.3.6-2 when performing the steps included in this tutorial. The numbers shown
on the exhibit correspond to the numbered steps. Callouts are provided to aid in identification of components.

Exhibit 3.3.6-1. Changing the Color to Represent a Specific Temperature
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Exhibit 3.3.6-2. Changing the Color to Represent a Specific Temperature Range

1  Open CAVE-D2D and then open the Imaging dialog box. Make sure the IR Window satellite

product is selected and the Sat/IR/CIRA (IR Default) imagery is displayed. Refer to the tutorial in
Subsection 3.3.3.

2  Open the Color Editing dialog box and set the Upper Color to blue and the Lower Color to green.

3  Drag the Upper Color Arrow Pointer until it is pointing to approximately 20C point, which is

somewhere in the gray scale.

4  Select the Upper Color Set button. Observe the following:

4a  A blue line appears at the 20C mark on the Color Editor dialog Color Bar.

4b  A blue line appears at the 20C mark on the display Color Bar.

4c  The displayed image shows blue to indicate areas on the map where the temperature is 20C.

5  You can also designate the color(s)to represent a specific temperature range. Let the Upper Color

Arrow Pointer remain at 20C, but drag the Lower Color Arrow Pointer to the 0.7C mark to delineate
the range of temperatures that fall between 0.7C and 20C.
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6  Select the lower Fill button. Observe the following:

6a  The Color Editor Color Bar changes to the green color between 20C and 0.7C.

6b  The display Color Bar also changes to the green color between these two temperatures.

6c  The displayed image shows green to indicate all areas on the map where the temperature

falls between 0.7C and 20C (33F to 68F).

7  Select the Revert button to return all the color changes to their original state.
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3.3.7 Practice Module (Tutorial): Using the Image Properties - Saving, Retrieving, and
Editing Your Customized Color Table

Objective: Use the Color Editing dialog to save your own customized color table, and then use the
Imaging dialog to retrieve your customized color table, make changes, and re-save or assign a new name
to create a new table from your base table.

Refer to Exhibits 3.3.7-1 and 3.3.7-2 when performing the steps included in this tutorial. The numbers shown
on the exhibit correspond to the numbered steps. Callouts are provided to aid in identification of components.

Exhibit 3.3.7-1. Saving Your Customized Color Table
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Exhibit 3.3.7-2. Retrieving Your Customized Color Table

1  Refer to the tutorials in Subsections 3.3.3 and 3.3.4 to open the Imaging Color Editor dialog for the

IR Window Satellite product with the Sat/IR/CIRA (IR Default) imagery preset selected.

2  Select the Revert button to display (if not already displayed) the default color table and associated

imagery.

3  Use the RGB and HSB color models to create your own new color table, distinctively different

from the default. Refer to the tutorials in Subsections 3.3.4, 3.3.5, and 3.3.6. Note that the changes you
made to the Color Editing dialog Color Bar are reflected on the display Color Bar and the associated
image.

4  Select the Save As button, which will open a pop-up window for naming your new color table.

Select a unique name and click OK.

5  Clear the screen and open the Imaging dialog for the IR Window Satellite product.

Note: To prevent the dropdown menus from closing, the steps that follow require you to hold
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down mouse Button 1 (B1) as you navigate the menu and submenus until you select your desired
customized color table.

6  Select the Imagery Presets button to drop down a list of imagery presets.

7  Scroll down to USER to open the USER submenu.

8  Scroll down the USER submenu to your user id to open your customized color tables.

9  Select your desired color table by highlighting your selection and releasing B1. Note the following:

9a  The displayed image colors change to your customized color table.

9b  The Color Bar at the top of the display changes to your customized color table.

10  On the Imaging dialog select the Edit IR Satellite (C) product button to open the Color Editing

dialog. The Color Editing dialog Color Bar will show the same colors as the display Color Bar.

11  Make changes to the Color Editing dialog Color Bar.

12  Select the Save button to make changes to your currently open color table, or select the Save As

button to create a new customized color table based on your currently opened table.

13  Select the Clear button on the CAVE-D2D Toolbar to close all dialogs and clear the map.
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3.3.8 Reserved
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3.3.9 Reserved
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3.3.10 Reserved
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4.0 The AWIPS Workstation and Textual User Interface

Each AWIPS Workstation is comprised of three graphic displays (Graphic Workstation) and one text display
(Text Workstation), as shown in Exhibit 4.0-1. The three graphic displays share a common keyboard, mouse,
and central processing unit (CPU - LX). The text display has a dedicated keyboard, mouse, and CPU - XT.

Exhibit 4.0-1. The AWIPS Workstation

This chapter includes the following sections:

Section 4.1: The AWIPS Text Workstation

Section 4.2: The AWIPS Textual User Interface
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4.1 The AWIPS Text Workstation

The AWIPS Text Workstation is located on the left side of the AWIPS Workstation, as shown in Exhibit
4.1-1. It has its own dedicated keyboard, mouse, and its own CPU (XT).

Exhibit 4.1-1. AWIPS Text Workstation

The input devices for the AWIPS Text Workstation function the same as those used for the AWIPS Graphic
Workstation. Refer to Section 2.1

Note 1: The mouse handedness of the Text Workstation can be set via Programs > Settings > Peripherals
> Mouse, which is available by clicking mouse Button 2 (B2) from the root (the colored background of
the display).

The Text Workstation allows you to retrieve, edit, and transmit textual information. It is also possible to send
and receive administrative messages with or without attachments. Like the CAVE graphical displays, the Text
display was developed with motif-style menus, windows, and mouse controls, but it also has an online editor
interface for editing text.
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Note 2: The Text Workstation accommodates both WMO text products and AFOS text identifiers.

If there are any problems, specific alert boxes appear. Once you send the product, a confirmation box pops up
asking you to verify the send or to abort the transmission.
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4.1.1 Starting the Text Workstation

The Text Workstation can be started from either the Text Workstation (XT) or the Graphic Workstation (LX).

To access the Text Workstation from the Text Workstation, simply log into AWIPS. The three dialogs shown in Exhibit 4.1.1-1 appear on the Text Workstation root 
screen. 

Exhibit 4.1.1-1. Text Workstation Dialogs from XT Workstation

To access the Text Workstation display from the Graphics Workstation CAVE-D2D Perspective: 

1. Log into CAVE.

2. On the Menu Bar of the CAVE-D2D Perspective, select CAVE > New > Text Workstation, as shown in Exhibit 4.1.1-2. After selecting the Text Workstation 
option, the two dialogs shown in Exhibit 4.1.1-3 appear on the Main Display Pane. 
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Exhibit 4.1.1-2. Accessing Text Workstation from CAVE

Exhibit 4.1.1-3. Text Workstation Dialogs from LX Workstation (CAVE-D2D)
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4.2 The AWIPS Text Workstation Dialogs

The two common dialogs that appear when opening the Text Workstation from either the Text 
Workstation (XT) or the Graphic Workstation (LX) are: the Text Workstation dialog and the Text 1 
dialog. Refer to Exhibit 4.1.1-1 and Exhibit 4.1.1-3 repectively. The subsections that follow describe 
these two common dialogs that comprise the Text Workstation.
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4.2.1 Text Workstation Dialog

The Text Workstation dialog shown in Exhibit 4.2.1-1 contains top-level dropdown menus. It also displays the current UTC date/time and your site's local (EDT, 
CDT, MDT, or PDT) date/time. 

Exhibit 4.2.1-1. Text Workstation Dialog

The numbered (1 - 4) Text dialogs can be opened simply by clicking on its button (Text 1, Text 2, etc.). If a text product has been loaded in one of the text dialogs, 
the product's Automation of Field Operations and Services (AFOS) identifier appears on the Text dialog's button.

A brief explanation of each button in the Text Workstation dialog box follows. 

File

Select User ID: This option opens a list of user names. 

Select: The Select submenu contains the Evaluation Log, End of Shift, and Questionnaire.

Exit: This option closes the Text Workstation windows. A confirmation dialog box appears to confirm the exit request.

Windows

Hide All: All Text display windows are closed without icons. 

Show All: Each Text display window is restored. 

New Window: This option allows you to generate another Text display window. By default, four windows are made available but up to eight are possible.

Alarm/Alert

This menu button opens the Current Alarm Queue. Refer to Section 5.4 for more information. 

Text 1-Text 4

These buttons open the individual Text display windows.
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4.2.2 Text Dialog

The Text dialog is where you browse, read, and edit textual products. Exhibit 4.2.2-1 shows a Text dialog as it appears when initially opened.

Exhibit 4.2.2-1. Text Dialog

A descriptions of the components comprising the Text dialog follow.
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4.2.2.1 Text Dialog Window Menu Bar

File

The File menu, as shown in Exhibit 4.2.2.1-1, contains commands for viewing, printing, and editing text data. 
Descriptions of each menu option follow.

Exhibit 4.2.2.1-1. Text Dialog File Dropdown Menu

AFOS Browser: A button that opens the Text Workstation AFOS Browser, which is discussed in 
Subsection 5.1.3. 

Print All (Ctrl+P): Creates hard copy of all text in that Text window. 

Print Selection: Creates hard copy of highlighted text in that Text window. 

Fax All: Opens the Fax Message dialog, as shown in Exhibit 4.2.2.1-2, which allows you to create a fax 
of all text in that Text window. 

Exhibit 4.2.2.1-2. Fax Message Dialog for Fax All

Page 1 of 9

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Fax Selection: When a text product is displayed in the Text window and a portion of the text is 
highlighted, this option opens the Fax Message dialog box, which allows you to generate a fax of the 
highlighted text. The Fax Message dialog box, as shown in Exhibit 4.1.3-2, includes the following: 

File: A dropdown menu that contains commands that control the Fax Message dialog box, 
including Exit, which closes the Fax Message dialog box. 

Help: A dropdown menu that contains useful information on the fax capabilities and version of the 
software. 

LDAD Fax Recipient: An area of the Fax Message dialog box that contains entry lines used to fill 
in the pertinent information on each fax site. 

Fax Number: An entry box in which to type the telephone number of the recipient's fax 
machine. This entry box must contain an entry for the capability to function. 

Recipient: An entry box in which to type the name of the person to receive the fax. 

Company: An entry box in which to type the name of the company to receive the fax. 

Send: A menu button that initiates the transmission of the fax message. 

Cancel: A menu button that cancels the fax message operation and closes the Fax Message dialog 
box. 

Configure Auto Fax: Opens the Fax Site Editor dialog box, as shown in Exhibit 4.2.2.1-3, which 
contains commands that allow you to add or edit fax sites, as well as update the fax sites text database. 

Exhibit 4.2.2.1-3. Fax Site Editor Dialog Box

Once fax sites have been set up, the window area of the Fax Site Editor dialog box contains a tree-view 
listing of the existing fax sites. (This area is empty if no fax sites have been set up.) The phone number is 
denoted with a "+" symbol. Click on the "+" symbol next to the phone number to expand the tree-view 
and view the AFOS product inventory lists (PIL) associated with each phone number.

Click on the "-" symbol next to each phone number to close the expanded tree-view listings. 

File: A dropdown menu, as shown in Exhibit 4.2.2.1-3, which contains the following options: 
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Add Site...: Opens a dialog box containing commands for configuring a fax site. 

File: Dropdown menu with the following options: 

Update Database (DB): Updates the fax site text database to reflect all changes 
you have made to the fax sites. 

Exit: Exits the Fax Site Editor dialog box. 

Recipient: Dropdown menu that contains the following options: 

Add Recipient...: Adds a newly defined fax recipient to the Fax Receipt list. 
Remember, you must select the Update DB option to activate the new recipient 
in the text database. 

Delete Recipient...: Removes a selected fax recipient from the Fax Receipt list. 
Remember, you must select the Update DB option to activate the removal of a 
recipient from the text database. 

Help: Dropdown menu that contains useful information on the fax capabilities and the 
software. 

LDAD Fax Recipient: An area of the dialog box that contains entry lines for you to 
fill in the pertinent information on each fax site. 

AFOS PIL: The AFOS identifier is given here. 

Fax number: This is the fax number of the recipient. 

Phone number: This is the phone number of the recipient. 

Recipient: This is the recipient's name. 

Company: This is the recipient's affiliated company. 

Edit Site: An option that allows you to modify an existing fax site. You must first select the 
site and the AFOS PIL. The Fax Site Editor dialog box that opens is described above. 

Update DB: A command that updates the fax site text database to reflect all changes you 
have made to the fax sites. 

Exit: Menu option used to close the Configure Auto Fax dialog box 

View: A dropdown menu with the following options: 

Sort by Fax Number: Rearranges the tree view so that the tree is organized by fax 
numbers. 

Sort by AFOS PIL: Rearranges the tree view so that the tree is organized by AFOS PILs. 

Help: A dropdown menu that contains useful information on the fax capabilities and the software. 

Site Information: An area of the Fax Site Editor dialog box that gives the following information 
for a highlighted fax site: 
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Fax Number 

AFOS PIL 

Company 

Phone Number 

Contact 

Update DB: A menu button that updates the fax site text database to reflect all changes you have 
made to the fax sites. It is placed here for user convenience. 

Enter Editor: Opens the Text Editor, which is discussed in Section 5.2. 

Save: Stores the product that you are currently editing in the text database, but continues the edit session. 

Send & Exit Editor: Stores the text product in the text database, ends the edit session, and sends the 
product for transmission. 

Cancel Editor: Ends the editing session without saving any changes made since the last save. 

Import From File...: Opens the Import From File dialog box, which allows you to select a file to bring 
into your current document. 

Export To File...: Opens the Export To File dialog box, which allows you to place your current file in 
another file or a different directory. 

Request From Remote Site (Request/Reply)...: A menu button that opens the Send Request dialog 
box, which allows you to send a product request to another site. You specify the desired product by 
filling in the WSFO Identification, the Product Category, and the Product Designator (9-character ID). 
The Addressee can remain as DEF (Default), which sends the request to the hub. The hub is the WFO 
colocated with the site's RFC. 

You may also specify a site from which You want the product. If that site does not have a product dated 
more current than what is requested, the request is not forwarded to the WNCF.

If the product is available, there is no notification. Rather, the product is sent to your database and is 
accessible from the Text Browser. If the product is not available, or there is some technical problem with 
the request, an error message is logged.

Recover Edit Session: While you are in the edit session, the system automatically saves the text product 
every minute. 

Note 1: The colocated WFO may be itself. If the product is not available, a request is automatically sen
to the WNCF. 

Note 2: You can request only the most recent product. You cannot specify a product for a specific time
date. 
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If there is a system crash or an inadvertent Text window closure while you are editing, this button 
restores the most recently saved text file.

Close (Alt+F4): Closes the Text window. 

Edit

Edit is the second Text display window menu. This menu, as shown in Exhibit 4.2.2.1-4 contains editing 
functions that apply to text products in the Text windows and/or the Text Editor windows. Many of the editing 
functions are the same as, or similar to, editing functions found in most word processing software. Descriptions 
of each menu option follow.

Exhibit 4.2.2.1-4. Text Display Window Edit Dropdown Menu

Cut (Ctrl + x): Deletes a text selection. 

Copy (Ctrl + c): Reproduces a text selection. 

Paste (Ctrl + v): Places copied text at the cursor location. 

Fill: Removes hard returns from selected text. 

Select: A submenu that contains options for selecting (highlighting) text. Table 4.2.2.1-1 lists the 
options. Keyboard shortcuts for each option are noted. 

Note 3: A number of these commands appear gray until you enter information in the Text Editor. 

Table 4.2.2.1-1. Text Editing Options Keyboard Shortcuts for Selecting Text

Submenu Option Keyboard 
Shortcut

Description

To previous word Ctrl+Shift+Left Selects previous word
To next word Ctrl+Shift+Right Selects next word
To beginning of 
line

Shift+Home Selects from cursor location to beginning of line

To end of line Shift+End Selects from cursor location to end of line
To previous page Shift+PageUp Selects from cursor location to beginning of 
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Delete: A submenu that contains options for deleting text. Keyboard shortcuts for each option are noted 
in bolded parentheses. 

Character (F6): Deletes the character after the cursor location. 

Word (F7): Deletes the word after the cursor location. 

Line (F8): Deletes the line after the cursor location. 

Undelete: A submenu that contains options for replacing text that was previously deleted. These 
Undelete functions work only on the last character, word, or line that was deleted. Keyboard shortcuts 
for each option are noted in bolded parentheses. 

Character (Shift+F6): Undeletes the character after the cursor location. 

Word (Shift+F7): Undeletes the word after the cursor location. 

Line (Shift+F8): Undeletes the line after the cursor location. 

Clear Window (Ctrl+Shift+F4): Deletes the entire content of the Text window. This function cannot be 
applied while the text window is in edit mode. 

Clear Selection: Deletes the highlighted section of text. This option is only available in edit mode. 

Edit Header: Opens Header Block of a text product for editing. This option is only available in edit 
mode. 

Search (F2): A menu button or keyboard shortcut that invokes the Search and Replace dialog box 
containing the following options: 

Search For: An entry box used to type a word or character string for which you wish to search. 

Replace With: An entry box used to type a word or character string that replaces the word or 
character string in the above search. 

Search: A button that initiates the search. 

Replace: A button that substitutes the original word or string with the new word or string. 

Replace and Search Again: A button that substitutes the original word or string with the new 
word or string and then continues the search for the original string. 

Replace All: Finds and replaces all occurrences of the original string with the new string. 

Cancel: Closes Search and Replace dialog box. 

previous page
To next page Shift+PageDown Selects from cursor location to end of next page
To top of product Ctrl+Shift+Home Selects from cursor location to first line of page
To end of product Ctrl+Shift+End Selects from cursor location to last line of page
All Selects all of the text

Note 4: All of the keyboard shortcuts used with the Text Editor are listed in Subsection 5.2.2. 
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Spell Checker (Ctrl+F1): A menu button (or keyboard combination shortcut keys) that invokes the 
Spell Check dialog box. This option is only available in edit mode. It employs features very similar to 
spell check functions in most word processing software programs, as listed below: 

Not in Dictionary: Identifies the unknown word. 

Change To: An entry box used to type the correctly spelled word. 

Suggestions: The Spell Checker accesses online dictionaries for the correct spelling and provides 
a list of suggestions. Click on or use the arrow key to select the correctly spelled word. 

Change: A button that replaces the misspelled word in the text with the correctly spelled word. 

Change All: A button that replaces all occurrences of the misspelled word with the correctly 
spelled word. 

Ignore: A button that passes over a word that the Spell Checker flags as incorrectly spelled. 

Ignore All: A button that passes over all occurrences of a word that the Spell Checker flags as 
incorrectly spelled. 

Add to Dictionary: A button that puts a word into one of the online dictionaries. 

Dictionary: A menu that allows you to choose either the English Dictionary or the Weather 
Dictionary. The English Dictionary accesses a standard online dictionary, while the Weather 
Dictionary contains abbreviations and meteorological acronyms that are typically not accepted in 
standard English dictionaries. 

Cancel: A button that closes the Spell Check dialog box. 

Clear Update Flags: Removes the highlighting from surface observations that are updating 
automatically. 

Options

The Text display window Options dropdown menu, as shown in Exhibit 4.2.2.1-5, contains text/font settings 
for the text displayed in the Text display window.

Exhibit 4.2.2.1-5. Text Display Window Options Dropdown Menu

The options listed under the Options menu are defined below.

Autowrap: A cascade menu that turns the character width off or sets it to 69, 72, 80, or Other. The Other 
option initiates a dialog box that allows you to set a width between 69 and 80 characters. 

Font Size: A cascade menu that sets the type size to small, medium (the default), or large. 

Overstrike/Insert Mode (Ins): A check box that toggles between the Overstrike Mode and the Insert 
Mode of the Text Editor. You can also toggle between the two modes using the "Insert" (Ins) keyboard 
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shortcut. 

Version

The Text display window Version dropdown menu, as shown in Exhibit 4.2.2.1-6, allows you to choose which 
version of a text product you want to display.

Exhibit 4.2.2.1-6. Text Display Window Version Dropdown Menu

Tools

The Text display window Tools dropdown menu is shown in Exhibit 4.2.2.1-7.

Exhibit 4.2.2.1-7. Text Display Window Tools Dropdown Menu

The menu options listed may vary from site to site. They are listed below.

Create TAF template: This option creates and displays the TAF (Terminal Aerodrome Forecast) 
template that users can fill in and then transmit using the "Transmit TAF" option. Cut, copy, and paste 
functions are available. The template must be set up by the System Administrator before this option can 
be used. 

Transmit TAF: This program takes the information in CCCWRKTAF, properly formats it in 
accordance with Weather Service Operations Manual (WSOM) Chapter D-31, stores the output in the 
appropriate product(s) in the AWIPS database, transmits the appropriate product(s) to the WAN, and 
either creates or updates a disk file containing information on amendments, Requirements Traceability 
Documents (RTD), and corrections. 

Print Latest METARs: OMA SNY VTN ARK: As stated, this option prints the "Latest METARs." In 
the exhibit above, the latest METARs are: OMA, SNY, VIN, and ARK. 

Print Last Hour FTUS80 KOMA: As stated, this option prints the "Last Hour." In the exhibit above, 
the last hour applies to FTUS80 KOMA. 

Scripts

Text Scripts are macro-like programs that allow you to display a preselected set of text products. They are very 
similar to procedures on the graphics display. Refer to Section 5.1 for further information.

Products

This is a dropdown menu of frequently used text products that can be configured for different sites. If no 
products are listed in this menu, the menu will not dropdown. If you need to enter a product, a "-" sign is used 
as a placeholder.
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Help

The "Help" dropdown menu is shown in Exhibit 4.2.2.1-8.

Exhibit 4.2.2.1-8. Text Display Window Help Dropdown Menu

The options listed under the Help menu are defined below.

On Text Window... (F1): Connects you to the Mozilla Firefox home page. 

About...: Provides the date/version number of the Text display software. 
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4.2.2.2 Text Display Window Toolbar

The Text Display Window Toolbar contains two rows of control options, as shown in Exhibit 4.2.2.2-1 . 
Among the options are the AFOS (Automation of Field Operations and Services) Browser and the 
WMO (World Meteorological Organization) Search buttons, which provide access to the text database. 
All of the options in the Toolbar are described below.

Exhibit 4.2.2.2-1. Text Display Window Toolbar

AFOS Browser: A menu button that opens the AFOS Browser, which is discussed further in 
Subsection 5.1.3. 

Load History: A menu that contains a History List of text product identifiers from previously 
loaded text products. Maximum list size is 20. If no products have been loaded, this menu 
contains a "-" sign as a placeholder.

When a text product identifier is selected (click on the identifier with mouse Button 1), it appears 
in the AFOS, WMO, or AWIPS entry box. Press the Enter key on the keyboard to load this text 
product to the Text display window. For AFOS products, the -1:, -2:, or ALL: prefixes can be 
used.

WMO Search: A menu button that opens the WMO Search dialog box. If you click this "cold," a 
warning dialog appears with a message that you must first enter the TTAAii and/or CCCC portion 
of the WMO header (in the boxes in the second row) to perform the search. Refer to Section 5.1
for details. 

Enter Editor: Enables the Text Editor, which is described in Section 5.2. 

Accum: A check button that enables or disables the capability to accumulate text by appending 
subsequent text product retrievals to the display window. 

Update Obs: A check button that enables/disables automatic display of the most recent 
observations, like METARs, in the display window. 

Clear: Clears the Text display window. 

AFOS Cmd: An entry line which is used to type in an AFOS PIL. When you hit the Enter key on 
your keyboard, the AFOS text product is displayed in the Text display window. 

WMO TTAAii CCCC: A two-part entry line that allows you to type in the WMO Data Type and 
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Area Indicator (TTAAii) and/or the International Location Indicator (CCCC) portion of the text 
product ID that you want to display. If you enter only the TTAAii or the CCCC, and then press 
the Enter key, the WMO Search dialog box will open containing the appropriate lists of WMO 
products. Refer to Section 5.1 Retrieving WMO and AFOS Text Products, for further details.

AWIPS ID: You can type an AWIPS ID (NNNXXX) in this entry line. When you hit Enter, the 
WMO Search dialog box will open to allow you to select the specific version of the product you 
requested.
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5.0 Getting Started Using the AWIPS Textual User Interface

This chapter introduces you to the Text Workstation for working with text products. It includes practice 
modules for getting you familiar with the Text Workstation and the Textual User Interface (TUI).

This chapter includes the following sections:

Section 5.1: Retrieving WMO and AFOS Text Products

Section 5.2: Editing Text Products

Section 5.3: Generating Text Products Using the Script Writing/Editing Functionality

Section 5.4: Working with Alarm/Alert Feature

Section 5.5: Practice Modules (Tutorials) for AWIPS Textual User Interface
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5.1 Retrieving WMO and AFOS Text Products

From the Text display window, you can retrieve WMO and AFOS Text products using the WMO 
Browser for WMO products, or the AFOS Browser for AFOS products. The sections that follow 
describe how to use each browser when searching for a particular Text product.

With AWIPS II, we are transitioning from AFOS to AWIPS text product identifiers. The AWIPS 
Product Identifier is a two-line product identifier made up of the WMO ID on the first line and the 
AWIPS Identifier (AFOS NNNxxx) on the second line. The WMO Header and the AFOS Header, as 
shown in Exhibit 5.1-1, together make up the AWIPS Product Identifier.

Exhibit 5.1-1. Text Product Headers

The WMO Search feature allows you to look for and load WMO text products into the Text display 
window. It is designed differently than the AFOS Browser because WMO text products generally do not 
have unique IDs as do AFOS text products. To search for a WMO product, you must already know a 
portion of the ID, such as the TTAAii (Data Type and Area Designator) or the CCCC (International 
Location Indicator), and type it into the appropriate entry line of the Text window. Brief descriptions of 
the WMO IDs and the WMO Search dialog box follow. You can obtain complete information on the 
format of WMO Headers from the following website: 

http://www.nws.noaa.gov/tg/head.php
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5.1.1 WMO Message Search

The entire WMO message, including the start and end lines, is often called the WMO "bulletin." The bulletin 
structure contains the WMO Abbreviated Heading Line, sometimes called the "product ID," or more often the 
"header," and the body, which is often called the "text" of the message.

The Product Header Line Components: The AWIPS Product Identifier is composed of two lines: the WMO 
Abbreviated Heading Line in the first row, and the AWIPS Identifier (AI) Line in the second row.

Each component of the Abbreviated Heading Line is defined below.

T1T2: Data type and/or form designators 
T1: This is an alpha character that designates the general code form of the contents of the bulletin. 
Refer to WMO Manual 386 Table A in the following website for detailed information: 
http://www.nws.noaa.gov/tg/table.html

T2: This is another alpha character that designates the data type. Its definition depends on the T1 
designator in Table A, and can be found in Tables B1 through B6 of the WMO Manual.

A useful cross-reference list between AFOS PILs "NNN" of the CCCNNNXXX used to identify 
products in the AFOS system and the WMO abbreviated heading "TT" groups can be found at 
http://www.nws.noaa.gov/datamgmt/x_ref/xr04_X_ref_by_NNN.html

A1A2: Geographical area and/or data type designators 
A1: A1 is taken from WMO Manual 386 Tables C1 through C6 depending on the T1 designator in 
Table A. It is an alpha character that defines the geographical area that the text of the bulletin 
covers.

A2: This alpha character designates the geographical area, or may define the forecast period. It is 
taken from WMO Manual Tables C1 through C5 depending on the T1 in Table A.

ii: These two numbers are used to differentiate between two or more bulletins that contain data in the 
same code, originate from the same geographical area, and have the same originating center. The set of 
"ii" numbers are used to indicate the bulletins for global, interregional, regional, and national 
distribution. The national distribution may have further definition as in the case of the U.S. National 
Weather Service.

CCCC: This four-letter ID is the international location identification of the processing center that 
generated the bulletin. Once the bulletin has been originated or compiled, the CCCC must not be 
changed even if the bulletin in question has to be edited at another center.

The NWS also has some special CCCC practices which are used to further define products sources 
within the National Centers for Environmental Prediction (NCEP). Following International Civil 
Aviation Organization (ICAO) standards, the first character is "K" for the CONUS offices, followed by 
the three-letter FAA identifier. For offices outside the CONUS, the first two characters are PA for 
Alaska, PH for Hawaii, and TJ for Puerto Rico followed by an additional two characters. The national 

WMO Abbreviated Heading Line: T1T2A1A2ii CCCC YYGGgg (BBB) (cr) (cr) (lf)
AWIPS ID: NNNxxx (cr) (cr) (lf)

Note 1: Refer to WMO Manual 386, paragraph 2.3.2.2, or to Table D1 or D2 depending on the T1 desi
Table A. 

Page 1 of 2

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



centers use a national practice form of the K<CCC> for CCC.

YYGGgg: This is the International Date-Time Group, and is defined as follows:

YY: This pair of numbers identifies the day of the month (01, 04, 10, etc.).

GGgg: This is the Hour-Minute Group. For bulletins containing meteorological reports intended 
for standard observation times, the time is the standard UTC observation time. For aerodrome, 
route and area (aeronautical) forecasts, the full UTC hour (the last two digits are 00) preceding the 
transmission time is used. For other forecasts and analyses, use the standard UTC observation time 
on which the forecast or analysis is based. For other messages, use the UTC time of compilation to 
the nearest minute. 

BBB: This three-letter Indicator Group is used to define the type of message being transmitted, whether 
it is a correction, an amendment, a delayed transmission, or a normal transmission. Refer to Section 5.2, 
Editing Text Products, for more information.

NNNxxx: This is the AWIPS Identifier (AI) Line and is composed of from four to six characters of the 
AFOS PIL without the CCC.

Note 2: The three-letter AFOS node identifier CCC is no longer valid in the AWIPS environment and w
appear in the AWIPS headings. 

Note 3: The one- to three-character xxx (product designator) is identical to the AFOS xxx. If the xxx is
three characters, the character(s) are left justified and filled with blanks to fill the field. The field is exp
to accommodate five-character product designators that are typical for some sites. 
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5.1.2 WMO Browser Search

The WMO Browser (Search) dialog, as shown in Exhibit 5.1.2-1, appears only after you have entered a 
portion of the WMO ID in the WMO TTAAii CCCC: field, and then selecting the WMO Search button 
on the window's toolbar.

Exhibit 5.1.2-1. WMO Browser Dialog

The WMO Browser dialog contains the following features: 

TTAAii: A listing of the WMO Data Type and Area Indicators whose contents vary depending on 
what is contained in the other lists within the dialog. 

CCCC: A list of the International Location indicators. Its contents vary depending on what is 
contained in the other lists within the dialog. 

AWIPS ID: A list containing the AWIPS ID that corresponds to the WMO TTAAii ID. If there is 
no corresponding AWIPS ID, then a dummy or blank ID appears in this column. 

DDHHMM: Contains an inventory of the issuance dates/times of the most recent versions of text 
products. The DD signifies the date, HH the hour, and MM shows the minutes. If you search only 
for the TTAAii portion of the WMO ID, then the DDHHMM list contains the latest issuances of 
that product for every CCCC site. 

BBB: A column that indicates if a text product is an Amendment (AAx), a Correction (CCx), or 
Delayed (RRx). 

Load and Continue: A menu button that displays the selected text product and leaves the WMO 
Search dialog box open. 
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Load and Close: Displays the selected text product and closes the WMO Search dialog box. 

Close: Closes the WMO Search dialog box.
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5.1.3 AFOS Text Product Browser

The AFOS Text Product Browser, as shown in Exhibit 5.1.3-1, is opened from the AFOS Browser toolbar 
button (see Exhibit 5.1.2-1).

Exhibit 5.1.3-1. Text Browser Dialog

The AFOS Browser allows you to look through and choose text products by AFOS ID to be displayed in a text 
window. To make the selection faster and easier, products have been broken down into three parts: Node, 
Ctgry (Category), and Designator, as illustrated in Exhibit 5.1.3-1. This mimics the nine-character AFOS 
Identifier, CCCNNNXXX. Each component of the Text Browser dialog box is described below.

Origin: An options menu that allows you to select the geographical area (Regional, East, Central, or 
West) of the United States or International locations whose text products you want to display. 

Class: An options menu with a list of the types of text product you wish to retrieve (e.g., Public, 
Aviation, or Hydrological). 

Node Menu (CCC): A central forecast office, listed by its AFOS Node ID, where text products are 
collected and stored. Also included at the bottom of this list are the identifiers for all radar alphanumeric 
products. 

Category Menu (NNN): The name of the text product. 

Designator Menu (XXX): Provides the site or area for which the text product applies. Valid times are 
also provided to the right of each designator. 

Display: Shows prefixes used to select special groupings of text products. ALL: returns all versions of a 
specific product from the database; A: retrieves all instances of a particular product type (e.g., 
LAXMTR) from the current hour. 

Load and Continue: Displays the selected text product and keeps the AFOS Browser open for further 
browsing. 

Load and Close: Displays the selected text product and then closes the AFOS Browser. 

Note: For CCC, NNN, and XXX, click mouse Button 3 (B3) over an item to see full identification, or 
click the Help button to get information on each of the items in the associated list. 
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Close: Closes the AFOS Browser.
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5.2 Editing Text Products

Editing requirements for CAVE are accommodated by the use of an online Text Editor. You can 
perform simple editing by selecting the Enter Editor button on the Text dialog Toolbar to open the 
AWIPS Header Block GUI, as shown in Exhibit 5.2-1.

Exhibit 5.2-1. Enter Editor Toolbar Button to Open AWIPS Header Block

The AWIPS Header Block GUI shown above in Exhibit 5.2-1, contains a 9-character ID example of 
NEWNOWLCH, which is the PIL for the DCA METAR oservation. 

After you complete the AWIPS Header Block, clicking Enter closes the AWIPS Header Block GUI and 
places the Text dialog in the Editing Mode (Now Editing), as shown in Exhibit 5.2-2. 

Note 1: The addressing of the text message can be accomplished either by filling in the top half of 
the AWIPS Header Block GUI (TTAAii, CCCC, BBB, BBB Version), or by filling in the bottom 
half, as shown in Exhibit 5.2-1. Which method to use is user-preference, based on which set of 
information is more readily available to the user. 
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Exhibit 5.2-2. Text Dialog in Editing Mode

Once in the Text Editor, several buttons on the CAVE Menu Bar appear in subdued text, while new 
editing commands are activated in the File, Edit, and Options menus. In addition, a Toolbar containing 
editing functions appears.

Note 2: The header lines can only be edited using the Edit Header button on the Text Editor 
Control Bar. 

Note 3: Refer to Tables 5.2.2-1 through 5.2.2-4 in Subsection 5.2.2 for keyboard shortcuts. 

Page 2 of 2

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



5.2.1 Toolbar Editing Commands

Once in the Text Editor, a second toolbar containing editing functions appears, as shown in Exhibit 5.2.1-1.

Exhibit 5.2.1-1. Toolbar Editing Commands

Descriptions of the editing functions follow.

Save

This menu button stores the product that you are currently editing in the text database, but continues the edit 
session. The product is not transmitted outside your local site. 

Cut

This menu button deletes a text selection. You can also cut text by clicking and holding mouse Button 3 (B3)
in the Editing window. This brings up a pop-up menu containing the Cut option. 

Copy

This menu button reproduces a text selection. You can also copy text by clicking and holding B3 in the Editing 
window. This brings up a pop-up menu containing the Copy option. 

Paste

This menu button places copied text at the cursor location. You can also Paste text by clicking and holding B3
in the Editing window. This brings up a pop-up menu containing the Paste option. 

Fill

This menu button removes hard carriage returns from selected text. 

Edit Header

This menu button opens the AWIPS Header Block dialog, which contains text product header information.

The AWIPS Header Block accommodates both WMO (upper section of the AWIPS Header Block) and AFOS 
IDs (lower section of the AWIPS Header Block). The fields are defined below as they apply to WMO and 
AFOS IDs:

TTAAii: This field contains the WMO Data Type and Area Indicators. 

CCCC: This field contains the International Location Indicator. 

BBB: The three-character "BBB" defines the type of message or the Indicator Group. Most messages 
will be sent with this field set to "NOR" (normal), which is the default. Other Indicator Groups include 
Delayed, Correction, and Amendment, and are described below: 

RRx: This is the Delayed Indicator Group, which is used to transmit a collection of one or more 
weather reports that are normally contained in the initial bulletin, but which were received after the 
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initial bulletin had been transmitted. 

CCx: This is the Correction Indicator Group, which is used to transmit a bulletin containing 
corrections to a previously transmitted bulletin. 

AAx: This is the Amendment Indicator Group, which is used to transmit a bulletin containing 
amendments to processed information that had been transmitted in an earlier bulletin. 

WSFO ID (optional): This field contains the AFOS site ID of the main node of the State Distribution 
Circuit (SDC) to which the office originating the message belongs. This field is automatically filled in 
with the SDC node of your local site. 

Product Category: Products are identified by a three-character AFOS PIL (e.g., TOR for tornado). A 
list of categories can be viewed from the AFOS Browser Help menu by clicking on the help button 
adjacent to the category selector. 

Product Designator: This field contains the AFOS ID of the site the message applies to, or a regional 
ID for messages that apply to a larger region (such as UT for Utah). Usually this field is set to your local 
site, but occasionally a site issues a message for another site. 

For example, Denver (DEN) can issue a message that applies to Colorado Springs (COS), in which case 
the product designator is COS. A list of AFOS IDs can be viewed from the AFOS Browser Help menu 
by clicking on the help button adjacent to the node selector. 

Addressee: This field defines the site(s) to which you want a text product or message sent. In this field 
you have a choice of three buttons: 000, DEF, and ALL. If you want the product to be stored in the text 
database, but don't want it to be distributed, press the 000 button. Use the DEF address to send products 
to a predefined group of sites (which usually includes neighboring sites). Refer to the AWIPS System 
Manager's Manual for information on setting up your local "DEF." Use the ALL address to send 
products to all sites. 

Enter: This button saves the AWIPS Header Block information, closes the AWIPS Header Block dialog, 
and places the Text dialog in Edit Mode. 

Cancel: This button closes the AWIPS Header Block dialog without saving anything. 

Send

This menu button ends the editing process, stores the text product in the text database, and sends it to the 
communications processor for transmission. 

Cancel

This menu button ends the editing session without saving any changes. 

Attach

Note: The 'x' version is set with the BBB Version button, which is enabled if RRx, CCx, or AAx is 
selected. For more information on the Indicator Group "BBB," refer to 
http://www.nws.noaa.gov/tg/bbb.html
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This menu button, which is activated when you are editing an administrative text message, opens a dialog in 
which you can enter a file path name of an attachment to add to your message. 

INS/OVR (Insert/Overstrike)

This pull-down menu contains the Insert Mode and the Overstrike Mode radio buttons. The choice you make 
appears as either "INS" or "OVR" to identify the current editing mode you are using. You can also use the 
"Insert" keyboard shortcut to toggle between the two modes.
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5.2.2 Keyboard Shortcuts

Tables 5.2.2-1 through 5.2.2-4 contain keyboard shortcuts used with the Text Display Editor. 

Table 5.2.2-1. Keyboard Shortcuts - Select Functions

Key Combination Select Function

Shift + Home extend selection to beginning of line
Ctrl + Shift + Home extend selection to top of document
Shift + End extend selection to end of line
Ctrl + Shift + End extend selection to bottom of document
Shift + Page Up extend selection up one screen
Shift + Page Down extend selection down one screen
Shift + Left Arrow extend selection to previous character
Ctrl + Shift + Left Arrow extend selection to beginning of previous word
Shift + Right Arrow extend selection to next character
Ctrl + Shift + Right Arrow extend selection to beginning of next word
Shift + Up Arrow extend selection to previous line
Shift + Down Arrow extend selection to next line

Table 5.2.2-2. Keyboard Shortcuts - Delete Functions

Key Combination Delete Function

Backspace delete left character
Shift + Backspace delete selection
Ctrl + Backapace delete word
Delete delete right character or selection
Ctrl + Delete delete to end of line
F6 delete right character
Shift + F6 undelete character
F7 delete word
Shift + F7 undelete word
F8 delete to end of line
Shift + F8 undelete line
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Table 5.2.2-3. Keyboard Shortcuts - Edit and Application Functions

Key Combination Edit and Application Function

Esc move back up one menu level
Ctrl + F1 start spell checker
F2 invoke search (and replace)
Alt + F4 close text window (no saving)
F5 print contents of window
F10 bring up first submenu of the main menu
Ctrl + C copy
Ctrl + P print contents of window
Ctrl + V paste
Ctrl + X cut
Insert toggle between insert and overstrike mode
Shift + Insert paste
Ctrl + Insert copy
Shift + Delete cut

Table 5.2.2-4. Keyboard Shortcuts - Cursor Movement and Position

Key Combination Cursor Movement and Position

Home position to beginning of line
Ctrl + Home position to top of document
End position to end of line
Ctrl + End position to bottom of document
Page Up position up one screen
Page Down position down one screen
Left Arrow move to previous character
Ctrl + Left Arrow position to beginning of previous word
Right Arrow move to next character
Ctrl + Right Arrow position ot beginning of next word
Up Arrow move to previous line
Down Arrow move to next line
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5.3 Generating Text Products Using the Script Writing/Editing Functionality

This section explains how to access and use the script writing/editing functionality to write error-free 
scripts for generating text products. The following topics are discussed:

Accessing the Scripts Writing/Editing Functionality - Subsection 5.3.1

Scripts Menu: Edit... Option - Subsection 5.3.2

Script Writing Guidelines - Subsection 5.3.3

Running the Script - Subsection 5.3.4

Refer to Subsection 5.5.5, Subsection 5.5.6, and Subsection 5.5.7 for practice using the scripts 
writing/editing functionality.
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5.3.1 Accessing the Scripts Writing/Editing Functionality

The scripts writing/editing functionality is accessed via the Text dialog's Scripts menu. You must use the 
XT (Text) Workstation, and not the LX (Graphics) Workstation. As illustrated in Exhibit 5.3.1-1, both 
workstations provide access to a Text dialog, but the Scripts menu is active only on the XT 
Workstation's Text dialog.

Exhibit 5.3.1-1. Active Scripts Dropdown Menu

Note: The Text Workstation application automatically opens when you log onto the XT 
Workstation. The Text 1 dialog is one of the dialogs displayed when the application is initiated. If 
you want to work in another Text dialog (2, 3, or 4), make your selection from the Text 
Workstation dialog, which is another one of the dialogs that opens with logon. 

Page 1 of 1

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



5.3.2 Scripts Menu: Edit... Option

The Scripts dropdown menu lists the options shown in Exhibit 5.3.2-1. The three active options (Edit..., Run..., and Show 
Output) are used when writing/editing and running scripts for generating text products. The three disabled (grayed-out) 
options (Continue, Skip Wait, and Cancel) are activated when a script is running. A detailed description of the Edit... option 
follows. The Run... option is discussed in Subsection 5.3.4. The grayed out options are part of the Run... option and are 
included in that discussion.

Exhibit 5.3.2-1. Scripts Dropdown Menu

Edit...: Selecting this option from the Scripts menu shown in Exhibit 5.3.2-1 opens the Text Script Editor dialog shown in 
Exhibit 5.3.2-2.

Exhibit 5.3.2-2. Text Script Editor Dialog

The Text Script Editor is used to write and edit text product scripts. Descriptions of the menus and options used to 
perform these functions follow.

File: This dropdown menu includes options for performing script writing and editing functions. A description of 
each option follows.

New (Ctrl+T): This option clears the Text Script Editor. 

Open... (Ctrl+O): This option opens the Open Script File dialog shown in Exhibit 5.3.2-3. Use this 
dialog to select a script. When a script is selected, the Text Script Editor title bar changes from 
"untitled" to the name of the script. 

Note 1: An ellipsis (three dots following the name of a menu option, as in "Edit..." and "Run...") indicates that selecting 
this option will open a dialog. 
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Exhibit 5.3.2-3. Open Script File Dialog

Save (Ctrl+S): This button saves the script under the current file name. If the script is new and unnamed, 
select the "Save As..." button. 

Save As... (F3): This option opens the Save Script As dialog shown in Exhibit 5.3.2-4. Use this dialog to 
name the script and designate the location of the file. To avoid confusion about what language is 
expected, make sure all Python scripts have the .py extension added to the file name. 

Exhibit 5.3.2-4. Save Script File As Dialog

Rename...: This option opens the Rename Script File dialog shown in Exhibit 5.3.2-5, in which you can 
enter a new name for the script and, if desired, a new location for the file. Make sure the new file name 
has the .py extension. 

Exhibit 5.3.2-5. Rename Script File Dialog

Delete...: This option opens the Delete Script dialog, which enables you to delete a script. 

Print (Ctrl+P): Use this button to print a hard copy of the script. 

Close (Alt+F4): Use this button to close the Script Editor dialog. 

Note 2: If you want to open an existing script file for editing, open the file from here. If you only want t
existing script file, you can open the file either from here or from the Scripts menu (from the Scripts me
Run... option). 
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Edit: This dropdown menu includes the standard editing options: cut, copy, and paste. It also includes: 
Select: This option opens a list of editing options with keyboard shortcuts, as shown in Table 5.3.2-1. 

Delete: This option enables you to delete a character, word, or line using the keyboard shortcuts F6, F7, 
and F8 respectively. 

Undelete: This option enables you to undelete a character, word, or line using the keyboard shortcuts 
Shift + F6, Shift + F7, and Shift + F8 respectively. 

Search...: This option opens the Search and Replace dialog. 

Options: This dropdown menu includes an option for changing the font size (small, medium, or large) of the 
text displayed in the Text Script Editor dialog window. It also includes a checkbox option for toggling between 
"Overstrike Mode" (checkbox checked) and "Insert Mode" (checkbox unchecked). You can also use the 
"Insert" (Ins) keyboard shortcut to toggle between the modes. The keyboard shortcut automatically checks and 
unchecks the checkbox.

Execute: This dropdown menu includes two controls for running the script: "Run" and "Show Output." A 
detailed description of this menu is provided in Subsection 5.3.4.

Help: This dropdown menu includes two options: "On Basic Commands" and "On Advanced Commands." A 
detailed description of this menu is provided in Subsection 5.3.3.

Table 5.3.2-1. Text Editing Options and Keyboard Shortcuts for Script Editing

Option Keyboard Shortcut Description
To previous word Ctrl+Shift+Left Selects previous word
To next word Ctrl+Shift+Right Selects next word
To beginning of line Shift+Home Selects from cursor location to beginning of line
To end of line Shift+End Selects from cursor location to end of line
To previous page Shift+PageUp Selects from cursor location to beginning of previous page
To next page Shift+PageDown Selects from cursor location to beginning of next page
To top of product Ctrl+Shift+Home Selects from cursor location to first line of page
To end of product Ctrl+Shift+End Selects from cursor location to last line of page
All Ctrl+A Selects all of the text
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5.3.3 Script Writing Guidelines

The Text Script Editor shown in Exhibit 5.3.3-1 is the dialog where you write/edit text scripts. Refer to Subsection 5.3.2 for 
a description of the menus applicable to writing/editing scripts. For information on running scripts and generating text 
products, see Subsection 5.3.4.

Exhibit 5.3.3-1. Text Script Editor Dialog

To generate a text product, you must write an error-free script using correctly structured commands and syntax. The Help 
menu shown in Exhibit 5.3.3-2 includes two options, "On Basic Commands" and "On Advanced Commands," which 
provide important structural information for each command.

Exhibit 5.3.3-2. Help for Basic Script Commands

Using the Text Script Editor dialog you can write entirely new scripts from scratch, create new scripts from existing scripts, 
or edit existing product scripts. Following the guidelines presented here will help to ensure that your scripts are error-free 
and that they generate the desired text products. They include: 

Important information on text product identification,

Rules for writing Python scripts, and

Tips on using the eight basic script commands.

To begin the process of writing error-free scripts, the Text Script Editor dialog must be open with the window blank for 
writing a new script from scratch, or displaying an existing script. Refer to Subsection 5.3.2 to familiar yourself with the 
Text Script Editor's File, Edit, and Options menus. Then begin the process by studying the information that follows: 

Note 1: The Advanced Script Commands are not used to generate text products. They are used when setting up 
macros and other office programs. These commands are intended for users with programming skills and an 
understanding of UNIX. 
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Text product identification: Text products are specified by a 9-character Product Identification Label (PIL), 
commonly referred to as an AFOS (Automation of Field Operations and Services) PIL or productId. The 9-character 
productId is in the form CCCNNNXXX, as shown in Table 5.3.3-1. Click the link for a list of Office Codes 
(CCC/XXX) or a list of Product Identifiers (NNN).

Python script writing rules: Table 5.3.3-2 lists basic Python rules for writing error-free scripts. 

Basic script commands: Eight basic script commands are used to write/edit text scripts in order to generate text 
products (see Exhibit 5.3.3-2). A description of each command follows. Study the structure of the examples provided 
and use them as models for your scripts.

1. accum

The "Accum" checkbox on the XT Workstation Text dialog shown in Exhibit 5.3.3-3 is manipulated 
(checked or unchecked) from a script.

Table 5.3.3-1. Text Product Identification (productId) Format - CCCNNNXXX

Format Menu Meaning
CCC Node Office code of location where text products are collected and stored.
NNN Category Name of the text product.
XXX Designator Office code of site or area for which the text product applies.

Table 5.3.3-2. Python Rules for Writing Error-Free Scripts

Rule # Issue Description
1 Case 

Sensitivity
Python Script Commands: Script commands are case-sensitive. They must be 
written in lower-case lettering. Writing any script command in upper case will 
cause a "NameError" when the script is run.

ProductId: The 9-character productId is not case sensitive. Upper-case lettering and lower-
case lettering are both acceptable, and are interchangeable. They will be converted to all 
upper case when the script is run. 

2 Single and 
Double Quotes

You can use either single (') quotes or double (") quotes in a Python string. 
However, whichever quote type you choose to start the string, the same quote 
type must be used to end the string; in addition, the other quote type, either single 
or double, must be used in the body of the string.

Example: repeat(3,'load("omanowoax"),load("OMAAFDOAX")').
A single quote starts and ends this repeat string. Double quotes are used in the 
body of the string.
Note: The productIds are written in both lower-case and upper-case lettering, 
which is an example of the interchangeability of cases within the same string.

3 Triple-single or 
Triple-double 

Quotes

Triple quotes (either single or double) are convenient to use for multi-lined 
strings, because it is cumbersome to add the new line character \n (back-slash n) 
at the end of each line. You only need to add the triple quotes at the beginning 
and end of the string.

4 Strings Commas must be used between commands when writing the strings in a 
horizontal pattern. They are not needed when writing the string vertically, one 
command per line.

5 Script Name Always add the .py extension to the file name when you save your script.
6 Running Script Never add the directory path when running a script. An error will result if there is 

a / (slash) in the script name used in the run command.
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Exhibit 5.3.3-3. XT Workstation Text Dialog

If the accum value is not specified, then accum returns the current value of the "Accum" checkbox. A 
checkmark in the "Accum" checkbox indicates that accum is on; an unchecked box indicates accum is off. 
If a value is specified, then it must be on or off and the state of the "Accum" checkbox is set to that value. 
If the value is off, then the "Accum" checkbox is unchecked to indicate accum is off, and will no longer 
append subsequent text product retrievals (see load command) to the display window. If the value is on, 
then the "Accum" checkbox is checked to indicate accum is on, and will append subsequent text product 
retrievals to the display window.

2. clear

This command clears the Text display window by deleting all of the text in the Text display window.

3. load

Load retrieves the product specified by its 9-character productId from the database and loads it into the 
Text display window. If the "Accum" checkbox is checked (on), then the product's text is appended to the 
previously loaded product; if the box is unchecked (off), it replaces the previous product.

4. readdb

Readdb retrieves the product specified by its 9-character productId from the database and stores it in the 
file specified by fileName. The fileName should be the name of a file in the current directory. If the file 
specified by the fileName exists, then it will be overwritten with the new product's text; if the fileName is 
new, then a new file will be created with the product's text.

5. repeat

Repeat executes the script on a continual basis by repeatedly executing the commands specified within 
the script body (string containing commands). If count (N) is specified, then body is executed 'N' times. If 
count is not specified, then body is executed indefinitely, or until the user cancels the execution either by 

Syntax Example
accum(on) Turn on accum by checking the "Accum" checkbox for loading text product 

in "appending mode:
accum(on)

accum(off) Turn off accum by unchecking the "Accum" checkbox for loading text 
product in "non-appending" mode:
accum(off)

Syntax Example
clear() Clear the text:

clear()

Syntax Example
load("productId") Loads latest text product with OMAAFDOAX productId:

load("omaafdoax")
load("a:productId") Loads all text products with OMANOWOAX productId:

load("a:omanowoax")

Syntax Example
readdb("productId","fileName") Read the product OKCAFDOUN from the database and write it to text file 

named okcafdoun.txt:
readdb("okcafdoun","okcafdoun.txt")
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pressing the Cancel button at the bottom of the dialog or by selecting the Cancel option under the Scripts 
menu.

6. run

Run retrieves and runs a script from a file specified by scriptName. The file specified by scriptName must 
be a valid script file in the local parent script directory. Refer to Subsection 5.3.4.

7. wait

Wait pauses a currently running script for a variable amount of time specified by a timeString. The 
timeString parameter specifies the number of hours, minutes, and seconds to wait, in the form 
HH:MM:SS. The user may stop waiting and choose to continue to run the script by pressing the Skip 
Wait button at the bottom of the Text dialog or by selecting the Skip Wait option from the Scripts menu. 
To continue running the script after it has paused, press the Continue button or select the Continue option 
from the Scripts menu. To cancel it altogether, press the Cancel button or select the Cancel option from 
the Scripts menu.

Syntax Example
repeat("""body""") Load multiple products and repeat the load after waiting 10 minutes. Since 

count is not specified, the loop will continue until user cancels:
repeat("""
accum(off)
load('seamtruil')
accum(on)
load('pdxmtrhqm')
load('pdxmtrast')
load('pdxmtrtmk')
load('pdxmtronp')
accum(off)
wait("00:10:00")
""") 

repeat(N,"""body""") Repeat three times the commands between the triple-double quotes
(written in a horizontal string):
repeat(3,"""wait("00:00:02"),load("pdxmtrhqm"),clear(),
wait("00:00:02"),load("a:pdxmtronp")""")

repeat(N,'body') Repeat three times the commands between the single quotes
(written in a vertical string):
repeat(3,'
wait("00:00:02")
load("pdxmtrhqm")
clear()
wait("00:00:02")
load("a:pdxmtronp")
')

Syntax Example
run("scriptName") Run the Python script named myscript.py:

run("myscript.py")

Syntax Example
wait() Wait until the user chooses to continue:

wait()
wait("until",MM) Wait until 15 minutes after the hour before continuing:

wait("until",15)
wait("HH:MM:SS") Wait for 10 seconds before continuing:

wait('00:00:10'),load('omanowoax'),load("omaafdoax")

Note 2: Note that in the third example above both single quotes ('omanowoax') and double quotes ("oma
used in the same string. This is acceptable as long as you start and end with the same type of quote. 
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8. writedb

Writedb writes a file specified by a fileName to the database with the text product specified by its 9-
character productId and returns an empty string. The fileName should be the name of a file in the current 
directory.

Syntax Example
writedb("productId","fileName") Read file okcafdoun.txt and write the text to the database as OKCAFDOUN:

writedb("okcafdoun","okcafdoun.txt")
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5.3.4 Running the Script

The Text dialog shown in Exhibit 5.3.4-1 is one of the dialogs that automatically opened when you logged onto the XT 
Workstation. It is the dialog where you started the Scripts process and where the text product will be displayed.

Exhibit 5.3.4-1. Text Dialog: Before and During Script Running

You can initiate a run command for an existing script from either the Text dialog or the Text Script Editor dialog. You can 
initate a run command for a new or edited script only from the Text Script Editor. Descriptions of both run options follow.

Text dialog: You can only run an existing script from the Text dialog. The dialogs and components for opening and 
running an existing script from this dialog are described below.

1. Show Output (Optional): This checkbox option, when checked, opens a popup window that displays the status 
of each line of the script as it is executed. If a requested product is not available or the script has an error, this 
information will be displayed in the Text Script Output dialog window, and the text product will not display in 
the Text display window. 

2. Selecting the Script: Selecting the "Run..." option from the Scripts menu opens the Select script to run dialog 
shown in Exhibit 5.3.4-2. To locate the desired script, first select the folder where the script is stored, and then 
select the script that you want to run. To make it easier to locate a specific script, you can list scripts by type 
(see dropdown list box in the lower-right corner of the dialog).

Note 1: In order to show the output of the script commands while the script is running, the Show Output checkbox 
must be checked before running the script. 
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Exhibit 5.3.4-2. Select Script to Run Dialog

3. Running the Script: Click the OK button to initiate the run. The following occurs when the running of the 
script is initiated (refer to Exhibit 5.3.4-1):

The "Cancel" option under the Scripts menu is enabled until the run is completed. Then it returns to being 
grayed out.

The "Cancel" button at the bottom of the Text dialog appears and is enabled until the run is completed. 
Then it disappears.

The "Skip Wait" option under the Scripts menu is enabled if a "wait" command is included in the script. 
If a "wait" command is not included the option remains grayed out. When the run is completed, the "Skip 
Wait" option will return (if enabled) to being grayed out.

The "Skip Wait" button at the bottom of the Text dialog appears and is enabled if a "wait" command is 
included in the script. If a "wait" command is not included, the button will appear, but will be grayed out. 
When the run is completed, the "Skip Wait" button will disappear.

The "Continue" option under the Scripts menu is enabled if a command is included in the script that 
requires user action to continue the running of the script after it has paused. If this type of command is not 
included in the script, the option remains grayed out. When the run is completed, the "Continue" option 
will return (if enabled) to being grayed out.

The "Continue" button at the bottom of the Text dialog appears and is enabled if a command is included 
in the script that requires user action to continue the running of the script after it has paused. If this type 
of command is not included in the script, the button will appear, but will be grayed out. When the run is 
completed, the "Continue" button will disappear.

4. Text Product: The Script Output dialog (if open) will display "Script Complete" and the text product will be 
displayed in the Text display window, as shown in Exhibit 5.3.4-3.
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Exhibit 5.3.4-3. Script Run Completed and Text Product Displayed

5. Clear Text Display Window: Select the Clear button to clear the Text display window.

6. Clear Text Script Output dialog's window or Close Text Script Output dialog: Select the Clear button to 
clear the Text Script Output dialog's window to prepare it for another script running. Select the Close button if 
finished running scripts.

Text Script Editor: The dialogs and components for opening and running a new, edited, or even an existing script 
from the Text Script Editor are described below.

Newly written, edited existing scripts, and even existing scripts can be run from the Text Script Editor dialog. 
Whatever you choose to do, the run is initiated from the Text Script Editor's Execute menu, as shown in Exhibit 
5.3.4-4.

Exhibit 5.3.4-4. Running a Script from the Text Script Editor

New Scripts

1. Write script: Write a new script in the Text Script Editor window. Refer to Subsections 5.3.2 and 5.3.3.

2. Save As new script: Refer to Subsection 5.3.2.

3. Show Output (Optional): Select the Execute menu and check the Show Output checkbox to show the 
output of the script command while the script is running.

4. Run: Select this option under the Execute menu to start the running of the script. The same actions will 
occur as described above after clicking the OK button when running a script from the Text dialog.

5. Text product: The Script Output dialog (if open) will display "Script Complete" and the text product will 
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be displayed in the Text display window, as shown in Exhibit 5.3.4-4.

6. Clear Text display window: Select the Clear button to clear the Text display window.

7. Clear Text Script Output window or Close Text Script Output dialog: Select the Clear button to 
clear the Text Script Output window to prepare it for another script running. Select the Close button if 
finished running scripts.

Edited Existing Scripts

1. Retrieve existing script: Select the script you want to edit. Refer to Subsection 5.3.2.

2. Edit the script: Make any required changes to the existing script. Refer to Subsection 5.3.3.

3. Save or Save As new script: If the edited script ran without any errors you can now either save the 
changed script to the existing script file or save it as a new script file. Refer to Subsection 5.3.2.

4. Show Output (Optional): Select the Execute menu and check the Show Output checkbox to show the 
output of the script command while the script is running.

5. Run: Select this option under the Execute menu to start the running of the script. The same actions will 
occur as described above after clicking the OK button when running a script from the Text display 
window.

6. Text product: The Script Output dialog (if open) will display "Script Complete" and the text product will 
be displayed in the Text display window, as shown in Exhibit 5.3.4-4.

7. Clear Text display window: Select the Clear button to clear the Text display window.

8. Clear or Close Text Script Output window: Select the Clear button to clear the Text Script Output 
window to prepare it for another script running. Select the Close button if finished running scripts.

Existing Scripts

1. Script File: Enter the basic "run" command and script file using the correct syntax in the Text Script 
Editor window. Refer to Subsection 5.3.3.

2. Show Output (Optional): Select the Execute menu and check the Show Output checkbox to show the 
output of the script command while the script is running.

3. Run: Select this option under the Execute menu to start the running of the script. The same actions will 
occur as described above after clicking the OK button when running a script from the Text display 
window.

4. Text product: The Text Script Output dialog (if open) will display "Script Complete" and the text 
product will be displayed in the Text display window, as shown in Exhibit 5.3.4-4.

5. Clear Text display window: Select the Clear button to clear the Text display window.

6. Clear or Close Text Script Output dialog window: Select the Clear button to clear the Text Script 
Output dialog window to prepare it for another script running. Select the Close button if finished running 
scripts.

Note 2: Remember: Never add the directory path when running a script. An error will result if there is a
the script name used in the run command. In addition, make sure your script has the Python (.py) extens
with extension if needed). 
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5.4 Working with Alarm/Alert Feature

The Alarm/Alert feature is initiated from the Text Workstation dialog and allows you to set up and receive 
Alarm/Alert messages. You may also select text products for which you want to be "alarmed" or "alerted." You can 
specify a list of text products that are fetched from the database. A visible and/or audible alarm alerts you when new 
versions have arrived. When new alarmed products are received, an observable Bell, as shown in Exhibit 5.4-1, 
appears on the XT screen. The alarm bell remains on the screen until the alarm is acknowledged.

Exhibit 5.4-1. Visible Alarm Bell Indicator

Current Alarm Queue

When you click on Alarm/Alert in the Text Workstation dialog box, the Current Alarm Queue dialog opens, as 
shown in Exhibit 5.4-2. The Current Alarm Queue dialog provides information about the products that are displayed 
in the Current Alarm Queue.

Exhibit 5.4-2. Current Alarm Queue Dialog

Three options are accessible from this dialog. 

Open Display: This menu button that opens the Alarm Display Window dialog. The Alarm Display Window 
dialog shown in Exhibit 5.4-3 displays the alarmed or alerted text products. 

Exhibit 5.4-3. Alarm Display Window Dialog

The Alarm Display Window dialog has the following capabilities. 

Note 1: The Alarm/Alert feature is workstation specific. 
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Print Window: Makes a hard copy of the alarmed or alerted text products displayed in the window. 

Print Entire Buffer: Makes a hard copy of all of the alarmed or alerted text products displayed in the 
buffer. 

Clear: Clears the Alarm Display Window dialog. 

Accumulate: Allows you to append incoming alarmed text products in the window.

Display All: A menu button that opens the Alarm Display Window dialog and displays all of the alarmed or 
alerted text products. 

Product List: A menu button that opens the Alarm/Alert and Proximity Alarm Products dialog, as shown in 
Exhibit 5.4-4. 

Exhibit 5.4-4. Alarm/Alert and Proximity Alarm Products Dialog

Products with the word "Alarm" in parentheses send an audible signal. The Alarm/Alert and Proximity Alarm 
Products dialog has the following capabilities: 

File: A dropdown menu that includes options Save, Save & Close, Close, Save as..., and Load.... The 
first three options are discussed at the end of this section. The latter two allow you to save and recall 
alarm settings that you might wish to apply at different times of the year or to support different programs 
(e.g., public or aviation).

The process for adding alarm/alert and proximity alarm products is illustrated in Exhibit 5.4-5. A description 
of the product entry buttons follow.
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Exhibit 5.4-5. Process for Adding Alarm Products

New AA Entry: A menu button that opens the New Alarm/Alert Product dialog, as shown in Exhibit 
5.4-6.

Exhibit 5.4-6. New Alarm/Alert Product Dialog

The New Alarm/Alert Product dialog has the following capabilities: 
Product ID: An entry box for a text product, identified by its AFOS PIL, that you want to add to 
the Alarm/Alert Products list. 

Alarm: A checkbox toggle button that allows you to set an audible alarm for a product. If you do 
not set this, the product is alerted but does not have an audible alarm. Products with the Alarm 
toggle set (checked) will be listed in the Alarm/Alert Products list annotated with (Alarm). 

Optional Search String: A string that must be present in the product text in order to trigger the 
alert. For example, you might be interested in a NOW product that mentions fog. 

Note 2: The Alarm/Alert feature does not allow you to set up alarms or alerts for text products by WMO
You must still use the AFOS PIL. 
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OK: Closes the New Alarm/Alert Product dialog and adds the new Alarm/Alert Product to the 
Products list. 

Cancel: Closes the New Alarm/Alert Product dialog without making changes to the list of alarmed 
products.

New PA Entry: A menu button that opens the New Proximity Alarm Product dialog, as shown in 
Exhibit 5.4-7.

Exhibit 5.4-7. New Proximity Alarm Product Dialog

The New Proximity Alarm Product dialog has the following capabilities: 
Product ID: An entry box for a text product, identified by its AFOS PIL, that you want to add to 
the Proximity Alarm Products list. This feature allows you to be notified when a specified product 
affecting a selected area is received. 

Alarm/Alert: An option menu that allows you to set an audible alarm for a product. If you select 
Alert, the product is alerted, but does not have an audible alarm.

Action Cmd: This feature is not yet implemented. 

AOR: A checkbox to set notification for a product that affects your Area of Responsibility (for a 
WFO, the CWA). 

AOR+Distance: Allows you to specify a distance in miles or kilometers beyond the AOR where 
you wish to be notified. 

UGC List: List UGCs of interest here for notification of the specified product.

OK: Saves the item to the Proximity Alarm list and closes the dialog.

Cancel: Closes the dialog without making changes to the Products list.

Change Entry: If you have clicked on a product in the AA or PA list, this button opens a dialog box in 
which you can modify the product's alarm/alert settings. 

Delete Entry: A menu button that deletes a highlighted product from the AA or PA list.

Save: A menu button that saves changes but leaves the Alarm/Alert and Proximity Alarm Products 
dialog open for additional work.

Save & Close: A menu button that saves changes and closes the Alarm/Alert and Proximity Alarm 
Products dialog.

Close: A menu button that closes the Alarm/Alert and Proximity Alarm Products dialog without making 
changes to the Alarmed Products list. If you have made changes but have not saved them, you will be 
asked to confirm.
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5.5 Practice Modules (Tutorials) for AWIPS Textual User Interface

This section gets you started (hands-on) working on the Text Workstation and with the Textual User 
Interface.

This section includes the following practice modules:

Reserved - Subsection 5.5.1

Reserved - Subsection 5.5.2

Reserved - Subsection 5.5.3

Reserved - Subsection 5.5.4

Practice Module (Tutorial): XT Workstation Scripts Menu - Creating, Saving, and Running a New 
Script - Subsection 5.5.5

Practice Module (Tutorial): XT Workstation Scripts Menu - Creating a New Script from an 
Existing Script - Subsection 5.5.6

Practice Module (Tutorial): XT Workstation Scripts Menu - Running a Script File from the Text 
Dialog - Subsection 5.5.7
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5.5.1 Reserved
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5.5.2 Reserved
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5.5.3 Reserved
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5.5.4 Reserved
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5.5.5 Practice Module (Tutorial): XT Workstation Scripts Menu - Creating, Saving, and Running a New Script

Refer to Exhibit 5.5.5-1 when performing the steps included in this tutorial. The numbers shown on the exhibit correspond to the numbered steps.

Exhibit 5.5.5-1. Using the Script Writing/Editing Functionality to Write, Save, and Run a Script

Objective: Use the scripts writing/editing functionality to write a new script, save it, and run it to generate text products. 

Note 1: In Exhibit 5.5.5-1 the Text Script Editor dialog and Text Script Output dialog are shown more than once. This is done to clarify the content of the dialogs and 
to prevent cluttering when multiple activities are associated with each dialog. 

Note 2: In Exhibit 5.5.5-1 the Text Script Editor and Text Script Output dialogs are shown more than once. This is done to clarify the content of the dialogs and to 
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Log onto the XT Workstation. Note that one of the three dialogs that automatically opens is the Text dialog.

On the Text dialog, check the Accum checkbox.

On the Text dialog, select Scripts > Edit... to open the Text Script Editor (untitled) dialog

.

Enter the script below in the Text Script Editor dialog window (do not enter "Line #:," which is only included for the purpose of this tutorial). Replace the 9-character 
productId with a productId appropriate for your site:

Line 1: repeat(3,'''
Line 2: accum(off)
Line 3: load("okcafdoun")
Line 4: accum(on)
Line 5: wait("00:10:00")
Line 6: load('omanowoax')
Line 7: wait('00:05:00')
Line 8: clear()
Line 9: accum(off)
Line 10: wait("00:10:00")
Line 11: load('omaafdoax')
Line 12: ''')

On the Text Script Editor (untitled) dialog, select File > Save As... to open the Save Script File As dialog 

.

On the Save Script File As dialog, locate and select your home folder (if you logged on to the XT Workstation, your username will automatically populate the Save
in Folder field). Enter a name for the script file, e.g., testscript1.py. Remember to add the dot py (.py) Python extension. Refer to Subsection 5.3.2.

Click the OK button to save the script. Clicking the OK button also closes the Save Script File As dialog. The name given the script (testscript1.py) replaces 
"untitled" on the Title Bar of the Text Script Editor dialog 

.

On the Text Script Editor (testscript1.py) dialog, check the Execute > Show Output checkbox to open the Text Show Output dialog (8a) for monitoring the script's 
run.

On the same dialog, select Execute > Run to generate the text product. Note the following:

At the first wait command, the Text dialog's Accum checkbox is still checked.

The Text Script Output dialog window is populated with the sequence of the script steps and status prior to the wait command.

The Text display window is populated with the first loaded product prior to the wait command.

prevent cluttering when multiple activities are associated with a dialog.

1

2

3

3a

4

Note 3: The sample script below intermixes single and double quotes, which is acceptable as long as you start and end with the same quote type. In addition, 
note that the script starts and ends with triple-single quotes. 

5

5a

6

7

7a

Note 4: Keep the saved script file (testscript1.py) after you finish this tutorial for the next practice module (tutorial), Subsection 5.5.6. 

8

9

9a

9b

9c

9d
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The three buttons (Continue, Skip Wait, and Cancel) appear at the bottom of the Text dialog.

A waiting to proceed status message is displayed at the bottom of the Text dialog.

On the Text dialog, open the Scripts menu and observe the statuses of the three previously disabled options (will show same status as the buttons).

On the Text Script Editor dialog, open the Execute menu and observe the statuses of the three previously disabled options (will show same status as the 
buttons).

Select the Skip Wait button at the bottom of the Text dialog to proceed with running the script (loads the second text product) to the next wait command (line 7 in the 
script). 

Either allow the second wait time to time out, or choose to skip the wait by selecting one of the methods (Skip Wait button, Scripts > Skip Wait, or Execute > Skip 
Wait) to bypass the clock and proceed with running the script to the next wait command (line 10 in the script). Note the following when the script continues:

a. The Text Script Output dialog window continues to populate with entries from the script run.

b. The Text display window is cleared of all text products.

c. The Text dialog's Accum checkbox is now unchecked.

d. The Status Bar and buttons at the bottom of the Text dialog are still present because the script run has not been completed.

Select one of the methods (Skip Wait button, Scripts > Skip Wait, or Execute > Skip Wait) to skip the wait time and proceed with running the script.

Note the following when the third run of the script is completed:

The Text Script Output dialog window concludes the script run with the statement that the script is complete.

b. The Text display window loads and displays the next text product.

c. The Text dialog's Accum checkbox remains unchecked.

d. The Status Bar and buttons at the bottom of the Text dialog disappear.

e. The three options (Continue, Skip Wait, and Cancel) under the Scripts menu and Execute menu are all disabled (grayed out).

On the Text Script Output dialog, select the Close button to close the window.

On the Text Script Editor dialog, select File > Close to close the dialog.

On the Text dialog, select the Clear button to clear the display window of the text product and display a blank window.

9e

9f

9g

10

11

12

Note 5: Step 12 completed the first running of the complete script. However, as noted in line 1, the script includes the command to repeat the running of the 
script three times before it is entirely completed. Therefore, you will need either to let the wait time run or continue to skip the waiting period until the third run 
of the script is completed. 

12a

13

14

15
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5.5.6 Practice Module (Tutorial): XT Workstation Scripts Menu - Creating a New 
Script from an Existing Script

Objective: Use the scripts writing/editing functionality to create a new script from an existing 
script. 

Refer to Exhibit 5.5.6-1 when performing the steps included in this tutorial. The numbers shown on 
the exhibit correspond to the numbered steps.

Note 1: In Exhibit 5.5.6-1 the Text Script Editor dialog is shown more than once. This is done to 
clarify the content of the dialog and to prevent cluttering when multiple activities are associated 
with the dialog. 
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Exhibit 5.5.6-1. Using the Script Writing/Editing Functionality to Create a New Script from an Existing 
Script
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1  Log onto the XT Workstation. Note that one of the three dialogs that automatically opens is 
the Text dialog.

2  On the Text dialog, select Scripts > Edit... to open the Text Script Editor (untitled) dialog 

2a .

3  On the Text Script Editor dialog, select File > Open... to open the Open Script File dialog 

3a .

4  Locate the Python script file you created while completing the practice module in 
Subsection 5.5.5, e.g., testscript1.py.

5  Click the OK button to display the script in the Text Script Editor dialog window 5a  and 

change the Text Script Editor dialog's title bar from "untitled" to "testscript1.py" 5b . Clicking 
the OK button also closes the Open Script File dialog.

6  On the Text Script Editor (testscript1.py) dialog, select File > Save As... to open the Save 

Script File As dialog 6a .

7  On the Save Script File As dialog, locate and select your home folder (if you logged on to 
the XT Workstation, your username will automatically populate the Save in Folder field. Name 
the script file adding the dot py (.py) Python extension, e.g., testscript2.py.

8  Click the OK button to display the new file name in the Text Script Editor dialog's title bar, 

changing it from "testscript1.py" to "testscript2.py" 8a . Clicking the OK button also closes 
the Open Script File dialog.

9  Change the testscript2.py script displayed in the Text Script Editor dialog window, which is 
currently the same as the testscript1.py file, to: 

repeat(3,"""
accum(on)
load("okcafdoun")
load("omanowoax")
load('omaafdoax')
""") 

10  Select File > Save to save the new testscript2.py file, which you created by modifying an 
existing script file (testscript1.py).
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Note 2: You now have two Python script files saved in your home directory (testscript1.py 
and testscript2.py). Keep both these files after you finish performing this tutorial for the 
next practice module (tutorial), Subsection 5.5.7. 

11  On the Text Script Editor (testscript2.py) dialog, select File > Close to close the dialog.
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5.5.7 Practice Module (Tutorial): XT Workstation Scripts Menu - Running a Script 
File from the Text Dialog

Objective: Use the scripts writing/editing functionality to run a script file from the Text display 
window. 

Refer to Exhibit 5.5.7-1 when performing the steps included in this tutorial. The numbers shown on 
the exhibit correspond to the numbered steps.

Note 1: In Exhibit 5.5.7-1 the Text dialog and Text Script Output dialog are shown more than 
once. This is done to clarify the content of the dialogs and to prevent cluttering when multiple 
activities are associated with each dialog. 
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Exhibit 5.5.7-1. Using the Script Writing/Editing Functionality to Run a Script File

1  Log onto the XT Workstation. Note that one of the three dialogs that automatically opens is 
the Text dialog.

2  On the Text dialog select Scripts > Show Output checkbox to check the checkbox and open 
the Text Show Output window for monitoring the script's run. The Text Script Output window 
is blank.

3  On the Text dialog, select Scripts > Run... to open the Select script to run dialog 3a .

4  Locate and select the Python script file you created while completing the practice module in 
Subsection 5.5.6, e.g., testscript2.py.

5  Click the OK button on Select script to run dialog.

Note 2: Because there are no user-initiated or wait commands in the script, the script 
automatically runs to completion. 

Note the following:

5a  The Select script to run dialog closes.

5b  The Text display window is populated with the text products defined by the script.

5c  The Accum checkbox is now checked as per the accum command in the script.

5d  The Text Script Output dialog window is populated with the script output from the 
start of the running of the script to script completion.

6  On the Text Script Output dialog, select the Close button to close the dialog. If you want to 
run another script and monitor the status of its run, select the Clear button instead of the Close 
button to clear the window and keep the Text Script Output dialog open.

7  On the Text dialog, select the Clear button to remove the displayed text product and display 
a blank window.
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6.0 WarnGen

The CAVE Warning Generator function is handled by a system extension called WarnGen. WarnGen 
enables you to issue flash flood, severe thunderstorm, tornado, and other short-term warnings for a 
single storm or a line of storms. In addition, you can issue text products (follow-up statements) that 
update the progress of the storm, cancel the warning if conditions change, re-issue another warning on 
the same storm, or note the expiration of the warning. WarnGen also enables you to provide warning 
backup support to neighboring sites.

This chapter provides an introduction to WarnGen and explains how to use it to issue warnings and 
follow-up statements.

This chapter includes the following sections:

• Section 6.1: Overview of Capabilities

• Section 6.2: Operating Modes

• Section 6.3: Starting WarnGen

• Section 6.4: Automated Insertion of Dam Break Data into FFW/FFS

•

Section 6.5: Reserved

• Section 6.6: Practice Module (Tutorial): Placing WarnGen in Practice Mode
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6.1 Overview of Capabilities

General Functionality

The WarnGen function utilizes both the CAVE Graphics display and the Text display. WarnGen is 
activated from any of the graphics displays by selecting the yellow WarnGen button to open the 
WarnGen dialog and display the "Drag me to storm" indicator shown on Exhibit 6.1-1.

Exhibit 6.1-1. WarnGen in Operational Mode

WARNING: In Operational mode warning messages are sent out to the public. You should put 
the workstation in the Test or the Practice mode to prevent errant test messages from being sent 
out to the public. Refer to Section 6.2 for how to place WarnGen into either of these protective 
modes. 

WarnGen can be run on multiple displays simultaneously. Once started, WarnGen lets you:
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• Choose backup sites, if necessary. 

• Select to warn on a single storm or a line of storms. 

• Establish a storm track (if appropriate to the type of warning) and designate a warning area. 

• Designate the type and duration of the warning or follow-up statement. 

• Choose an option to be included in the warning or follow-up statement text. 

• Send the warning or follow-up statement information to the Text display where internal 
consistency checks are performed. 

• Choose whether to send (Restart) or abort (Close) the warning or follow-up statement. 

Text Display

WarnGen translates the storm path (if one is designated) into text describing the speed and direction 
of the storm, identifies the counties and cities affected by the warning, and generates warning text, 
including any selected options.  From the Text display, you can review and edit the automatically 
generated text.

The draft text warning is checked for the following:

• Correct header information

• Proper UGC and VTEC codes

• Time and Time Zone consistency

• Correct product type

• Mass News Dissemination (MND) consistency

• Contents

• Presence of closing $$

If there are any problems, specific alert boxes appear to notify you. Once you send the product, a 
confirmation box pops up asking you to verify the send or abort the transmission.

Note 1: WarnGen can be run on any scale; however, because essentially all warnings are 
restricted to your County Warning Area (CWA), the preferred scales are State(s) and WFO. The 
choice of scale is entirely up to you and should be determined by what is most appropriate for 
the warning situation at hand. 

Note 2: You can overlay WarnGen on any data source, but the most useful data sources are radar 
and satellite. You are most likely to zoom in on the threatened area using these data sources. The 
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choice of data source is entirely up to you and should be determined by what is most appropriate 
for the warning situation at hand. 

Warn by Polygon

WarnGen accommodates a polygon-centric approach to warnings generated on AWIPS. Users can 
provide a better-quality warning to the public by defining a more specific area, thereby reducing the 
number of people unnecessarily warned. 

The following functionality is present in Warn By Polygon:

• The hatched area on the display, rather than the polygon you draw, will be described by the 
LAT...LON coordinates in the text. Corollaries of this include the following: 

◦ The warned area may not cross your CWA boundary. 

◦ For non-marine products, the warned area will not extend over water, and for marine 
products, the warned area will not extend over land. 

• For follow-up statements, the area of the warning may be reduced but not expanded. 

• The location and motion of the weather event will be encoded below the LAT...LON line. 

• Warning templates can be configured to list affected basins, just as they historically have listed 
counties. 
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6.2 Operating Modes

WarnGen can be operated in three modes: 

1. Operational Mode: Live communication that is broadcast to the public 

2. Test Mode (Comms Live): Live communication with Test message that is broadcast to the 
public 

3. Practice Mode (In-House): In-house communication that is not broadcast to the public. 

The background color of the CAVE-D2D screen, as shown in Exhibit 6.2-1, changes to reflect the 
mode setting.

Exhibit 6.2-1. Graphics Display Color for WarnGen Modes

Test Mode vs. Practice Mode

Operational Mode is the Default operating mode, where warning messages are sent out to the public. 
The Test and Practice modes prevent errant test messages from being sent out to the public. Although 
the main reason for using these two modes is to learn warning generation procedures, all generated 
text products are affected, not just those created via WarnGen.
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The specific differences between the Test Mode and the Practice Mode are described in Table 6.2-1.

Table 6.2-1. Test Mode vs. Practice Mode
Test Mode Practice Mode

Products are created in test format with the 
appropriate VTEC plain language modifications. ----------

Products are stored in primary text database. Products are stored locally in flat files.
Products are sent out over the WAN. Products are never sent out over the WAN.
Triggers will fire. Triggers will not fire.
Communications testing occurs to verify that the 
dissemination paths to the outside world are 
working correctly.

----------

---------- Practice Mode allows offline testing of applications.

Changing Modes

To change from Operational Mode to either Test or Practice mode: 

1. Ensure you are logged into both the LX and the XT workstations and that CAVE is not running 
on either workstation.

Note 1: Offices with CWSU AWIPS remote display connections should not attempt Test 
or Practice modes on the workstation running the CWSU AWIPS remote display without 
coordinating with the associated CWSU. As long as the CWSU has the AWIPS remote 
display running, the affected workstation cannot be placed in Test or Practice mode. 

2. On the LX workstation, click mouse Button 1 (B1) over the background display to open the 
AWIPS Start-up Menu. 

3. From the AWIPS Start-up Menu, select Test Mode Control Program, as shown in Exhibit 
6.2-2.
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Exhibit 6.2-2. AWIPS Start-up Menu - Test Mode Control Program

4. The Test Mode Control dialog opens with Operational Mode active. To change to either Test or 
Practice mode, select the appropriate button, as shown in Exhibit 6.2-3. When you are in Test 
or Practice mode, the only eligible action you can take is to switch back into operational mode, 
indicated by the mode button not being grayed out. 
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Exhibit 6.2-3. Test Mode Control Dialog - Selecting Mode

When switched to the Test or Practice mode, a flashing Mode Indicator, as shown in Exhibit 
6.2-4, appears on both the Graphics display and the Text display to indicate the mode is 
activated. 

Exhibit 6.2-4. Mode Indicator
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Note 2: You can also run the command from a Terminal window. After navigating to the 
directory where Test Mode Control Program (TMCP) is located 
(e.g., /usr/local/cave/caveEnvironment), run the TMCP (e.g., /TMCP). 

5. Start CAVE and note the background color of the Graphics display, as shown in Exhibit 6.2-1, 
which indicates the selected mode setting. 
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6.3 Starting WarnGen

Note 1: Make sure the appropriate mode is set before starting WarnGen. Refer to Section 6.2. 
The exhibits shown in this chapter are representative of the Practice Mode. 

Activate WarnGen by clicking the yellow WarnGen button, located on the right side of the CAVE 
toolbar, as shown in Exhibit 6.3-1. The WarnGen dialog opens and the “Drag me to storm”
Centroid is shown on the Graphics display, indicating that the CAVE display is in Editable Interactive 
WarnGen mode.

Exhibit 6.3-1. Starting WarnGen (Practice Mode Shown)

Note 2: The color of the WarnGen dialog is determined by the mode setting. Refer to Section 
6.2. 
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WarnGen Dialog Box

The WarnGen dialog, shown in Exhibit 6.3-2, is divided into nine sections:

Exhibit 6.3-2. WarnGen Dialog (Practice Mode Shown)

1. Backup 

2. Track type 

3. Edit 

4. Redraw Box on Screen from, including Warned Area Visible

5. Product type, including Follow-up Statements or Re-Issuing Warnings 

6. Time range 

7. Options window (provides important detailed information) 
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8. Instructions 

9. WarnGen Control Buttons

Each section of the WarnGen dialog box is described below. 

Backup

This section of the WarnGen dialog contains an option menu to select a CWA for backup operations. 
To use Service Backup, your Site Manager must run the localizations for your surrounding CWAs in 
advance of a warning situation. When you select a CWA other than your own for service backup, the 
WarnGen dialog box disappears for a brief moment. When it reappears, the option menu turns yellow, 
and any warning text messages will include your site name as the issuing office in the text header.

Track type

The track type allows you to choose whether you want to warn on a single storm or a line of storms. 
The appropriate storm or line location information is automatically mentioned in the warning message 
text.

Edit

This set of radio buttons allows you to choose to edit the warning box, the storm track, or both 
(default). An example of when you might choose one of the alternates is a case where you are 
warning on a line of storms and there are too many editing handles on the display to be managed 
easily.

Redraw Box on Screen from

These buttons redraw the warning area.

• Track: This button draws a trapezoid based on the storm track you have established.

• Warned/Hatched Area: This button draws a polygon around the hatched area. This is used, for 
example, when you are creating a follow-up product (SVS, FFS, FSL, MWS) and you have 
expanded the polygon beyond the allowable hatched area, or in a case where your polygon 
extends out of your CWA.

• Dam Break Threat Area: This button is used only when you are creating a Dam Break 
product and have selected a 'dam break' primary cause and a specific dam. If used in other 
cases, nothing happens on the display, and you will see a note in the Instructions box at the 
bottom of the WarnGen dialog. 

• Warned Area Visible: This checkbox toggles the hatching that is used to highlight the warning 
area or counties that are selected with mouse Button 3 (B3).

Product type
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From the Product type section, select the type of warning to be issued.

The radio buttons are selectors for Severe Thunderstorm, Tornado Warning, SVS - Update Cancel 
Expire SVR TOR, SPS - Special Weather Statement, Flash Flood Warning, and Other. The Other 
radio button is toggled on when you select an option from the adjacent field's drop-down list, which in 
Exhibit 6.3-2 shows “SMW - Special Marine Warning.” Other product types include: other types of 
warnings, watches, and advisories. These watches, warnings, and advisories are configurable to your 
site.

Note 3: The Other button is selected automatically if you select an option from the adjacent 
field. 

• Follow-up Capability: When local severe weather warnings or extreme wind warnings are 
issued, it is customary to issue additional text products that update the progress of the storm, 
cancel the warning if conditions change, or note the expiration of the warning. These text 
products are known as follow-up statements. WarnGen includes a capability to assist you in 
issuing follow-up statements for existing warnings, to cancel or continue existing warnings, or 
to re-issue additional warnings based on existing warnings. These follow-up products will at a 
minimum inherit key characteristics from the originally issued warning, including UGC codes, 
list of counties/zones, Valid Time Event Code (VTEC) type, VTEC number, VTEC expiration 
time, and area of warning. Other characteristics are inherited as appropriate for the warning 
type. Table 6.3-1 lists warning types and their appropriate follow-up statements.

Table 6.3-1. Text Warning Types and the 
Accompanying Follow-up Statements

Warning Type Follow-up Statement

TOR - Tornado Severe Weather 
Statement (SVS)

SVR - Severe 
Thunderstorm Warning

Severe Weather 
Statement (SVS)

FFW - Flash Flood 
Warning

Flash Flood Statement 
(FFS)

SMW - Special Marine 
Warning

Marine Weather 
Statement (MWS)

EWW - Extreme Wind 
Warning Extreme Wind (SVS)

Note 4: After a follow-up product is selected, the Create Text control button is enabled, 
while the time characteristics (Time Range section) are disabled. 

• Update List / Follow-up Action List: This drop-down menu in the Product type area of the 
WarnGen dialog box contains a dynamic list of available actions and warning IDs to issue 
follow-up statements when warnings are currently valid, or have expired in the last two hours. 
The contents of this list depend on which Product type you have selected. 

Note 5: Notice that each warning is identified with a follow-up prefix, the text product 
type, the VTEC number, and the time of / until expiration. 
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The Update List / Follow-up Action List can have the following options:

◦ Update List: This selection will cause WarnGen to regenerate the follow-up action list to 
reflect the current state of available products. Because there is currently no automatic 
notification when new warning products are issued, you should manually select this 
option before issuing a follow-up statement to ensure that you have all of the current 
choices presented. 

◦ Cancellation (CAN): This prefix identifies all current warnings that can be cancelled. 

◦ Continuance (CON): This prefix identifies all current warnings that can be continued. 

◦ Cancel Second Part (CA2): In the case of following a combined flash flood/severe 
thunderstorm warning with a flash flood statement, the CA2 prefix is used. This means to 
cancel the second part of the warning (the SVR) but continue the first part (the FFW). 

◦ Expiration (EXP): This prefix identifies those warnings that have expired within the last 
two hours, but can still be used as the basis for a reissuance. 

◦ Correction (COR): This prefix identifies the correction of recently issued warnings of 
the same type in the text database. The times and calls to action are locked. 

◦ Extension (EXT): This prefix identifies an extension in time. Extensions in time are 
implemented only for hydrologic products. 

◦ Reissue (NEW): This capability is meant to help with reissuing additional warnings for 
an ongoing quasi-steady severe weather event. When an SVR, TOR, FFW, or SMW 
product type is chosen, the follow-up action list will list all warnings of that same type 
that are active or have expired in the last two hours. Choosing one will initialize 
WarnGen with the state it had when that warning was issued, including the call to action 
and original bullet selections. Hitting the Redo Box button once will then advect the box 
to the approximate location it would have now, assuming constant storm movement. In 
contrast to followup products, the box and time characteristics are fully editable, because 
this results in a whole new warning being issued. Reissue is identified by the prefix 
NEW.

In a case where there are several active warnings at once, you may need some guidance as to 
which is the correct VTEC number to select for the product you wish to follow up. To help with 
this, the Local Warnings and Marine Warnings graphics display the VTEC number of the 
warnings.

Identifying Warnings Graphically

To help distinguish the correct VTEC numbers for multiple warnings, you may want to use the 
geographic selection feature. If you have selected a product type for which a follow-up action is 
possible, clicking B3 will select the nearest product, and display its track and box on the map. 
This will also cause the follow-up action list to reorganize itself to be sorted by distance from 
the selected point. This is based on the assumption that if you make this type of selection and 
do not get the desired product, it is very likely that the product actually desired was nearby, and 
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thus it will end up very near the top of the follow-up action list. (Normally, the list is sorted 
from newest to oldest.)

Service Backup and Follow-up Statements

Service backup issues are handled seamlessly by this capability. All necessary information 
about how to issue the followup products (as well as assigning VTEC numbers for the initial 
warning products) is now obtained by decoding the warning products from the text database. As 
such, as long as the text database is correctly storing warning products from neighboring sites, 
there are no coordination issues for service backup.

Time Range

Within the Time range section of the WarnGen dialog, select the Duration that defines how long the 
warning will be in effect. The available options in this menu change depending on the type of 
warning. Warning times can also be adjusted by editing the warning text using the Text display.

If you are issuing a warning that will go into effect at a future time, and it has a time range rather than 
just an expiration time, then you can enter these times in the “time/date boxes.” Press the Change 
menu button to select different dates and/or times. Setting the Time Range applies to only certain text 
products. The Time Range feature can also support the VTEC text system.

"Warning Options Panel"

For some types of warnings, WarnGen provides additional options for automatic inclusion in the 
warning. The highlighted selections are chosen by default; you can deselect them and/or select others 
by clicking on them. Some warnings, advisories, and statements do not include these selectable 
options. However, your Site Manager can set up or modified the options shown in the panel.

Instructions

WarnGen instructions are shown in this section of the dialog. As you perform the instructions, new 
ones appear to help you through the warning process. In Exhibit 6.3-1 you are instructed to “Move 
Centroid to Storm in any Frame”. Click and hold mouse Button 1 (B1) on the “Drag me to 
storm” Centroid and drag it to the storm. Then you are instructed to “Adjust box around Warning 
Area”.

"WarnGen Control Buttons"

These button, which are located at the bottom of the WarnGen dialog, control WarnGen's basic 
functions.

• Create Text: A click on the Create Text button sends the warning to the Text display where it 
can be edited, if needed, and then issued. This button is enabled once you have moved the 
Storm Centroid marker from its default position, or, for a hydrologic warning (e.g., flash flood), 
once you have moved the default warning box. 
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• Restart: A click on the Restart button resets the display to the default Storm Centroid marker 
or to the default warning box, depending on which Warning Product type is selected, but leaves 
the dialog box settings in their current state. You can use the Restart button to issue multiple 
warnings or, if necessary, cancel a warning before it is sent to the Text display. 

• Close: A click on the Close button closes the dialog box and leaves WarnGen in its current 
state, including the Storm Centroid and warning box, if either is on the display. To reopen the 
dialog box, simply click on the yellow WarnGen button on the menu bar. 
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6.4 Automated Insertion of Dam Break Data into FFW/FFS

Sites have the capability to create Dam Break non-convective Flash Flood Warnings (FFW) and Flash 
Flood Statements (FFS) using locally defined, dam-specific text in WarnGen. For this feature to work at 
a particular site, the site must create a text file (LLL-dam_info.txt). This text file is referred to as a “dam 
info file.” This section explains how to create the dam info file, and how to use this feature.

Note 1: The LLL in the LLL-dam_info.txt file should be replaced by your site ID, i.e., by the value 
of environment variable FXA_LOCAL_SITE. 

WarnGen Dam Break Threat Button and Options

In the WarnGen GUI, the items listed in the "Options Information Pane" outlined by the green box, as 
shown in Exhibit 6.4-1, apply to all sites and are retrieved from the WarnGen templates. The items listed 
in the "Options Information Pane" outlined by the yellow box, as shown in Exhibit 6.4-2, are unique to 
the particular site and are retrieved from the dam info file, i.e., LWX-dam_info.txt for this example.
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Exhibit 6.4-1. Dam Break Threat - All Sites
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Exhibit 6.4-2. Dam Break Threat - Unique to Specific Site

"Warning Options Panel"

The "Warning Options Panel" is composed of four sections (refer to Exhibit 6.4-1 for the first two 
sections, and Exhibit 6.4-2 for the last two sections). 

1. Primary Cause: This section includes two dam break options, one of which must be selected for 
this feature to work:

1. dam break - imminent failure 
2. dam break - failure has occurred.

2. Dam Failure Reported By: This section, which appears below Primary Cause, includes six 
options from which you must choose one (who reported the dam failure).

3. Dam & Dam Break Scenarios: This section displays dam name, dam break scenarios, and rule of 
thumb. In the example (see Exhibit 6.4-2), there are two dams — Ada dam and Howard dam. 
There are four scenarios for Ada dam and two scenarios for Howard dam, and there is one rule of 
thumb for each dam.
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4. Calls to Action: As the name implies, this is an optional selection that is chosen after checking the 
location and level of the threat to the Dam Break Threat Area. 

Dam Info File

Site-specific information for the DAM & DAM BREAK SCENARIOS section is stored in the dam info 
file, LLL-dam_info.txt. To use the new WarnGen feature, this file needs to be created in advance and 
stored in the $FXA_CUSTOM_FILES directory. An example of such a file is shown in Exhibits 6.4-3 
and 6.4-4. The example file can be divided into 3 parts: Part 1, lines 1-3, contains commonAddInfo 
substitution text; Part 2, lines 5-42, contains information related to Ada dam; and Part 3, lines 44-70, 
contains information related to Howard dam. For each additional dam, a part similar to Part 2 or Part 3 
should be added to the file.

Exhibit 6.4-3. LWX-dam_info.txt (Sections 1 and 2)
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Exhibit 6.4-4. LWX-dam_info.txt (Section 3)

Understanding the Dam Info File

• File Structure: The structure of a dam info file, i.e., LLL-dam_info.txt, is as follows:

When creating a dam info file, the symbols and words in the above structure must be kept 
unchanged. In the terminology of WarnGen, DAMNAME, SCENARIO, and ROT are bullets, 
VAR is a substitution, and commonAddInfo, riverInfo, damInfo, countyInfo, stateInfo, cityInfo, 
addInfo, coords, scenario, and ruleOfThumb are variable names into which the corresponding 
substitution text is directed.

Note 2: The variable addInfo is defined in DAMNAME and in several instances of 
SCENARIO as well. 
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The following is the format of a substitution: <substitution_type | qualifier_type = qualifier_value 
| ...>. VAR is a specific type of substitution. It allows the user to direct text into a variable, i.e., the 
text following lead= will be directed to the variable following var=.  For example, in VAR 
substitution, <VAR lead=THE POTOMAC RIVER BELOW THE ADA DAM|var=riverInfo>, 
THE POTOMAC RIVER BELOW THE ADA DAM is directed to riverInfo. Such text is referred 
to as <variable name> substitution text hereafter, e.g., riverInfo substitution text.

In the bullet of each dam, there are seven VAR substitutions. The variable names into which the 
substitutions text is directed are as follows: riverInfo, damInfo, countyInfo, stateInfo, cityInfo, 
addInfo, and coords, respectively. All seven VAR substitutions must be included.

Refer to Text Templates [http://www-
sdd.fsl.noaa.gov/~ramer/noaa/wgnDesign/TextTemplate.html] for more details on bullets, 
substitutions, and variables.

• commonAddInfo, addInfo, and scenario:

◦ commonAddInfo substitution text precedes addInfo substitution text

The commonAddInfo is defined in lines 1-3 of LWX-dam_info.txt, which is used for all 
dams for site LWX. The addInfo is defined in the DAMNAME bullet in (refer to Exhibit 
6.4-3, lines 11-13), and in the SCENARIO bullets in (refer to Exhibit 6.4-3, lines 18-22, 23-
27, 28-32, and 33-37) for the Ada dam). There could be no SCENARIO at all. Although 
commonAddInfo is defined before addInfo in the dam info file, addInfo substitution text 
(marked in the black box) precedes commonAddInfo substitution text (marked in the blue 
box), in the warning text, as shown in Exhibit 6.4-5.

Note 3: Test mode was not used when creating the screen shots for this document. If it 
is used, the following sentences will be inserted in the warning text: “...THIS 
MESSAGE IS FOR TEST PURPOSES ONLY...”, “THIS IS A TEST MESSAGE”, 
and “THIS IS A TEST MESSAGE, DO NOT TAKE ACTION BASED ON THIS 
MESSAGE”. 
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Exhibit 6.4-5. AddInfo Substitution Text Precedes commonAddInfo Substitution Text

◦ scenario

The scenario substitutions are defined for the Ada dam (refer to Exhibit 6.4-3, lines 18-22, 
23-27, 28-32, and 33-37). Having SCENARIO bullets in the dam info file is optional.

◦ addInfo substitution text override

If a SCENARIO is defined in the dam info file and the scenario is selected, its corresponding 
scenario substitution text overrides the addInfo substitution text defined in DAMNAME. For 
example, when a threat level is increased and "high fast" is selected, the statement in the 
blue box replaces the statement in the black box, as shown in Exhibit 6.4-5.

• ruleOfThumb: The ruleOfThumb (ROT) substitution is intended to provide the basis for the 
statements in the scenarios. The substitution text (refer to Exhibit 6.4-4, lines 67-71) is such an 
example. Having a ROT bullet in the dam info file is optional. 

• coords:

◦ Format and unit

The coords substitution text is the coordinates, in latitude and longitude, of the vertices of 
the polygon that outlines a dam break threat area. The coordinates are listed in hundredths of 
a degree, with no minus sign for west longitude.
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WARNING: && must be placed at the end of the coordinates (refer to Exhibit 6.4-3, 
line 16) in order for them to be handled correctly by the software. 

◦ Get coordinates of vertices of a polygon

If you know the dam break threat area and can outline it with a polygon, the existing D2D 
capability of lat/lon readout can be used to get the latitude and longitude values of each 
vertex of the polygon. Then, they can be stored in the dam info file. The procedure is as 
follows:

a. Select non-convective FFW (Dam Break) in WarnGen. A square will appear.

b. Manipulate the polygon to outline the threat area; drag it around, add or move vertices.

c. When the threat area is well outlined by the polygon, activate the sampling capacity of 
D2D by selecting Lat/Lon Readout from the button 3 pop-up menu, and then bringing 
up the pop-up again and toggling on Sampling.

d. Open your dam info file, LLL-dam_info.txt, with vi or another editor. 

e. Obtain the lat/lon values of each vertex by moving the cursor over the center of the 
vertex one by one clockwise.

f. While moving the cursor, read latitude/longitude on screen and enter them in the dam 
info file; enter latitude first, then longitude, and ignore the floating point. For example, 
enter 3820 for 38.20N and 7817 for 78.17W. Each datum should be separated by a 
space.

Note 4: If a dam break threat area, outlined by a polygon, covers more than one county, 
the names of all counties must be included in the countyInfo substitution text. 
Otherwise, the warning text will generate error messages when it goes through format 
checking. HOWARD DAM is an example dam break threat area that covers both 
Montgomery County, Maryland and Loudoun County, Virginia. The format for 
countyInfo that has more than one county is shown in Exhibit 6.4-4, lines 44-48. 

Note 5: IN CENTRAL VIRGINIA follows LOUDOUN COUNTY, the first of the two 
counties; ...&~~ precedes the name of the second county; and the name of the state to 
which the second county belongs is listed in the stateInfo substitution text, as shown in 
Exhibit 6.4-4, line 49. 

Creating a Dam Break FFW or FFS

CAUTION: As with any WarnGen testing, you should put the workstation in the Test or the 
Practice mode before proceeding. Refer to Section 6.2. 
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1. To create an FFW or FFS warning product with the new options of PRIMARY CAUSE:

1. In the WarnGen GUI, select non-convective FFW or FFS (Dam Break) from the Other 
Product type options field.

2. Select either “dam break – imminent failure” or “dam break – failure has occurred” under 
PRIMARY CAUSE.

3. Select one reporter in DAM FAILURE REPORTED BY.
4. Select a dam, e.g., Ada dam (Montgomery).
5. Optionally, select a SCENARIO, e.g., high fast under Ada dam.
6. Optionally, select rule of thumb under the selected dam (refer back to Step 4).
7. Click on the Dam Break Threat Area button and observe the location of the polygon in the 

D2D main pane, as shown in Exhibit 6.4-6.
8. Optionally, select option(s) in CALLS TO ACTION.
9. Click Create Text. The warning product should appear in a pop-up Text WarnGen window 

on the text workstation.

Note 6: The selection of a SCENARIO is not forced to be associated with the selected dam by the 
current software design, so make sure a scenario under the selected dam is selected. Selecting a dam 
and then a scenario under an unselected dam will result in incorrect warning text. The same is true 
for ROT; i.e., the ROT selected should be under the selected dam. 

Exhibit 6.4-6. Dam Break Threat Area Outlined By a Polygon 
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6.5 Reserved
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6.6 Practice Module (Tutorial): Placing WarnGen in Practice Mode

Objective: Place WarnGen in Practice Mode in order to keep the communication in-house and 
not have the warning broadcast to the public. 

Refer to Exhibits 6.6-1 and 6.6-2 when performing the steps included in this tutorial. The numbers 
shown on the exhibit correspond to the numbered steps. Callouts are provided to aid in identification 
of components.

Exhibit 6.6-1. Placing WarnGen in Practice Mode
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Exhibit 6.6-2. CAVE and WarnGen Dialog in WarnGen Practice Mode

1  On the graphics display, close CAVE if it is open and return to the Red Hat desktop.

2  Go to the GNOME Panel along the bottom of the desktop and click mouse Button 1 (B1)
on the AWIPS menu icon to open the AWIPS Start Menu. Select the AWIPS start-up menu
option to open a list of options.

3  Select Test Mode Control Program to open the Test Mode Control dialog box. Note that 
the default Operational Mode is active.

4  Change to the Practice Mode by selecting the Change Mode to Practice (In House)
button. The following occur: 

4a  The Test Mode Control dialog changes from Operational Mode to Practice Mode (In 
House).

4b  A flashing orange-colored indicator labeled Practice Mode (In House) appears on 
the display to indicate the mode is active.

4c  When you open CAVE-D2D, the CAVE screen, Toolbar, and CAVE Perspectives 
Tab Bar will be colored orange.

4d  When you select the WarnGen button, the WarnGen dialog will be colored orange.
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CAUTION: If the screen, tool bars, and WarnGen dialog box are not colored 
orange when you open CAVE, then you are not in the Practice Mode and you 
should not perform any WarnGen activities. Repeat the steps for placing WarnGen 
in Practice Mode. 

5  Orange indicates you are in WarnGen Practice Mode. You can now perform WarnGen 
activities. All communications will be retained in-house and will not be sent out to the public.

6  Close CAVE when you have finished practicing WarnGen and return to the Test Mode 
Control Program dialog to change the system to the default Operational Model.
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7.0 The Interactive NsharpSkewt (NSHARP) Application

The Interactive NsharpSkewt (NSHARP) program is integrated into the CAVE interface and allows 
you to modify a sounding and/or hodograph to derive various thermodynamic quantities. This 
implementation enables you to obtain a better understanding of the current and future states of the 
atmosphere. 

Note: This discussion assumes that you have at least a fundamental understanding of both the 
Skew-T log-p thermodynamic diagram and the hodograph. 

Through NSHARP, you can modify the temperature, dewpoint, and/or hodograph profiles either by 
using the cursor or by manual entry in a dialog box; lift a modified air parcel and immediately see a 
listing of the modified convective parameters; and interactively sample the sounding itself. The basic 
premise of the program is to assume constant pressure while interactively editing the data points.

Because the NSHARP program is integrated into the CAVE interface, you can perform display 
manipulations such as looping, stepping, and swapping. Also, in the event that an incomplete 
sounding is plotted, but mandatory and significant level data are available in the text database, you 
can enter the missing data points using NSHARP and obtain the thermodynamic and stability 
variables.

This chapter includes the following sections:

• Section 7.1: Starting the NSHARP Application

• Section 7.2: The NSHARP Interface, NSHARP(D2D) Functions Panel, and SPC Graphs Panel

• Section 7.3: Sampling and Editing Sounding Profiles

• Section 7.4: Reserved
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7.1 Starting the NSHARP Application

The NSHARP application starts when you display at least one sounding from the Upper Air pull-
down menu, as shown in Exhibit 7.1-1. Loading the sounding opens the NSHARP interface, as 
shown in Exhibit 7.1-2 or Exhibit 7.1-3, depending on the Display Pane Configuration that is set up 
on your Workstation. You can load other soundings from the Upper Air menu after the NSHARP 
interface is open, as well as change the display configuration.

Exhibit 7.1-1. Selecting a Sounding from the Upper Air Menu
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Exhibit 7.1-2. NSHARP Interface - D2D Skewt Standard Screen Configuration
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Exhibit 7.1-3. NSHARP Interface - SPC Wide Screen Configuration

You can close NSHARP and clear it from the Main Display Pane by clicking the "X" on the 
NsharpEditor tab, or by clicking the Clear button on the Toolbar. Both actions will close NSHARP. 
However, if you want the NSHARP GUI and the NSHARP(D2D) functions panel to disappear from 
the Main Display Pane and run in the background, click on the Map tab, but be sure not to click the 
"X" on the Map tab, which will close the map. You can restore both the NSHARP GUI and the 
NSHARP(D2D) functions panel by clicking on the NsharpEditor tab, but be sure not to click the "X" 
on the NsharpEditor tab, which will close NSHARP completely.

Note: If you inadvertently close the NSHARP(D2D) functions panel by clicking on the "X" on 
the NSHARP(D2D) tab while the NSHARP GUI is displayed, you can restore it without closing 
NSHARP and losing your work. Click the Map tab and then click the NSHARPEditor tab to 
return the NSHARP GUI to the Main Display Pane with the NSHARP(D2D) functions panel 
restored. NSHARP will be restored to the place it was when the panel closed. 
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7.2 The NSHARP Interface, NSHARP(D2D) Functions Panel, and SPC Graphs 
Panel

This section provides an overview of the NSHARP interface, and operation of the NSHARP(D2D) 
functions panel, shown on all NSHARP display configurations, and the SPC Graphs panel, shown 
only on the SPC Wide Screen configuration.

Note: The NSHARP(D2D) functions panel: The number of rows and the number of buttons 
displayed on each row vary, depending on the width of your screen. 

The subsections that follow describe the NSHARP GUI, NSHARP(D2D) functions panel, and SPC 
Graphs panel in greater detail.
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7.2.1 The NSHARP Interface

The NSHARP application interface is comprised of:

• The Skew-T Diagram

• The Hodograph Diagram

• Selected Soundings and Time Lines (Frames)

• Data Parameters

• Inset Diagrams

Skew-T Diagram

The NSHARP Skew-T diagram is shown in Exhibit 7.2.1-1. The temperature is represented by the 
solid red line, the dewpoint by the solid green line, the wetbulb by the solid cyan line, the virtual 
temperature by the dashed red line, and the lifted parcel profile by the dashed white line. 

Exhibit 7.2.1-1. NSHARP Skew-T Diagram

Hodograph Diagram

The NSHARP hodograph diagram is shown in Exhibit 7.2.1-2. The hodograph is drawn with height 
color coding: solid red line for below 3000 feet (3 Kft) above ground level (AGL); solid green line for 
3 to 6 Kft AGL; solid "Yellow" line for "6 to 9 Kft" AGL; solid cyan line for 9 to 12 Kft AGL; and 
solid purple line for above 12 Kft AGL. The yellow rectangle represents the mean wind vector. The 
30/70 and 15/85 storm motion vectors are marked by small pink and dark red ellipses (not shown in 
Exhibit 7.2.1-2). The user moveable storm motion vector is marked by a large white ellipse (also not 
shown in exhibit). 
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Exhibit 7.2.1-2. NSHARP Hodograph Diagram

Selected Soundings and Time Lines (Frames)

The stations (listed by Site ID) are derived from the soundings selected from the Upper Air menu. 
They are listed in alphabetical order, and not in the order in which they were selected, as shown in 
Exhibit 7.2.1-3.

Exhibit 7.2.1-3. Identifying State and Status of Selected Soundings

Note 1: Click mouse Button 1 (B1) on a "time line" or "station" item to toggle state between 
active (yellow) and current (green). Click Shift + B1 to toggle state between active (yellow) and 
inactive (white). 

Data Parameters — Next Data

A collection of calculated values is provided in text panels for the currently displayed station. The 
values are grouped into ten pages, as shown in Exhibit 7.2.1-4. You can cycle through the pages 
using the Next Data button on the NSHARP(D2D) functions panel. 

Note 2: The data parameters and value ranges are not defined in this document. It is assumed 
that the meteorologists using this manual know the meaning and value ranges of these 
parameters. 
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Exhibit 7.2.1-4. Data Parameters Pages 1 - 10

Inset Diagrams — Next Inset

There are two pages of Inset diagrams, as shown in Exhibit 7.2.1-5. You can cycle through the pages 
using the Next Inset button on the NSHARP(D2D) functions panel. 

Exhibit 7.2.1-5. Inset Diagrams Pages 1 - 2
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7.2.2 The NSHARP(D2D) Functions Panel

The buttons on the NSHARP(D2D) functions panel, shown in Exhibit 7.2.2-1, enable the forecaster 
to control the NSHARP environment for the selected interactive NSHARP sounding.

Exhibit 7.2.2-1. NSHARP(D2D) Functions Panel 

Note 1: The buttons that have two mode positions — (off) or (on) — will show the current mode 
on the label of the button. For example, if EditGraph(off) is displayed on the button, as shown in 
Exhibit 7.2.2-1, it means the Skew-T and hodograph diagrams are not editable at this time. 
EditGraph(on) would indicate the diagrams are editable. 

The buttons associated with all parts of the NSHARP(D2D) functions panel are described below.

Load

Selecting the Load button opens the Open dialog box where you can open a saved Skew-T that was 
edited in the past. 

Save

Selecting the Save button opens the Save Text Data dialog box, which allows you to save an edited 
Skew-T. 

Configure

Selecting the Configure button opens the NSHARP Configuration dialog, as shown in Exhibit 
7.2.2-2. As illustrated in Exhibit 7.2.2-2, the nine options allow you to control what is displayed on 
the Skew-T diagram, changing the default setup to customize to your preference.
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Exhibit 7.2.2-2. NSHARP Configuration Dialog Options
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Reset

Selecting the Reset button restores the sounding to the original (initial) Skew-T and hodograph 
settings and values, and diagrams to their initial size and alignment.

Reset Display

Selecting the Reset Display button restores all the panels that comprise the NsharpEditor to their 
original size and alignment. When zooming into a specific section of diagram, graph, or table, and 
repositioning the display to improve the view of the information presented, selecting the Reset 
Display button restores all the the panels to their original size and alignment.

Parcel

Selecting the Parcel button opens the Parcels Display Configuration dialog, shown in Exhibit 7.2.2-3, 
which allows you to define the parcel display parameters that are shown on the data parameters page 
for Parcel Data. (Refer to Exhibit 7.2.1-4 (Page 2), which reflects the “Most Unstable Parcel” radio 
button selected in Exhibit 7.2.2-3.)

Exhibit 7.2.2-3. Parcels Display Configuration Dialog

Next Data

Refer to Subsection 7.2.1 for a description of this function.

Next Inset

Refer to Subsection 7.2.1 for a description of this function.

Interp(off)/Interp(on)

Switching from Interp(off) to Interp(on) populates the Skew-T diagram grid with the most current 
temperature and dewpoint data traces. 
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Note 2: The text values in the "Show Text" display will also change as you change the mode of 
the interpolation button. 

Ovrlay2(off)/Ovrlay2(on)

Switching from Ovrlay2(off) to Ovrlay2(on) overlays the current and previous sounding temperature 
and dewpoint data time traces on the Skew-T diagram for the current station. 

CompStn(off)/CompStn(on)

Switching from CompStn(off) to CompStn(on) adds all the data paths (temperature, dewpoint, and 
wetbulb) for all the active stations (shown in yellow text) to the current station's data paths on the 
Skew-T and hodograph diagrams for comparing purposes. Inactive or unloaded stations will not 
display. 

Note 3: CompStn(off/on) only works with the Skew-T (S) display. The button is grayed out 
when switched to the Turbulence (T) or Icing (I) displays. 

CompTm(off)/CompTm(on)

Switching from CompTm(off) to CompTm(on) adds the data paths (temperature, dewpoint, and 
wetbulb) for all the active timelines (shown in yellow text) to the current station's data paths on the 
Skew-T and hodograph diagrams for comparing purposes. Inactive or unloaded time lines will not 
display. 

Note 4: CompTm(off/on) only works with the Skew-T (S) display. The button is grayed out 
when switched to the Turbulence (T) or Icing (I) displays. 

Note 5: The overlay (Ovrlay2), station comparison (CompStn), and time line comparison 
(CompTm) functions cannot work at the same time. When one function is selected, the others 
will be grayed out. 

Edit Data

Selecting the Edit Data button opens the Sounding Data Editor dialog, shown in Exhibit 7.2.2-4. The 
Sounding Data Editor dialog allows you to change the values for atmospheric parameters. 
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Exhibit 7.2.2-4. Sounding Data Editor Dialog 

EditGraph(off)/EditGraph(on)

Switching from EditGraph(off) to EditGraph(on) makes the Skew-T and hodograph diagrams 
interactive. Observe the small circles along the data paths when the diagrams are in interactive mode, 
as shown in Exhibit 7.2.2-5. 
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Exhibit 7.2.2-5. Changing from EditGraph(off) to Interactive EditGraph(on) Mode 

Show Text

Selecting the Show Text button opens a non-editable Sounding Text dialog listing the parameter 
values for the active sounding for the current frame, as shown in Exhibit 7.2.2-6. Text values in the 
display will automatically be updated whenever the sounding profile is altered. Clicking the SAVE 
button in the text panel will output the data to a user-designated file in the current working directory. 
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Exhibit 7.2.2-6. Sounding Text Dialog 

Display Modes

There are three NSHARP display modes:

• S: Standard Skew-T Display

• T: Turbulence Display

• I: Icing Display

The different NSHARP display modes are illustrated in Exhibit 7.2.2-7. 
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Exhibit 7.2.2-7. NSHARP Display Modes 

Print

Selecting the Print button opens the Print dialog. 
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7.2.3 The SPC Graphs Panel

The buttons on the SPC Graphs panel shown in Exhibit 7.2.3-1 enable the forecaster to graphically 
display the statistical information for the selected NSHARP sounding.

Exhibit 7.2.3-1. Location of SPC Graphs Panel and Statistical Graphs on NSHARP Display 

Only two graphs are displayed on the NSHARP display at any given time, and the graphs are only 
shown on the SPC Wide Screen configuration. However, there are a total of seven SPC graphs, as 
shown in Exhibit 7.2.3-2.

As of the release of this edition of the User's Manual, four of the SPC graphs (WINTER, FIRE, 
HAIL, and SARS) were still under development, as shown in Exhibit 7.2.3-2. 
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Exhibit 7.2.3-2. SPC Graphs
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7.3 Sampling and Editing Sounding Profiles

The NSHARP Skew-T and hodograph diagrams use the same method for editing a sounding profile. 

There are two ways to edit a sounding profile: 

1. Interactively move or add data points on the temperature or dewpoint profiles, made 
interactive via the EditGraph(on) button on the NSHARP(D2D) functions panel.

2. Manually by entering values in the Sounding Data Editor dialog box accessed from the 
NSHARP(D2D) functions panel via the Edit Data button.

Sampling Data

Move the mouse cursor (arrow) over the Skew-T (or hodograph) diagram and observe the sampling 
data readout displayed on the diagram next to the cursor, as shown in Exhibit 7.3-1. 

Exhibit 7.3-1. Skew-T Sampling Data Readout 

Interactively Editing a Sounding Profile

Follow the procedures below to perform the interactive editing function.

1. Select Edit Graph mode: On the NSHARP(D2D) functions panel, switch EditGraph(off) to 
EditGraph(on).

2. Enlarge the Skew-T or hodograph diagram: Use the zoom function to obtain a better view of 
the sounding profile. If you have a 2-button mouse with clickable scroll wheel, use either of the 
following two methods to enlarge the diagram. If you don't have a clickable scroll wheel, use 
the first method. 

◦ Position the mouse cursor (arrow) over the Skew-T or hodograph diagram and click and 
hold mouse Button 3 (B3) to open the pop-up menu. Then select Zoom > 6.3X, or any 
other zoom value from the list. You can then advance to the next highest value by 
incrementally clicking mouse Button 2 (B2) with the mouse cursor positioned over the 
diagram. To zoom back out, reopen the pop-up menu and select a lower zoom value. 
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◦ Position the mouse cursor (arrow) over the Skew-T or hodograph diagram and use the B2
scroll wheel to zoom both in and out. 

3. Relocate a Point: Move the mouse cursor (arrow) over a data point. Notice that, by clicking 
and holding mouse Button 1 (B1) on either the temperature or the dewpoint line, you can drag 
the point to a new position. Remember that the data point is constrained to maintain its original 
pressure. The software keeps the new temperature value but automatically keeps the point on 
the original pressure level. The software also prevents you from crossing the temperature and 
dewpoint profile lines.

4. Add a Point: Adding a point to the temperature or dewpoint line is simple. Place the mouse 
cursor (arrow) on the line. Then click B2 to create a new point. Then clicking B1 on that same 
point, you can drag it to a new location. You are constrained to stay within the two neighboring 
data points. Once you release B1, the new point remains at the new location. If you add a new 
temperature point, a corresponding dewpoint value, interpolated from existing data points, 
appears on the dewpoint profile automatically. To remove a point from the sounding, click B2
on a data point.

5. Move a Profile: Moving the entire temperature or dewpoint temperature profile is also simple. 
Move the mouse pointer over the profile; notice that the pointer changes to a finger-pointing 
hand. Click and hold B1, and drag the mouse to move the entire line.

Manually Editing a Sounding Profile

Follow the procedures below to perform the manual editing function.

1. Select Edit Data mode: On the NSHARP(D2D) functions panel, click the Edit Data button to 
open the Sounding Data Editor dialog box. It is here that you change parameters.

2. Apply changes: When finished changing parameters, click the Apply button. The Skew-T 
display and hodograph diagram profiles change accordingly and the parameter data panels also 
change to reflect the manually changed parameters. The Sounding Data Editor dialog box 
closes. 

3. Restore settings: On the NSHARP(D2D) functions panel, click the Reset button to return the 
data to the original settings.

Page 2 of 2

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



7.4 Reserved
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8.0 Radar Applications

The radar applications allow you to interact with the Open Radar Products Generator (ORPG) to 
schedule or request radar data collection, provide automated interpretations of data, and modify some 
of the radar display settings.

As you interact with the various radar applications, radar status messages appear on the AlertViz 
Status Bar. Please refer to the AWIPS II System Manager's Manual (SMM) for further information on 
these messages.

This chapter includes the following sections:

• Section 8.1: Alert Request

• Section 8.2: RPS List Editor

• Section 8.3: One Time Request

• Section 8.4: Radar Multiple Request

• Section 8.5: Radar Display Controls

• Section 8.6: Dual-Polarization

• Section 8.7: Reserved

Page 1 of 1

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



8.1 Alert Request

The Alert Request application lets you request special notifications from the RPG when certain radar-
derived variables exceed user-specified thresholds. For example, you can specify a threshold of 50 
decibels (dBZ) within a 15-mile Alert Area surrounding a major city. Then, an Alert Visualization 
message notifies you when the radar detects 50 dBZ echoes.

From the Alert Request dialog, shown in Exhibit 8.1-1, you can select the desired radar, edit the Alert 
Area, and define the categories and thresholds for the Alert Request messages.

Exhibit 8.1-1. Alert Request Dialog

This dialog is opened from the Radar menu or the kxxx menu and has the following options:

Add

The Add menu button on the Alert Request dialog opens the Add Request Definitions dialog.

This dialog contains the following options.

• Category: This option lists available Alert Adaptation Parameters.

• Threshold: This option lists Threshold Codes that can be set to flag the desired data. The threshold 
options vary depending on the category chosen.

• Request Product: This option tells the RPG whether to generate a product (image or graphic) 
when the threshold is exceeded. The product depends on the category in question.

Remove

This menu button removes a selected radar product from the Alert Request list.

RPG
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This options menu opens a list of available RPGs. You can send a request to only one RPG at a time. 
There are two Alert Areas for each radar. When a new RPG is selected, the main D2D display pane is 
cleared and the Alert Area and category/threshold settings for that RPG are displayed.

Clear

This menu contains options to clear products or Alert Areas for the currently selected RPG and Alert 
Area, or to clear globally. A Global Clear operation clears all product and Alert Area settings for all 
radars.

Alert Area #1 and #2

These radio buttons are used to toggle on an Alert Area. Once you select an area, it is displayed in the 
large pane, and the category/threshold settings for that area are displayed in the Alert Request dialog.

Send Request

This menu button submits the alert request to the selected RPG and saves the current Alert Area and 
threshold settings.

Status messages appear on the AlertViz Status Bar to notify you that your request was sent. When the 
radar detects your specified thresholds, an Alert Visualization message automatically appears on the 
display.

Revert

The Revert menu button opens the Revert dialog, which confirms your intent to restore the previous Alert 
Areas and category and threshold settings to the display. When you select OK, the display clears and the 
previously saved Alert Areas and category/threshold settings are restored and displayed.

Load/Edit Area

This menu button displays either Alert Area #1 or Alert Area #2, whichever radio button is selected. 
Once an Alert Area is displayed, you can modify it using the following information.

• Editing the Alert Area: Editing the Alert Area involves the use of the pop-up menu over the large 
display pane. (Refer to Subsection 2.2.8 for more information on pop-up menus.) 

Once you have displayed Alert Area #1 or Alert Area #2, the legend indicates whether the graphic 
is editable. Clicking mouse Button 2 (B2) on the legend makes the selected area editable. Clicking 
and holding mouse Button 3 (B3) over the display opens the pop-up menu. In addition to the 
commonly available options, the options specifically added for Alert Area editing are Select 
Location and Select Area.

◦ Select Location: This option places an alert cell, as shown in Exhibit 8.1-2, at the cursor 
location. 
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Exhibit 8.1-2. Place Alert Cells with Mouse Button 3

Clicking mouse B3 in the Main Display Pane places alert cells over the graphic at the 
location of the mouse pointer. To remove cells, click B3 over the cells you wish to remove.

◦ Select Area: The Select Area menu option allows you to choose an area using a Stretch 
Rectangle tool (responds like a stretch "rubberband" tool), as shown in Exhibit 8.1-3, that is 
activated from a pop-up menu. The rectangle automatically fills in or clears alert cells, 
depending on whether the initial selection point is empty or has a dot in it. 

Exhibit 8.1-3. Select Alert Area with Stretch Rectangle Tool

Note: Another way to select an area is by pressing and holding the Shift Key on the 
Keyboard while clicking B3 to obtain the Stretch Rectangle tool. 

Exit

Exit is the menu button that closes the Alert Request dialog. If you have not sent a request, a Warning 
dialog appears and gives you the options to cancel and return to the editor, save before exiting, revert 
before exiting, or send a request and save the settings before exiting.
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8.2 RPS List Editor

The primary function of the RPS List Editor is to create or edit a list of radar products (up to 50 for a 
56 Kbps line, up to 31 for a 14.4-Kbps line, up to 20 for a 9.6-Kbps line) and send the list to a WSR-
88D RPG for display in the next radar Volume Scan(s). The RPS List Editor is accessed from the 
D2D Radar menu, as shown in Exhibit 8.2-1.

Exhibit 8.2-1. RPS List Editor Option on Radar Menu

The RPS List Editor dialog shown in Exhibit 8.2-2 lets you view current RPS lists, open other lists, 
create new lists, and edit existing lists. For sites with more than one radar, you need to select an RPG 
using the Select an RPG dialog (see the discussion of the RPS List Editor "View" option in this 
section).
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Exhibit 8.2-2. RPS List Editor Dialog

The RPS List Editor dialog is comprised of menus and buttons. A description of each follows.

File

The File menu shown in Exhibit 8.2-2, includes the following options:

Exhibit 8.2-3. RPS List Editor — File Menu

• New...: This menu option lets you open a new RPS list. 

• Open...: This menu option opens a list of previously built RPS lists. Choose one from the list or 
type the filename in the command line. 

• Save: This option saves the current RPS list. 
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• Save As...: If it is a newly created RPS list, a Save As dialog appears, where you can type a 
new name. 

• Exit: This option closes the RPS List Editor dialog. 

List

The List menu (not shown) includes the following options.

• Add product...: This option opens the Add Product dialog (see the discussion of the RPS List 
Editor "Add" option in this section).

• Edit product...: This option allows you to edit the selected product. (A selected product is one 
you have highlighted by clicking on its name in the list.) 

• Remove product: This option removes the selected product. 

• Send list...: This option allows you to send the displayed RPS list to an RPG. 

View

The View menu as shown in Exhibit 8.2-4, includes the following options.

Exhibit 8.2-4. RPS List Editor — View Menu

• Current List: This menu option displays the RPS list that is currently being used by the RPG. 
Most offices can view lists from associated radars that are included in the Select an RPG dialog. 

• Clear Air Lists: This menu option displays RPS lists that contain products used in Clear Air 
Mode. Once you select one of these lists, the Select an RPG dialog appears. From this dialog 
box, you choose the desired radar. 

• Storm Mode Lists: This menu option displays RPS lists that contain products used in Storm 
Mode. When selected, the Select an RPG dialog appears. From it you choose the desired radar.
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Add

Selecting the Add button brings up the Add Product dialog.

This dialog presents you with a list of products that may be added to the RPS list, along with relevant 
parameters. For example, if you add a reflectivity product to the list, you are also asked to select 
elevation angle, data levels, and resolution. 

Note 1: For Super Res products, there is only one choice of data levels and resolution, so you are 
not asked for those. 

Edit

This option allows you to edit a product selected from the RPS list. This dialog behaves in the same 
manner as the Add Product dialog.

Remove

This option removes a selected product from the RPS list. 

Send

Once you have created or edited an RPS list, you send it to the RPG by clicking on the Send button. A 
dialog appears, asking you to select the RPG you want to send the list to (that is, which radar). 

Note 2: The RPS list that you send may be modified to meet the requirements for Central Radar 
Collection. Verify your RPS by viewing the current list. You may need to edit your list to ensure 
the highest priority products are present. 
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8.3 One Time Request

The One Time Request (OTR) application enables you to specify a nonroutine radar product (image 
or graphic) and send a request message to the RPG to generate this product for up to nine Volume 
Scans. It is through this application that you can generate radar cross sections. You must specify 
which RPG is to receive the request, and specify the relevant parameters of the desired product. Then 
you send the request message to the radar.

A message appears in the Radar portion of your Alert Visualization Popup Message Dialog window 
indicating that your requested product has been sent by the RPG.

The One Time Request dialog, as shown in Exhibit 8.3-1, includes several options. A description of 
each follows the exhibit. 

Note: Exhibit 8.3-1 is valid for reflectivity. Different products will bring up other options. 

Exhibit 8.3-1. One Time Request Dialog

Repeat count:

This menu button opens a list, numbered 1 through 9, which tells the RPG how many upcoming 
Volume Scans should include the newly added radar product. 

RPG:

This menu button opens a list of RPGs. You may send a request to only one RPG at a time. If you 
wish to send a request to multiple RPGs, use the RMR application, which is covered in Section 8.4. 
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Product:

This menu button opens a list of radar products, as shown in Exhibit 8.3-2. The radar products listed 
here should be familiar to WSR-88D users. Each product has certain parameters that you must specify 
in your request. Once you select a product, the One Time Request dialog adjusts to make these 
parameters available.

Exhibit 8.3-2. Radar Products

Priority:

This menu button allows you to select a normal or high priority for the request. The button is not 
available for nonassociated RPGs. 

Request interval:

This slider bar contains a range of numbers. Each number represents an interval of Volume Scans that 
can be selected. For example, a "3" indicates that you wish to have your requested radar product 
generated every third Volume Scan. 

Elevation(s):

Elevation(s) includes two dropdown list boxes for specifying elevation angles, as shown in Exhibit 
8.3-3. 
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Exhibit 8.3-3. Elevation(s) List of Options

Variant:

This menu button opens a list of data levels and associated radar data resolutions/kilometers, as shown 
in Exhibit 8.3-4. 

Exhibit 8.3-4. Variant List of Options

Time:

There are three time settings that let you request and view older radar data. The product is generated 
by the RPG from stored raw data.

• Current: The requested product will be from the most recent (real time) Volume Scan.

• Latest: The requested product will be from the latest Volume Scan, whether the data are 
current or archived.

• Selected: This radio button activates the Change... button for opening the Set Time dialog. 

Change...:

This button opens the Set Time dialog, as shown in Exhibit 8.3-5, where you can either set the 
current real time or change the time, which lets you access radar data from earlier Volume Scans.
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Exhibit 8.3-5. Set Time Dialog with Set time Radio Button Selected

Close

This button closes the One Time Request dialog.

Send

This button sends the requested products message to the RPG.
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8.4 Radar Multiple Request

The Radar Multiple Request (RMR) application allows you to specify up to eight consecutive hours 
of automatic non-routine radar product requests from dedicated and/or dial-out radars. Not only are 
you able to obtain and view non-routine radar products from various RPGs with this application, but 
you can also use these data to generate Radar Mosaics.

The RMR dialog, as shown in Exhibit 8.4-1, is divided into two parts: Existing Requests, described in 
Subsection 8.4.1; and Active Requests, described in Subsection 8.4.2.

Exhibit 8.4-1. Radar Multiple Request (RMR) Dialog
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8.4.1 Existing Requests

Once products have been requested, this area of the Radar Multiple Request dialog contains a tree-
view listing of the existing RMR. (This area is empty if no radar products have been chosen.) The 
request name is denoted with a book symbol. Click on the "+" symbol next to the request name to 
expand the tree-view and view the contents of the request. If a request has a red "X" through the book 
symbol, it means that the request is poorly formed. That is, the request is missing either an RPG or a 
product, making it unable to work properly. 

Each radar product within a request is denoted with a folder symbol. Click on the "+" symbol next to 
the radar product name to reveal the list of RPGs from which the product is sent. The phone symbol 
next to an RPG denotes a dial-out radar, while an arrow denotes a dedicated radar. Click on the "-" 
symbol next to each product or request name to close the expanded tree-view listings. 

New Request

This button opens the Edit Request dialog, as shown in Exhibit 8.4.1-1. Both new requests and edited 
requests use the same dialog. It contains options for selecting and requesting a radar product from one 
or more RPGs.

Exhibit 8.4.1-1. Edit Request Dialog New Requests

The Edit Request dialog has the following options (the Existing Request section of the RMR dialog 
also contains these options):

• Name: In this entry line you can type a unique name to identify your radar request.

• Single Request: This radio button limits the radar request to one product retrieval.
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• Multiple Request: Choose this radio button if you want to repeat a radar product request.

• Repeat every: You can choose the update frequency of your product request by using the 
minute(s)/hour(s) option menus, or by typing the time interval in the entry boxes.

• Duration: Within these entry boxes you can choose up to 8 hours of consecutive requests.

• Cancel: This menu button closes the New Request dialog without initiating any requests.

• OK: This button acknowledges the entry you have made, closes the New Request dialog, and 
immediately opens the Add Products dialog.

Copy Request

This button opens the Copy Request dialog, which allows you to copy the existing highlighted request 
and give it a new name in the entry line provided. This button is disabled if nothing is currently 
selected in the tree view.

Add Products

This button opens the Add Products dialog. This button is disabled if nothing is currently selected in 
the tree view.

The Add Products dialog the following options: 

• Dial-out RPGs: This is a list of available dial-out radars. Click mouse Button 1 (B1) on the 
desired RPGs.

• Dedicated RPGs: This is a list of available dedicated radars. Click B1 on the desired RPGs.

• Product: This option contains a list of radar-generated products that should be familiar to 
WSR-88D users. Each product has certain parameters to specify in your request.

• Request Interval: (1-9)

• Add: This button adds the selected products to your request. The Add Products dialog remains 
open when you add a product so you may add multiple products without having to reopen it 
each time.

• Close: This button closes the Add Products dialog.

Note 1: The contents of the Add Products dialog box vary depending upon the products. Possible 
options and parameters are listed as follows:

1. Elevation Angle (0.5-19.5 degrees) 7. Contour Interval (2,000 - 30,000 ft)
2. Data Levels (8 or 16) 8. Altitude (0-70 thousand feet [kft])
3. Resolution (1, 2, or 4 km) 9. End Hour and Time Span
4. Speed 10. Channel Map
5. Dir 11. Elevation Segment Number
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6. Layer

Edit

This button is context sensitive. That is, what you edit depends upon what you select in the tree view. 
If you highlight a request and press the Edit button, the Edit Request dialog, shown in Exhibit 8.4.1-1
opens (refer to the descriptions listed above under New Request).

Note 2: If a product or RPG is highlighted in the tree view, selecting the Edit button opens the 
Edit Product dialog, which is similar to the Add Product dialog except that it has OK and 
Cancel buttons instead of Add and Close buttons. This allows you to edit the products or RPGs 
that were selected in the tree view. 

Delete

This button is also context sensitive. What it deletes depends on what is highlighted in the tree view. 

• If a request is highlighted and you select the Delete button, a Confirmation dialog box appears 
to confirm your decision to delete the request. 

• If a product within a request is highlighted when you select the Delete button, a Confirmation 
dialog appears to confirm your decision to delete the product within the request.

• If an RPG is highlighted in the tree view when you select the Delete button, the RPG is 
removed from the request.

Submit

This button makes a highlighted request active. This button is enabled only if a request containing at 
least one product is highlighted in the tree view. Observe the AlertViz Status Bar at the bottom of the 
CAVE-D2D display for messages on your request.
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8.4.2 Active Requests

The Active Requests area of the Radar Multiple Request (RMR) dialog contains a tree-view listing of 
the radar product requests that are currently running (see Exhibit 8.4-1). There are two options 
associated with this dialog. 

• Cancel: The Cancel menu button deactivates the highlighted active request. This button is 
disabled if a request is not selected in the Active Requests Tree View.

• Close: The Close menu button closes the RMR dialog.
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8.5 Radar Display Controls

The Radar Display Controls dialog is derived from the Radar Tools submenu, as shown in Exhibit 
8.5-1. It provides options that control the appearance of the Storm Track Information (STI), the Hail 
Index (HI), the Tornado Vortex Signature (TVS), and the Digital Mesocyclone Display (DMD) 
products, along with Storm Relative Motion (SRM) options. The Radar Display Controls dialog box 
options are described below. 

Exhibit 8.5-1. Radar Tools Submenu - Radar Display Controls Dialog

The Radar Display Controls dialog is divided into six sections: STI, HI, TVS, DMD/MD/TVS, DMD, 
and SRM. Each section has the following options:

STI (Storm Track Information)

This section has options to adjust the appearance of the STI graphic product.

• Number of storms to show: This slider bar lets you choose the maximum number of storms (0 
to 100) you wish to display on the STI product. The default value is 20 storms.

• Type of track to show: This options menu allows you to choose the type of storm track that 
you want displayed.

◦ no tracks: When you select this option, only the current storm location(s) are displayed.
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◦ past: When you select this option, the previous location(s) of the storm(s) are plotted 
with small dots.

◦ forecast: When you select this option, the extrapolated forecast positions(s) of the storm
(s) are plotted with small + symbols.

◦ past & fcst: When you select this option, both the previous and the forecast position(s) of 
the storm(s) are displayed. The default track setting is to show both the past and the 
forecast tracks.

HI (Hail Index)

This portion of the Radar Display Controls dialog contains options that alter the appearance of the HI 
radar graphic product. You can set the low and high algorithm thresholds of the Probability of Hail 
(POH) and the Probability of Severe Hail (POSH). Storms that meet the low POH threshold are 
indicated by small open triangles, while small solid triangles mark those that meet the high POH 
threshold. Similarly, large open triangles or solid triangles are plotted for the POSH low and high 
thresholds, respectively.

• Low hail probability (POH): The storms that meet or exceed the threshold are indicated by 
small open triangles. The default setting is 30. 

• Low severe hail probability (POSH): The storms that meet or exceed the threshold are 
indicated by large open triangles. The default setting is 30.

• High hail probability: The storms that meet or exceed the threshold are indicated by small 
solid triangles. The default setting is 50. 

• High severe hail probability: The storms that meet or exceed the threshold are indicated by 
small solid triangles. The default setting is 50. 

TVS (Tornado Vortex Signature)

There is one option in this section of the Radar Display Controls dialog.

• Show elevated TVS: This toggle button lets you control the appearance of the elevated TVS 
radar graphic product.

DMD, MD, TVS

There is one option in this section of the Radar Display Controls dialog.

• Show extrapolated Features: With this option, you can choose whether to show the time-
extrapolated features using DMD, MD, or TVS.

DMD (Digital Mesocyclone Display)
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This section of the Radar Display Controls dialog enables you to control what features are displayed. 
For example, at the default setting of 3, only features with strength 3 (r3) or higher will be shown on 
the display. You can also choose to display the overlapping Mesos. 

• Type of track to show: This options menu allows you to choose the type of storm track that 
you want displayed.

◦ no tracks: When you select this option, only the current storm location(s) are displayed.

◦ past: When you select this option, the previous location(s) of the storm(s) are plotted 
with small dots.

◦ forecast: When you select this option, the extrapolated forecast positions(s) of the storm
(s) are plotted with small + symbols.

◦ past & fcst: When you select this option, both the previous and the forecast position(s) of 
the storm(s) are displayed. The default track setting is to show both the past and the 
forecast tracks.

SRM (Storm Relative Motion)

This section has options to set the storm motion vector. The high-resolution version of the SRM 
product uses the 8-bit velocity for a given tilt and applies a storm motion vector to the field. Options 
for specifying the storm motion vector are:

• Storm Motion from WarnGen Track: The display uses the vector that was last generated 
from either WarnGen or the Distance/Speed Tool. The storm motion vector that is used will be 
shown on the display. If a vector has not been set within the last 24 hours, it will be deemed out 
of date and will not be used. In this case, a zero movement will be used, and you will get an 
indication of this in the upper left corner of the product.

• Average Storm Motion from STI: The display uses the storm motion calculated by the storm 
track algorithm. This motion is available as part of the storm track (STI) product.

• Custom Storm Motion: Selecting this radio button enables the coordinated slider bars used to 
set the direction and speed. 

It is important to note that the user-specified motion vectors, as well as the other settings in the Radar 
Display Controls dialog, are workstation-specific. This means that changes to the number of storms, 
track types, etc., affect all displays on that particular workstation. Once these settings are changed 
from their default setting, they stay that way until changed again. 
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8.6 Dual-Polarization

There are three types of radars for collecting data used in forecasting the weather: WSR-88D (Weather 
Surveillance Radar - 1988 Doppler), TDWR (Terminal Doppler Weather Radar), and ASR (Airport Surveillance 
Radar). The WSR-88D is the only type that has been equipped with the dual-polarization technology. WSR-88Ds 
are only located at Radar Product Generator (RPG) sites, accessed via the CAVE D2D - kxxx menu. The CAVE 
D2D - txxx menu supports Supplemental Product Generator (SPG) sites, which are equipped with TDWR radars, 
and ASRs are FAA radars at airports, which only provide fill-in coverage for the WSR-88D network, and are 
accessed via the CAVE D2D - Radar menu.

Dual-polarization Doppler radars simultaneously transmit and receive pulses that are polarized both horizontally 
and vertically, which enables the radar to measure the horizontal and vertical dimensions of atmospheric targets. 
Conventional Doppler radars transmit and receive only horizontally polarized pulses, which only allow the radar to 
be sensitive to the motions toward and away from the radar. These systems can determine the location of 
precipitative areas, pick up moving targets, and even filter out stationary objects such as buildings and terrain. 
However, even moving targets can cause clutter, and unidentifiable non-weather objects such as birds and flying 
debris compromise the radar data, which has a major negative impact on forecast and warning operations. Thus, 
the conversion of all WSR-88Ds to dual-polarization is a major upgrade, which allows the radar to sense the size 
and shape of objects in the atmosphere, making for reliable identification of weather and non-weather objects.

The WSR-88D with dual-polarization technology greatly improves forecasts and warnings for hazardous weather. 
This capability not only affects meteorologists, but it also has significant impact for hydrologists, aviation users, 
and society. How each of these groups is affected follows.

• Meteorologists:

◦ Improves accuracy in identifying precipitation types, which leads to more accurate winter weather 
forecasts, especially during times of mixed and icy precipitation.

◦ Improves precipitation estimates, which leads to more accurate river forecasts and flash flood 
warnings.

◦ Improves flash flood watches and warnings by distinguishing between very heavy rain and hail, which 
contributes to increased lead time in flash flood and winter weather hazard warnings.

◦ Improves detection of non-weather artifacts, such as birds and ground clutter, which allows forecasters 
to focus on real precipitation radar targets.

◦ Improves hail detection, which leads to increased confidence in the presence and size of hail in strong 
to severe thunderstorms.

◦ Enables the detection of lofted tornado debris, which does not directly lead to improvements in 
tornado warnings, but does provide a higher degree of confidence in a tornado's presence and track 
when significant damage is occurring. This feature is especially beneficial at night, when tornadoes 
are difficult to see. However, to detect the debris, the tornado must be either close to the radar, or if far 
away, the tornado needs to be strong enough to lift debris to the altitude that the radar can see. 

• Hydrologists:

◦ Provides critical rainfall estimation information for stream flow forecasts and river flooding.

◦ Provides information useful in water management.
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• Aviation Users:

◦ Detects aviation hazards such as birds.

◦ Detects aircraft icing conditions.

• Society:

◦ Improves rainfall estimates, which saves public funds.

◦ Improves forecasts and warnings, which reduces the impact of hazardous weather on our national 
transportation systems.

◦ Provides improved forecasts, which help the public make wiser safety decisions.

Dual-Polarization Products

All dual-polarization products originate from the D2D kxxx menu shown in Exhibit 8.6-1.

Exhibit 8.6-1. Accessing Dual-Polarization Products

Note 1: The numbers shown on Exhibit 6.8-1 correspond to the descriptions of the dual-pol products 
described below. 

Dual-polarization technology is comprised of six products. Descriptions of each product follow. 

1. Correlation Coefficient (CC): Defined as the measure of how similarly the horizontally and vertically 
polarized pulses behave within a pulse volume. CC is great at discriminating between non-meteorological 
echoes and meteorological echoes. The possible range of values is from 0.2 to 1.05. CC has no unit of 
measurement. It is used for identification of:

◦ Meteorological vs Non-meteorological Echoes

◦ Melting Layer
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◦ Rain vs. Snow

◦ Tornadic Debris

◦ Large Hail

◦ Irregular Hydrometeor Shapes

◦ Quality of Other Polarimetric Variables.

Exhibit 8.6-2 illustrates an example of how to access and display the dual-pol CC product.

Exhibit 8.6-2. Example of CC Product

2. Differential Reflectivity (ZDR): Defined as the difference between the horizontal and vertical reflectivity 
factors. ZDR is a good indicator of the mean drop size diameter of the dominant echoes. The possible range 
of values is from -7.9dB to +7.9dB. ZDR is measured in decibels and is used for identification of:

◦ Hail

◦ Melting Layer

◦ Rain vs. Snow

◦ Tornadic Debris

◦ Updraft (ZDR column)

◦ Different Types of Frozen Precip.
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Exhibit 8.6-3 illustrates an example of how to access and display the dual-pol ZDR product.

Exhibit 8.6-3. Example of ZDR Product

3. Specific Differential Phase (KDP): Defined as the range derivative of the differential phase shift along a 
radial. KDP is similar to ZDR in that the shape of the target affects the differential phase shift, but unlike 
ZDR, KDP is dependent on particle concentration. KDP is measured in deg/km and is used for identification 
of:

◦ Heavy Rain only

◦ Heavy Rain mixed with Hail

◦ Cold vs. Warm Rain Processes.

Exhibit 8.6-4 illustrates an example of how to access and display the dual-pol KDP product.
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Exhibit 8.6-4. Example of KDP Product

4. Hydrometeor Classification (HC) or Hydrometeor Classification Algorithm (HCA): The purpose of this 
product is to determine the most likely echo from a pre-defined list of echo classes. It makes its best guess of 
precip type using the echo's Z, V, ZDR, CC, and KDP values and the quality and reliability of those base 
products. The pre-defined list of possible echo classifications consists of 12 different classes of echoes 
displayed on the AWIPS color bar shown in Exhibit 8.6-5. A description of the classes of echoes follows. 

Exhibit 8.6-5. HC Color Bar

◦ BI (Biological Scatters): Includes things such as birds and insects.

◦ GC (Ground Clutter): Includes things such as buildings, trees, and cars, which appear normally or as 
anomalous propagation.

◦ IC (Ice Crystals): Ice in the form of columns, needles, plates, etc. 

◦ DS (Dry Snow): Includes snow flakes that are low-density.

◦ WS (Wet Snow): DS that begins to melt and become water coated.

◦ RA (Moderate Rain): Light to moderate rain.

◦ HR (Heavy Rain): Heavy rain.

◦ BD (Big Drops): Large rain drops (at least 3-4 mm in diameter) that appear in low concentration.
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◦ GR (Graupel): Includes precipitation in the form of soft hail or snow pellets.

◦ HA (Hail): Includes pure hail or hail possibly mixed with rain.

◦ UK (Unknown): Includes bins where the algorithm could not decisively say what category that bin 
could fit into, either because the confidence value was too low or because two categories were too 
close to determine.

◦ RF (Range Folding): Another classification that will most likely never affect the HC product.

In an operational setting, the HC product is most useful for supplementing base data analysis. The HC 
algorithm (HCA) can alert a forecaster to something possibly missed in base data analysis. It can help a 
forecaster more quickly hone in on a feature of interest (most notably hail), or other subtle hint provided by 
the base data. However, it could possibly misclassify a signature, so it is recommended that the HC product 
be used in conjunction with the polarimetric base data and not as a stand-alone product. Exhibit 8.6-6
illustrates an example of how to access and display the dual-pol HC product.

Exhibit 8.6-6. Example of HC Product

5. Melting Layer (ML) or Melting Layer Detection Algorithm (MLDA): The ML product is an elevation-
based radar product. The MLDA provides the height of the top and bottom of the melting layer and is 
updated every volume scan, which is every 5 minutes. The product should always be used with another 
elevation-based radar product that is being analyzed. Also, the elevation angle of the ML product must 
match the elevation angle of the product being analyzed. The reason the angles must match is that the ML 
products are radar centric and specific to radar elevation angles; thus they are meaningless unless overlaid on 
matching elevation angle products. The ML product is best used with the elevation-based ZDR and CC 
products. Both of these products are great in identifying the melting layer because the melting layer has 
distinct signatures in these products. Exhibit 8.6-7 illustrates an example of how to access and display the 
dual-pol ML product.
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Exhibit 8.6-7. Example of ML Product Overlay on CC Product

6. Quantitative Precipitation Estimation (QPE): The dual-pol QPE improves the accuracy of rainfall 
estimation. Dual-pol adds 9 new precip products to the legacy precip products. The legacy precip uses the 
hybrid scan reflectivity for a single R(Z) relationship. Whereas for dual-pol precip estimations, the hybrid 
scan hydroclass product is used to assign a rainfall rate relationship. This means the rainfall rate relationship 
used for a particular location is specific to the dominant hydrometeor type at that location, which potentially 
improves the estimation of rainfall rate. Dual-pol QPE products are accessed via the kxxx Precip submenu 
shown in Exhibit 8.6-8. Table 8.6-1 provides a description of each dual-pol QPE product, and Exhibit 8.6-9
illustrates an example of a QPE HHC product.
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Exhibit 8.6-8. Dual-Pol QPE Products

Note 2: The numbers shown on Exhibit 6.8-8 correspond to the numbers in Table 8.6-1. 

Table 8.6-1. QPE Products
# Product Type Product Name Abbreviation Description

1. Instantaneous Hybrid 
Hydroclass HHC

This product is the hydrometeor classification used in rain rate relationship. 
The HHC product is the radar's best guess of the echo type that is used as an 
imput into the dual-pol precipitation algorithm.

2. Instantaneous
Digital 
Precipitation 
Rate

DPR
This product displays instantaneous precipitation rate (new functionality with 
dual-pol). One advantage of this product is that it can give you a good idea of 
where there may be heavy rain right now.

3. Accumulation
Digital 
Accumulation 
Array

DAA This product provides a 1 hour accumulation with no bias (bias=1.00) applied 
ever. It is for users who want raw, unbiased 1 hour accumulation data.

4. Accumulation One Hour 
Accumulation OHA This product is similar to the legacy OHP product, providing the maximum 1 

hour accumulation. 

5. Accumulation
Digital Storm 
Total 
Accumulation

DSA

This product is similar to the legacy DSP product, showing the total 
accumulated rainfall since the beginning of an event. There is no DSA label on 
the kxxx Precip submenu. Therefore, to load the DSA product, select "Storm 
Total Accum (STA)."

6. Accumulation Storm Total 
Accumulation STA This product is the 2 km resolution, 4-bit version of the DSA product. It 

matches the resolution and data levels of the legacy STP product.
7. Difference DOD
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Digital One 
Hour 
Difference

This product is used to compare legacy precip products to dual-pol precip 
products. DOD is the difference between dual-pol and legacy 1 hour 
accumulations, with no bias applied.

8. Difference
Digital Storm 
Total 
Difference

DSD
Like DOD, this product is used to compare legacy precip products to dual-pol 
precip products. DSD is the difference between dual-pol and legacy storm total 
accumulations, with no bias applied.

9. User-
selectable

Digital User-
selectable 
Accumulation

DUA

This product provides accumulated precipation over a time period chosen by 
the user. The time period can be as short as 15 minutes, or as long as 24 hours. 
One advantage of this is that a precipitation product that most suits the situation 
can be requested. A 1 hour DUA will be automatically generated every volume 
scan, and a 12 hour DUA will be automatically generated every day at 12 Z. 
Note that the kxxx Precip submenu includes 6 pre-set duration entries, which 
will load any DUA product exactly matching the duration given in the menu. 

Exhibit 8.6-9. Example of a QPE HHC Product

7. Specific Diff Phase, Differential Refl and Correlation Coeff Products

The following Dual Polarization Products were added to theMenu.

Specific Diff Phase- KDP productID is 163 and 0.5 elevation angle

Differential Refl  - ZDR productID is 159 and 0.5 elevation angle

Correlation Coeff - CC  productID is 161 and 0.5 elevation angle
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Exhibit 8.6-10. Specific Diff Phase, Differential Refl and Correlation Coeff Products 

8.
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Note 3: For a detailed presentation on dual-polarization, refer to the NWS Warning Decision Training 
Branch (WDTB) - Dual-Polarization Radar Training Course at 
http://www.wdtb.noaa.gov/courses/dualpol/outreach/. 
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8.7 The Supplemental Adaptive Intra-Volume Low-Level Scan (SAILS) 

Background Information and Reason for Enhancement: NWS Pueblo is a Beta Test site for WSR-
88D Build 14. This build now provides a supplemental 0.5 degree Reflectivity, Velocity and 
Spectrum Width slice (called a SAILS slice) collected midway through the collection time of a 
volume scan. (Eventually ZDR, CC, and KDP SAILS products will be included in the level 3 feed to 
AWIPS in a future radar build.) This 0.5 degree SAILS slice is assigned a time stamp of when the 
data were collected, which is a more recent time stamp than the parent volume scan time during which 
it was collected. 

Operational Impact: During operations, it is difficult to keep track of which 0.5 degree product is 
associated with a full volume scan vs, which is the SAILS slice. This becomes especially important 
when navigating radar data in All Tilts displays, as an up arrow on a 0.5 degree slice associated with a 
full volume scan will take you up in elevation, but an up arrow on a SAILS slice will not. Being able 
to quickly identify which 0.5 degree slice is a SAILS slice will allow the user to know immediately 
whether higher elevation tilts are available for that time stamp. This will eliminate the current trail 
and error method, of hitting the up arrow to see if a higher elevation slice exists, and if not then hitting 
the left arrow to go back in time, then the up arrow to go up in elevation in the full volume scan.This 
will make radar interrogation more efficient during severe weather operations. 

• A"SAILS" label is added to the upper left side of the display, beneath the label already 
there consisting of VCP, product resolution, and Max Value. This has been done for each 
of the SAILS products (0.5 degree Z, V, SRM, SW) as shown below respectively and it will 
be eventually done for SAIL products (ZDR, CC, KDP).
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9.0 Background Applications

The AWIPS background applications are designed to run unattended in the background. Once they 
are set up, they run independently and need only to be monitored. 

The AWIPS background applications currently consist of the following two applications: 

• The NOAA Climatological Reports Formatter 

• The Hourly Weather Roundup (HWR) Application 

Both applications are accessed by opening the AWIPS start-up menu shown in Exhibit 9.0-1, and 
selecting Background WFO Apps. 

Exhibit 9.0-1. AWIPS Start-up Menu - Background WFO Apps 

The NOAA Climatological Reports Formatter and HWR applications generate products that you may 
wish to review and edit before transmission. The status of these products is displayed in the 
Monitoring Controller dialog box, which is automatically displayed when you log into the AWIPS 
text display.

Note: The NOAA Climatological Reports Formatter and HWR need to be set up for each site by 
the site's System Administrator. 

This chapter includes the following sections:

• Section 9.1: The NOAA Climatological Reports Formatter
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• Section 9.2: The Hourly Weather Roundup (HWR) Application

• Section 9.3: The Monitoring Controller
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9.1 The NOAA Climatological Reports Formatter

The NOAA Climatological Reports Formatter formats Daily Climatological Reports (product 
identifier "CLI"); Monthly, Seasonal, and Yearly Climatological Reports (product identifier "CLM") 
for AWIPS.

The Daily Climatological Report is used to summarize one or more stations' daily weather 
observations, records, normals, departures from normal, and last year's values for that date. Similarly, 
the Monthly, Seasonal, and Yearly Reports are used to summarize one or more stations' weather 
observations, records, normals, departures from normal, greatest amounts and values, and dates of 
occurrence over the corresponding period. The Formatter prepares tabular products to be disseminated 
over the NOAA Weather Wire Service (NWWS) and voice-ready products for broadcast over the 
NOAA Weather Radio (NWR).
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9.1.1 Normal Operations

The Daily Climatological Reports Formatter application is normally scheduled for execution by a crontab twice per 
day. If required, an intermediate product can be scheduled by a crontab also. Options for forecaster initiation of the 
morning, intermediate, and evening Daily Climatological Reports are provided on the Climate Master dialog. An 
example of a Display Station Daily Climate Values dialog is shown in Exhibit 9.1.1-1.

Exhibit 9.1.1-1. Display Station Daily Climate Values Dialog

The Monthly, Seasonal, and Yearly Reports Formatter application is normally scheduled for execution by a 
crontab after the period of interest ends. Options for forecaster initiation of the Climatological Reports for each 
period are provided on the Climate Master dialog.

Once the formatter has completed the climate products, the eyeglasses notification symbol pops up and the word 
"New" appears to the left of the Edit Climate Product button on the Monitoring Controller dialog. You would 
then press the Edit Climate Product button. If at least one NWR product has been produced, the NWRWAVES 
Browser appears. The available products are displayed in the Delayed field. The forecaster now has the following 
options:

• To view the product, highlight the product and select View.

• To edit the product, highlight the product and select Edit.

• To send the product, highlight the product and select Send.

• Select Refresh to update the Delayed field.

• Select Close to terminate the program.
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After the tabular product is formatted, it is sent to the correct directory for forecaster review and then transmission 
over the NWWS. When the voice-ready product is formatted, it is sent to the correct directory for display by the 
NWRWAVES Browser and transmission to the CRS.

If at least one NWWS product has been produced, the Review Climate Product GUI appears with a listing of all 
NWWS products. Prior to transmission, this GUI allows the forecaster to view, edit, delete, and send the generated 
NWWS products. The forecaster can also abort the transmission of the NWWS products if necessary.

If the forecaster chooses to send the NWWS product(s), a work copy (heading WRKALTCLI) of the product is 
also stored in the text database. The user/forecaster has to configure the WRKALTCLI to alert. This will cause an 
alert bell to appear. Upon clicking on the alert bell, the Alarm Display window will display the WRKALTCLI 
product. If it contains errors, the forecaster can use the text editor window to edit the actual NWWS climate 
product for retransmission.

The Select Climate Run Date Dialog

The Select Climate Run Date GUI is shown in Exhibit 9.1.1-2 and its fields are discussed below.

Exhibit 9.1.1-2. Select Climate Run Date Dialog

The upper portion of the GUI provides two options: Latest 
<Morning|Intermediate|Evening|Monthly|Seasonal|Annual> Climate and Retrieve Climate for a Prior Period. 

• Latest Morning Climate: Choosing this option will execute the Daily Climatological Formatting 
application for the previous calendar day.

• Latest Intermediate/Evening Climate: For intermediate and evening climate products, Latest 
Intermediate/Evening Climate is the only available option for the GUI. This option will execute the Daily 
Climatological Formatting application from midnight to either the execution time or a user-defined valid 
time.

• Latest Monthly Climate: Selecting this option will execute the Monthly Climatological Formatting 
application for the previous calendar month.

• Latest Seasonal Climate: Selecting this option will execute the Seasonal Climatological Formatting 
application for the previous 3-month season.

• Latest Annual Climate: Selecting this option will execute the Annual Climatological Formatting 
application for the previous year.

• Retrieve Climate for a Prior Period: This option is available for Morning, Monthly, Seasonal, and Annual 
Climatology products. Use this option if the desired climate report is other than the latest morning, monthly, 
seasonal, and annual product.
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◦ Morning: Enter the day, month, and year in their respective fields to produce a Daily Climatology 
report for a specific date.

◦ Monthly: Enter the beginning and ending day, month, and year into their respective fields to produce 
a Monthly Climatology report for a specific month.

◦ Seasonal: Enter the beginning and ending day, month, and year into their respective fields to produce 
a Seasonal Climatology report for a specific season.

◦ Annual: Enter the beginning and ending day, month, and year into their respective fields to produce 
an Annual Climatology report for a specific year.

• OK: This closes this GUI and executes the Climatology Formatting application that was selected.

• Cancel: This closes this GUI and shuts down the Climate application without making any changes.

There are two versions of the Display Station Climate Values dialog that provide climate summaries, Daily (refer 
to Exhibits 9.1.1-1) and monthly/seasonal/yearly. Both allow the forecaster to review the Daily Climate Values, or 
Monthly, Seasonal, or Yearly Climate Values for a list of stations.

Display Station Daily Climate Values Dialog

The dialog menus are discussed below.

• File: The dropdown File option allows the forecaster to Close this dialog.

• Help: The dropdown Help option allows the forecaster to access help for this dialog.

The dialog fields are discussed below. 

• Accept Values: The displayed values are stored into the hydromet (HM) database.

• Clear Values: The displayed data are removed from the dialog so that the fields are blank. This option does 
not affect data already stored in the HM database.

• Station: This field provides the user with the option to select the climatological station for which data are to 
be displayed in this dialog. When this Display Station Daily Climate dialog is initiated, the first station in 
the list is automatically highlighted and its daily observations are loaded in the data fields.

• Date: This field displays the observation date.

• Type of Summary: This field displays either "Morning daily climate summary," "Intermediate daily climate 
summary," or "Evening daily climate summary."

The next section lists the category names: Temperature, Precipitation, Snow, Wind, and Sky & Weather. Choosing 
a category will display related values in the lower portion of the Display Station Climate Values GUI. 

• The large group in the middle of the dialog contains the maximum/minimum temperature and humidity, 
maximum wind speed and direction, and maximum gust speed and direction as well as the time of 
occurrence for each of these variables. It also contains the average wind speed.

• The bottom left group contains precipitation and snowfall amounts, percent sunshine, average sky cover, 
and maximum/minimum SLP.

• The bottom right group contains all of the observed weather types reported for the day. The observed types 
are identified by a check mark in these fields.
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Tip: By positioning the mouse cursor over the maximum temperature, minimum temperature, maximum wind 
direction and speed, wind gust direction and speed, daily precipitation, daily snowfall, possible sun, sky 
cover, or observed weather fields, and then clicking and holding down mouse Button 3 (B3), the forecaster 
can view the data retrieval method of the weather parameter. For example, for the maximum temperature, a 
pop-up window will appear and indicate the data retrieval method was determined from the Daily Summary 
Message, the 24-Hour Temperature Group, the 6-Hour Temperature Group, the Hourly Temperature 
Observations, or the Rounded Temperature Observations. 

The forecaster can change the values if needed but must select Accept Values before closing the dialog.

Note 1: There is a high-level quality control check in the Display Station Daily Climate Values dialog. The 
user is unable to enter extreme values for each category. However, there is no comparison between two fields 
at this time. 

Display Climate Values Dialog for Monthly, Seasonal, and Yearly Formatter

The dialog menus are discussed below.

• File: The dropdown File option allows the forecaster to Accept the Climate Values and Continue or Abort 
the Climate Run.

• Help: The dropdown Help option allows the forecaster to access help for this dialog.

The dialog fields are discussed below.

• Save Station Values: The displayed values are stored into the hydromet (HM) database.

• Clear Values: The displayed data are removed from the dialog so that the fields are blank. This option does 
not affect data already stored in the HM database.

• Station: This field provides the user with the option to select the climatological station for which data are to 
be displayed in this dialog. When this Display Station Climate Values dialog is initiated, the first station in 
the list is automatically highlighted and its climate values are loaded in the data fields.

• Report Period: This field displays the beginning and ending dates for the period.

• Type of Summary: This field displays either "Monthly Climate Summary," "Seasonal Climate Summary," 
or "Annual Climate Summary." 

The next section lists the category names: Temperature, Precipitation, Snow, Wind, and Sky & Weather. Choosing 
a category will display related values in the lower portion of the Display Station Climate Values GUI. 

• The large group in the middle of the dialog contains the maximum/minimum temperature and humidity, 
maximum wind speed and direction, and maximum gust speed and direction as well as the time of 
occurrence for each of these variables. It also contains the average wind speed.

• The bottom left group contains precipitation and snowfall amounts, percent sunshine, average sky cover, 
and maximum/minimum SLP.

• The bottom right group contains all of the observed weather types reported for the day. The observed types 
are identified by a check mark in these fields.

The forecaster can change the values if needed but must select Save Station Values before closing the dialog.
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The Review Climate Product Dialog

When an NWWS product is created, it can be viewed and modified before it is distributed over the WAN. After 
the Display Station Climate Values GUI is closed and the values are written to the database, the forecaster can 
actually view and edit the product through the Review Climate Product GUI shown in Exhibit 9.1.1-3.

Exhibit 9.1.1-3. Review Climate Product GUI

The dialog menus are discussed below.

• File: The dropdown File option allows the forecaster to accept or abort the climate run.

• Edit: The dropdown Save option allows the forecaster to save or delete the climate product.

The dialog fields are discussed below.

• NWWS Climate Reports: This field displays the name of the output file for the NWWS Climate Report. 
The files are named according to the type of Climate run. See Table 9.1.1-1 for more information. Single 
clicking on the file name will display the output file in the lower frame of the GUI. At this time, the 
forecaster can add text, edit values, or delete the product.

Table 9.1.1-1. Climate Runs and Output
Type of Climate Run Output File Name

Morning output_am_<station ID>.nwws
Evening output_pm_<station ID>.nwws

Intermediate output_im_<station ID>.nwws
Monthly output_mon_<station ID>.nwws
Seasonal output_sea_<station ID>.nwws
Annual output_ann_<station ID>.nwws

• Date: This field displays the date and time that the Climate product was created.

The dialog buttons are discussed below.

• Clear: This button clears the bottom portion of the GUI.

• Delete: This button will delete the product that is selected in the NWWS Climate Report field.
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• Save: This button saves the product that is selected in the NWWS Climate Report field.

Note 2: If any products are modified, they must be saved before the product is sent. Otherwise, the 
original product will be sent. 

• Send: This button will distribute for broadcast over the WAN all of the products listed in the NWWS 
Climate Report field. 

Note 3: It is very important to maintain a specific Font size when running Climate. 

Note 4: Most Climate dialogs are initiated with the Cancel button as the default. Therefore, if the space 
bar or the Return key is hit within a particular dialog, it will follow the procedures for canceling that 
dialog. 
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9.1.2 Manual Operation of the NOAA Climatological Reports Formatter

Any forecaster may initiate a manual run of the Morning or Evening Climate products via the 
Climate Master dialog, as shown in Exhibit 9.1.2-1. 

Exhibit 9.1.2-1. Opening The Climate Master Dialog with Configure Climate Parameters Option 
Selected 

Climate Master Dialog

The dialog menus are discussed below.

• File: The dropdown File option allows the forecaster to Close the Climate Master dialog. 

• Help: The dropdown Help option allows the forecaster to access help on the Climate Master 
dialog.

The dialog box Climate Field options are discussed below.

• Configure Climate Parameters: This selection displays the Climate Preferences GUI, as 
shown in Exhibit 9.1.2-1. 

• Set Up/Edit Climate Products: This selection displays the Report Format GUI. 
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• Execute Morning Climate: This selection executes the Daily Climatological Formatting 
application for the previous calendar day. 

• Execute Intermediate Climate: This selection executes the Daily Climatological Formatting 
application for the current day, from midnight to either the execution time or a user-defined 
valid time. 

• Execute Evening Climate: This selection executes the Daily Climatological Formatting 
application for the current day, from midnight to either the execution time or a user-defined 
valid time. 

• Execute Monthly Climate: This selection executes the Monthly Climatological Formatting 
application for the previous month.  Monthly climatology can be run in the middle of a month 
to create a product through the previous day of the month. 

• Execute Seasonal Climate: This selection executes the Seasonal Climatological Formatting 
application for the previous season. 

• Execute Annual Climate: This selection executes the Annual Climatological Formatting 
application for the previous year. 

• Create F6 Products: This selection displays the F6 Product Date and Stations GUI. 

• Initialize Climate Database: This selection displays the Climatology Normals, Means, 
Extremes GUI; the Import Climate GUI; the Daily Normals, Means, Extremes GUI; and the 
Monthly Normals, Means, Extremes GUI. 

• Quality Control Climate Database: This selection displays the Edit Daily Climate GUI and 
the Edit Daily Climatological Data GUI.

The dialog buttons are discussed below.

• OK: This button initiates the selected option from the above list. 

• Cancel: This button closes this GUI.

Select an option and then select the OK button to initiate the option.
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9.1.3 Climate Record Report Formatter

AWIPS automatically produces a basic Climate Record Report (product category RER) for the 
NOAA Weather Wire Service (NWWS). The RER will be created whenever a Daily Climate Report 
is run and the climate program detects that a new daily climate record has been set, or an existing 
record has been tied, for one or more of the following climatological variables: 

• Daily Maximum Temperature 

• Daily Minimum Temperature 

• Daily Precipitation (liquid equivalent) 

• Daily Snowfall. 

There is no need or capability to configure the RER product. The station setup of the NWWS Daily 
Climate (CLI) products determines the configuration of the RER products. The RER product has a 
one-to-one correspondence with an associated CLI product in regard to the stations included in the 
products, and with the node (CCC) and location identifier (XXX) of the text products full AFOS IDs 
(CCCNNNXXX, where NNN is RER or CLI). Outside of that, the only thing that controls the RER 
product's contents and creation is the presence or absence of daily climate records in the AWIPS 
climate database, for the variables listed above, for the stations contained in the paired CLI/RER 
products. 

Note 1: There is no automated NOAA Weather Radio (NWR) product capability for climate 
record reporting. 

The wording of the RER varies slightly between the morning CLI runs (based on yesterday's complete 
daily observational data) and the intermediate or evening CLI runs (based on today's data so far). The 
RER wording also indicates whether a new record was set or an old record was tied.

The RER formatter does no checking of the values it receives as input from the daily climate program. 
The new values are those taken from an untouched daily climate run, if it runs to completion without 
manual intervention, or those daily data modified and accepted by the user in the Display Station 
Daily Climate Values editor, if manual Quality Control (QC) of the daily climate run is performed. 
The old records reflect those record values in the climate database at the time daily climate is run. If 
the existing climate record value for the day has a value of MISSING (9999), no new climate record 
can be established for the variable and no RER will be created. When a given record has occurred in 
more than one prior year, only the latest year in which it previously occurred will be noted in the 
RER. 

Usage

The Climate Record Report Formatter stores the output RER product(s) in the AWIPS Text Database. 
It also provides a visual notification on the D2D whenever an RER product has been created and 
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stored. A new Alert Visualization message will appear, indicating that one or more climate records 
have been reached and listing the AFOS ID under which the corresponding RER product has been 
stored in the text database. A separate notification message will be provided for each RER product 
that is formatted. The appearance of the Alert Visualization message for the RER is the last automated 
action that the Climate Record Report Formatter performs and is the only visible indication that an 
RER has been created in the Daily Climate program run. Unlike the CLI, the output NWWS RER 
products will not be listed and will not be able to be loaded, edited, or transmitted from the Review 
Climate Product user interface that appears as part of the normal climate program sequence. Also, the 
RER will not be automatically transmitted over the NWWS after a time-out period. All user 
interactions with the RER product, including viewing, editing, and product dissemination, must be 
performed manually via the AWIPS Text Browser on the text workstation. 

Software and Data Files

The Climate Record Report Formatter consists of a single executable program (recordClimate), 
which runs as a persistent process on the Data Server (DS) platform, under user fxa, and a script 
(catRecordClimateData.sh) that feeds climate record data to recordClimate when called by the 
daily climate control script. The recordClimate process is automatically started whenever the 
startIngest script is executed on the DS and stopped whenever data ingest is stopped by stopIngest. 
Whenever recordClimate is started, it automatically creates a pair of FIFO pipe files that it 
continually listens to and from which it receives its input data. These pipe files, named 
RecordClimateStationInfo.dat and RecordClimateRawData.dat, are located under 
the /awips/adapt/adapt_apps/tmp directory. 

Note 2: The user should make no attempt to delete or otherwise interact with these two FIFO 
pipe files. 

The recordClimate process does not determine whether or not climate records have been reached. 
This determination of climate records is performed by the format_climate executable of the basic 
suite of AWIPS Climate Reports programs. Whenever the daily climate is run, the program 
format_climate will write climate setup and record data to a pair of ASCII text files named 
RecordClimateStationInfo1.dat and RecordClimateRawData1.dat (overwriting any existing files 
of the same name) located under the /awips/adapt/adapt_apps/tmp directory. These files are not 
removed after format_climate and recordClimate have completed. 

The file RecordClimateStationInfo1.dat will list the AFOS IDs of the RER products that may be 
produced and the station(s) whose data are to be included in the RER if a record occurred at the 
station. This file changes only if the station setups of the RERs matching CLI products are modified 
and lists all stations for all configured CLI/RER products, whether or not a climate record was set for 
the station in the current run. The file RecordClimateRawData1.dat contains the old and new 
climate record data for stations and variables where records have been reached for the date for which 
Daily Climate is being run. The combination of the data from the two files determines which (if any) 
RER products will be formatted and the data type and station location of climate records included in 
each RER. Note that if there are additional climate stations that are configured for the daily NWR 
climate products but not included in a CLI product, any new climate records for these stations will be 
included in the RecordClimateRawData1.dat file, but no RER will be formatted based on these 
climate records since no matching station entry will be found in the station/product file 
RecordClimateStationInfo1.dat. 
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Once format_climate is complete, the climate control script will execute the script 
catRecordClimateData.sh to pipe the data in the ASCII text files to their corresponding FIFO files, 
where the recordClimate executable receives and processes the data, creates and stores any required 
RER products, and provides the Alert Visualization notifications.
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9.1.4 Create F6 Products

Selecting Create F6 Products from the Climate Master GUI will bring up the F6 Product Date and 
Stations dialog. 

The GUI default is to generate the F6 product for the current month. The forecaster can also select a 
previous month by clicking the button beside the Previous Month: option. Use the dropdown menu 
to select the month and type in a desired year. Clicking OK will send the F6 products for all stations 
to the printer and also to the text database. 

To view the product in the text database, bring up a Text window on the Text Workstation. In the 
Load cmd: area, type SSSLCDMMM where SSS is the three-letter station identifier and MMM is 
the abbreviation of the month. Press Enter. For example, the F6 for Pittsburgh for March would be 
stored under PITLCDMAR. The last generated F6 product for Pittsburgh would then be displayed. 

• Select station: Individual F6 products can be produced by clicking on the checkboxes beside 
the station name. 

• Print selected F6s: Clicking this checkbox will send all selected F6 products to the printer for a 
hard copy of the product(s). 

• OK: This will execute the build_f6 program with specified forecaster options. 

• Cancel: Pressing this button will close the build_f6 program without producing any F6 
products. 

The F6 generation can also be run by a cron so that the products can be produced automatically at 
certain times of the day.  Cron setup should be accomplished during site installation but can be 
changed as requirements dictate. 

Two command line arguments can be used, both of which can have values of "1" or "0": 

• The first argument determines whether or not the F6 Product Date and Stations GUI pops up.  A 
value of "1" results in the GUI popping up while a value of "0" results in it not popping up.  

• For the second argument, a value of "1" results in the F6 product being printed while a value of 
"0" does not.  When neither argument is used, the GUI will not pop up and the product will not 
print, as if both arguments were assigned values of "0".
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9.1.5 Record Climate

The following sections provide an overview of the Record Climate process and the steps required to 
create a record report.

Note: The sections that follow assume the user has a knowledge of climate. 
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9.1.5.1 Record Climate Process Overview

The Record Climate process performs the basic "Record Report" (RER) functionality required by 
AWIPS. Record Climate is an extension to the Current Climate functionality. If a record is set in the 
climate process, Record Climate will recognize this and produce a formatted RER, and store it in the 
fxa text database. A forecaster can then retrieve this product from the database via the Text 
Workstation or the nwrEditor for data verification and subsequent off-site dissemination.

Note: Distribution and verification of products from the AWIPS fxatext database are manually 
accomplished via the Text Workstation (WAN) and nwrEditor (CRS). 

Record Climate performs three basic operations:

• Formatting of Record Climate Reports

• Storage of Record Climate Reports in the fxa text database (CCCRERXXX)

• Forecaster notification (local/system) that a record has been set:

◦ Local workstation notification via a pop-up message box (Tcl/Tk) and system notification

◦ System via D2D the task bar and an audible alarm (uses Announcer objects).
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9.1.5.2 Creating a Record Report (RER)

1. To Create a Record Report 

1. Run climate and create a record, or wait until a climatic record normally occurs; then 
validate the climate data. 

2. If a record has occurred, Record Climate will recognize this and do the following: 

1. Create a Record Report (RER).

2. Display a text message box on the local workstation notifying the forecaster that a 
climatic record event occurred.

3. If set in the Record Climate configuration file, notify all other workstations via 
the D2D status bar.

4. Store the RER product in the fxatext database under the id CCCRERXXX, where 
CCC and XXX are site dependent.

Note: If more than one record occurs during a single climate run, RER products 
will be stored to the fxatext database under the same RER ID.  This means that 
records are stored as previous versions; e.g., if a min-temp and a max-snowfall 
occurred in the same climate run, a separate RER would be created for each 
climatic event. Then these RERs would be stored to the fxatext database in turn.  
To retrieve them, the forecaster would use the Text Workstation text window to 
retrieve the multiple versions of the product stored under the RER ID. 

3. Verify the Record Report and disseminate it off-site using the Text Workstation text 
window and nwrEditor. The text window can be used to verify and disseminate the 
product off-site. To disseminate the product to the NOAA Weather Radio (NWR), use 
the nwrEditor to create a new voice-ready RER product. If more than one record 
occurred in a single climate run, the forecaster will need to pull up the previous versions 
using the text window and paste them into the body of the voice-ready RER product.  
This is because the nwrEditor will retrieve only the latest RER stored in the fxatext 
database. 
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9.2 The Hourly Weather Roundup (HWR) Application

The Hourly Weather Roundup (HWR) is a summary of the current weather observations for locations 
in and around the local area, including marine observations for those WFOs with coastal 
responsibilities. The application is used to prepare the products sent to the NWR and the NWWS. 

The HWR consists of two applications. 

• The Hourly Weather Roundup NOAA Weather Radio (HWR NWR) application prepares 
voice-ready products, as shown in Exhibit 9.2-1 for broadcast over NWR. The products are 
automatically sent to the NWR, but the forecaster has an opportunity to review and edit them 
before broadcasting.

Exhibit 9.2-1. Sample Output for Broadcast on the NWR

• The Hourly Weather Roundup NOAA Weather Wire Service (HWR NWWS) application 
prepares tabular products that are automatically sent to the NWWS, as shown in Exhibit 9.2-2
for broadcast over the NWR.
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Exhibit 9.2-2. Sample Station List for the NWWS

The HWR uses:

◦ METAR observations 

◦ Marine observations 

◦ Supplementary Climatological Data (SCD) (snowfall only) 

◦ Satellite Cloud Product (SCP) data
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9.2.1 HWR Routine Operations

Both of the HWR applications (HWR NWR and HWR NWWS) are normally executed automatically 
via the crontab utility (see Subsections 9.2.2 and 9.2.3); however, both may be executed manually as 
needed (see Subsections 9.2.4 and 9.2.5).

 Refer to the separate NWRWAVES User's Manual for more information by clicking on the 
book symbol.
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9.2.2 Automatic Execution of the HWR NWR Application and NWRWAVES 
Browser

The Hourly Weather Roundup (HWR) NOAA Weather Radio (NWR) application uses METAR and 
marine observations, the Satellite Cloud Product (SCP), and Supplementary Climate Data (SCD) 
(snowfall only) to perform required calculations, build phrases, and add instructions for the Console 
Replacement System (CRS). The output product is stored temporarily and the WFO is notified of its 
completion via the "eyeglasses" icon, as shown in Exhibit 9.2.2-1 on the Text Displays for all 
workstations and the appearance of the word "NEW" next to the "Hourly Weather Roundup" button 
on the Monitoring Controller. Refer to Exhibit 9.3-1.

Exhibit 9.2.2-1. "Eyeglasses" Icon for the HWR NWR Product

Note 1: If the Monitoring Controller is iconified at the time of the notification, it will be restored 
at the mouse click. 

By clicking on the "Hourly Weather Roundup" button in the Monitoring Controller, the 
NWRWAVES Browser, as shown in Exhibit 9.2.2-2, appears. 

Exhibit 9.2.2-2. NWRWAVES Browser 

Note 2: The NWRWAVES Browser can also be opened by selecting NWRBrowser from the 
AWIPS start-up menu's list of applications. 
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NWRWAVES is a comprehensive formatter for NWR products. Its purpose is threefold. First, it is 
designed to replace all existing formatter capabilites found in the AWIPS WWA program and also the 
capabilities found in CAFÉ. Second, NWRWAVES utilizes VTEC coding found in an increasing 
suite of NWS products to better identify, produce, and manage outbound Console Replacement 
System (CRS) weather messages. The use of the Message Reference Designator (MRD) number will 
allow sites to better automate their CRS broadcast cycle management. Third, NWRWAVES is 
designed to be easier to mainting and enhance than CAFÉ.

NWRWAVES Browser Menus

The NWRWAVES Browser menus include File, Sort, Filter, Options, and NWRWAVES. 
Descriptions of each menu follow.

File (Keyboard Shortcut Alt-F)

• Print: Prints highlighted items items from Pending/Sent lists. 

• Exit: Closes the browser. 

Sort Keyboard Shortcut Alt-S): Allows quick location of outbound or transmitted CRS messages.

• None: No sorting, browser will function in a manner similar to the old NWR Browser. 

• Alphabetical (Default): Sorts files in the Pending and Sent list boxes in alphabetical order. 

• Expiration Time: Sorts files in the Pending and Sent list boxes in the order in which CRS 
messages are scheduled to expire. 

• Creation Time: Sorts files in the Pending and Sent list boxes in the order in which the CRS 
messages were added. 

• Decreasing Sort: Sorts the list boxes in either reverse alphabetical order (Alphabetical sort 
applied) or in the reverse order in which CRS messages are scheduled to expire (Expiration 
Time sort). 

Filter (Keyboard Shortcut Alt-i): Filters items in the NWRBrowser to help you locate products in the 
Pending and Sent lists quickly. 

• Filter by Transmitter: Displays outbound/Transmitted products that are applicable to the 
selected transmitter. 

• Filter by Product Type/WFO: Filters the lists to display only requested product types/WFOs. 

Note 3: The "output" item filters the AWIPS climate program CRS messages. You can apply a 
combined filter by selecting an item under both the Filter by Transmitter and Filter by Product 
Type submenus. 

Options (Keyboard Shortcut Alt-O) 
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• Clear Old Products (Purge): Allows you to delete files whose CRS message expiration time 
has passed. You will be prompted to remove products from both the Pending and Sent 
directories. This feature can be quite helpful in eliminating dead products from an extensive file 
listing, but remember that there may be instances when you may want to maintain an expired 
product for later retransmission. 

• Update Expiration Time: Allows you to modify the expiration time of a product and 
retransmit it to CRS. This option is enabled when you clicked on a product in the Sent list to 
select it. 

• Auto Refresh: Auto updates the Pending and Sent list boxes (on by default). 

• Set Refresh Interval: Allows you to change the refresh interval from the default of 30 seconds 
by clicking on this menu item and entering a new number (in seconds) into the box. 

• Highlight Warnings: Causes the NWRWAVES Browser list boxes to change briefly from a 
blue to a purple/pink background color when a short-fuse warning has been issued (on by 
default). 

NWRWAVES (Keyboard Shortcut Alt-N) 

• NWRWAVES Setup (Purge): The NWRWAVES menu options, as shown in Exhibit 9.2.2-3, 
are administratively restricted by AWIPS user accounts. Most NWRWAVES users will not 
have access to the Setup Utility. 

Exhibit 9.2.2-3. NWRWAVES Menu Options

Note 4: Only one version of the setup GUI can run on AWIPS at a time. If permitted to 
access the setup GUI, you would be able to open the setup GUI on your workstation only 
if there are no others open. 
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• View/Edit VTEC Summary File: If your system is configured to generate summary messages, 
you have the ability to edit/delete specific product summary messages manually if the 
automated VTEC replacement method fails. The pop-up GUI appears when active hazards are 
being tracked for summarization. You select the hazard you wish to modify from a list of 
buttons, and then you can either clear all Listening Area Codes (LAC) at once or selected LACs 
through their individual radio buttons. Your site will rarely (if ever) need to use this interface, 
because active hazards are tracked through VTEC action codes in follow-up satements. This 
interface is useful if you track a non-VTEC hazard such as a Flash Flood Warning (FFW) in the 
interim period before full VTEC implementation. 

• Regenerate a CRS Message: Allows you to call an AWIPS PIL from the text database and 
reprocess the product through the NWRWAVES formatter. When you select this option, you 
are prompted to enter an AWIPS product identifier and then click OK. The latest version of the 
product will appear in the Regenerate Product GUI. Sites can toggle between database versions 
of the product type by using the Previous Version or Latest Version buttons. Once you have 
the product you wish to retransmit in the viewer, click the Send to NWRWAVES button to re-
process the product. 

• HLS Subheadlines Selection: The Hurricane Local Statement (HLS) option is used to 
configure how the HLS is formatted to make the text more radio friendly.

NWRWAVES Browser Control Buttons

The NWRWAVES Browser control buttons are located in the middle of the NWRWAVES Browser. 
They include View, Refresh, Edit, Delete, Send, Purge, and Exit. Descriptions of each control button 
follow (refer to Exhibit 9.2.2-2). 

View: After selecting a product(s) from the Pending or Sent lists, clicking the View button brings up 
the product in a viewer, as shown in Exhibit 9.2.2-4. 

Exhibit 9.2.2-4. NWRWAVES Product Viewer
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WARNING: If you view or edit a product, you disable the automatic transmission. You must 
send it manually via the NWRWAVES Browser. If the product was in the Sent list, you need to 
select the Send button to retransmit the edited Product to CRS. 

Refresh: Forces a manual auto-refresh of the NWRWAVES Browser. 

Edit: Lets you edit a transmitted product and modify the CRS message header properties, as shown in 
Exhibit 9.2.2-5. After editing, you can then save the edited product to the Pending list, or send to 
CRS. 

Exhibit 9.2.2-5. NOAA Weather Radio Editor

Delete: After selecting a product(s) from the Pending or Sent lists, clicking the Delete button opens a 
pop-up confirmation window prompting you to comfirm your decision to delete the product. Once 
confirmed, the product is removed from the browser. 

Send: After selecting a product(s) from the Pending or Sent lists, clicking the Send button sends the 
product to CRS. 

Purge: Deletes files whose CRS message expiration time has passed. 

Exit: Exits the NWRWAVES Browser. 
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9.2.3 Automatic Execution of the HWR NWWS Application

The Hourly Weather Roundup (HWR) NOAA Weather Wire Service (NWWS) application performs 
calculations on hourly land and marine weather data, constructs the product, and stores the resultant 
text files into a temporary target directory. From the temporary directory, the product is automatically 
sent to the NWWS.
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9.2.4 Manual Execution of the HWR NWR Application

The Hourly Weather Roundup (HWR) NOAA Weather Radio (NWR) application can be run manually.

1. To run the HWR NWR application manually 

◾ From the System Control Menu:

1. Select Background WFO Apps > Hourly Weather Roundup. The Hourly Weather 
Roundup window, as shown in Exhibit 9.2.4-1, appears. 

2. Select NWR from the Product Maker section. In this manner, the program executes without 
switches. 

Exhibit 9.2.4-1. Hourly Weather Roundup Options Window - Select NWR

◾ From the Terminal Window:

1. Type the following command: hwrnwr [-t] [product]

2. The output file will be sent to the correct directory for transmission to the CRS even without 
the options. The optional "-t" switch is for subsequent transmission to the CRS after the 
number of minutes specified in the review period of the configuration file expires. The 
"product" argument permits the user to specify individual products to be created. The default 
is that all products specified in the nwr.config files will be created. 

Page 1 of 1

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



9.2.5 Manual Execution of the HWR NWWS Application

The Hourly Weather Roundup (HWR) NOAA Weather Wire Service (NWWS) application normally runs 
unattended via a cron. However, it can be run manually. 

1. To run the HWR NWWS application manually 

◾ From the System Control Menu:

1. Select Background WFO Apps > Hourly Weather Roundup. The Hourly Weather 
Roundup window, as shown in Exhibit 9.2.5-1, appears. 

2. Select NWWS from the Product Maker section. In this manner, the program executes 
without switches. 

Exhibit 9.2.5-1. Hourly Weather Roundup Options Window - Select NWWS

◾ From the Terminal Window:

1. Type the following command: hwrnwws [-t] [product]

2. The output file will be sent to the correct directory for transmission to the CRS even without 
the options. The optional "-t" switch is for subsequent transmission to the CRS after the 
number of minutes specified in the review period of the configuration file expires. The 
"product" argument permits the user to specify individual products to be created. The default 
is that all products specified in the nwws.config files will be created. 
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9.3 The Monitoring Controller

The Monitoring Controller dialog, as shown in Exhibit 9.3-1 automatically starts when a user logs 
into the AWIPS text display. It alerts the forecaster whenever a background applications product is 
ready for review or editing.

Exhibit 9.3-1. Monitoring Controller Dialog

The Monitoring Controller menu bar has three choices: File, Windows, and Options. 

File

The File menu provides access to the Exit menu option.

Windows

The Windows menu provides the following options:

• The Hourly Weather Roundup option provides access to the NWRWAVES browser. 

• The Daily Climate Data option provides access to the Display Station Daily Climate Values 
dialog. 

• The Daily Climate Product option provides access to the NWR browser. 

Options

The Options menu provides the following options:

• The Climate On button turns Climate notification on or off. 

• The HWR On button turns the HWR notification on or off. 

Notification Messages and Monitoring Controller Dialog Buttons

Page 1 of 2

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Notification messages may be received for one of several different monitoring applications. When a 
notification message is received for a particular application, the text "New" will appear beside its 
button in the Monitoring Controller.

Note: The user may turn the different types of notifications on and off by selecting the Options
menu on the Monitoring Controller. The two monitoring notifications are turned on by default. 

For the HWR, the normal mode of operation is via cron, and the user is notified only if a review value 
greater than "0" is specified in the hwrnwr.conf file.

If a review value greater than "0" is specified ("New" appears next to the Hourly Weather Roundup
button), the NWR will cause a notification, but the NOAA Weather Wire Service (NWWS) will not. 
When the user is notified and presses the Hourly Weather Roundup button, the NWRWAVES 
Browser appears. The NWRWAVES Browser permits the forecaster to view, edit, or transmit the 
HWR products. 

For the Climate application, two notifications will occur in normal processing: 

1. When the create_climate program is run, the user is notified ("New" appears next to the Edit 
Climate Data button). When the Edit Climate Data button is pressed, the Display Station 
Daily Climate Values dialog appears with the new climate data. The user my edit the values 
before the execution goes forward.

2. After the format_climate program runs, the user is again notified ("New" appears next to the 
Edit Climate Product button) and presses the Edit Climate Product button. The NWR 
browser appears, which allows the user to view and edit the daily climate product. Once the 
user is satisfied with the product, it may be transmitted.

Page 2 of 2

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



10.0 Local Data Acquisition and Dissemination

The function of the Local Data Acquisition and Dissemination (LDAD) system is threefold: 

1. Acquire local data sets of varying types and communication means.

2. Perform quality control on the incoming data.

3. Disseminate weather data and information to external users including emergency managers of 
local and State Government agencies.

The LDAD system was built upon the Office of Hydrology's (OH) RFC Gateway and the NWS 
Central Region's PC-Remote Observing System Automation (ROSA) system. 

The LDAD system is a set of software components, both of which reside on the internal AWIPS 
network and the LDAD server, which is the external server. Due to security concerns, the LDAD 
external server and the AWIPS internal network are separated by a security firewall. 

The user interface, data processing, and control are accessed by WFO personnel via the AWIPS 
workstation. The actual components that perform the dial-out and other communications activities 
reside on the external LDAD server.

This chapter includes the following sections:

• Section 10.1: LDAD Scheduler

• Section 10.2: Reserved
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10.1 LDAD Scheduler

The LDAD Scheduler allows you to specify up to 1 year of automatic continuous non-routine data 
requests from either Local Automatic Remote Collector (LARC), Campbell, or Sutron gauges, or 
external cooperative users.

You can access the LDAD Scheduler from CAVE by selecting Obs > Collection/Dissemination, as 
shown in Exhibit 10.1-1.

Exhibit 10.1-1. Accessing LDAD Scheduler from CAVE

The LDAD Scheduler provides access to the LDAD Gateway, which is a set of software components 
that links and allows communication between the internal and external sides of the AWIPS security 
firewall. Through this interface, you can incorporate new data sources into the system and set up 
collection and dissemination scripts for external users.

The LDAD Scheduler dialog, as shown in Exhibit 10.1-2, is divided into two parts: Existing 
Requests and Active Requests.
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Exhibit 10.1-2. LDAD Scheduler Dialog
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10.1.1 Existing Requests

Once products have been requested, this area of the LDAD Scheduler dialog contains a tree-view 
listing of the existing requests. (It is empty if no gauges or users have been chosen.) The request name 
is denoted with a book symbol. Click on the "+" symbol next to the request name to expand the tree 
view and view the contents of the request. A request with a red "X" through the book symbol is 
poorly formed; i.e., the request is missing either a gauge ID or a user, making it unusable.

Each gauge within a request is signified by a blue rain gauge symbol, while a yellow face identifies 
external users.

Click on the "-" symbol next to each request name to close the expanded tree-view listings. 

The Existing Requests section of the LDAD Scheduler dialog also contains the following options. 
Refer to Exhibit 10.1-2. 

• New Request...: This menu button opens the New Request dialog, as shown in Exhibit 
10.1.1-1, which contains options for selecting and requesting data from one or more gauges or 
collecting or disseminating data from external users. 

Exhibit 10.1.1-1. New Request Dialog

This dialog has the following options: 
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◦ Name: Use this entry line to type a unique name to identify your request. 

◦ Single Request: This check button limits the request to one retrieval of gauge or external 
user data. 

◦ Multiple Request: Choose this check button if you want to repeat a request. 

◦ Repeat every: You can choose the update frequency of your request by using the minute
(s)/hour(s) option menus, and by typing the time interval in the entry boxes. 

◦ Duration: With these entry boxes you can choose how many times to re-issue the request 
with "indefinitely" as one of the choices. 

◦ Start time (DDMMHH): If this button is selected, this request will start up at the time 
defined in the input entry box. 

◦ Gauges: You can select one or more gauges from the list.

◦ Users: You can choose one or more users from the list.

◦ OK: This menu button acknowledges the entries you have made and closes the New 
Request dialog. 

◦ Cancel: This menu button closes the New Request dialog without creating new requests. 

• Copy Request...: This menu button opens the Copy Request dialog, as shown in Exhibit 
10.1.1-2. This option allows you to copy the existing highlighted request and give this request a 
new name in the entry line provided. This button is disabled if nothing is currently selected in 
the tree view. 
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Exhibit 10.1.1-2. Copy Request Dialog

• Edit Request...: This button opens the Edit Request dialog, as shown in Exhibit 10.1.1-3. You 
need to select one of the existing requests (or one of the gauge or user IDs in that request) in the 
tree view before you can edit it. The Edit Request dialog has the same options as the New 
Request dialog. 

Exhibit 10.1.1-3. Edit Request Dialog

Page 3 of 4

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



• Delete...: This menu button is context sensitive. What it deletes depends on what is highlighted 
in the Existing Requests list. 

◦ If a request is highlighted and you select the Delete button, the request is removed. A 
confirmation dialog box asks you to verify your deletion.

◦ If a gauge or user ID within the request is highlighted when you select the Delete button, 
the gauge ID is deleted from the request. No confirmation box will appear to request 
verification.

• Modify Gauges: This menu button opens the Modify Gauges dialog. It is described in 
Subsection 10.1.3 and shown in Exhibit 10.1.3-1. 

• Modify Users: This button opens the Modify Users dialog, which provides options to 
create/modify table entries for external users. External users are outside persons/groups that 
send or receive LDAD data. You need to have site information for external users, such as the 
Internet Protocol (IP) address, site login and password, as well as relevant file names. The 
Modify Users dialog contains all the options needed to set up an external user. Your System 
Administrator is responsible for setting up external users. If you opened the Modify Users
dialog and don't wish to make any changes, click the Close button.

• Submit: This button sends a highlighted request to the LDAD Server, which processes your 
request. The button is enabled only if a request containing at least one ID is highlighted in the 
Existing Requests list. The status of your request appears automatically in the Status: window. 
The results of your gauge request appear in the Result: window. 
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10.1.2 Active Requests

The Active Requests area is similar to the Existing Requests area of the LDAD Scheduler dialog 
(refer to Exhibit 10.1-2) in that it lists requests in a tree view layout. However, this section contains 
requests that are currently running. 

Note: A one-time request will never appear in the active request area. Only multiple requests 
appear as active requests. 

• The Active Requests area of the LDAD Scheduler has the following options:

◦ Cancel: This button deactivates the highlighted active request. This button is disabled if a 
request is not selected in the Active Requests tree view.

◦ LDAD Queue: This section of the window contains color indicators showing the LDAD 
Queue status and two percentage readouts that display the capacity at which the LDAD 
queue is currently running.

◾ If the LDAD Queue is overloaded, the indicator is red. Currently active requests 
may not be fulfilled in a timely manner and a backlog may occur.

◾ If it is flashing red, that means a request was just added and the LDAD Queue is 
overloaded. The light flashes red for a few seconds before changing to a steady red.

◾ If it is green, the LDAD Queue is not overloaded.

◾ The percentage readouts indicate the capacity at which the LDAD Queue is 
operating. For the gauges, the operating capacity is determined by calculating how 
many gauges have to be contacted for each request. This calculated number is 
expressed as a percentage of the safe maximum gauge capacity, i.e., the maximum 
number that can be used without creating a backlog. If the calculated number 
exceeds the safe maximum, the percentage is over 100 percent. Otherwise, the 
percentage is at or under this amount. The same calculations apply to the user 
percentage readout.

◾ The percentage readouts allow users to see at a glance whether gauge or user (or 
both) requests can end up being backlogged. If either is over 100 percent, the 
colored indicator will be red instead of green. To bring the percentages down to the 
safe maximum of 100 percent, cancel one or more requests in the Active Requests 
tree view. You will notice how the percentages decrease as requests are canceled.

• The menu buttons at the bottom of the LDAD Scheduler dialog apply to both areas: 

◦ Close: This menu button closes the LDAD Scheduler dialog.
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◦ Help: This menu button opens the online help for information contained in the LDAD 
Scheduler dialog.
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10.1.3 Modify Gauges Dialog

Selecting the Modify Gauges... button in the LDAD Scheduler (refer to Exhibit 10.1-2) will cause 
the Modify Gauges dialog to launch, as shown in Exhibit 10.1.3-1. 

Exhibit 10.1.3-1. Modify Gauges Dialog

Allow a few moments for the Modify Gauges dialog to open as it is a large file. Within this dialog, 
you can create or modify entries for gauges with the following options:

• New: This menu button opens the New Gauge dialog, which is shown in Exhibit 10.1.3-2. 

• Edit: This menu button opens the Edit Session File dialog, which allows you to modify 
information for a selected gauge. All of the options are the same as in the New Gauge dialog. 

• Delete: Use this Modify Gauges dialog button to delete a selected entry from the gauge list. A 
confirmation dialog appears to verify your deletion. 

• Close: This button closes the Modify Gauges dialog. 

Discussions of the dialog boxes reached by pressing the "New" and "Edit" menu buttons follow.
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Exhibit 10.1.3-2. New Gauge Dialog

New: New Gauge Dialog

The New Guage (refer to Exhibit 10.1.3-2 has the following options:

• ID: This entry box is for the five-character gauge ID.

• Non-NWS ID (if any): This entry box is for entering a non-NWS ID. 

• Description: This entry box is for the location (or other helpful) information of a gauge. 

• Phone: This entry box is for the dial-in phone number. You should check all gauges to 
verify their complete local or long distance numbers, including area codes. Be sure to 
include any required external access codes (i.e., some offices require a "9" to be dialed 
before an external phone number). 

• Terminal Server: This entry box is for the terminal server name. The terminal server 
connects your machine to the modems that dial into the gauges.

• Gauge Model: This option menu specifies the type of gauge, as shown in Exhibit 10.1.3-3. 
The choices are Handar (for LARC gauges), Campbell, or Sutron. Depending on which of 
these options is selected, you will need to provide more information specific to the gauge 
model.
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Exhibit 10.1.3-3. Gauge Models with Model Specific Information Blocks

◦ Specific Information: These elements, which are shown in Exhibit 10.1.3-3, will 
appear when you select Handar from the Gauge Model option menu. 

◾ Collected Data: This option menu specifies which data the gauge collects. The 
value is used to determine which session file is used. This option has no effect if 
you choose an alternate session file (the menu will display Unspecified). If the 
session file is being selected automatically, using the value Unspecified has the 
same effect as using the value River Stage. 

◦ Campbell Specific Information: These elements, which are shown in Exhibit 
10.1.3-3, will appear when you select Campbell from the Gauge Model option menu.

◾ Time Zone: This option menu specifies the time zone used in data reported by 
the gauge. 

◾ Datalogger Format:

◾ Setup...: These menu buttons will open an Edit Storage Area Reporting 
Format dialog. 

◾ Has Second Storage Area: If the gauge is equipped with a second 
storage area, select this option. 

◦ Sutron Specific Information: These elements, which are shown in Exhibit 10.1.3-3, 
will appear when you select Sutron from the Gauge Model option menu.

◾ Time Zone: This option menu specifies the time zone used in the data reported 
by the gauge. 

◾ Datalogger Format: The Setup... button found in this field will open an Edit 
Storage Area Reporting Format dialog. This dialog is discussed later in the 
section. This dialog is discussed later in the section.

• Automatically Select Session File: When this radio button is selected, the scheduler will 
determine which session file should be used. A session file is a text-based script that is used 
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to collect data from an external user or disseminate data to an external user. Typically, the 
script is written in a UNIX or Linux scripting language. 

• Use Alternate Session File: When this radio button is selected it allows you to choose a 
specific session file. There are also options for creating and modifying session files. After 
you select this button, the Choose button appears. The Choose button opens the Choose 
Session File dialog, as shown in Exhibit 10.1.3-54. 

Exhibit 10.1.3-4. Choose Session File Dialog

The Choose Session File dialog has the following options: 

◦ Entry Box:You can enter a session file name in this entry box. 

◦ List of Sessions: This is a list of session files. The list may not contain all valid 
session files, in which case you may simply enter the name in the Entry box. 

◦ OK: Once you have selected a session file, this menu button closes the dialog. 

◦ Cancel: This menu button closes the dialog without any changes. 

When a session filename is entered, and the Use Alternate Session File radio button is 
selected, an Edit button appears, which opens the Edit Session File dialog. This option is 
used to create or modify a session file to acquire gauge data. See your System Administrator 
is responsible for creating and modifying session files. 

Edit: Edit Storage Area Reporting Format Dialog

This dialog specifies the data reported by a Campbell or Sutron gauge.  It is shown in Exhibit 
10.1.3-5, and has the following options:

• Array ID: This entry box specifies the array ID associated with the storage area.  This 
option is present only for Campbell gauges. 
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Exhibit 10.1.3-5. Edit Storage Area Reporting Format Dialog

• Reported Data: This list contains the data elements reported by the gauge.  The order of 
elements in this list must match the order of the reported data.  At most, the list may contain 
eight elements. 

• Add...: This menu button will open a menu of data elements that can be reported by gauges.  
Select an item from the menu to add an element to the Reported Data list.  Select the last 
item on the menu if you do not want to include it in the collected data. 

• Remove: This menu button will remove the selected element from the Reported Data list. 

• Move up: This menu button will move a selected list element up one position. 

• Move down: This menu button will move a selected list element down one position. 

• OK: This menu button acknowledges the changes you have made and closes the dialog. 

• Cancel: This menu button closes the dialog box without any changes. 
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10.2 Reserved
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11.0 AWIPS Quality Control and Monitoring System

The AWIPS Quality Control and Monitoring System (QCMS) supplies forecasters with readily 
available quality control (QC) information and statistics. Two types of QC checks are considered: 
static checks, which are single-station and single-time checks, such as internal consistency checks and 
validity checks; and dynamic checks, which take advantage of other hydrometeorological 
information, such as temporal and spatial consistency checks.

Other features of for the QCMS include the use of "data descriptors," which give an overall rating of 
the quality of each observation, development of a QC database for storage of QC results, and the 
ability of forecasters to override objective QC decisions.

Note: The AWIPS QCMS deals with both SBN and LDAD System data. 

This chapter includes the following sections:

• Section 11.1: Overview of QCMS

• Section 11.2: QCMS Text Output and Displays

• Section 11.3: QCMS LDAD Mesonet Displays

• Section 11.4: Reserved
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11.1 Overview of QCMS

The QCMS for AWIPS is a partial implementation of the requirements for AWIPS quality control 
procedures. The implementation includes both subhourly and hourly QC processing. The subhourly 
processing consists of the application of validity, internal consistency, and temporal consistency 
checks to LDAD mesonet observations of sea-level pressure, temperature, dewpoint temperature, 
wind, station pressure, altimeter setting, pressure change, relative humidity, visibility, and 
precipitation observations. The hourly processing consists of the application of validity, internal 
consistency, temporal consistency, and spatial consistency checks to LDAD mesonet and 
NOAAPORT observations of sea-level pressure, temperature, wind, and dewpoint temperature. 

With the subhourly processing, the QCMS checks every 5 minutes for newly arrived observations. 
Observations not previously checked are then immediately quality controlled. The QCMS also 
calculates hourly, daily, weekly, and monthly statistics on the frequency and magnitude of the 
observational errors encountered for sea-level pressure, temperature, dewpoint, and surface winds.

This section discusses the following topics:

• QCMS Automated Checks - Subsection 11.1.1

• QCMS Subjective Intervention - Subsection 11.1.2

• QCMS Observation Files - Subsection 11.1.3

For more details on the QCMS, go to the QCMS website.
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11.1.1 QCMS Automated Checks

QCMS automated quality control procedures consist of validity, temporal consistency, internal 
consistency, and spatial consistency checks. 

The validity checks restrict each observation to a specified set of tolerance limits. The temporal 
consistency checks restrict the temporal rate-of-change of observations at each station to another set 
of tolerance limits. In both cases, observations not falling within the limits are flagged as failing the 
respective QC check. 

The internal consistency checks enforce reasonable, meteorological relationships among observations 
measured at a single station. For example, a dewpoint temperature observation must not exceed the 
temperature observation made at the same station. If it does, both the dewpoint and the temperature 
observation are flagged as failing the internal consistency check. Pressure internal consistency checks 
include a comparison of pressure change observations at each station with the difference of the 
current station pressure and the station pressure 3 hours previous, and a comparison of the reported 
sea-level pressure with a sea-level pressure estimated from the station pressure and the 12-hour mean 
surface temperature. In the former check, if the reported 3-hour pressure change observation does not 
match the calculated observation, then only the reported observation is flagged as bad. In the latter 
check, however, if the reported sea-level pressure does not match the calculated observation, then 
both the sea-level and the station pressure observation are flagged as "failing."

The spatial consistency checks compare observations to values estimated from neighboring data using 
meteorological analysis techniques. The error threshold, to which the absolute value of the difference 
between estimated and observed values is compared, is a function of the expected analysis error. This 
helps account for differences in observed and estimated values, which may be acceptable due to 
estimation errors. The threshold also takes into account the distance of the surrounding stations, as 
well as the differences in elevation.
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11.1.2 QCMS Subjective Intervention

Two text files, a "reject" list and an "accept" list, are provided to allow the site to override the results 
of the automated QC checks. The reject list is a list of stations and associated input observations that 
are labeled as bad, regardless of the outcome of the QC checks; the accept list is the corresponding list 
for stations that are labeled as good, regardless of the outcome of the QC checks. Applications reading 
the lists (e.g., MSAS) reject or accept the stations specified. In both cases, observations associated 
with the stations in the lists can be either flagged individually or in groups. 

The QCMS statistical procedures (and summary files) are not affected by the intervention lists. This 
allows you to continue to monitor the performance of the stations contained in the reject and accept 
lists. For example, you may notice a station with wind observations that fail the QC checks a large 
percentage of the time, and choose to have that station added to the reject list. However, once the 
observation failure rate at the station falls back to near zero (possibly due to an anemometer repair), 
you can recommend that the station be deleted from the reject list. 

The Science and Operations Officer (SOO), Electronic Systems Analyst (ESA), or other focal point 
can change entries in the reject and accept lists. Information on how to edit these lists is contained in 
the AWIPS System Manager's Manual.
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11.1.3 QCMS Observation Files

In addition to the output described in Section 11.2, the QCMS writes netCDF and comma-separated 
value (CSV) observation files for use by AWIPS applications programs. The netCDF files contain 
raw observations and the results of the automated and subjective QC procedures. Also included are 
single-character data descriptors. These are data structures are intended to define an overall opinion of 
the quality of each observation by combining the information from the various QC checks.

Table 11.1.3-1 provides a complete list of the netCDF data descriptors.

Table 11.1.3-1. Data Descriptor Definitions
Preliminary (Z) No QC Applied
Coarse Pass (C) Passed stage 1
Screened (S) Passed stages 1 and 2
Verified (V) Passed stages 1, 2, and 3
Erroneous (X) Failed stage 1
Questionable (Q) Passed stage 1, but failed stages 2 or 3
Subjective Good (G) Included in accept list
Subjective Bad (B) Included in reject list

Stage 1 QC consists of observation validity checks; stage 2, temporal and internal consistency checks; 
and stage 3, spatial consistency checks. 

Raw observations and data descriptors are also included in the CSV files, which are used as input to 
the LDAD SHEF encoder. Table 11.1.3-2 provides a mapping between netCDF and SHEF data 
descriptor definitions.

Table 11.1.3-2. netCDF-SHEF Data Descriptor Mapping
netCDF Description SHEF

Z no QC Z
X failed stage 1 R
Q passed stage 1, failed 2 or 3 Q
C passed stage 1 S
S passed stages 1 and 2 V
V passed stages 1, 2, and 3 P
G subjective override - good G
B subjective override - bad B

Page 1 of 1

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



11.2 QCMS Text Output and Displays

This section provides a basic understanding and usage of the Quality Control Monitoring System 
(QCMS) message format.

This section discusses the following topics:

• Accessing QCMS Summary Files - Subsection 11.2.1

• QCMS Summary File Descriptions - Subsection 11.2.2
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11.2.1 Accessing QCMS Summary Files

You can access the text QCMS files via the Text Display (refer to Chapter 4 for information about 
using the Text Display). The nine-character descriptor name for QC messages is on the 
CCCNNNXXX-based format. 

Here, CCC is the number assigned to the data provider. For example, the first five numbers are 
assigned to national data sets: 

001 SAO (METAR manual)

002 Buoy

003 NPN (NOAA Profiler Network)

004 AUTO (automated, non-ASOS)

005 ASOS

Slots 006 - 020 are assigned to local data networks, ingested into the LDAD system. For example, the 
NWS office in Boulder currently has two local data sets: 

006 Colorado Department of Transportation

007 ALERT Weather

The "NNN" identifies the desired QC summary file, for example:

QCH hourly

QCD daily

QCW weekly

QCM monthly (4 week)

Finally, the XXX is the three-character NWS field office name, such as SLC, SEA, DEN, and OKC. 
For example, in the entry box in a Text Window, the descriptor 003QCDSLC generates a daily 
summary of NPN quality control statistics. 

QC statistics for national data sets such as the NPN are generated at each WFO, as are the local data 
sets. Statistics are maintained separately for each given network, such as ASOS, METARs, or buoy. 
In addition, Automated Surface Observing System (ASOS) network statistics are subdivided by 
individual NWS Regions.
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11.2.2 QCMS Summary File Descriptions

The QCMS collects statistics on observational errors of sea-level pressure, potential temperature, 
dewpoint, surface wind, and altimeter setting. The system provides the total number of observations 
for each variable, the number that failed the QC checks, the station names of the failed observations, 
and the error and threshold values for each of the failed observations. Then statistics are calculated 
and hourly, daily, weekly, and monthly summaries are then made available.

Note: Daily, weekly, and monthly summaries include only those stations with observations that 
have failed more than 25% of the time. 

A QCMS Summary includes data for the following parameters:

• Date/Time: Time interval of summary data, shown in upper left corner of page.

• Variables:

◦ SLP (MB) - Mean sea level pressure, in millibars. 

◦ POT TEMP (DEG F) - Potential temperature, in degrees Fahrenheit. 

◦ DEW PNT (DEG F) - Dewpoint temperature, in degrees Fahrenheit. 

◦ DD (DEG) - Wind direction, in degrees. 

◦ FF (KNTS) - Wind speed, in knots. 

◦ ALT (MB) - Altimeter setting, in megabytes. 

• Total OBS: Number of observations for each variable for the period covered by the report. 
Statistics are calculated for the entire country, but are grouped by region.

• QST OBS: Number of questionable (failed) observations for each variable.

• Percent QST: Percentage of failure for each variable.

• Station ID: Name of failed stations, given in column 1. These names vary depending on the 
data set.

• OB Error: Amount of error (defined as QC estimation minus observation) for each variable.

• Error Threshold: The difference allowed between the estimated and observed values, given in 
parentheses.

• RMS Error: Root-mean-square error of failed observations for each station during the 
prescribed time period (not shown in Exhibits).
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• Mean Error: Mean error of failed observations for each station during the prescribed time 
period (not shown in Exhibits).

• Percent QST:

◦ Percentage of failed observations, or failure rate, for each station for the prescribed time 
period (not shown in Exhibits). 

◦ Daily, weekly, and monthly summaries include only those stations with observations that 
have failed more than 25% of the time. 
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11.3 QCMS LDAD Mesonet Displays

In addition to the text QC output, AWIPS has the ability to display LDAD QC information along with 
the raw Mesonet observations. (Mesonet data include observations from the Department of 
Transportation, Alert Weather, RAWS, cooperative schools, and other cooperative participants. These 
observations will vary among forecast offices.) The QC displays consist of color-coded station plots. 
Stations with observations found bad by the QCMS are distinctly colored to indicate possible 
problems with their reported data. Pointing and clicking on any station invokes the display of a small 
QC table indicating which QC checks have been applied at the time of the display, which ones have 
been passed, and which ones have been failed. Plots are automatically updated as new data arrives and 
is quality controlled.

An example of a QC table is shown in Exhibit 11.3-1.

Exhibit 11.3-1. Example of a QC Table

Blanks in the table indicate that the associated QC check was not applied. In cases where the check 
was applied, the observation either passed (P) or failed (F) the automated checks, or was labeled good 
(G) or bad (B) through the subjective intervention procedures. 

To access the QC plots from CAVE, you can be on any scale. Then select the MSAS cascading menu 
in the Other section of the NCEP/Hydro pull-down menu.
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11.4 Reserved
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12.0 AWIPS System Monitor

This chapter describes the tools for monitoring the AWIPS system (System Monitor). The AWIPS 
System Monitor provides statuses of products and/or processes for DATA and LDAD datasets. It also 
enables you to monitor SCAN and FFMP data; check the workstation's disk usage; and monitor and 
display the workstation's CPU utilization.

The HTML online User's Manual, the System Manager's Manual, and links to other important 
forecasting information are accessible from the System Monitor. 

This chapter includes the following sections:

• Section 12.1: The AWIPS System Monitor

• Section 12.2: Extras - Online Documentation

• Section 12.3: Reserved
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12.1 The AWIPS System Monitor

The AWIPS System Monitor is accessed via the Internet, which is invoked by selecting the Firefox 
Web Browser option on the AWIPS Menu. The AWIPS Menu can be accessed directly or via the 
Main Menu. Both menus are opened by selecting the appropriate icon at the bottom of the GNOME 
desktop, as shown Exhibit 12.1-1. The AWIPS System Monitor opens immediately to the DATA 
Monitor page shown in Exhibit 12.1-2 upon selecting the Firefox Web Browser option.

Exhibit 12.1-1. Accessing the AWIPS Menu for Selecting the Firefox Web Browser Option
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Exhibit 12.1-2. AWIPS System Monitor Home Page - DATA Monitor

The AWIPS System Monitor is a software-based system used to monitor resources and performance 
for DATA, LDAD, SCAN, and FFMP. When left running, the AWIPS System Monitor automatically 
updates the status of the monitored products and processes for the selected monitor.

All the individual datasets, which contain products and/or processes associated with the monitored 
dataset (DATA and LDAD), can be expanded by clicking Expand All. If you only want to expand a 
single dataset, you can do that by clicking the Plus sign (+) iconified button on the far right of the 
dataset row. When a dataset is expanded, it lists the statuses of the products and/or processes 
applicable to the selected dataset. When a dataset is contracted, it displays the lowest-level product or 
process status within that dataset. Subsection 12.1.1, Monitoring Status Indicators, explains statuses in 
detail. 

Note: Because the AWIPS System Monitor is continually updating the state of the system, 
information displayed on the captured screens in this document for a particular dataset may not 
always display the same status or information. 
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12.1.1 Monitoring Status Indicators

The AWIPS System Monitor reports on the timeliness and/or completeness of a given dataset. Each 
dataset has been given threshold values for both timeliness and completeness depending on the typical 
update frequency and volume of the incoming data. 

The symbols, shown in Exhibit 12.1.1-1, are used to indicate the status of the data.

Exhibit 12.1.1-1. Status Symbols

• Green checkmark indicates that data is being received in a complete and timely manner. For 
grid data, the percentage of current completeness is also provided. For data disk usage, a green 
check mark indicates that the disks are running at acceptable levels of use.

• Yellow triangle indicates that data is somewhat late. For data disk usage, the yellow triangle 
indicates that the disks are running at a somewhat high level. A change from a "green" to a 
"yellow" state is noteworthy and a message is sent to the NCF. Green-to-yellow state changes 
are logged but do not appear on the NCF controller's screen.

• Red circle indicates that data are very late and/or very incomplete. For data disk usage, a red 
circle indicates that the disks are exceeding acceptable levels of usage. A change from a 
"yellow" to a "red" state is an indicator of a more serious problem and a message is sent to the 
NCF. Yellow-to-red state changes are logged and appear on the NCF controller's screen.

For an example showing all the status symbols, refer to Exhibit 12.1.1-2. The status symbol that is 
displayed on a dataset's row represents the lowest-level status of a product or process within that 
particular dataset. For example, if the products or processes within a particular dataset have all green 
checkmarks, the dataset will show a green checkmark. In Exhibit 12.1.1-2, the Satellite Data set is 
displaying a yellow triangle because one of the satellite products (Supernational Imager Visible) has 
that status.
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Exhibit 12.1.1-2. Example Showing System Monitor Status Symbols
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12.1.2 Monitored Datasets and Application Data

This subsection displays and describes the contracted and expanded monitoring pages for the DATA 
and LDAD datasets and the SCAN and FFMP application data pages.
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12.1.2.1 DATA Datasets

The datasets of products under DATA monitoring are shown in Exhibit 12.1.2.1-1. The status column 
for each contracted dataset summarizes the status of that dataset. Use the Contract (-) / Expand (+) 
button, located on the right side of the dataset status symbol, to expand the dataset. When expanded, a 
status is supplied for each product listed within the dataset.

Exhibit 12.1.2.1-1. DATA Datasets - Contracted

Exhibits 12.1.2.1-2 through 12.1.2.1-10 illustrate the individual pages for monitoring the products 
within each DATA dataset, as well as Disk Usage and CPU Utilization.

The AWIPS II Process Monitor allows a user to quickly see what AWIPS II processes are running. 
The data is actually populated by the ITO agents that are running on the various servers. The monitor 
displays the current status of the process along with the last time it was successfully checked.
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Exhibit 12.1.2.1-2. AWIPS II Process Monitor - Expanded
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Exhibit 12.1.2.1-3. Satellite Data Set Products - Expanded
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Exhibit 12.1.2.1-4. Radar Data Set Products - Expanded
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Exhibit 12.1.2.1-5. Point Data Set Products - Expanded
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Exhibit 12.1.2.1-6. Grid Data Set Products - Expanded
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Exhibit 12.1.2.1-7. Redbook Data Set Products - Expanded
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Exhibit 12.1.2.1-8. Disk Usage Monitoring - Expanded
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Exhibit 12.1.2.1-9. CPU Utilization Monitoring - Expanded

The DATA monitoring page includes Disk Usage Monitoring and CPU Utilization Monitoring, which 
show disk and CPU checks against all internal AWIPS systems. Expand CPU Utilization Monitoring 
to view the CPU usage for the system. Then click mouse Button 1 (B1) on the statement, "Click here 
to display the CPU Usage for the system" to open the CPU History window, as shown in Exhibits 
12.1.2.1-10.

Page 9 of 10

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Exhibit 12.1.2.1-10. CPU History Window for the Internal AWIPS System
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12.1.2.2 LDAD System Datasets

The datasets of processes and products under LDAD System monitoring are shown in Exhibit 
12.1.2.2-1. The status column for each contracted dataset summarizes the statuses of the processes or 
products associated with that dataset, with the dataset status showing the lowest-level status of a 
process or product within that set. When expanded, a status is supplied for each process or product 
listed within the dataset. 

Exhibit 12.1.2.2-1. LDAD System Datasets - Contracted

When expanded, the named LDAD Process(es) are listed under the LDAD Processes dataset, as 
shown Exhibit 12.1.2.2-2.
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Exhibit 12.1.2.2-2. LDAD Processes - Expanded

When expanded, the LDAD Acquisition Product(s) are listed under the LDAD Acquisition Data set, 
as shown Exhibit 12.1.2.2-3.
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Exhibit 12.1.2.2-3. LDAD Acquisition Data - Expanded

When expanded, the LDAD Dissemination Product(s) are listed under the LDAD Dissemination Data 
set, as shown Exhibit 12.1.2.2-4.
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Exhibit 12.1.2.2-4. LDAD Dissemination Data - Expanded

Note: LDAD Disk Usage Monitoring and LDAD CPU Utilization Monitoring are checks against 
the LDAD servers, not the internal AWIPS system. Unlike CPU Utilization Monitoring of the 
internal AWIPS system, which was accessible from the DATA monitoring page, LDAD CPU 
Utilization Monitoring does not open a CPU History page. 
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12.1.2.3 SCAN Application Data Monitoring

The SCAN Data Monitoring System page, shown in Exhibit 12.1.2.3-1, refreshes every 2 minutes, 
displaying the most recent data for the radars and systems monitored by SCAN.

Exhibit 12.1.2.3-1. SCAN Data Monitoring System Page
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12.1.2.4 FFMP Application Data Monitoring

The FFMP Data Monitoring System page, shown in Exhibit 12.1.2.4-1, refreshes every 2 minutes, 
displaying the most recent QPE and Non-QPE data for the radars operating within the FFMP system. 

Exhibit 12.1.2.4-1. FFMP Data Monitoring System Page
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12.2 Extras - Online Documentation

Another selection on the AWIPS System Monitor, which is not a system monitoring function, is the 
Extras option, as shown in Exhibit 12.2-1. The Extras page enables the user to access current Online 
Documentation, including the AWIPS CAVE-D2D User's Manual and the AWIPS System Manager's 
Manual, as well as links to other sites of interest to the meteorologist.

Exhibit 12.2-1. AWIPS System Monitor Extras Page - Online Documents

Other online AWIPS documents and site URLs can be added to the server as they become available. 
They would be listed and accessed here on the Extras page.

Page 1 of 1

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



12.3 Reserved
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13.0 MDL and OHD Applications

This chapter describes the applications developed by the NWS Meteorological Development 
Laboratory (MDL) and NWS Office of Hydrologic Development (OHD), and how to access these 
applications from within the AWIPS environment. Although access to these applications is via the 
AWIPS CAVE interface, the AWIPS CAVE-D2D User's Manual does not discuss them in detail. 
Separate manuals support these NWS-developed applications. Links to the manuals are supplied in 
this chapter.

You can also access the NWS-developed application manuals, as well as other useful AWIPS 
information from Appendix D. AWIPS Applications / Interfaces.

This chapter includes the following sections:

• Section 13.1: NWS Meteorological Development Laboratory (MDL) Applications

• Section 13.2: NWS Office of Hydrologic Development (OHD) Applications
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13.1 NWS Meteorological Development Laboratory (MDL) Applications

The Meteorological Development Laboratory (MDL) develops forecast applications for use at 
Weather Forecast Offices (WFO). The following MDL applications are accessible within AWIPS:

• Aviation Forecast Preparation System (AvnFPS)

• System for Convection Analysis & Nowcasting (SCAN)

• Digital Mesocyclone Detection (DMD)

• Flash Flood Monitoring Prediction: Advanced (FFMPA)

• Forced Flash Flood Guidance (FFFG)

• System on AWIPS for Forecasting & Evaluation of Seas & Lakes (SAFESEAS)

• Fog Monitor

• Four Dimensional Storm Investigator (FSI)

• System for Nowcasting of Winter Weather (SNOW)

Each application is supported by its own manual, as listed below. 

 Refer to the separate AvnFPS User Guide for more information by clicking on the book 
symbol.

 Refer to the separate SCAN Guide for Users for more information by clicking on the book 
symbol.

 Refer to the separate DMD Guide for Users for more information by clicking on the book 
symbol.

 Refer to the separate FFMPA Guide for Users for more information by clicking on the book 
symbol.

 Refer to the separate FFFG Guide for Users for more information by clicking on the book 
symbol.

 Refer to the separate SAFESEAS User's Guide for more information by clicking on the book 
symbol.

 Refer to the separate Fog Monitor User's Guide for more information by clicking on the book 
symbol.
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 Refer to the separate FSI Guide for Users for more information by clicking on the book 
symbol.

 Refer to the separate SNOW Users' Guide for more information by clicking on the book 
symbol.

Refer to NWS Meteorological Development Laboratory (MDL) website for additional information 
and useful links.
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13.1.1 Accessing the Aviation Forecast Preparation System (AvnFPS)

The Aviation Forecast Preparation System (AvnFPS) is an AWIPS application that helps forecasters 
monitor weather conditions and prepare their aviation forecasts. AvnFPS monitoring capability gives 
forecasters quick and continuous feedback on Terminal Aerodrome Forecasts (TAF) as well as 
associated observations. This monitoring capability uses a site-configurable, color-coded scheme. 
AvnFPS includes specialized editors to aid the production of TAFs. These editors can display TAFs, 
guidance products, and current observations as both text and graphics. AvnFPS also includes tools 
that help forecasters assess the quality of each forecast before it is issued. These Quality Control tools 
can assess the syntax of the forecast and compare its meteorological content with a database of 
historical observational data.

AvnFPS is a WFO application. It is accessible from both the CAVE menu and the AWIPS Start 
menu. To view the AvnFPS menu, see Exhibit 13.1.1-1.

Exhibit 13.1.1-1. AvnFPS Menu

Note: Your "Log-in User ID" is already selected when you log into the workstation. 

From the CAVE Menu: To open the AvnFPS Menu from the CAVE menu, shown in Exhibit 
13.1.1-2, select New > Aviation > AvnFPS Menu.
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Exhibit 13.1.1-2. Starting AvnFPS via the CAVE Menu

From the AWIPS Menu: To open the AvnFPS Menu from the AWIPS Menu, shown in Exhibit 
13.1.1-3, select AWIPS start-up menu > Start AvnFPS > AvnWatch GUI.

Exhibit 13.1.1-3. Starting AvnFPS via the AWIPS Menu

For a detailed discussion of AvnFPS, refer to the AvnFPS User Guide.
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13.1.2 System for Convection Analysis and Nowcasting (SCAN)

The System for Convection Analysis and Nowcasting (SCAN) is an integrated suite of multi-sensor 
applications that detect, analyze, and monitor convection, and automatically generate short-term, 
probabilistic forecast and warning guidance for severe weather. SCAN provides forecasters with 
severe weather guidance and supplements forecaster event monitoring with multi-sensor, automated 
event monitoring.

The intended benefits are:

• Longer lead times on warned events, 

• Fewer missed events, 

• Increased forecaster situational awareness, and 

• Reduced forecaster fatigue during warning situations. 

The SCAN menu shown in Exhibit 13.1.2-1, is accessible from the CAVE-D2D Menu Bar. 

Exhibit 13.1.2-1. SCAN Dropdown Menu

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.2.1 Digital Mesocyclone Detection (DMD)

The Digital Mesocyclone Detection (DMD) display is very similar to SCAN's Storm Cell display. 
Both are accessed from the SCAN Menu, as shown in Exhibit 13.1.2.1-1.

Exhibit 13.1.2.1-1. Accessing the DMD Display

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.3 Flash Flood Monitoring and Prediction: Advanced (FFMPA)

The Flash Flood Monitoring and Prediction: Advanced (FFMPA) system (formerly FFMP), is an integrated
suite of multi-sensor applications that detect, analyze, and monitor precipitation, and automatically generate
short-term warning guidance for flash flooding. FFMPA provides forecasters with accurate, timely, and
consistent guidance. The suite of applications also supplements forecaster event monitoring with its multi-
sensor, automated event monitoring.

The intended benefits are:

Longer lead times on warned events,

Fewer missed events,

Increased forecaster situational awareness, and

Reduced forecaster fatigue during warning situations.

Refer to the SCAN menu shown in Exhibit 13.1.3-1 for FFMP options.

Exhibit 13.1.3-1. SCAN Dropdown Menu with FFMP Options

Note: County values are calculated by determining the maximum value of all of the basins within that
county, except for Flash Flood Guidance (FFG), which is averaged for all basins within that county.

Note: DR 6054: The Attribute Color Threshold (ACT) window should be displayed by the right-clicking on
an attribute name title in the FFMP table. This choice was missing from AWIPS-II implementation for FFMP.
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In AWIPS-II, the ACT is now displayed by clicking the Thresholds button and selecting the column name
from the drop down list. Operational Impact: The ticket states that the right-click on the table column issue
has been fixed in the Eclipse upgrade but it doesn't work on Windows which means that if we take away the
current capability (clicking the button) then the Thin Client FFMP will be broken. There is a link to the MDL
FFMP documentation to get details on how to set the attribute threshold. It says to click the column name to
bring up the ACT. It should say to right-click, not just click.

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.3.1 Forced Flash Flood Guidance (FFFG) Graphical User Interface

One of the basic inputs to Flash Flood Monitoring and Prediction (FFMP) is Flash Flood Guidance 
(FFG), which is issued by the nation's River Forecast Centers (RFC). Unfortunately, in some 
instances the FFG issued by the RFC is not valid, or it is no longer representative of true conditions 
for a particular county warning area (CWA). In addition, there are also areas of the country for which 
no RFC issues FFGs.

The Forced Flash Flood Guidance (FFFG) GUI provides NWS forecasters with a method for 
obtaining their own FFG values (hence the word "Forced") for use in FFMP. Whether used for the 
purposes of filling a void left by the RFC, accommodating urban areas or fire scars, or perhaps 
handling antecedent precipitation, FFFG will enhance FFMP's ability to monitor your CWA for flash 
flood potential. The FFFG GUI is an option under the FFMP section of the SCAN menu, as shown in 
Exhibit 13.1.3.1-1.

Exhibit 13.1.3.1-1. Accessing the FFFG GUI

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.4 System on AWIPS for Forecasting and Evaluation of Seas and Lakes 
(SAFESEAS)

The WFO faces a stream of observations spread over a large area of water and land, and highly 
clustered in time. It must be constantly aware not only of current conditions within its area of 
responsibility (AOR), but also of what is moving into and out of its AOR, and how conditions are 
changing within its AOR.

SAFESEAS is an AWIPS decision assistance tool engineered to continuously monitor marine and 
adjacent overland conditions for specific marine weather hazards. It automatically alerts the WFO 
whenever such conditions are detected. It also helps the WFO maintain awareness of how conditions 
are changing within its AOR by providing time trend plots of marine observations. Thus SAFESEAS 
assists the WFO in making faster, earlier, and higher-quality decisions regarding marine watches and 
warnings, and contributes to "no surprises" marine watch/warning service.

SAFESEAS provides capabilities to:

• Display observed marine conditions in ways that help the WFO focus on what it considers most 
important, 

• Facilitate awareness of conditions moving into and out of its area of responsibility (AOR), 

• Customize which station's observations are monitored for each zone in its AOR, and 

• Customize the thresholds at which conditions will be considered threatening. 

The SAFESEAS application can be launched from either the CAVE-D2D OBs menu, shown in 
Exhibit 13.1.4-1, or from the Start-up menu, shown in Exhibit 13.1.4-2.
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Exhibit 13.1.4-1. Launching SAFESEAS from OBs Menu

Exhibit 13.1.4-2. Launching SAFESEAS from Start-up Menu

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.5 Fog Monitor

The Fog Monitor alerts forecasters to visibility hazards using station observations and satellite data. 
The station information is displayed in an interactive table and on the D2D map. Operating during the 
daytime and at night, adjustable algorithms are applied to visible and infrared satellite images in order 
to identify potential areas of fog. Filters help to distinguish fog from possible false signal features, 
such as snow cover and mid-level clouds. The Fog Monitor's display table and configuration tools 
were based on the SAFESEAS design, so forecasters who use SAFESEAS or SNOW will find this 
application's operation familiar.

The Fog Monitor application can be launched from either the CAVE-D2D OBs menu, shown in 
Exhibit 13.1.5-1, or from the Start-up menu, shown in Exhibit 13.1.5-2.
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Exhibit 13.1.5-1. Launching Fog Monitor from OBs Menu
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Exhibit 13.1.5-2. Launching Fog Monitor from Start-up Menu

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.6 Four-dimensional Stormcell Investigator (FSI)

The Four-dimensional Stormcell Investigator (FSI) is an innovative base radar data display application 
that is based on the National Severe Storms Laboratory (NSSL) Warning Decision Support System – 
Integrated Information (WDSSII) graphical user interface. This technology enables users to create and 
manipulate dynamic cross-sections (both vertical and at constant altitude), making it possible to “slice and 
dice” storms and view this cross-section data in three dimensions and across time. The FSI is a 4-panel 
display depicting base radar data from a variety of linked two- and three-dimensional representations. An 
AWIPS extension is used to launch this application into an independent window. The extension is 
accessible from the CAVE-D2D Tools menu and Radar Tools submenu, as shown in Exhibit 13.1.6-1.

Exhibit 13.1.6-1. FSI Menu Option Located on Tools Menu and Radar Tools Submenu

Note 1: In Exhibit 13.1.6-1 the Tools menu has been torn away from the CAVE Menu Bar. 

The FSI extension must be loaded in the D2D Perspective before the main display can be launched. 

1. To load the FSI extension, from the main CAVE-D2D menu 

◾ From the Tools menu or Radar Tools submenu, select 4-D Storm Investigator (FSI). 
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Once the extension is loaded, the legend will list that extension and automatically make it editable, as 
shown in Exhibit 13.1.6-2.

Exhibit 13.1.6-2. CAVE-D2D Display of Loaded FSI Extension

Now that the FSI extension has been loaded, you can launch FSI. 

1. To launch FSI 

◾ In the main CAVE-D2D display pane, center your cursor over the storm of interest, and then 
click the left mouse Button 1.

◾ If your WFO uses more than one dedicated radar, or your backup radars are turned on for 
SCAN, a radar selection GUI will open, as shown in Exhibit 13.1.6-3. Choose which radar's 
data you want to use, and click the "OK" button.

Exhibit 13.1.6-3. Choosing Which Radar to Use for FSI

If your WFO only has one dedicated radar, the FSI window will automatically open, with the data already 
centered on your storm of interest, using the radar data matching your WFO’s dedicated radar, as shown in 
Exhibit 13.1.6-4.

Page 2 of 4

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Exhibit 13.1.6-4. FSI: Four Dimensional Storecell Investigator Main Window

The following FSI display initial conditions will be reset to the values shown each time you launch or re-
launch the FSI from the D2D Perspective:

◦ Product = Reflectivity at 0.5° at the latest time 

◦ Location = centered in latitude/longitude of mouse click on the CAVE-D2D Main Display

◦ Zoom Altitude = 50 meters (about the size of a large supercell storm)

◦ CAPPI Altitude = 2 km (~6.5 kft)

◦ Vertical Cross-Section Altitude = 20 km (~65 kft)

◦ 3D Rotate = 360° (pointing north)

◦ 3D tilt = 0.75 (slightly tilted off the vertical)

◦ Storm Motion Vector = as set by Radar Product Controls

All other display preferences (e.g., loop parameters) will be retained from the previous FSI session. These 
preferences are unique to each individual username.

Note 2: The Graphic Workstations (LX) are equipped with two video graphics cards; one supports 
2D applications, and the other supports 3D applications such as the FSI. The FSI cannot be launched 
on the 2D display, and a pop-up window will appear to remind users if this is attempted. 

Page 3 of 4

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Note 3: Only one FSI display is designed to run at any one time per workstation. If you attempt to 
launch another FSI display using another mouse click to the D2D pane, the original FSI window will 
reposition to a new storm location. 

Refer to Section 13.1 for a link to access the manual discussing this application in detail.

Page 4 of 4

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



13.1.7 System for Nowcasting Of Winter Weather (SNOW)

The System for Nowcasting Of Winter Weather (SNOW) is an AWIPS application suite that 
continuously monitors surface observations for winter weather hazards and automatically alerts the 
forecasters whenever such conditions are detected. SNOW provides capabilities to display observed 
winter weather threats in ways that help forecasters focus on what they consider most important. This 
application’s design was based on the SAFESEAS tool running at maritime WFOs, so users of 
SAFESEAS will find SNOW familiar.

SNOW contains the following monitoring/display components:

• SNOW Monitor 

• SNOW CAVE Plan-view Plots 

• SNOW Tabular Displays: Zone/Station and Trend Plot 

The editor for the SNOW monitoring area is launched from the AWIPS start-up menu. At the bottom 
of the AWIPS start-up menu, click SNOW Apps to configure the SNOW application, by selecting 
Configure Monitor Area or Configure Thresholds for Guardian Monitoring, as shown in Exhibit 
13.1.7-1.

Exhibit 13.1.7-1. Accessing SNOW Application from AWIPS Start-up Menu

The Configure Monitor Area option starts the editor for the SNOW monitoring area. There are two 
modes for editing the monitoring area: Zone mode and Station mode. In the Zone mode, you specify 
which zones/counties are in the monitoring area, and then associate observing stations with the 
zones/counties. In the Station mode, you specify which stations are in the monitoring area and then 
associate zones and counties with the stations. The edit mode is selected via the Zone and Station
buttons in the Configure area, which is near the upper left corner of the SNOW Configure Monitor 
Area Set Up Data window.
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The Configure Thresholds for Guardian Monitoring option starts the editor for the SNOW monitoring 
area thresholds. The SNOW monitor compares observation values (within the user-specific time 
window) against thresholds for alert levels to determine a single, overall threat level for the entire 
monitoring area. The most severe individual observation value threat level becomes the threat level 
for the entire monitoring area. The thresholds for the alert levels are both variable- and zone/county-
specific. The editor for the monitor thresholds allows each site to customize the thresholds. The 
thresholds include wind speed, gust speed, peak wind, temperature, visibility, and snow depth. The 
Meteo tab is useful in the display thresholds interface but has no function in this monitor interface.

The SNOW application is accessed from Obs Menu on the CAVE-D2D Perspective, as shown in 
Exhibit 13.1.7-2. You can also configure SNOW from the Obs menu. The SNOW Monitor is a clock-
driven process that automatically monitors observations in the WFO-configured monitoring area for 
hazardous conditions, as defined through the configuration. It regularly evaluates and updates a 
single, overall threat level for the monitoring area and generate SNOW CAVE Plan-view Plots.

The SNOW CAVE Plan-view Plot consists of two AWIPS CAVE station plots packaged together, 
and nearly identical to their CAVE counterparts: a “METAR” plot and a “Mesonet” plot. The SNOW 
plots differ from the CAVE plots only in that SNOW plots record only those reports that are within 
the office’s monitoring area, as defined by the monitoring area station setup.
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Exhibit 13.1.7-2. Accessing SNOW Application from the CAVE-D2D - Obs Menu

The SNOW Tabular Display consists of two types of display GUIs: the configurable zone/county and 
station tables, and the trend plot. In both configuration tables, individual columns of the table display 
the current threat level for each product, and both the observed value and the threat level for each 
variable. In the zone configuration, each row of the table shows these threat levels for a zone or a 
county, for all zones and counties in the monitoring area. In the station configuration, each row of the 
table shows these threat levels for the stations within (or related to) a single user-selected zone or 
county. Trend plots display a meteogram of a selected variable, or a composite meteogram of the 
values of the variables comprising a selected product, for single stations. The trend covers the most 
recent 24 hours.

To access Zone/County table

• From the Obs menu, select SNOW.
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Note 1: The SNOW Threat Level Zone/County table will display after the D2D loads the 
SNOW plot. 

To access the Station table

• With the Zone/County table displayed, from the Area_Id column, click a zone identifier. 

Note 2: The SNOW Threat Level Zone/County table will close and the Snow Threat Level 
Station table will display. 

To access the Trend plot

• With the Station table displayed, right-click the cell containing the data for which you want to 
see plotted for trend analysis. 

Note 3: The Trend Plot window for the specific station and variable or product of interest 
will display. 

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.2 NWS Office of Hydrologic Development (OHD) Applications

Applications developed by the NWS OHD are accessible from both the CAVE-Hydro Perspective, 
shown in Exhibit 13.2-1, and from the AWIPS Start-up menu, shown in Exhibit 13.2-2.

Exhibit 13.2-1. List of Hydro Apps from CAVE-Hydro Perspective Hydro Menu

Exhibit 13.2-2. List of Hydro Apps from AWIPS Start-up Menu

Not all the OHD applications are accessible from both locations. However, the following can be 
accessed from either location:

• Dam Catalog 

• HydroGen Manager 

• Hydro Time Series 
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• Riverpro 

• Site Specific 

• River Monitor 

Note 1: The HydroView option opens the CAVE-Hydro Perspective window, if you don't 
already have that perspective open. The MPE Editor option opens the MPE Editor, which is also 
accessible from the CAVE-MPE Perspective. 

Note 2: Remember, the AWIPS CAVE-D2D User's Manual only discusses in detail the D2D 
perspective. Other perspectives, including Hydro and MPE, which are mentioned in this section, 
are not discussed in detail in this manual. Refer to the NWS Office of Hydrologic Development 
(OHD) website for additional information and useful links. 
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14.0 Thin Client Remote Access

The Thin Client component supports the NWS enterprise requirements for remote access to baseline 
AWIPS capabilities. The Thin Client can take advantage of new and enhanced AWIPS capabilities in 
a seamless manner as they are deployed to the baseline. There are two versions of the Thin Client: the 
Windows version (Windows OS); and the Linux version (Linux OS).

Windows Version: The Windows version makes it possible to access baseline AWIPS capabilities on 
a laptop computer. The Windows version has a number of target users, including Incident 
Meteorologists (IMET) dispatched to remote locations to gather localized weather information in 
support of hazardous situations.

Linux Version: The Linux version is installed on a dual monitor AWIPS Remote Display (ARD) at a 
Center Weather Service Unit (CWSU).

The Thin Client targets the following users:

• CWSU 

• Weather Service Offices (WSO) 

• Incident Support Specialists (ISS), including IMETs 

• National Centers for Environmental Prediction (NCEP), in partial support of their 
Continuity of Operations Planning (COOP) requirements and remote access 
requirements 

• River Forecast Centers (RFC), in partial support of their backup requirements. 

Note: The Thin Client can also be used to brief state and local emergency managers during 
incident operations. 

The Thin Client component adds the following features to CAVE/AlertViz:

• Support for access to EDEX via a single well-known port (e.g., http port 80). This 
allows CAVE to run on firewall-restricted networks. 

• Support for compression of data sent to/from EDEX. 

• Local caching of localization, map, and weather data. 

• Timed refresh of data. 

This chapter includes the following sections:

• Section 14.1: Starting Thin Client
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• Section 14.2: Thin Client Configuration

• Section 14.3: Thin Client Versions - Specifications, Capabilities, and Limitations
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14.1 Starting Thin Client

Prior to starting the Thin Client, obtain the following information from your System Administrator:

Localization Server: http://<hostname>/services (Example: http://px1f/services)

Site: <three-character localization site ID>

Proxy Server Address (Inside the firewall): http://<hostname> (Example: http://px1f)

Proxy Server Address (Outside the firewall): https://<hostname> (Example: https://px1f).

Thin Client Process

. Thin Client uses the same code installation as CAVE. Depending on the operating system (Windows or
Linux), you start Thin Client by providing the appropriate options to CAVE at CAVE startup.

For Linux, Thin Client (and CAVE) really consists of two processes:

AlertViz: The error and alert message client

CAVE: The Common AWIPS Visualization Environment.

AlertViz must be up and running before CAVE is started.

For Windows, Thin Client only requires the CAVE process. The error and alert message client (AlertViz) is a
process that runs within CAVE called Alert View instead of AlertViz.

Starting AlertViz for the Linux User

In ordinary usage AlertViz will automatically start on the workstation when you log in.

Note 1: Ordinarily the command for automatically starting AlertViz will be put into the file /etc/xdg
/autostart/awips2-alertviz.desktop so that the command will be executed when logging into the
workstation.

However, if AlertViz does not start automatically, you will need to start it manually.

Open a terminal window and start Thin Client AlertViz (aka thinalertviz) by entering on the command
line:

/awips2/alertviz/alertviz.sh -component thinalertviz.

It can also be started in the background and redirected:

/awips2/alertviz/alertviz.sh -component thinalertviz > av.out 2>&1 &.
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When AlertViz starts, the AlertViz notification bar shown in Exhibit 14.1-1 appears on your screen.

Exhibit 14.1-1. AlertViz Notification Bar

When AlertViz starts it attempts to connect to a localization server. It gets the localization server address
from a file in ~/caveData. If there is no caveData directory in the home directory or if AlertViz cannot contact
a localization server at the address it gets from caveData, the AlertViz will open the Connectivity Preferences
dialog and highlight the fields in red that need to have information entered, as shown in Exhibit 14.1-2. This
situation will most frequently occur after updates of the AWIPS software on the workstation. It is a good
practice to delete ~/caveData when updating the AWIPS software.

Exhibit 14.1-2. Connectivity Preferences Dialog When Unable to Connect to Localization Server

Connecting to a Localization Server

In the Connectivity Preferences dialog, shown in Exhibit 14.1-2, enter the information you obtained
from your System Administrator. You should also check the "Use Proxy Servers" checkbox.

For ARD users at CWSUs, the <hostname> in the addresses will almost always be <px1f>, making the
Localization Server address http://px1f. For users inside the firewall, the compression proxy server
supporting the Thin Client will listen on port 80, the standard port for the http protocol. For users
outside the firewall, the Thin Client will use port 443. Therefore, in both cases there is no need to add
an explicit port number to the address.

The Prompt for settings on startup check box is unchecked by default. If enabled, every startup of
CAVE will prompt the user with the Thin Client Connectivity Preferences dialog. This allows for the
option to enter a different proxy server address instead of removing cave data.  

1. 

Click the Validate button after completing all the required fields. All the fields on the Connectivity
Preferences dialog should turn white, and the Status should state “Successful connection” as shown in
Exhibit 14.1-3.

2. 

file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users Manual/OB16...

2 of 5 1/28/2016 12:37 PM



Exhibit 14.1-3. Connectivity Preferences Dialog When All Fields Are Valid

Click the OK button. The AlertViz notification bar shown in Exhibit 14.1-1 will appear on the screen.
Once AlertViz is running, Thin Client CAVE can be started.

3. 

Authentication for Users Outside the Firewall When AlertViz Is Launched:

A user running Thin Client on an untrusted network outside of the firewall will receive the pop-up
authentication "Log in" dialog box shown in Exhibit 14.1-4 when AlertViz is launched. Once the Proxy
Server is validated in the Connectivity Preferences dialog shown in Exhibit 14.1-3, the authentication Log in
dialog will appear. The user will enter his or her NOAA Login (email address without @noaa.gov) and
password. After selecting the OK button, the authentication Log in dialog will close, and the user will be
brought back to the Connectivity Preferences dialog.

Exhibit 14.1-4. Authentication Log in Dialog

Starting Thin Client CAVE for the Linux User

The method for starting Thin Client CAVE depends on your operating system (Windows or Linux).

Starting CAVE from Linux: To start CAVE on a Linux OS, open a terminal window and start Thin
Client CAVE (aka thinclient) by entering the following on the command line:

/awips2/cave/cave.sh -component thinclient.

It can also be started in the background and redirected with the following command:

/awips2/cave/cave.sh -component thinclient > tc.out 2>&1 &.

Wait until the system is fully up and running and initial maps are displayed before proceeding.

Authentication for Users Outside the Firewall When CAVE Is Launched:

A user running Thin Client on an untrusted network outside of the firewall will receive the pop-up
Authentication Log in dialog shown in Exhibit 14.1-4 when CAVE is launched. The user will enter his or her
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NOAA Login (email address without @noaa.gov) and password. After selecting the OK button, CAVE will
load and display.

Starting Thin Client CAVE for the Windows User

To start CAVE on a Windows OS, double-click on the CAVE icon on your desktop.

Connecting to a Localization Server

In the Connectivity Preferences dialog, shown in Exhibit 14.1-2, enter the information you obtained
from your System Administrator. You should also check the "Use Proxy Servers" checkbox.

1. 

IMETs outside the firewall will typically use an IP address (hostname is preferred) provided by support
personnel at their WFO to enter into the Server Proxy address field. For users inside the firewall, the
compression proxy server supporting the Thin Client will listen on port 80, the standard port for the http
protocol. For users outside the firewall, the Thin Client will use port 443. Therefore, in both cases there is no
need to add an explicit port number to the address.

For IMET users, the Disable JMS box must be checked as noted in Subsection 14.2.4 (Recommended
Settings for Thin Client Operating Systems).

1. 

The Prompt for settings on startup check box is unchecked by default. If enabled, every startup of
CAVE will prompt the user with the Thin Client Connectivity Preferences dialog. This allows for the
option to enter a different proxy server address instead of removing caveData.  

2. 

Click the Validate button after completing all the required fields. All the fields on the Connectivity
Preferences dialog should turn white, and the Status should state “Successful connection” as shown in
Exhibit 14.1-3.

3. 

Click the OK button.4. 

Authentication for Users Outside the Firewall When CAVE Is Launched:

A user running Thin Client on an untrusted network outside of the firewall will receive the pop-up
Authentication Log in dialog shown in Exhibit 14.1-4 when CAVE is launched. The user will enter his or her
NOAA Login (email address without @noaa.gov) and password. After selecting the OK button, CAVE will
load and display. Alert View (Windows version of AlertViz) will launch within CAVE as a docked tab
alongside the Map Editor in D2D. See Exhibit 14.1-5.
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Exhibit 14.1-5. CAVE with Alert View
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14.2 Thin Client Configuration

When starting the Thin Client from the CAVE command line or launcher, an additional set of options 
is visible in the Preferences dialog box (CAVE > Preferences). These options open preferences 
dialog windows for configuring the Thin Client.

Note: It is not possible to set these options unless CAVE has been started with "-component 
thinclient."

Subsections 14.2.1, 14.2.2, and 14.2.3 describe the preferences dialog windows for configuring the 
Thin Client. Subsection 14.2.4 provides recommended settings for Thin Client operating systems.
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14.2.1 Thin Client Caches Preferences Dialog Window

The Thin Client Caches Preferences dialog window, shown in Exhibit 14.2.1-1, controls the caching 
features of the Thin Client.

Exhibit 14.2.1-1. Thin Client Caches Preferences Dialog Window

The available options are: 

• Cache Directory: This sets the directory on the local workstation to be used for all of 
the caching files. This should be set to a user-specified directory — a subdirectory of 
your user caveData is a good choice. 

• Cache Weather Data: When checked, most weather data is cached after retrieval 
from the PyPies server. Note that Point Data (e.g., from the "Obs" menu) is never 
cached. This caching persists between CAVE sessions. 

• Cache Localization Files: When checked, localization data is cached after retrieval 
from the localization server. Data from the cache is used in preference to those on the 
server, but files that do not exist on the local workstation are fetched from the server 
on demand. However, server updates to files already cached are not retrieved. This 
caching persists between CAVE sessions. 

• Use Only Cached Localization Files: When checked, the Thin Client assumes all 
localization files exist on the local workstation. If a file is not found locally, CAVE 
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gives an error. When you first check this option, the dialog shown in Exhibit 14.2.1-2
appears to prompt you to upload all localization files. 

Exhibit 14.2.1-2. Do you want to synchronize? Dialog

• Sync Files Button: When pressed, this button initiates a localization file 
synchronization. This action should be performed if you change localization or need to 
acquire any localization updates from the server. 

• Cache Map Data: When checked, map data is cached after retrieval from the map 
server. Changes to the map database on the server are seen if the same data is already 
cached locally. This caching persists between CAVE sessions. 
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14.2.2 Thin Client Connections Preferences Dialog Window

The Thin Client Connections Preferences dialog window shown in Exhibit 14.2.2-1 controls the Thin 
Client connections to the EDEX server. The primary component of this connection is the Java 
Messaging System (JMS).

Exhibit 14.2.2-1. Thin Client Connections Preferences Dialog Window

The available options are: 

• Disable JMS: If this box is checked:

◦ the client will not attempt to make a connection to the server, and

◦ the Menu Time Update Interval and Data Update Interval selections 
become available.

• Disable Menu Times: If this box is checked:

◦ the menu times will not update, and

◦ the Menu Time Update Interval selection becomes unavailable.
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• Menu Time Update Interval (min): This determines the frequency with which the 
client will query the server for menu data times. This is only available if Disable 
JMS is checked. 

• Data Update Interval (min): This determines the frequency with which the client 
will query the server for updates to displayed data. This is only available if Disable 
JMS is checked.

Java Messaging System

When CAVE is used in its "non-Thin Client" mode of operation (at WFOs, for example), EDEX uses 
the JMS to notify CAVE that new data is available. CAVE then updates its menu times and data 
displays accordingly.

When CAVE is used in its "Thin Client" mode (by IMETs and at CWSUs, for example), the JMS 
connection may not be available. Even if the JMS connection is available, Thin Client users may 
choose to turn it off to save bandwidth.

Typically JMS messaging is available for ARDs at CWSUs (no firewall between CWSU and WFO), 
but not for IMETs (IMETs connect from the open Internet, where the server will probably be 
protected by a firewall passing only port 80 and blocking JMS).

When JMS is not used (either because it is disabled via the Thin Client Connections Preferences
dialog or because it is blocked by firewalls), the Thin Client must request updates for menu times, 
displayed data, or both.
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14.2.3 Thin Client Servers Preferences Dialog Window

The Thin Client Servers Preferences dialog window, shown in Exhibit 14.2.3-1, allows you to change the
proxy server configuration. The Thin Client uses an http proxy to implement compression and allow
tunneling over a single port.

Exhibit 14.2.3-1. Thin Client Servers Preferences Dialog Window

The available options are:

Use Proxy Servers: When checked, the proxy server is used instead of a dynamically
assigned server. The proxy server is required to support data compression and remote
access. If the proxy server settings are changed, CAVE must be restarted in order for the
changes to take effect.

Proxy Address: Sample format for users inside the firewall: http://remote-edex; and
https://remote-edex for users outside the firewall.
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14.2.4 Localization Preferences Dialog Window

The Prompt for settings on startup option was added to the CAVE Localization Preferences dialog 
window, shown in Exhibit 14.2.4-1. 

Exhibit 14.2.4-1. Localization Preferences Dialog Window

When enabled, the Thin-Client Connectivity Preferences dialog will appear upon each startup of CAVE, 
prompting the user to update the connectivity information if desired.    

14.2.4.1 Recommended Setting for Thin Client Operating Systems

Table 14.2.4.1-1 and Table 14.2.4.1-2 list the recommended settings for "Windows" common use 
cases. Table 14.2.4.1-3 and Table 14.2.4.1-4 list the recommended settings for "Linux" common use 
cases.

Windows OS

Table 14.2.4.1-1. IMET Windows Laptop Using BGAN Satellite Link (Minimal Bandwidth)
Setting Recommended Value
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Cache Directory C:\Users\username\caveData\cache
Cache Weather Data Checked
Cache Localization Files Checked

Use Only Cached Localization Files Checked - ideally the localization files should be synced before deployment while 
you have a fast connection.

Cache Map Data Checked
Disable Menu Times Checked
Menu Time Update Interval Off or infrequent
Data Update Interval As needed
Disable JMS Checked
Use Proxy Servers Checked

Table 14.2.4.1-2. IMET Windows Laptop with 3G Connection (Moderate Bandwidth Usage)
Setting Recommended Value

Cache Directory C:\Users\username\caveData\cache
Cache Weather Data Checked
Cache Localization Files Checked
Use Only Cached Localization Files Checked (Unchecked if performance lags)
Cache Map Data Checked
Disable Menu Times Unchecked
Menu Time Update Interval As needed
Data Update Interval As needed
Disable JMS Checked
Use Proxy Servers Checked

Linux OS

Table 14.2.4.1-3. CWSU Linux Workstation with T1 (Moderate Bandwidth Usage)
Setting Recommended Value

Cache Directory /home/username/caveData/cache
Cache Weather Data Checked
Cache Localization Files Checked
Use Only Cached Localization Files Checked (Unchecked if performance lags)
Cache Map Data Checked
Disable Menu Times Unchecked
Menu Time Update Interval Off (dynamic updates)
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Data Update Interval Off (dynamic updates)
Disable JMS Unchecked
Use Proxy Servers Checked

Table 14.2.4.1-4. Compression Only Settings (i.e., Allow All Server File Updates)
Setting Recommended Value

Cache Directory /home/username/caveData/cache
Cache Weather Data Unchecked
Cache Localization Files Unchecked
Use Only Cached Localization Files Checked (Unchecked if performance lags)
Cache Map Data Unchecked
Disable Menu Times Unchecked
Menu Time Update Interval Off (dynamic updates)
Data Update Interval Off (dynamic updates)
Disable JMS Unchecked
Use Proxy Servers Checked
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14.3 Thin Client Versions - Specifications, Capabilities, and Limitations

This section describes the specifications (hardware and software), and the known capabilities and 
limitations of the Windows and Linux versions of the Thin Client.

See Subsection 14.3.1 for the hardware and software specifications of the Thin Client, and Subsection 
14.3.2 for a summary of its capabilities and limitations.
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14.3.1 Thin Client Hardware and Software Specifications

Windows OS

Table 14.3.1-1 lists the required and recommended hardware and software specifications for the 
laptop that will host the Thin Client at remote locations on the Windows OS.

Table 14.3.1-1. Thin Client Windows Version Hardware/Software Specifications
Specification Hardware/Software Requirements Recommended/Comments

Processor 2GHz Intel Core Duo 2.5GHz Intel i7 or better

Memory 2GB 4GB (CAVE's 32-bit application can only 
access 2GB of memory)

Disk Space Approx. 1GB for program and data caches N/A

Operating System
Windows XP (Windows XP only supports 
OpenGL 2.0 or better if implemented in a 
3rd party video driver)

Vista 32-bit, Windows 7 32-bit, Windows 7 
64-bit

Video Card OpenGL 2.0 capable Nvidia discrete graphics

Linux OS

Table 14.3.1-2 lists the required and recommended hardware and software specifications for the ARD 
workstations at the CWSUs that will host the Thin Client on the Linux OS.

Table 14.3.1-2. Thin Client Linux Version Hardware/Software Specifications
Specification Hardware/Software Requirements Recommended/Comments

Processor Intel Xeon E5620
Memory 6GB

Disk Space

At least 1.5GB on the partition 
holding /awips2 (for the software 
installation); and at least 1GB per user on 
the partition that holds the user cache 
directories, which would usually be /home

Operating System Linux

Video Card Nvidia, OpenGL 2.0 or better, 512MB or 
more

Nvidia GPU Quadro FX 580 512MB GDDR3. 
Two graphic adapters, each capable of 
managing two screens (same as used in LX 
workstations) 
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14.3.2 Thin Client Capabilities and Limitations

Both the Thin Client Windows version and the Thin Client Linux version support all the features of CAVE
and AlertViz except for the following:

Non-D2D perspectives, i.e., GFE, Hydro, MPE, National Centers, and Localization

WarnGen

AvnFPS (Supported for CWSU's only)

Collaboration

4D Storm Cell Investigator (FSI)

LAPS tools

Radar applications and radar tools

Data dissemination and upload

Note: The Windows version has less available memory than the Linux version (refer to Subsection
14.3.1). Therefore, some operations involving multiple large data sets may cause an out-of-memory
error with the Windows version.
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14.3.3 Alert View

Alert View is the Windows version of AlertViz. Instead of the AlertViz message bar and pop up dialog, Alert
View is an eclipse view that launches as part of CAVE. By default, Alert View opens when CAVE is launched
and is a docked tab alongside the Map Editor in D2D. See Exhibit 14.3.3-1.

Exhibit 14.3.3-1. Starting AlertView

The messages are listed in a table format. When a message within the table is selected (highlight by a single
left mouse button click), the entire output of the message is visible in the blank window below. By default, all
priority messages will be visible, but this is configurable in several locations described later in this section.

As messages come in, a pop-up will appear in the lower right hand corner of the desktop, as shown in
Exhibit 14.3.3-2. By default, the pop up box is visible for 3 seconds before it disappears. The purpose of the
pop up is to notify the user even if Alert View is closed, or CAVE is minimized/hidden.
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Exhibit 14.3.3-2. Message Popup

Alert View Preferences

Alert View has several settings that can be accessed from the CAVE -> Preferences dialog as shown in
Exhibit 14.3.3-3.
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Exhibit 14.3.3-3. Alert View Window

The following settings can be applied:

Automatically show AlertView for alerts with priority:

There are 5 options listed in the drop down. The option selected determines which priority
messages will appear in the Alert View table.

All - All priorities
None – No messages will appear in AlertView
Error – Only messages that are errors will be shown
Error + Warning – Only messages that are errors and warnings will be shown
Error + Warning + Info – All messages with the exception of DEBUG will appear in
Alert View

When Alert View is expanded in the Preferences dialog, there are two sub-options; Popup and
Style. See options available for Popup in Exhibit 14.3.4-4.
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Exhibit 14.3.3-4. Popup options

Popup: The following settings can be modifed:

Popup alerts with priority – There are 5 options listed in the drop down. By default, All is
selected. The option selected determines which priority messages will popup.

Duration (seconds) – The amount of time the popup remains on the screen.

Position – This setting determines the position of the popup box. Currently, it is set to the lower
right corner of the display. It can be changed to lower left, upper left or upper right.

Style – See Exhibit 14.3.3-5 to see options for configuring the way alerts appear in the Alert View table.

Priority – If the priority you are interested in is listed in the alert list box, select it to configure
font and colors for that particular priority. If the priority is not listed, select the drop down box
next to Priority. DEBUG, INFO, WARN, and ERROR are the available options. Select a
priority, then select the New button to add it to the alert list box. Note, the delete button can be
selected to remove a configuration from the alert list box.
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Exhibit 14.3.3-5. Alert View Style

Alert View View Menu

In the Alert View tab, there is a View Menu button (upside down triangle). When selected the
following options are presented:

Show – Allows the user to change the alerts shown in the Alert View table on the fly. The

available options are All, Only Errors, Errors + Warnings, as shown in Exhibit 14.3.3-6.
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Exhibit 14.3.3-6. Change Alert Dialog

Preferences – Brings up a filtered CAVE preferences dialog specifically for Alert View, as
shown in Exhibit 14.3.3-7.

file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users Manual/OB16...

6 of 7 1/28/2016 12:31 PM



Exhibit 14.3.3-7. Alert View filtered CAVE Preferences dialog
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15.0 Alert Visualization

This chapter describes the tools for alerting the user to any malfunctions, such as data and signal loss. Alert
Visualization (AlertViz) is the communicator between the AWIPS software and the AWIPS forecaster, and is
a continuously running process on each workstation.

This chapter includes the following sections:

Section 15.1: The Alert Visualization (AlertViz) Interface

Section 15.2: Reserved
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15.1 The Alert Visualization (AlertViz) Interface

The AWIPS AlertViz communication utility is an independent, centralized tool for displaying AWIPS 
alerts and status. AlertViz must be active for CAVE to open. Refer to Subsection 2.2.1. When AlertViz is 
activated, the AlertViz symbol is displayed on the GNOME Panel and the AlertViz Status Bar sits on the 
desktop above the panel, as shown in Exhibit 15.1-1. 

Exhibit 15.1-1. AlertViz Active Symbol and Status Bar

The AlertViz Status Bar can be hidden by opening the AlertViz Menu and unchecking Show Alert 
Dialog, which in the default state is checked. Placing the cursor over the AlertViz Symbol and clicking 
mouse Button 3 (B3) opens the AlertViz Menu, shown in Exhibit 15.1-2.

Exhibit 15.1-2. AlertViz Menu

Note 1: Unchecking Show Alert Dialog only hides the AlertViz Status Bar. The Alert Visualization 
Popup Message Dialog window will still appear on the screen when an alert occurs. 

Alert Visualization Configuration
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The Alert Visualization Configuration dialog controls the configuration of the AlertViz Status Bar. 
Selecting the Configuration option on the AlertViz menu opens the Alert Visualization Configuration 
dialog, shown in Exhibit 15.1-3.

Exhibit 15.1-3. Alert Visualization Configuration Dialog

Note 2: The Alert Visualization Configuration dialog is Workstation independent, meaning it only 
controls the diaplay of alerts for that particular Workstation. 

The Alert Visualization Configuration dialog is divided into three sections. A description of each section 
follows:

1. Layout: In this section the AlertViz Status Bar "Cell #" configuration is defined. The components 
of this section are:

◦ Layout: This component defines the number and layout of the cells. The options are Q4, H1, 
H2, V2, V3, V4, and MO. The "Q" yields a 2 x 2 arrangement, "H" a horizontal 
arrangement, and "V" a vertical arrangement. Selecting "MO" yields no cells. You can also 
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remove the layout and yield the same result as selecting "MO" by clicking on the "Remove 
Selection" button. An example of a V3 layout is shown in Exhibit 15.1-4, which also shows 
how the AlertViz Status Bar would look.

Exhibit 15.1-4. Configuring a Vertical 3-Cell Layout

◦ Category: This column provides a default list of alert categories. 

Note 3: You cannot delete any default categories. When a default category is selected, 
the Delete button is grayed out. 

You can add a new category by selecting the "New" button and providing a name and 
description of the category. Refer to Exhibit 15.1-4.

Note 4: You can only delete categories that you have added, which is indicated by the 
Delete button being active. You can also restore the original default list of categories 
(assuming the default configuration hasn't been modified) by clicking the "Retrieve" 
button at the bottom of the Alert Visualization Configuration dialog and selecting 
"Default" from the list. You can also save the new AlertViz configuration for the 
Workstation by clicking the "Save As" button at the bottom of the dialog and supplying 
a name for the new custom configuration. 

◦ Cell #: This column lists the cell # where the alert for the selected category will appear on 
the Status Bar. "None" indicates that no alerts for that category will be displayed. You can 
clear all categories to "None" by clicking the "Clear All Layouts" button. The "Click cell to 
add to category:" label, as shown in Exhibit 15.1-4, means that clicking a Cell # in the 
Message Text Layout: window will add that Cell # in the Cell # column for the highlighted 
Category.
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2. Source and Priorities: In this section the attributes of the alert are defined. A list of default 
Sources for alerts is shown on the left. 

Note 5: You cannot delete any default sources. When a default source is selected, the Delete
button is grayed out. 

You can add a new source by selecting the "New" button and providing a name and description of 
the source. Refer to Exhibit 15.1-4.

Note 6: You can only delete added sources (non-default), which is indicated by the Delete
button being active. You can also restore the original default list of sources (assuming the 
default configuration hasn't been modified) by clicking the "Retrieve" button at the bottom of 
the Alert Visualization Configuration dialog and selecting "Default" from the list. You can 
also save the new AlertViz configuration for the Workstation by clicking the "Save As" 
button at the bottom of the dialog box and supplying a name for the new custom 
configuration. 

From this section you configure the attributes associated with the alert type (Source). For example, 
you can configure the priority of the alert based on its source and then configure the font and 
background color as it will appear on the AlertViz Status Bar for each priority level. You can also 
configure how you want the alert message to be indicated (blinking, audio, action, etc.) to make 
you aware of the alert. Refer to Exhibit 15.1-3 to view all the attributes for each priority. Select the 
Source, then set its attributes.

3. Common Settings: In this section you define the amount of information (Priority, Source, and 
Category) you want to include on the Alert Visualization Popup Message Dialog. Also in this 
section you define other attributes associated with the Alert Visualization Popup Message Dialog 
Message Log, which is an extension of the Popup Message Dialog. Refer to Exhibit 15.1-3.

When finished, you can save the new configuration as the default or as a new configuration (Save 
As). The AlertViz: Default Config Action pop-up verification window, shown in Exhibit 15.1-5, 
appears when saving the configuration, suggesting the default settings be changed only by the 
AlertViz Manager.

Exhibit 15.1-5. AlertViz: Default Config Action Pop-up Window

When an Alert Occurs

The following actions take place when an alert occurs.

1. The AlertViz symbol changes to a blinking red X.
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2. The alert message is displayed in the window of the AlertViz Status Bar.

3. The Alert Visualization Popup Message Dialog window appears in the middle of the main 
display pane, again telling you what caused the alert.

The Alert Visualization Popup Message Dialog, as shown in Exhibit 15.1-6, displays AWIPS 
system and product monitor messages. When an alert occurs, the Alert Visualization Popup 
Message Dialog window appears only in the display pane where the AlertViz Status Bar is 
running. It is from this dialog window that you would acknowledge the alert and access the stored 
alerts.

Exhibit 15.1-6. Alert Visualization Pop-up Message Dialog

Selecting the Show Log button extends the Alert Visualization Popup Message Dialog window, as 
shown in Exhibit 15.1-7, showing the stored messages in descending order with the latest message 
appearing at the top of the list. If the "Expand Popup Information" checkbox is checked, you can 
double-click on the message to display more information concerning the alert.

Exhibit 15.1-7. Alert Visualization Pop-up Message Dialog Message Log

Note 7: The amount of information displayed in the Alert Visualization Popup Message 
Dialog is controlled by the "Common Settings" section of the Alert Visualization 
Configuration dialog box. In the case of Exhibit 15.1-6, all options under "Text Message" are 
unchecked; in Exhibit 15.1-7, all options are checked. 

If you want to view the Error Log and the Alert Visualization Popup Message Dialog is not open, 
you can display the log by clicking on the Error Log iconified button located on the AlertViz 
Status Bar (refer to Exhibit 15.1-1).

AlertViz Tips
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To access basic tips on how to use AlertViz and information concerning the different priorities, 
click on the AlertViz Tips iconified button located on the AlertViz Status Bar (refer to Exhibit 
15.1-1). The AlertViz Tips! window opens, as shown in Exhibit 15.1-8.

Exhibit 15.1-8. AlertViz Tips! Window

Forced Settings Xml Format

Sometimes the existing response definitions for AlertViz are not quite as specific as the user would 
like it to be. Some AlertViz messages are of an inappropriate Priority and thus can yield a Popup 
when a Popup is not really warranted.  Or, sometimes a site may want a singularly specific 
message to result in a specific sound file - but only that one specific message and sound file. 
AlertViz provides a method to override the response for specific message criteria in the form of a 
Forced Response xml file (just like Guardian did in AWIPS 1). 

The AlertViz Forced Responses file can be found in CAVE --> Localization Perspective --> 
AlertViz --> Forced configuration --> AlertVizForced.xml.  If it does not exist, it must be created 
locally, at the "SITE" level.  The format of this file is described below. 

Note: After the Forced Response file is changed, AlertViz does not need to be re-started.

AlertVizForced Format
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AlertVizForced.xml is an XML file with a root element named <forcedConfiguration>. Each 
forced setting specification is defined with one <item> element within the root element. 

Each <item> element contains two type attributes: Matching criteria and settings. Matching 
criteria determine which messages the forced settings will apply to. Some criteria are optional. 
Settings override values specified in the AlertViz configuration dialog. All settings are optional. 

Matching Criteria:

Attribute 
Name 

Required Description 

sourceKey yes Specifies an AlertViz source 
priority yes Specifies an AlertViz priority name (CRITICAL, 

SIGNIFICANT, PROBLEM, EVENTA, EVENTB, or 
VERBOSE) 

categoryKey no Specifies an AlertViz category name 
textMatch no If specified, the item will only match an alert if its 

message contains this text. 

Settings:

Attribute 
Name 

Format 

text “true” or “false” 
blink “true” or “false”
popup “true” or “false”
foreground #rrggbb – Specifies the red, green, and blue color components. 

Each component is a hexadecimal value in the range 00 to FF. 
background #rrggbb – Specifies the red, green, and blue color components. 

Each component is a hexadecimal value in the range 00 to FF.
audio If “true”, generates a beep. 

If “false”, disables audio. 
Otherwise, this should be the name of an audio file. 

python If “false” or empty, disables Python scripting 

Example

The following example will match against the alert sent by EDEX when an Alert Adaptation 
Parameters message is received from an RPG. The AlertViz client will show the message in the 
text with a green background. The AlertViz client will be prevented from displaying a popup. The 
AlertViz client will also play the “asterisk” sound. 
<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 
<forcedConfiguration> 
<item sourceKey="WORKSTATION" priority="SIGNIFICANT" 

textMatch="Alert Adapation Parameter Message Received" 
popup="false" text="true" background="#00ff00" 
audio="asterisk.wav" />

</forcedConfiguration>
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15.2 Reserved
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16.0 Applications within CAVE

The following applications are accessed from the CAVE menu: 

• Data Delivery 

• Collaboration 

• AWIPS-2 Archiver 

• AWIPS Statistics 

• GIS Data 

As shown in Exhibit 16.0-1, the first four applications are options listed directly under the CAVE 
menu. The fifth, GIS Data, is accessed under the CAVE menu via the Import option. 

Exhibit 16.0-1. Applications within CAVE 

Note: Data Delivery is the only application within CAVE that has a submenu for accessing the 
Data Delivery options (shown detached from CAVE menu in Exhibit 16.0-1). 
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This chapter includes the following sections:

• Section 16.1: Data Delivery

• Section 16.2: Collaboration

• Section 16.3: AWIPS-2 Archiver

• Section 16.4: AWIPS Statistics

• Section 16.5: GIS Data
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16.1 Data Delivery

As of the release of this edition of the User's Manual, the Data Delivery application was not 
operational. 

Data Delivery is a permission-based application, meaning that the System Manager or User 
Administrator controls the user's access to the Data Delivery functionalities (see System Manager's 
Manual - Chapter 30). If granted permission to access this application, Data Delivery allows a user to 
subscribe to a data source or create an ad hoc request and have the data delivered in near real time. 
Whether delivered by subscription or in response to an ad hoc request, the data can be tailored to a 
user's specific temporal, geographic, and parameter needs.

The Data Delivery application is accessed via the CAVE menu, and is comprised of the six 
components, as shown in Exhibit 16.1-1.

Exhibit 16.1-1. Data Delivery Compoenents

A description of each function is discussed in the subsections that follow.

• Dataset Discovery Browser - Creating Subscriptions and Ad Hoc Requests - Subsection 16.1.1

• Viewing Subscriptions and Ad Hoc Requests - Subsection 16.1.2

• Subscription Manager - Subsection 16.1.3

• Notification Center - Subsection 16.1.4

• Load Saved Subset - Subsection 16.1.5

• System Management - Subsection 16.1.6
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• Bandwidth Utilization Graph - Subsection 16.1.7
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16.1.1 Dataset Discovery Browser - Creating Subscriptions and Ad Hoc Requests

The Dataset Discovery Browser is used to retrieve datasets and to create subscriptions and ad hoc 
requests. Although this section is written primarily using GRID dataset examples, the processes being 
discussed are equally applicable to POINT datasets.

Note 1: Subscriptions can also be created via the Subscription Manager. 

Before you can create subscriptions and ad hoc requests, you must select a dataset, which starts by 
selecting the Dataset Discovery Browser... option shown in Exhibit 16.1.1-1.

Exhibit 16.1.1-1. Starting Data Delivery Functionality 

Selecting Dataset Discovery Browser... opens the Dataset Discovery Browser dialog shown in 
Exhibit 16.1.1-2.
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Exhibit 16.1.1-2. Dataset Discovery Browser Dialog Components 

The Dataset Discovery Browser dialog is comprised of four parts, as illustrated in Exhibit 16.1.1-2.

• Part 1 is for selection of the Data Type for retrieval of a desired dataset.

• Part 2 is used to define the Areal Coverage filter for the desired dataset.

• Part 3 is used for additional filtering the dataset products based on: Data Provider, Data Set, 
Level, and Parameter.

• Part 4 lists available dataset products based on selected data type and filtering.

At a minimum, the forecaster must select a Data Type (GRID or POINT) in Part 1 before the 
Update Results button is enabled. Upon clicking the Update Results button, if no additional 
filtering has been selected, all available dataset products, based on the selected data type are 
displayed in Part 4. Whenever you add or remove a filter, select the Update Results button to 
update the information listed in Part 4.

Note 2: Due to the large number of products available for a Data Type, a forecaster may wish to 
reduce the list down to a more manageable number of products by reducing the areal coverage 
and/or applying additional filtering. As additional filtering is added, the list of dataset products is 
reduced upon clicking the Update Results button. 

The subsections that follow describe how to retrieve a desired dataset and how to work within the 
dataset to create a subscription.
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16.1.1.1 Retrieving a Desired Dataset

To retrieve a desired dataset, perform the following actions in the order presented. For the following 
discussion, unless otherwise noted, refer to Exhibit 16.1.1-2.

1. Part 1 – Data Type: Select a Data Type. Once the Data Type is selected, the user can further 
define the dataset search results using the other filters (Part 2 and 3)..

Note 1: The Update Results button becomes active once a data type is selected. Once the 
button is active, the list can be updated at any time. 

2. Part 2 – Areal Coverage: This feature is used to filter the dataset areal coverage based on a 
desired area of interest. Click the Set Area button to open the Area Filter Selection dialog shown 
in Exhibit 16.1.1.1-1.

Exhibit 16.1.1.1-1. Areal Filter Selection Dialog 

In the Area Filter Selection dialog there are three methods for selecting a desired area of interest. 

◦ Manual Lat/Lon Edit: Selecting this radio button makes the upper and lower latitude and 
longitude data fields editable. This enables manual entry of the desired latitude and longitude 
values for the area of interest within the dataset boundaries.

◦ Pre-defined Regions: Selecting this radio button activates two dropdown lists. By default, 
these dropdown lists are set to Pre-defined (left) and WFO scale (right). When Pre-defined 
is selected, the dropdown list on the right displays the D2D scales, as shown in Exhibit 
16.1.1.1-1. User-defined regions can be used by selecting My Region in the Pre-defined
dropdown, then selecting a previously saved region. The latitude and longitude values 
displayed in the upper and lower latitude and longitude data fields reflect the selected region.

◦ Draw Bounding Box: Selecting this radio button and clicking the Draw Bounding Box...
button open the Subset / Subset by Space dialog shown in Exhibit 16.1.1.1-2. The user can 
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draw a “Bounding Box” around the desired area by holding down Mouse Button 1 (B1) at a 
point on the map and dragging the cursor. At the bottom of the Subset by Space dialog, the 
Upper Left and Lower Right data fields display the latitude and longitude values. Clicking 
the Subset dialog's OK button saves the selected area, closes the dialog, and returns the user 
to the Area Filter Selection dialog.

Exhibit 16.1.1.1-2. Subset Dialog — Draw Bounding Box 

Once returned to the Area Filter Selection dialog, clicking the OK button sets the areal coverage 
component for the dataset and returns the user to the Dataset Discovery Browser with the latitude 
and longitude values displayed in the Areal Coverage data fields.

3. Part 3 – Filters: This section displays the applicable filter sets associated with the Data Type
selection. These filters can be used to further narrow the search for the desired dataset. The greatest 
difference between the GRID and POINT data types are the number of filters associated with each 
type. The two data types and associated filters are shown in Exhibit 16.1.1.1-3. Selecting the 
GRID data type displays four filters in the Filters section. Selecting the POINT data type displays 
two filters. The filters under each data type operate in the same manner. A description of each filter 
under the GRID data type follows.
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Exhibit 16.1.1.1-3. Dataset Discovery Browser — GRID and POINT Data Type Filters 

The four filter control buttons located in the Filters section of the Data Discovery Browser dialog 
shown in Exhibit 16.1.1.1-4 enable the user to expand (+) or collapse (-) all filters, enable or 
disable a particular filter (gray button), or clear all previously set filter settings (white button). 
Selecting the gray button opens the Enable Filters dialog. Selecting the white button opens a pop-
up confirmation window asking the user to verify the clearing of all the previously set filters. The 
LED indicator buttons next to each of the filter labels turn green once a selection has been made 
within the filter.

Exhibit 16.1.1.1-4. Dataset Discovery Browser — Filter Controls and Indicators 

A description of the filter types follow:
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◦ Data Provider Filter: Selecting the arrow next to this filter expands the filter as shown in 
Exhibit 16.1.1.1-5. Data providers are listed in the Available Providers field. After 
selecting a provider, the single arrow button moves the selected item(s) to the Selected 
Providers field. The double arrow buttons move all entries to the opposite field. Once a 
provider is selected (moved to the Selected Providers column), the LED indicator button 
turns Green.

Exhibit 16.1.1.1-5. Dataset Discovery Browser — Data Provider Filter 

Note 2: Multiple items may be selected in either the Available or Selected columns. 
Users can execute the keyboard shortcut Ctrl + B1 to select individual items, or Shift + 
B1 to select two items and all items in between. Selected items are highlighted. 

◦ Data Set Filter: Selecting the arrow next to this filter expands the filter as shown in Exhibit 
16.1.1.1-6. Although basic operation of this filter is the same as described for the Data 
Provider filter, users are able to select one, several, or all the available data sets listed in the 
Available Data Sets field. They can also locate data sets using the Search text field. 
Searches can be focused using the Case Sensitive and Exclude checkboxes, and Match Any
and Match All radio buttons.
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Exhibit 16.1.1.1-6. Dataset Discovery Browser — Data Set Filter 

◦ Level Filter: Selecting the arrow next to this filter expands the filter as shown in Exhibit 
16.1.1.1-7. The Level filter operates the same as the Data Set filter.

Exhibit 16.1.1.1-7. Dataset Discovery Browser — Level Filter 

◦ Parameter Filter: Selecting the arrow next to this filter expands the filter as shown in 
Exhibit 16.1.1.1-8. The Parameter filter operates the same as the Data Set filter.
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Exhibit 16.1.1.1-8. Dataset Discovery Browser — Parameter Filter 

4. Part 4 – Update Results: This button updates the list of datasets, based on the selected filters.

Note 3: Applying filters is not necessary in order to view available datasets. However, it does 
reduce the number of datasets to be considered. 

The left image in Exhibit 16.1.1.1-9 shows the results of executing a request for available datasets 
using no filters. The right image in Exhibit 16.1.1.1-9 is an example of a request for available 
datasets using filters. In both cases, the user is provided with the available datasets meeting the 
filtered criteria. Note the number of Datasets Listed on the top-right side of Part 4 for both 
images.
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Exhibit 16.1.1.1-9. Update Results — Unfiltered and Filtered 

Results populate in three columns:

◦ Name: The names of the datasets are listed in this column.

◦ Subscription: Each row within this column contains either an "N" or a "Y." 

◾ "N" signifies that there is no existing subscription against the dataset at the local site.

◾ "Y" identifies datasets from which one or more subscriptions have been created.

◦ Provider: The names of the dataset providers are listed in this column.
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16.1.1.2 Working within a Dataset to Create a Subscription

From the Updated Results list shown in Exhibit 16.1.1.2-1, select a dataset by highlighting its name and 
clicking the Subset button to open the Data Delivery Subset Manager dialog with the name of the selected 
dataset displayed in the title bar. The Data Delivery Subset Manager dialog always opens to the left-most tab.

Exhibit 16.1.1.2-1. Selecting a Dataset to Open the Data Delivery Subset Manager Dialog

GRID Datasets: The Data Delivery Subset Manager dialog for GRID datasets usually contain four tabs. 
These tabs are used to identify the product parameters, forecast period, and location for the desired dataset, 
with the fourth tab listing any saved datasets. Depending upon the selected dataset, an additional tab may 
display. For example, for CMC Ensemble products, a fifth tab, “Ensemble Members” displays a list of the 
available ensemble members, as shown in Exhibit 16.1.1.2-2.

Exhibit 16.1.1.2-2. Data Delivery Subset Manager Dialog — Ensemble Members Tab
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POINT Datasets: The Data Delivery Subset Manager dialog for POINT datasets contain three tabs. These 
tabs are used to identify the retrieval interval and location for the desired dataset, with the third tab listing any 
saved subsets.

A description of the two fields located at the bottom of the Data Delivery Subset Manager dialog follow. 
Both fields are displayed in all the tabs, in addition to the three buttons at the bottom of the dialog.

• Est. File Size: This field provides a rough estimate of the size of the dataset being created based on the 
parameters, numbers of forecast hours, and spatial area selected in the Data Delivery Subset Manager 
dialog, compared to a full dataset.

• Subset Name: This text field is where you enter a subset name. It can be entered at any time during the 
selection of the filters process, but it must be entered prior to clicking the Subscribe button or Query
button.

GRID Datasets Tabs: A description of the four tabs and dialog buttons associated with the GRID Datasets
follow. 

• Vertical Levels/Parameters: By default, the Data Delivery Subset Manager dialog, as shown in in 
Exhibit 16.1.1.2-2, opens with the Vertical Levels/Parameters tab displayed. Depending upon the 
selected dataset, the tab lists one or more available Vertical Levels/Parameters. Each of these levels or 
parameters can be expanded by clicking on the arrow next to the label.

For example, Exhibit 16.1.1.2-3 shows the expanded Convective Level with all parameters for that level 
in the Available Parameters window. After selecting one or multiple parameters, they can be moved 
between the Available Parameters window and the Selected Parameters windows using the directional 
arrows. Once at least one parameter is entered into the Selected Parameters window, the Level’s LED 
indicator turns green to denote that a selection has been made for that parameter.

Exhibit 16.1.1.2-3. Selecting from the Vertical Levels/Parameters Tab

• Forecast Hours: Selecting the Forecast Hours tab shown in Exhibit 16.1.1.2-4, displays all available 
forecast hours for the selected dataset in the Available Hours window. The user is able to then select a 
single forecast hour, multiple forecast hours, or all forecast hours for the dataset.
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Exhibit 16.1.1.2-4. Forecast Hours Tab

• Spatial: Selecting the Spatial tab shown in Exhibit 16.1.1.2-5, enables the user to define a desired area 
for data retrieval. A description of each section of the Spatial tab window follows. 

Exhibit 16.1.1.2-5. Spatial Tab — Use Dataset Boundary (Unchecked)

◦ Section 1 – Use Dataset Boundary: By default, the Use Dataset Boundary checkbox is NOT
checked. When the box is not checked, there are three methods available to the user for defining 
the area of interest, as shown in Exhibit 16.1.1.2-6. These three methods are discussed in 
subsequent paragraphs.

When the Use Dataset Boundary checkbox is checked, all Lat/Lon fields and radio buttons in the 
Subset by Area section are grayed-out. In this situation, the latitude and longitude boundaries 
associated with the domain of the dataset are automatically applied to the latitude and longitude 
data fields and cannot be modified by the forecaster. 
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Exhibit 16.1.1.2-6. Spatial Tab — Use Dataset Boundary (Unchecked/Checked)

◾ Manual Lat/Lon Edit: This option makes the upper and lower latitude and longitude data 
fields editable. This enables manual entry of the desired latitude and longitude values for the 
area of interest within the dataset boundaries.

◾ Pre-defined Regions: Selecting this radio button activates two dropdown lists. When Pre-
defined is selected, the dropdown list on the right displays the D2D scales. By default, these 
dropdown lists are set to Pre-defined (left) and WFO scale (right).

Note 1: The Pre-defined Regions WFO scale boundaries are dependent upon the site to 
which the EDEX has been localized and do NOT imply that the site is a WFO site. 

User-defined regions can be used by selecting the My Region option in the Pre-defined
dropdown list and then selecting a previously saved region from the dropdown list on the 
right. A discussion on how the forecaster can create a customized region is provided in the 
Section 2 – Save Boundary as Region. The latitude and longitude values displayed in the 
upper and lower latitude and longitude data fields reflect the selected region.

◾ Draw Bounding Box: Selecting this radio button and clicking the Draw Bounding Box…
button opens the Subset by Space dialog. A “Bounding Box” can be drawn around the 
desired area by holding down Mouse Button 1 (B1) and dragging the cursor. The latitude 
and longitude boundaries for the bounded area are automatically applied to the Upper Left
and Lower Right data fields at the bottom of the dialog. Refer to Exhibit 16.1.1.1-2. 
Clicking the OK button on the Subset by Space dialog saves the selection, closes the dialog, 
and returns the user to the Subset Manager dialog.

◦ Section 2 – Save Boundary as Region: This option provides the capability to create customized 
regions for future use. When a region is defined by manually entering latitude and longitude 
coordinates in the text fields or by dragging a bounding box on the map, that region can be saved 
for future use by entering a name for the region in the Saved Region Name text field. After 
clicking the OK button, the saved name appears as an option in the dropdown list for My Regions, 
as shown in Exhibit 16.1.1.2-7. 
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Exhibit 16.1.1.2-7. Dropdown List of Saved Region Names

• Saved Subsets: Selecting the Saved Subsets tab shown in Exhibit 16.1.1.2-8, lists of all the subsets 
saved by the user. After selecting a saved subset, users can load the saved subset by clicking the Load
button. Once the subset is loaded, the Vertical Levels/Parameters tab and Forecast Hours tab 
selections populate with the valid selections for the current dataset. The spatial area is not carried 
forward.

Exhibit 16.1.1.2-8. Saved Subsets Tab

For example, there are no similar parameters between the estofs_conus dataset and the gfs dataset. If the 
estofs_conus dataset is selected and the gfs saved subset is loaded, no selections are set within the 
Vertical Levels/Parameters tab. Only the applicable forecast hours selections are applied to the 
estofs_conus dataset.

Once the saved subset is loaded, the forecaster should review the Spatial tab settings/selection and 
modify the area as needed. They can also modify the Vertical Levels/Parameters tab and Forecast 
Hours tab selections, if desired. The forecaster can then submit the subset as a subscription or as an ad-
hoc query.

• Dialog Buttons: A description of the dialog buttons for the Saved Subsets tab follow.

◦ Load: This button loads the selected saved subset.
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◦ Save: This button saves the subset that is currently being worked in the Data Delivery Subset 
Manager dialog. This option can only be executed in the Saved Subsets tab. Once all the filters 
have been set, enter a Subset Name, then click the Save button. Subsets listed in this tab have 
been saved by the user.

◦ Delete: This button deletes a selected saved subset.

POINT Datasets Tabs: A description of the three tabs and dialog buttons associated with the POINT 
Datasets follow. 

• Retrieval Interval (POINT Datasets Only): The Data Delivery Subset Manager for POINT datasets 
opens, by default, in the Retrieval Interval tab shown in Exhibit 16.1.1.2-9 with the Retrieval Interval
set to 5 minutes. The Retrieval Interval (minutes) dropdown allows the forecaster to select a time 
interval from which data is requested and retrieved. For subscriptions, a lower retrieval interval (i.e., 5 or 
10 minutes) allows the data to update more frequently while spreading out the bandwidth utilized for 
retrieving the data. A higher retrieval interval (i.e., 30 or 60 minutes) allows for a longer collection of 
data which then requires greater bandwidth upon retrieval.

Exhibit 16.1.1.2-9. Selecting from Retrieval Interval Tab

The Retrieval Interval values play a more important role when executing ad hoc/one-time request 
queries. When the query is requested, the amount of data returned is based on the selected Retrieval 
Interval value. For example, if the Retrieval Interval value is set to 15 minutes, the query retrieves the 
last 15 minutes of data received for the selected area. The larger the Retrieval Interval, the more data 
returned for the query.

• Spatial: The POINT datasets' Spatial tab functions the same as the GRID datasets' Spatial tab. Refer to 
the Spatial tab discussion for the GRID datasets.

• Saved Subsets: The POINT datasets' Saved Subsets tab functions the same as the GRID datasets' 
Saved Subsets tab. Refer to the Saved Subsets tab discussion for the GRID datasets.

• Dialog Buttons: The dialog buttons for the POINT datasets function the same as the dialog buttons for 
the GRID datasets. Refer to the Dialog Buttons discussion for the GRID datasets.

Subscriptions and Queries: A description of the Subscriptions and Queries function buttons shown in 
Exhibit 16.1.1.2-10 follow. 
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Exhibit 16.1.1.2-10. Data Delivery Subset Manager Dialog Subscribe and Query Buttons

Note 2: The system does not allow the user to continue if the first three tabs (for GRID or POINT) have 
not been completed. 

Subscriptions

• Subscribe...: The Subscribe button is used to submit either a local or shared subscription. Once all the 
filters have been set, clicking the Subscribe button opens the Create Subscription dialog shown in 
Exhibit 16.1.1.2-11. This starts the subscription process.

Exhibit 16.1.1.2-11. Create Subscription Dialog

The created subscriptions can be continuous (having no expiration date), seasonal (repeated yearly for a 
set coverage period), or limited (having a defined start and stop dates/times). The Create Subscriptions
dialog is applicable for both individual and shared subscriptions. The Create Subscriptions dialog 
contains seven sections. A description of each section follows.

◦ Subscription Information: This section includes two fields:

◾ Name: The name entered into the Subset Name text field on the Data Delivery Subset 
Manager dialog appears here. If a saved subset is loaded, the product name displays in this 
field. However, the subscription name may be edited if a different name is desired.

◾ Description: This field is optional. If desired, a description may be added for the 
subscription.

◦ Group Information: This section includes a Group Name field where a group name can only be 
selected from a name on the dropdown list.
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◦ Subscription Duration: This section includes two fields which are controlled by the checkbox 
(Checked or Unchecked):

◾ No Expiration Date - Checked: This checkbox is checked by default. When the checkbox 
is checked, the Start Date and Expiration Date fields and the Select Date buttons within 
this section are disabled.

◾ No Expiration Date - Unchecked: When the No Expiration Date checkbox is unchecked, 
the Start Date and Expiration Date fields and the Select Date buttons are active. When the 
fields are active, clicking on the Select Date button opens the Calendar dialog shown in 
Exhibit 16.1.1.2-12. Both the start or expiration dates and times must be selected in the 
applicable Calendar dialog.

Exhibit 16.1.1.2-12. Calendar Dialog for Subscription Duration Fields

◦ Subscription Active Period: This section includes two fields which are controlled by the 
checkbox (Checked or Unchecked):

◾ Always Active - Checked: This checkbox is checked by default. When the box is checked, 
the Active Period Start and Active Period End fields and the Select Date buttons within 
this section are disabled.

◾ Always Active - Unchecked: When the Always Active checkbox is unchecked, the Active 
Period Start and Active Period End fields and the Select Date buttons are active. When 
the fields are active, clicking on the Select Date button opens the Calendar dialog shown in 
Exhibit 16.1.1.2-13. Note that unlike the Calendar dialog shown in Exhibit 16.1.1.2-12, 
this Calendar dialog does not have a Select Hour (Z) field. For the Active Period Start
and Active Period End selections, the times are automatically set to 00Z.

Exhibit 16.1.1.2-13. Calendar Dialog for Subscription Active Period Fields

◦ Priority/Latency: This section includes two fields: 

◾ Priority (Rule: Normal): This dropdown list field offers three options: High, Normal, and 
Low priorities, which determine download rank among other ad hoc requests and 
subscriptions. The default setting is Normal priority.
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◾ Latency in Minutes: This setting is a window of opportunity for downloading the requested 
dataset. It is the maximum time, in minutes, that the subscription data is allowed to be 
scheduled for download from its time of availability. If the data is unavailable or cannot be 
fulfilled during that time period, the data is not downloaded for that download time window. 
It should be noted that there is no default Latency setting for all GRID data. The value 
displayed in this field is dependent on the selected GRID model. For example, for the GFS 
GRID model the entry would be 115, and for the RAP GRID model, the entry would be 40, 
etc.

◦ Model Cycle Time: This section includes four checkboxes and two buttons. All available model 
run times for the dataset are listed in this section with a checkbox. Individual model run times may 
be selected, or select the Select All button to request all model run times. It should be noted that 
some models, i.e., the ice model, do not list any model cycle times.

Note 3: If the system has undergone a fresh install within the last 24 hours, it is possible that 
not all model cycle times will be available. 

◦ Shared Sites: This section only applies to Shared Subscriptions. Access to this option is 
dependent on the permissions assigned to the user in the AWIPS User Administration dialog (refer 
to the AWIPS System Manager's Manual - Chapter 30). This field enables authorized users to 
enter or select sites with whom to share subscriptions. This process shown in Exhibit 16.1.1.2-14, 
is activated by clicking the Shared Sites button which opens the Site Selection dialog. By default, 
the host site is listed first in the Selected Sites field. Upon selection of the desired shared sites, 
clicking the OK button returns the user to the Create Subscriptions dialog where the selected 
sites are then listed in the Shared Sites field. 

Exhibit 16.1.1.2-14. Shared Subscription Site Selection Process

Submitting the Subscriptions: After all selections have been made in the Create Subscription dialog, 
clicking the OK button causes a Subscription Summary pop-up window shown in Exhibit 16.1.1.2-15 to 
appear informing the user that the subscription has been created. Click the OK button to acknowledge receipt.
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Exhibit 16.1.1.2-15. Subscription Summary Pop-up Window

Depending upon the Subscription Rules setup in the System Management dialog (refer to Subsection 16.1.6 
System Management), if part, or all of a requested subscription is covered by another subscription, upon 
requesting the subscription, a Shared Subscription dialog shown in Exhibit 16.1.1.2-16 may be returned 
notifying the user that the subscription may be a candidate for a shared subscription. The displayed dialog is 
for informational purposes only and does not force the user into any action. Regardless of whether it is 
acknowledged or not, it is followed by the Subscription Summary dialog informing the forecaster that the 
subscription has been created. Both the Subscription Summary and Shared Subscription dialogs should be 
acknowledged by clicking the OK button.

Exhibit 16.1.1.2-16. Shared Subscription Candidate Pop-up Window

In other instances, based on the Subscription Rules that have been applied, if a requested subscription is fully 
covered by a previous subscription, a Subscription Updated popup window appears indicating the requested 
subscription is already covered and the user’s subscription will not be created.

Queries

• Query: The Query button is used to submit an ad-hoc request. Once all the parameter settings have been 
selected, clicking the Query button, as shown in Exhibit 16.1.1.2-10 starts the process for submitting 
the ad-hoc request against the selected dataset, subset, and spatial area parameters. The following 
paragraphs describe how the Query request is executed.

For GRID products, upon selecting the Query button, the Select Data/Cycle dialog opens, as shown in 
Exhibit 16.1.1.2-17.
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Exhibit 16.1.1.2-17. Select Data/Cycle Dialog

When the Select Date/Cycle dialog opens, the Get Latest Data checkbox is checked by default, and the 
Priority dropdown list box is set to Normal. The value displayed in the Latency in Minutes field is 
specific to the selected GRID dataset, which for the GFS model is 115, as shown in Exhibit 16.1.1.2-17. 
With the Get Latest Data checkbox checked, the latest available data is retrieved. If the Get Latest 
Data checkbox is unchecked, the user is able to select the desired data from the list.

Note 4: Executing GRID queries contain one extra dialog compared to executing POINT queries. 

Note 5: Only one model run can be selected at a time. 

The Priority dropdown list box offers High, Normal, and Low priority options. The selected options 
are used to determine download rank among other ad-hoc queries and subscriptions.

The Latency (Minutes) setting provides a “window of opportunity” for downloading the requested 
dataset. It is the maximum time, in minutes, that the subscripted data is allowed to be scheduled to 
download from its time of availability.

When the OK button is selected, the system proceeds to schedule the query request. Regardless of 
whether the query request was for a GRID or POINT product, once the system has completed the 
scheduling process, the Query Scheduled notification pop-up window shown in Exhibit 16.1.1.2-18
appears. This pop-up informs the user that the query was successfully stored and provides the user with 
the estimated completion time for the product.

Exhibit 16.1.1.2-18. Query Scheduled Pop-up Window
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16.1.2 Viewing Subscriptions and Ad Hoc Requests

All retrieved subscriptions and ad hoc requests are viewable through the D2D Product Browser. The 
browser is opened via the CAVE menu by selecting CAVE > Data Browsers > Product Browser. 
When the Product Browser window displays, click on the arrow to expand Data Delivery, then 
expand GRID and POINT to list all stored subscription data. Under the GRID and POINT headings, 
all active subscriptions and ad hoc requests are listed by their assigned names. Refer to Exhibit 
16.1.2-1.

Exhibit 16.1.2-1. Accessing Subscription in Product Browser

For example, refer to Exhibit 16.1.2-1 to view Smoke-test-rtma2p5-ani expanded under GRID 
products in the Product Browser window. All the products associated with the Smoke-test-rtma2p5-
ani listed in the Product Browser have been downloaded from the Data Provider and are available for 
viewing. Expand further and double click a desired product displays the GRID products as contours 
(or POINT products as plot data).
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Exhibit 16.1.2-2. Contour Display of Product Browser Selected GRID Product

Right-clicking Mouse Button 3 (B3) on the desired product causes a pop-up selection menu, as 
shown in Exhibit 16.1.2-3 to open. For grid data, the selection menu allows the forecaster to select 
how they wish to view the data (contour or image), or to view the product information. 

Note: Only Product Info is available for POINT products. 
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Exhibit 16.1.2-3. Pop-up Menu to Select Contour or Image of GRID Product (Image Displayed)
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16.1.3 Subscription Manager

The Data Delivery Subscription Manager dialog shown in Exhibit 16.1.3-1, is accessed by selecting 
Subscription Manager from the Data Delivery option under the CAVE menu. The Data Delivery 
Subscription Manager lists all the subscriptions created by users at the selected office. By default, the 
Office dropdown list displays the local site ID and the Group displays All Subscriptions,

Exhibit 16.1.3-1. Accessing the Data Delivery Subscription Manager Dialog

From the Subscription Manager dialog menus, a user is able to create, edit, copy, view, delete, activate, 
deactivate, and group data delivery local site and shared subscriptions. Local site subscriptions can be 
easily identified by viewing the owners listed in the Owner column of the dialog. Shared subscriptions 
are identified with shared displayed in the Owner column, as shown in Exhibit 16.1.3-1.

Descriptions of the Data Delivery Subscription Manager dialog menus and Deactivate and Activate 
buttons follow.

File

The options under the File menu shown in Exhibit 16.1.3-2 follow.

Exhibit 16.1.3-2. Data Delivery Subscription Manager Dialog File Menu Options
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• New Subscription...: This File menu option opens the Dataset Discovery Browser dialog, which 
allows you to find datasets using filtering options. Once a dataset is selected, the user can then 
begin the process to create subscriptions or ad-hoc requests as previously discussed in Subsection 
16.1.1.

• New Group...: This File menu option opens the Create Group dialog shown in Exhibit 16.1.3-3, 
which allows the user to create a new group made up of selected subscriptions.

Exhibit 16.1.3-3. Create Group Dialog

The Create Group dialog contains five sections. Descriptions of these sections follow.

◦ Group Information - Group Name: It is here that you enter in the text field a desired group 
name that applies to a group of subscriptions.

Note 1: When the Subscription Duration, Subscription Active Period, and/or Areal 
Coverage settings are selected and applied to subscriptions within a group, the group 
subscription settings override the individual subscription settings. 

◦ Subscription Duration: This section includes two fields which are controlled by the 
checkbox (Checked or Unchecked):

◾ No Expiration Date - Checked: This checkbox is checked by default. When the box 
is checked, the Start Date and Expiration Date fields and the Select Date buttons 
within this section are disabled. The Subscription Duration assigned to a group 
overrides the duration for the original subscription when a subscription is added to the 
group.

◾ No Expiration Date - Unchecked: Unchecking the checkbox activates the Start Date
and Expiration Date fields and the Select Date buttons. When the fields are active, 
clicking on the Select Date button opens the Calendar dialog shown in Exhibit 
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16.1.1.2-12. Both the start and expiration dates and times must be selected in the 
applicable Calendar dialog.

◦ Subscription Active Period: This section includes two fields which are controlled by the 
checkbox (Checked or Unchecked):

◾ Always Active - Checked: This checkbox is checked by default. When the checkbox 
is checked, the Active Period Start and Active Period End fields and the Select Date
buttons within this section are disabled. This setting allows data to be retrieved year-
round for the duration of the group subscription.

◾ No Expiration Date - Unchecked: Unchecking the checkbox activates the Active 
Period Start and Active Period End fields and the Select Date buttons. When the 
fields are active, clicking on the Select Date button opens the Calendar dialog shown 
in Exhibit 16.1.1.2-13. This setting allows data to be retrieved only during the active 
period selected via the Calendar dialog. For the Active Period Start and Active 
Period End selections, the times are automatically set to 00Z.

◦ Areal Coverage - No Areal Coverage: By default, this checkbox is checked to indicate No 
Areal Coverage. Unchecking the checkbox activates the Set Area button which, when 
selected, opens the Area Filter Selection dialog. Refer to Subsection 16.1.1.1 for a detailed 
discussion of this feature and the associated dialogs.

◦ User Information: This section identifies the current user by default, but does allow for 
selection of a different user. It also lists all currently available subscriptions. The user can 
then select any or all the available subscriptions to become members of the newly created 
group. However, the new group does not come into existence until the user clicks the OK
button.

• Refresh Table: This File menu option refreshes the information contained in the Data Delivery 
Subscription Manager dialog.

• Approve Pending Subscriptions...: This File menu option permits authorized users to approve 
pending subscriptions. This process is dependent on whether site-specific rules and permissions 
require created subscriptions go through an approval process. Access to this option is dependent on 
the permissions assigned to the user by the site’s AWIPS Administrator in the AWIPS User 
Administration dialog (refer to the System Manager's Manual - Chapter 30). A description of the 
function of the Approve Pending Subscriptions option follows.

◦ Subscribing User: Immediately upon submittal of a subscription, the subscribing user 
receives an AlertViz message, as shown in Exhibit 16.1.3-4, stating the subscription is 
awaiting approval and that a notification message will be generated upon approval.
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Exhibit 16.1.3-4. Subscription Approval Pending AlertViz Notification

◦ Designated Approver: For the designated approver, the Subscription Approval dialog 
shown in Exhibit 16.1.3-5 lists all user-created subscriptions that are pending approval. 
Anyone at the site with approval permissions is able to approve or deny the submitted 
subscription.

Exhibit 16.1.3-5. Subscription Approval Dialog

◦ Subscription Approved: Upon approval of a subscription, a notification message is sent to 
the originating subscriber informing them of the approval. The subscription is then created 
and becomes active.

◦ Subscription Denied: Upon denial of a subscription, a notification message is sent to the 
originating subscriber informing them of the denial. The subscription is not created.

• Set as Default: This File menu option sets the current arrangement of information displayed on the 
Data Delivery Subscription Manager dialog as the default setting. These settings are applied the 
next time the Data Delivery Subscription Manager is opened.

• Load Configuration...: This File menu option opens the Load Configuration dialog shown in 
Exhibit 16.1.3-6, which lists the available configurations for the Data Delivery Subscription 
Manager dialog. The user is able to select and load any listed configuration, and then preview the 
configuration by selecting the Preview button. The Preview button displays the saved 
settings/configuration contents of the selected configuration xml file.
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Exhibit 16.1.3-6. Load Configuration Dialog with Preview Window

• Save Configuration: This File menu option replaces the loaded configuration file with the current 
configuration setup.

• Save Configuration As... This File menu option opens the Save Configuration dialog shown in 
Exhibit 16.1.3-7, which permits the user to save the current configuration setup with a new name 
or to replace any existing configuration file.

Exhibit 16.1.3-7. Save Configuration Dialog

• Delete Configuration...: This File menu option opens the Delete Configuration dialog shown in 
Exhibit 16.1.3-8, which permits the user to delete any listed configuration file).
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Exhibit 16.1.3-8. Delete Configuration Dialog

• Exit: This File menu option closes the Data Delivery Subscription Manager dialog.

Edit

The options under the Edit menu shown in Exhibit 16.1.3-9 follow.

Exhibit 16.1.3-9. Data Delivery Subscription Manager Dialog Edit Menu Options

• Edit Subscriptions...: After selecting a subscription in the Data Delivery Subscription Manager
dialog, selecting the Edit menu option opens the Data Delivery Subset Manager dialog shown in 
Exhibit 16.1.3-10. With the exception of the Continue… button, circled in Exhibit 16.1.3-10, this 
dialog is the same as discussed in Subsection 16.1.1.2. A description of the use of the Continue
button follows.
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Exhibit 16.1.3-10. Data Delivery Subset Manager Dialog

Note 2: The approach for editing subscriptions applies to both local site and shared 
subscriptions. When editing subscriptions, users are able to modify any parameters in the 
Data Delivery Subset Manager dialog. For shared subscriptions, these changes are seen by 
all shared sites. 

Clicking the Continue… button opens the Edit Subscription dialog shown in Exhibit 16.1.3-11. 
Although this dialog consists of eight sections, seven of the eight sections look and operate in the 
same manner as discussed in the Create Subscription dialog described in Subsection 16.1.1.2 for 
both local site and shared subscriptions. However, there are a couple of differences, which are 
discussed below:
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Exhibit 16.1.3-11. Edit Subscription Dialog

◦ Subscription Information - Name: Since the user is editing an existing subscription, the 
subscription name CANNOT be changed.

◦ Reason for Change: This is an optional function that is not required for editing a 
subscription, but provides useful information. Enter the reason for modifying the 
subscription.

◦ OK: After making changes in the Edit Subscription dialog, click the OK button to update 
the subscription and open the Subscription Updated dialog shown in Exhibit 16.1.3-12. If 
the subscription was successfully updated the dialog will contain a message to that effect, as 
shown in Exhibit 16.1.3-12. Click the Edit Subscription dialog's OK button to 
acknowledge this message, which also closes both the Subscription Updated dialog and the 
Edit Subscription dialog, and returns the user to the Data Delivery Subset Manager
dialog.

Exhibit 16.1.3-12. Subscription Updated Dialog — Subscription Updated

If the subscription was not updated because the request is fulfilled by an existing 
subscription, the Subscription Updated dialog displays a message identifying which current 
subscription(s) fulfill the request, as shown in Exhibit 16.1.3-13. In this case, 
acknowledging the Subscription Updated dialog message closes the dialog and returns the 
user to the Edit Subscription dialog. The user can then either continue editing or exit the 
dialog and return to the Data Delivery Subset Manager dialog.
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Exhibit 16.1.3-13. Subscription Updated Dialog — Subscription Completely Fulfilled

• Copy Subscriptions...: This Edit menu option allows a forecaster to take an existing subscription, 
modify its parameters, and apply it to a different area or region. After selecting a subscription to be 
copied in the Data Delivery Subscription Manager dialog, selecting the Copy Subscription...
option opens the Copy Subscription dialog shown in Exhibit 16.1.3-14. Enter a new name in the 
New Subscription Name text field. After clicking the OK button, the new subscription name is 
listed in the Data Delivery Subscription Manager dialog.

Exhibit 16.1.3-14. Copy Subscription Dialog

• Delete/Remove from Subscription: After selecting a subscription to be deleted in the Data 
Delivery Subscription Manager dialog, this Edit menu option opens the Delete Confirmation
dialog shown in Exhibit 16.1.3-15, to confirm the decision to delete the subscription.

Exhibit 16.1.3-15. Delete Subscription Dialog

The deleted subscription is removed from the Data Delivery Subscription Manager dialog. A 
message is displayed in the Notification Center dialog, as shown in Exhibit 16.1.3-16, to inform 
the user that the subscription has been deleted. For shared subscriptions, the deleted subscription is 
removed for the local site but does not affect the subscription at other shared sites.

Exhibit 16.1.3-16. Notification Center Dialog — Deleted Subscription Message

• Edit Group...: Selecting this Edit menu option opens the Edit Group dialog shown in Exhibit 
16.1.3-17. The Edit Group dialog functions the same as the Create Group dialog shown in 
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Exhibit 16.1.3-3. In the Group Name dropdown list, select the group to be edited. Once all edits 
are completed, clicking The OK button in the Edit Group dialog opens an Edit Group pop-up 
window with a message informing the user the subscriptions have been updated. Clicking the OK
button on the pop-up window acknowledges the message and closes the pop-up window and the 
Edit Group dialog.

Exhibit 16.1.3-17. Edit Group Dialog

• Delete Group...: Selecting this Edit menu option opens the Delete Group dialog shown in 
Exhibit 16.1.3-18. After selecting a group to be deleted from the Group Name dropdown list, 
clicking the Delete button opens the Delete Confirmation pop-up window asking the user to 
confirm the decision to delete the group.

Exhibit 16.1.3-18. Delete Group Dialog and Delete Group Confirmation Pop-up Window

Settings

The options under the Settings menu shown in Exhibit 16.1.3-19 follow.
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Exhibit 16.1.3-19. Data Delivery Subscription Manager Dialog Settings Menu Options

• Configure Table...: Selecting this Settings menu option opens the Subscription Manager 
Configuration dialog shown in Exhibit 16.1.3-20. The Data Delivery Subscription Manager
dialog arranges information as a table with columns and headings. The Configure Table… option 
allows the user to customize the order, using the up/down arrows to the right of the Visible 
Columns field, and number of visible columns displayed, using the left/right arrows between the 
Visible Columns and Hidden Columns fields.

Exhibit 16.1.3-20. Subscription Manager Configuration Dialog

Once the customization is done, the user can either select the Apply button, which lets the user see 
their changes, and allows them to continue making additional customizations, or select the OK
button, which applies the customizations and closes the Subscription Manager Configuration
dialog. The Close button closes the Subscription Manager Configuration dialog without 
applying the settings to the Data Delivery Subscription Manager dialog.

• Tooltips: Checking the Tooltips checkbox activates tooltip text in the Data Delivery 
Subscription Manager dialog. This affects all dialogs launched from within the Data Delivery 
Subscription Manager dialog.

Help

The Help menu contains an About Subscription Manager selection, which provides a brief overview of 
the menu options within the 

Data Delivery Subscription Manager dialog. 

Deactivate Button
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There may be times when valid subscriptions are not required or desired at a particular time by a site. In 
these types of situations, rather than deleting the subscriptions and then having to recreate them, the 
forecaster is able to deactivate the subscription(s). To deactivate a subscription, select the subscription 
in the Data Delivery Subscription Manager dialog then click the Deactivate button.

Upon deactivation, the following events occur:

• The forecaster receives the pop-up window shown in Exhibit 16.1.3-21 with a message informing 
the user that the subscription has been updated.

Exhibit 16.1.3-21. <Subscription Name> Activated Pop-up Window

• The Data Delivery Subscription Manager dialog refreshes to show the subscription in a 
deactivated state in the Status column, as shown in Exhibit 16.1.3-22.

Exhibit 16.1.3-22. Data Delivery Subscription Manager Dialog with Active/Deactivated Status

• The Notification Center dialog displays a message that the subscription has been updated, as 
shown in Exhibit 16.1.3-23.

Exhibit 16.1.3-23. Notification Center Dialog with Active/Deactivate Status

• Upon clicking the OK button on the <Subscription Name> Activated pop-up window, the 
Notification Center posts a second message stating that the subscription has been deactivated. An 
example of the message (for another subscription) is shown in Exhibit 16.1.3-23.
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Note 3: While in a deactivated state, the data for the deactivated subscription is no longer 
received by the site. In the case of shared subscriptions, the data is not received by the 
deactivating site, but will remain in effect for the other sites that are sharing the subscription. 

Activate Button

Any subscriptions in a deactivated state can be activated by first selecting the subscription in the Data 
Delivery Subscription Manager dialog and then clicking the Activate button.

Upon activation, the following events occur:

• The forecaster receives the pop-up window, as that shown in Exhibit 16.1.3-21 with a message 
informing the user that the subscription has been updated.

• The Data Delivery Subscription Manager dialog refreshes to show the subscription is now in an 
activated state in the Status column, as shown in Exhibit 16.1.3-22.

• The Notification Center dialog displays a message that the subscription has been updated, as 
shown in Exhibit 16.1.3-23.

• Upon clicking the OK button on the <Subscription Name> Activated pop-up window, the 
Notification Center posts a second message stating that the subscription has been activated. An 
example of the message (for another subscription) is shown in Exhibit 16.1.3-23.

Note 4: Once activated, the site receives the data for the active subscription. In the case of 
shared subscriptions, the data is received by the activating site, but does not affect the state 
other sites have defined for the subscription. In other words, if another site has previously 
deactivated the subscription, it will remain in a deactivated state for that site. 

Page 13 of 13

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



16.1.4 Notification Center

The Notification Center dialog is accessed by selecting Notification Center from the Data Delivery
option under the CAVE menu, as shown in Exhibit 16.1.4-1. The Notification Center dialog is 
arranged in the style of a table. It lists all notifications received by Data Delivery.

Exhibit 16.1.4-1. Accessing the Notification Center Dialog 

In addition to opening the Notification Center dialog, a small DD icon appears on your desktop, as 
shown in Exhibit 16.1.4-2. The DD icon is meant to inform the user that the Notification Center
dialog is open when the dialog is not in view. Clicking mouse Button 1 (B1) on the DD icon opens a 
small pop-up with checkbox, as shown in Exhibit 16.1.4-2. When the checkbox is checked the 
Notification Center dialog remains open and visible. When unchecked, the Notification Center
dialog remains open but not visible and the DD icon will remain active and visible. Once the 
Notification Center dialog is closed, the DD icon disappears. 

Exhibit 16.1.4-2. DD Icon and DD Icon Pop-up 

Descriptions of the Notification Center dialog menus follow.

File

The File menu options are shown in Exhibit 16.1.4-3.
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Exhibit 16.1.4-3. Notification Center Dialog — File Menu

The options under the File menu follow.

• Set as Default: This File menu option sets the current arrangement of information displayed on 
the Notification Center dialog as the default settings. These settings are applied the next time 
the Notification Center dialog is opened.

• Load Configuration...: This File menu option opens the Load Configuration dialog shown in 
Exhibit 16.1.4-4. All available configurations are listed as "xml" files. The user is able to select 
and preview, load, or delete any configuration listed in this dialog.

Exhibit 16.1.4-4. Load Configuration with Preview Window

A description of the Load Configuration dialog function buttons follow.

◦ < < Preview: Before loading the configuration file, you can select and preview the "xml" 
file by the Preview button, which opens the Preview window shown in Exhibit 16.1.4-4.
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◦ Load: Selecting this button loads the selected configuration xml file.

◦ Cancel: Selecting this button cancels the operation without loading the configuration xml 
file.

• Save Configuration: This File menu option replaces the loaded Notification Center 
configuration file with the current configuration setup.

• Save Configuration As...: This File menu option opens the Save Configuration dialog shown 
in Exhibit 16.1.4-5, which permits the user to save the current configuration setup with a new 
name or to overwrite any existing configuration file.

Exhibit 16.1.4-5. Save Configuration Dialog

• Delete Configuration...: This File menu option opens the Delete Configuration dialog shown 
in Exhibit 16.1.4-6, which permits the user to delete any selected Notification Center 
configuration file.
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Exhibit 16.1.4-6. Delete Configuration Dialog

• Exit: This File menu option closes the Notification Center dialog.

Edit

The Notification Center dialog Edit menu is shown in Exhibit 16.1.4-7.

Exhibit 16.1.4-7. Notification Center Dialog — Edit Menu

The options under the Edit menu follow.

• Find: This option acts as a search function within the Notification Center dialog. Selecting 
this option opens the Find dialog shown in Exhibit 16.1.4-8, which allows the user to enter a 
filtered text search.
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Exhibit 16.1.4-8. Find Dialog

• View: The View menu options shown in Exhibit 16.1.4-9, are discussed below.

Exhibit 16.1.4-9. Notification Center Dialog - View menu

• Priority:. Selecting this option opens a submenu listing Priority 1 – 5 as shown in Exhibit 
16.1.4-10.  By default, all priority levels will be enabled to make all notifications visible to the 
user.  The user can then hide notifications by deselecting the desired priority level(s) listed in 
the menu.  It should be noted that by default, the Priority 1 option cannot be disabled and these 
notifications will ALWAYS be displayed.

Exhibit 16.1.4-10. Notification Center Dialog - Priority Menu

• Hide Older Than Selected: After highlighting any given notification message in the 
Notification Center dialog, select this option to hide "all" notifications older than the 
highlighted message.  The older messages are no longer visible in the Notification Center 
dialog.
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• Hide by Notification(s): . This option hides the selected notification message.  Multiple 
messages can be selected using the standard keyboard-mouse shift+MB1 or ctrl+MB1 actions.

• Show Hidden Notifications: This option displays all previously hidden notifications.

Settings

The Settings menu options, shown in Exhibit 16.1.4-11, are discussed below:

Exhibit 16.1.4-11. Notification Center Dialog — Settings Menu

• Configure Table...: This option opens the Notification Configuration dialog shown in 
Exhibit 16.1.4-12. The Notification Configuration dialog allows the user to configure how the 
Notification Center displays its content. The Notification Configuration dialog is divided into 
five areas within the Display Configuration Settings section. A description of each area 
follows.
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Exhibit 16.1.4-12. Notification Configuration Dialog

•

◦ Load All Messages - Checked and Load Last Settings: When the Load All Messages
checkbox is checked, all available messages across the site are displayed in the 
Notification Center dialog. When the checkbox is checked, the Load Last text field/list 
box, the Messages radio button, and the Hours of Messages radio button are disabled 
(grayed out).

◦ Load All Messages - Unchecked and Load Last Settings: When the Load All 
Messages checkbox is unchecked, the Load Last text field/list box is active. In this state, 
the user can enter a number, either manually or select an entry from the Load Last list 
box by using the up and down arrow buttons. Depending on which radio button, 
Messages or Hours of Messages, is selected determines how the entered value is 
applied. A description of the application for each radio button follows.

◾ Messages: When this radio button is selected, the value entered into the Load Last
field represents the number of messages to be loaded/displayed in the Notification 
Center dialog.

◾ Hours of Messages: When this radio button is selected, the value entered into the 
Load Last field represents the number of hours of messages to be loaded/displayed 
in the Notification Center dialog.

◦ Sort Column: This area allows the user to determine which column is used to sort the 
messages and whether to sort the messages in ascending or descending order.

◦ Rows Per Page: This area allows the user to determine how many rows to display on 
each page.
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◦ Priority Symbols: The five options in this area allow the user to customize how they 
want to display the message priorities in the Notification Center dialog. 

◦ Hidden/Visible Windows: This area allows the user to determine which columns are 
visible in the Notification Center dialog.

Once the customization is done, the user can either select from the following buttons at the 
bottom of the Notification Configuration dialog: Once the customization is done, the user can 
either select [Apply] or [OK].  Selecting [Apply] applies the settings, but keeps the user in the 
customization mode.  This lets them see their changes implemented without closing the 
Notification Configuration dialog and allows them to continue making additional 
customization changes.  If finished with their customizations, the user can select [OK] which 
applies the settings and closes the Notification Configuration dialog.  The [Cancel] button 
closes the Notification Configuration dialog without applying the settings to the Notification 
Center dialog.

• Filter Table...: This Settings menu option opens the Notification Filter Settings dialog shown 
in Exhibit 16.1.4-13. The Notification Filter Settings dialog is divided into three sections. A 
description of each section follows.

Exhibit 16.1.4-13. Notification Filter Settings Dialog

◦ Filter by User: This section consists of two areas. A description of each area follows.

◾ Always include my notifications - Checked: When this checkbox is checked, the 
active user’s username appears listed in the Selected Users window. The username 
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remains in the Selected Users window indefinitely until the checkbox is no longer 
checked. A user can select other user-assigned notifications they wish to view or no 
longer view by moving the username(s) between the Available Users window and 
the Selected Users window using the left/right arrows.

◾ Always include my notifications - Unchecked: When this checkbox is 
unchecked, the active user’s username can be moved between the Selected Users
window and Available Users window the same as any other user. All other actions 
are as described in the previous paragraph.

◦ Filter by Subscription: This section allows the user to select subscriptions for which 
they wish to receive or no longer receive notifications by moving the subscription(s) 
between the Available Subscriptions window and the Selected Subscriptions window 
using the left/right arrows. New subscriptions appear in the Available Subscriptions
window. Note:  If no Subscriptions are listed in the Selected Subscriptions field, all 
messages will be displayed in the Notification Center.

◦ Filter by Priority: This section lists priority levels 1 through 5, with a checkbox beside 
each one.  The selection for 1 – Crit is grayed out because, by default, users will always 
receive Critical 1 priority notifications.  All other priorities are selectable by checking or 
unchecking the applicable box. Once the filtering customization is done, the user can 
either select [Apply] or [OK].  Selecting [Apply] applies the settings, but keeps the user 
in the customization mode.  This lets them see their changes implemented without closing 
the Notification Filter Settings dialog and allows them to continue making additional 
customization changes.  If finished with their customizations, the user can select [OK] 
which applies the settings and closes the Notification Filter Settings dialog.  The 
[Cancel] button closes the Notification Filter Settings dialog without applying the 
settings to the Notification Center dialog. 

◦
• Tooltips: Checking the Tooltips checkbox activates tooltip text in the Data Delivery 

Notification Center dialog. This affects all dialogs launched from within the Data Delivery 
Notification Center dialog. 

Help

The Help pull-down menu contains an About Notification Center… selection.  This selection 
provides a brief overview of the menu options within the Notification Center dialog shown in 
Exhibit 16.1.4-14.

Exhibit 16.1.4-14. Notification Center — Help Menu
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16.1.5 Load Saved Subset

From the CAVE menu, select the Data Delivery submenu Load Saved Subset option to open the 
Load Configuration dialog shown in Exhibit 16.1.5-1. 

Exhibit 16.1.5-1. Accessing the Load Configuration Dialog from Load Saved Subset 

By selecting the Load Saved Subsets... option users are able to directly access and load saved subsets 
from the CAVE menu. The Load Configuration dialog that opens list all available saved subsets. This 
is the same set of products that is contained in the Data Delivery Subset Manager dialog — Saved 
Subsets tab. Refer to Subsection 16.1.1.2.

Both the Load Configuration dialog and the Data Delivery Subset Manager dialog — Saved 
Subsets tab function similarly. In both cases, users are able to modify and save, or modify and add a 
new subset. In this regard, the only distinction between the two approaches is not having to use the 
Dataset Discovery Browser to access the saved subsets.

However, a more significant difference between the two is that when loading subsets from via CAVE 
> Data Delivery > Load Saved Subset…, all settings (including the spatial settings, and even the 
original data set) is loaded. If loading a subset from the Saved Subsets tab, the spatial area is not 
carried forward.

A description of the three Load Configuration dialog function buttons, as shown in Exhibit 16.1.5-1, 
follow.

• Preview > >: You can preview the content of a saved subset xml file before loading it by 
highlighting the file and selecting the Preview > > button, which opens the Preview window 
shown in Exhibit 16.1.5-2.
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Exhibit 16.1.5-2. Previewing the Saved Subset 

• Load: Selecting this button loads the saved subset and opens the Data Delivery Subset 
Manager dialog. Refer to Subsection 16.1.1.2 for a complete discussion of this dialog.

• Cancel: Selecting this button cancels the operation without loading the configuration xml file.
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16.1.6 System Management

The System Management dialog is accessed by selecting System Management from the Data 
Delivery option under the CAVE menu, as shown in Exhibit 16.1.6-1. 

Exhibit 16.1.6-1. Accessing the Data Delivery System Management Dialog 

The System Management functionality is only available to the System Administrator or a forecaster 
identified as a focal point. Refer to the System Manager's Manual for additional information.
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16.1.7 Bandwidth Utilization Graph

The Bandwidth Utilization dialog is accessed by selecting Bandwidth Utilization Graph... from the Data 
Delivery option under the CAVE menu, as shown in Exhibit 16.1.7-1.

Exhibit 16.1.7-1. Accessing the Bandwidth Utilization Dialog 

By default, the Bandwidth Utilization dialog opens displaying the active local subscriptions that are fulfilled 
via the Operations Network (OPSNET) data feed. The other data feed network is the Satellite Broadcast 
Network (SBN). To view shared subscriptions, the user would need to drop down the Graph menu and select 
the Display for SBN option. A description of the components that comprise the Bandwidth Utilization dialog 
follow.

The Bandwidth Utilization dialog consists of two sections, at the top is a small graph showing the Percent of 
Bandwidth Used by all the active subscriptions, and at the bottom a larger graph showing all active 
Subscriptions and their download time windows.

The current Subscriptions are listed on the vertical axis of the graph. The horizontal scale presents Time in 
UTC (Coordinated Universal Time). As updates occur, the graph maintains the current time at the far left 
and extends over a 48-hour period. The user is able to use the horizontal scrollbar to view times further into the 
future. This scale applies to both the Percent of Bandwidth Used graph and the Subscriptions graph. 
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Although the time reflects the current time, the actual subscription data displayed on the graph updates 
automatically every 15 minutes. However, there are a couple of exceptions to this rule.

1. The data within the graph updates whenever there is an action taken to force an update (such as updating, 
editing, or creating a new subscription).

2. If an update was made within the 5-minute window leading up to the automatic update, then the graph 
skips the scheduled update until the next automatic update point occurs (up to 20 minutes later).

A description of each section follows.

• Percent of Bandwidth Used

A description of the components of the Percentage of Bandwidth Used section follows.

◦ Legend - Percentages and Colors: On the graph, whether displayed in line form or bar graph 
form, each point represents the percentage of bandwidth used for a three minute period or 
“bucket.” At the top of the Percent of Bandwidth Used graph is the Legend depicting the 
percentage of usage assigned to each color. The percentages shown are a configurable setting, with 
the following default settings:

◾ Green: > 0%

◾ Yellow: > 33%

◾ Red: > 66%

The colors are also configurable. Double-clicking Mouse Button 1 (B1) on one of the colored 
boxes opens the Select a Color dialog shown in Exhibit 16.1.7-2, where the user can change the 
color for the selected box. Repeat for each box you desire to change the color.

Exhibit 16.1.7-2. Opening the Select a Color Dialog 
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◦ Style of Graph - Line or Bar: Clicking Mouse Button 3 (B3) anywhere inside the Percent of 
Bandwidth Used graph area opens a pop-up menu, as shown in Exhibit 16.1.7-3, that allows the 
user to select how they wish to view the data, whether a line graph or a bar graph.

Exhibit 16.1.7-3. Bandwidth Utilization Graph Pop-up Menu — Selecting Line or Bar Graph Style 

• Subscriptions

A description of the components of the Subscriptions section follows.

◦ Priority Legend: Within the Subscriptions graph are colored bars representing the download 
time window for each subscription. At the top of the Subscriptions graph is the Priority legend 
showing the priority assigned to each color.

◾ Red: High Priority

◾ Green: Normal Priority

◾ Blue: Low Priority

The colors representing the different priorities are configurable. Double-clicking B1 on one of the 
colored boxes opens the Select a Color dialog shown in Exhibit 16.1.7-2, where the user can 
change the color for the selected box. Repeat for each box you desire to change the color.

◦ Subscription Details: Clicking B1 on a subscription’s color bar in the Subscription graph places a 
purple box around the bar to show it has been selected. Hovering the cursor inside the box 
displays a popup providing details on the subscription. Refer to Exhibit 16.1.7-1. Details include 
the start time, end time, base time, and availability offset.

◦ Selecting/Deselecting Subscriptions: On the left side of the graph is a list of all subscriptions. 
Beside each subscription is a small box that turns blue when a subscription is selected by clicking 
B1 in the box. Clicking B3 anywhere within the subscription list area displays a pop-up menu with 
three options, as shown in Exhibit 16.1.7-4. If at least one subscription has been selected, all three 
options are active. Otherwise, only the options for selecting or deselecting all the subscriptions in 
the Bandwidth Utilization Graph are active.
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Exhibit 16.1.7-4. Bandwidth Utilization Graph Pop-up Menu — Subscription List Menu 

◦ View Selected Subscriptions: With at least one subscription selected, the View Selected 
Subscriptions… option is active and allows the user to select the option to open the 
Subscriptions dialog shown in Exhibit 16.1.7-5.

Exhibit 16.1.7-5. Subscriptions Dialog 

In addition to the two graphs, the Bandwidth Utilization dialog includes a Menu Bar comprised of two 
menus and a button at the bottom of the dialog. A description of the menus and button follow.

◦ File: The File menu includes two options. Descriptions for each are provided below:

◾ Save: This option saves an image of the graph to a directory selected by the user.

◾ Quit: This option closes the Bandwidth Utilization dialog.

◦ Graph: The Graph menu, as shown in Exhibit 16.1.7-6, includes the six options. A description of 
each option follows.
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Exhibit 16.1.7-6. Bandwidth Utilization Dialog — Graph Menu 

◾ Display for OPSNET: By default, the Bandwidth Utilization Dialog opens in the OPSNET 
view shown in Exhibit 16.1.7-7. By default, the Graph menu's Display for OPSNET option 
radio button is selected by default. This view displays locally created (non-shared) active 
subscriptions fulfilled via the OPSNET data feed.

Exhibit 16.1.7-7. Bandwidth Utilization Dialog — OPSNET Display 

◾ Display for SBN: Selecting the Display for SBN option radio button enables the user to 
view shared subscriptions that are fulfilled via the SBN data feed, as shown in Exhibit 
16.1.7-8.
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Exhibit 16.1.7-8. Bandwidth Utilization Dialog — SBN Display 

◾ Live Update - Checked (Default): With the Live Update checkbox checked, the 
Bandwidth Utilization Graph reflects the current time. The subscription data within the 
Bandwidth Utilization Graph continues to update automatically every 15 minutes and with 
the same exceptions as discussed earlier.

◾ Live Update - Unchecked: When the Live Update checkbox is unchecked, the time in the 
Bandwidth Utilization Graph stops updating. In this case, neither the time nor the 
subscription data within the graph update any further until the Live Update box is checked.

◾ Color By Priority - Checked (Default): With the Color By Priority checkbox checked, 
each subscription’s download time window is colored based on its assigned priority.

◾ Color By Priority - Unchecked: When the Color By Priority checkbox is unchecked, all 
subscription download time windows download time windows are colored blue.

◾ Show Subscription Lines - Checked (Default): With the Show Subscription Lines
checkbox unchecked, only the download time windows are displayed in the Bandwidth 
Utilization Graph.

◾ Show Subscription Lines - Unchecked: When the Show Subscription Lines checkbox 
checked, visible lines link each subscription’s download time windows in order to facilitate 
viewing on the Bandwidth Utilization Graph.

◾ Configure Bandwidth Percent...: Selecting this option opens the Utilization Threshold
dialog shown in Exhibit 16.1.7-9. The dialog is used to configure the percentage of 
bandwidth usage assigned to each point/marker, when displayed as a line graph, or bar, 
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when displayed as a bar graph. The settings are changed by sliding the delta slide markers in 
the dialog.

Exhibit 16.1.7-9. Utilization Threshold Dialog 

◦ Close: Selecting the Close button closes the Bandwidth Utilization dialog.
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16.2 Collaboration

Collaboration is an option under the CAVE menu. It is a component within CAVE that offers two 
main functions: chatting and sharing displays. "Chat" allows users to instant message or text chat in 
real time with fellow forecasters and offices in a chat room. "Sharing displays" adds onto the chat 
room capabilities allowing the room's creator to show a CAVE Map display to other participants in 
the Shared Display Session.

This section provides an introduction to Collaboration and explains how to set up "Collaboration 
Sessions" with other users/offices. The following topics are discussed:

• Starting the Collaboration Application - Subsection 16.2.1

• Creating a Chat Session - Subsection 16.2.2

• Configuring Your Collaboration Experience - Subsection 16.2.3

• Creating a Shared Display Session - Subsection 16.2.4

• Other Session Leader Capabilities - Subsection 16.2.5
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16.2.1 Starting the Collaboration Application

The Collaboration application is accessed through the CAVE menu and starts when users log on to the
Collaboration server and enters a designated user ID and password, as shown in Exhibit 16.2.1-1. The user
Status can be set to Available, Do Not Disturb, or Away upon logging in.  A Message field is available to
enter a text message that is viewable to all users.  A Site dropdown menu allows the user to select the site
location they represent (e.g., their local site or a backup site).  A Role dropdown list allows for the user to
select their assigned forecast role.

Exhibit 16.2.1-1. Starting Collaboration

To log on to the Collaboration server, the user must select the appropriate server from the Server dropdown
menu.  To add the server, select the Add button to open the Add Server dialog (Exhibit 16.2.1-2).  Enter a
Server Description and the Server Address as provided by the Collaboration admin.  To persist the address
in the Server dropdown menu, click the Persist to user localization checkbox and click the OK button.
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Exhibit 16.2.1-2. Add Server Dialog

Once logged on, a Collaboration Information pane opens to the right of the Main Display pane, as shown in
Exhibit 16.2.1-3.
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Exhibit 16.2.1-3. Collaboration Information Pane

The Collaboration Information pane contains one row of iconified toolbar buttons, as shown in Exhibit
16.2.1-4.
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Exhibit 16.2.1-4. Collaboration Information Toolbar

Descriptions of the Collaboration Information toolbar buttons shown in Exhibit 16.2.1-4 follow.

Float: Floats the Collaboration pane from the main window allowing users to drag the pane to a
different location, or to minimize/maximize the pane as desired. Note: When the tab is detached using
the Detached option from the MB3 popup menu on the tab, the window can only be closed.  It cannot
be minimized or maximized like a floating window.

Create Session: Opens a Create Session dialog box that allows users to create an invitation to a
Collaboration/Shared Display Session.

Display nws-colloboration: Opens or brings into view the NWS Collaboration Chat Room.

Collapse All: Collapses all expanded groups in the Collaboration window.

Link Map Editor to Chat Session: Links the Collaboration Session to the respective Map Editor.

View Menu: Opens the pop-up menu, shown in Exhibit 16.2.1-5, which provides the options
described below.

Exhibit 16.2.1-5. Collaboration View Menu

User Search...: Opens the User Search dialog (Exhibit 16.2.1-6) which provides users the ability
to search for someone who may not be listed in one of their existing groups. From this dialog,
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the searched user can be added to a new or existing group by right clicking on the highlighted
name and selecting Add to Group. The right click pop up menu also offers the option to create a
collaboration session with the searched user. See Section 16.2.4 on how to create a shared
session

Exhibit 16.2.1-6. User Search Dialog

Public Room Search…: Opens the Room Search dialog listing the public rooms available
(Exhibit 16.2.1-7).  Clicking MB3 on one of the public rooms opens a popup menu listing
2 options (Exhibit 16.2.1-8):

Join Room: This option opens the selected room as a new tab in the Collaboration
view.
Add Bookmark: This option adds the bookmarked room under the Bookmarked
Rooms group in the Collaboration tab.  Double clicking on a room under the
Bookmarked Rooms group opens the selected room as a separate tab.
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Exhibit 16.2.1-7. Room Search Dialog

Exhibit 16.2.1-8. Popup Menu on Public Room

Change Font...: Opens the Change Font dialog (Exhibit 16.2.1-9) that allows users to
select a font (family, style, and/or size) in which the text is displayed in all chat windows.

Exhibit 16.2.1-9. Change Font Dialog

Change Status...: Opens a dropdown list that allows users to change their Status to
"Available," "Do Not Disturb," or "Away." Upon changing the status, the icon next to the
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users name in the Collaboration tab updates.

Change Status Message...: Opens the Change Status Message dialog (Exhibit 16.2.1-10)
allowing users to update the status Message.

Exhibit 16.2.1-10. Change Status Message Dialog

Change Password...: Opens the Change Password dialog (Exhibit 16.2.1-11) allowing
users to change their own individual Password..

Exhibit 16.2.1-11. Change Password Dialog

View Log...: Opens a Log that lists all of the user's sessions and chat logs.

Logout: Allows users to log out of Collaboration.

Note 1: Users must select the Logout button on the Collaboration View menu
to log off the Collaboration. Simply clicking the "X" on the Collaboration
Information tab to close the Collaboration Information pane does not log users
off the Collaboration server. If the Collaboration Information pane is closed
before logging out, reopen the pane by selecting Collaboration from the CAVE
menu.

There exists several options under the right click Mouse Button 3 (MB3) popup
menu on a username in the user’s contact list (Exhibit 16.2.1-12).  These options are
described below:

 Note: Only users logged into Collaboration appear in the contact list.
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Exhibit 16.2.1-12. Collaboration Information MB3 Popup Menu on Contact List

Invite…: Selecting a public room under this option opens a Session Invitation dialog on the invitee’s
workstation (Exhibit 6.2.1-13) if the invitee is not a participant in the selected public chat room. The invitee
joins the nws-collaboration room upon clicking the Join button.

Note: This option is only available in the popup menu when the selected user is logged into Collaboration.

Exhibit 16.2.1-13. Invite...Submenu

Chat: .This option opens a chat window with the selected user on which the MB3 popup was opened.  The
chat tab and associated conversation and compose window do not appear on the other user’s workstation until
the initiator sends a message to that user.

Create Session…: Selecting this option opens the Create Session dialog from which a user can invite the
selected user(s) to a Shared Display Session.  Refer to Section 16.2.4 for additional information.
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View Log…: Opens a Log that lists all of the user's sessions and chat logs.

Add Notifier…: Selecting this option opens the Add Notifier dialog with the selected username in the Add
Notifier to: section.  This piece of functionality is discussed in further detail in Section 16.2.3.

Change User Text Colors…When this option is selected, a Foreground/Background Color Chooser dialog
opens (Exhibit 16.2.1-14)).  The user is able to create a customized color combination for the text that
appears in the one-on-one chat sessions (e.g., not in shared display sessions).  The foreground (text) and
background colors are set by selecting the appropriate radio button and setting the desired colors.  A preview
of the selected color combination is displayed in the Foreground/Background Color Chooser dialog.  All new
chat entries are color-coded based on the selected color combination (Exhibit 16.2.1-15).  The set color
combination is only applied to the one-on-one chat session for the user.  The color combination does not
cross into public rooms.

Exhibit 16.2.1-14. Foreground/Background Color Chooser Dialog

Exhibit 16.2.1-15. Create Group Dialog Chat Entries Before and After Color Selection
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16.2.2 Creating a Chat Session

To view all users associated with a group or site, click the ">" next to the group or site name.  This expands
the group or site and lists all available users of that group or site. The Status of a user is identified by the
icon next to the user's name. The appearance of the icon indicates the current status, as described below.

Available: The icon is bright gray.

Do Not Disturb: The Available icon is indicated, but with a red dot.

Away: The Available icon is indicated, but with a clock symbol.

Note 1: Users can also mouse over other usernames to view text in a pop-up window indicating the
user's current status.

When other users are logged on to Collaboration, the site and role appear as the username in the contact list
as illustrated in Exhibit 16.2.2-1.

Exhibit 16.2.2-1. Username with Site and Role Displayed

Chat with Individual User

To start a Chat Session with an individual user, double click on the username listed within a group.

Note 2: Users not logged into Colloboration do not appear in the group lists.

After double-clicking on the user's name, a Conversation window (to display the text messages associated
with the user) with a Compose section (for entering the text messages) open. A new tab with the user's name
as the title in the tab is added to the Collaboration pane, as shown in Exhibit 16.2.2-2.
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Exhibit 16.2.2-2. Chat Session with Individual User

The real-time text chatting begins by entering a text message in the Compose section and submitting it by
pressing the Enter key. When the first text message is sent by the initial user, a new tab opens within the
selected user's Collaboration Information pane. The new tab is titled with the initial user's name and the
transmitted text appears in the Conversation window adjacent to the user's name.

Note 3: To return to the Collaboration Information window, select the Collaboration Information tab.

Chat with NWS Community

The Collaboration toolbar includes a Display nws-collaboration button that allows users to chat with the
NWS community. By default, the user joins the nws-collaboration room when Collaboration is launched, and
the nws-collaboration tab appears adjacent to the Collaboration tab. A list of participants displayes (when
expanded) in the Participants window, above the Conversation window, as shown in Exhibit 16.2.2-3.
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Note 4: Users only see messages from the sites that their office subscribes to; this has been set up by the
System Manager via a configuration file (see Chapter 27 in the System Manager's Manual).

Exhibit 16.2.2-3. Chat with NWS Community

The user is able to create a customized color combination for the text that appears in the public room chat
sessions (e.g., not in shared display sessions) for each user in the public room.  From the Participants list in
the public room, MB3 clicking on the username for one of the participants displays a popup menu as
illustrated in Exhibit 16.2.2-4.  
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Exhibit 16.2.2-4. MB3 Popup Menu from the public room

By selecting the Change User Text Colors… option, the Foreground/Background Color Chooser dialog opens
(Exhibit 16.2.2.5).  The foreground (text) and background colors are set by selecting the appropriate radio
button and setting the desired colors.  A preview of the selected color combination is displayed in the
Foreground/Background Color Chooser dialog. 

Exhibit 16.2.2-5. Foreground Background Color Chooser Dialog

All new chat entries are color-coded based on the selected color combination (Exhibits 16.2.2-6 and
16.2.2-7).  The set color combination is only applied to the individual within that public room’s chat session. 
Set color combinations do not cross into one-on-one/private rooms or other available public rooms.
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Exhibit 16.2.2-6. Selected Color Combination Applied to the Participants List

Exhibit 16.2.2-7. Selected Color Combination Applied to the Conversation Window

Clicking the Display nws-collaboration icon opens the nws-collaboration room if the user has not joined the
room, or brings the nws-collaboration tab into view if the user has already joined the room.

Chat with other Platforms

If a user has an account on the chat server, the user can use other XMPP-compliant applications (such as
Pidgin) with the same account to chat with other users logged on to Collaboration in CAVE.  This requires
the user to set up their account with the appropriate server information.  Users using applications outside of
CAVE are not be able to see or share displays in a Shared Display Session.
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16.2.3 Configuring Your Collaboration Experience

The Collaboration Preferences are located in Preferences under the CAVE menu, as shown in Exhibit
16.2.3-1. Expanding Collaboration in the Preferences dialog lists several configurable items; Contact
Notifiers, Room Alerts, and Significant Words.

Exhibit 16.2.3-1. Preferences Dialog for Setting the Collaboration User Interface Preferences

Descriptions of the various preference configurations are noted below:

Collaboration: Lists the Collaboration User Interface Preferences

Display Chat messages on separate line from time and name (Exhibit 16.2.3-2): When
activating this option, the date, time, and username associated with the sent message are
displayed on separate lines.  The date/time/username information displays on the line above the
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sent message.  When deactivated (the default setting), the date, time, username, and message are
displayed on the same line.

Exhibit 16.2.3-2. Chat Messages On Separate Line From Time And Name Example

Show the date on messages (Exhibit 16.2.3-3): When this option is activated, each message
sent or received displays the date and time adjacent to the message on the user’s workstation. 
When deactivated (the default setting), the date only appears with the first message listed in the
conversation window, or if it’s the first message of a new day.  All other messages in that
conversation window displays only the time.

Exhibit 16.2.3-3. Always Show The Date On Messages Example
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Show Chat notification popups: When the Show Chat Notification Popups checkbox is
checked (active), a pop-up message appears in the lower right corner of the monitor with
messages sent by other users via chat windows.  The Notification Popups only appear when the
CAVE window is not in focus.

Join nws-collaboration room on login: This option is checked (activated) by default.  When
checked, the NWS Collaboration chat room is loaded by default when Collaboration is launched.
When the box is un-checked the NWS Collaboration chat room is not readily available upon
logging into Collaboration.  The user manually selects the Display nws-collaboration button in
the Collaboration tab to access and use the NWS chat feature, as shown in Exhibit 16.2.2-4.

Max chat room history message age in minutes: Transmitted messages in the public room that
are within the set age (in minutes) load in the chat history when joining the public room.  Older
messages do not appear in the chat history.  Older messages may be loaded by increasing the
value in the text field, leaving the public room, and rejoining the public room.

Automatically float tabs on login: When activated, the Collaboration and nws-collaboration
tabs load as floating windows.  When deactivated, the Collaboration and nws-collaboration tabs
are docked within the CAVE window.

Automatically attach new views to existing views: When activated, new chat windows are
automatically attached to existing chat windows, whether docked or floating.  If no chat windows
are present, the new chat window attaches to the Collaboration tab or window, whether docked
or floating.

Change Status on Idle:  By default, Change Status on Idle is checked (active), and the Minutes
Before Becoming Idle is set to 10 minutes. The timing can be manually changed by changing the
value in the text field. The person icon next the users name in the Collaboration Information tab
changes to include a clock identifying the user is idle after the entered time period elapses with
no activity.  

Automatically Accept Contact Requests: When the Automatically Accept Contact Requests
option is checked (activated), any user that requests to add you to their contact list is
automatically added without notification. By default, this option is left unchecked.  As a result,
notifications are received when another user attempts to add you to their contact list.  Upon
accepting the contact request, the user appears in the contact list.

Months to keep chat logs: Users can view chat logs within the time frame set by this
configurable value.  Chat logs older than the set number of months are purged.

Contact Notifiers: This option allows the user to apply notification settings to select users. The New
button brings up the Add Notifier dialog, as shown in Exhibit 16.2.3-4. Usernames in the user’s
contact list are listed in the Add Notifier to dropdown menu.  Sound files can be applied to notify the
user when someone logs on, logs off, sends a message, becomes unavailable, and/or becomes available.
To select a sound file, click the Browse… button and navigate to the preferred sound file.  The user can
click the Preview button to listen to the selected sound file.  The frequency of the notifications is set by
either selecting the single instance or recurring radio button.  After the settings are set and the OK
button is selected, the username is added to the Contact Notifiers list.  Once added, the user may edit or
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delete the Contact Notifier by selecting the username and the respective button.

Note: Users must be logged into Collaboration in order to add Contact Notifiers.

Exhibit 16.2.3-4. Contact/Add Notifier Dialogs

Room Alerts: Activating the Enable Join Room Alerts (Exhibit 16.2.3-5) option applies a sound to
any user that joins a Shared Display Session. By default, this option is not enabled (not checked).  To
select a sound file, click the Browse… button and navigate to the preferred sound file. 
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Exhibit 16.2.3-5. Room Alerts

Significant Words: To enhance the collaboration experience, users can make specific words in the
chat message stand out from the normal text. Selecting Significant Words opens the Significant Words
window, as shown in Exhibit 16.2.3-6. Clicking the Add New button enables the attributes and creates
a blank line in the words list. Users can then enter a word and set up attributes to make the words catch
the eye when mentioned during the chat. For example, users may choose to make the word "tornado"
appear in a large red font and play a selected sound file.  Once the word, color, font, and sound file are
selected, clicking the Apply or OK buttons saves the new Significant Words.  Clicking the Add New
button begins the process of creating another significant word.  Significant words may also be removed
by selecting a word in the Significant Words box and clicking the Remove Selected button.  When
significant words are used by other users during a chat session, the text appears in the conversation
window based on the selected attributes and the sound file plays.
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Exhibit 16.2.3-6. Preferences Dialog Box for Configuring Significant Words
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16.2.4 Creating a Shared Display Session

A Shared Display Session can be created when a user wants to share a CAVE display and collaborate with
another user or group of users. The Session Leader (also known as the Data Provider) of the Collaboration
session is the individual who creates the Shared Display Session, and has initial control over what is shared.

Note 1: Shared Display Sessions can be started from any perspective. However, displays can only be
shared when sessions are created in perspectives containing Map Editor tabs (e.g., D2D, GFE, Hydro,
MPE, and National Centers perspectives).

Invitation to Session

All clients (invited participants) invited to a Shared Display Session receive an invitation to the session, as
shown in Exhibit 16.2.4-1, no matter what perspective is displayed on the client's workstation. For Shared
Display Sessions created in perspectives with Map Editor tabs displayed, a new Map Editor tab displays on
the client's Main Display pane upon acceptance of the invitation. If a Shared Display Session is created in
perspectives without Map Editor tabs (e.g., Localization or XML), a chat session is opened with the invited
guests (clients), but they are not able to share displays (refer to Note 6).

Exhibit 16.2.4-1. Session Invitation Dialog Box

Invitees to the Collaboration Session can either "Accept" the invitation by clicking the Join button or
"Reject" the invitation by clicking the Cancel button.

Multiple Shared Display Sessions

Users may create multiple Shared Display Sessions across multiple (different) Map Editor tabs or
perspectives. A single Map Editor tab cannot be used to create more than one Shared Display Session. For
example, in D2D, User "A" can create a Shared Display Session in one Map Editor tab with Users "B," "C,"
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and "D." User "A" can create a second Shared Display Session from a second Map Editor tab with Users "E,"
"F," and "G," as long as the second Map Editor tab is not already involved in another Shared Display Session.
Similarly, User "A" can open another perspective and create another Shared Display Session with any user.
A user within a Shared Display Session can also create his or her own Shared Display Session from another
Map Editor tab or perspective. The user can be a client of one Shared Display Session, and be the Session
Leader of another Shared Display Session. For example, in D2D, if User "B" is a client of a Shared Display
Session led by User "A," User "B" may invite Users "C," "D," and "E" (and even User "A") to his or her
Shared Display Session. Similarly, User "B" can open another perspective and create a Shared Display
Session with any user.

Rules When Sharing Displays

X-Y displays cannot be shared (e.g., Nsharp/soundings, Cross Sections, Time Height). A chat session
is created if a Shared Display Session is created with an X-Y display in the Main Display pane.

4-panel displays cannot be shared. A chat session is created if a Shared Display Session is created with
a 4-panel display in the Main Display pane. If a single frame is converted into a 4-panel layout, only
the single frame is shared. The Rotate Panels functionality does not share data in the other 3 panels. 
When converting back to a single pane layout, the user must select the upper left panel or the ‘correct’
data is not transferred over to the participants’ displays.

Dialogs and windows are not shared across workstations.

Users cannot create Shared Data Displays with the Localization and XML perspectives. A chat session
is created when attempting to create a session with one of these perspectives.

The cursor is not shared (although the sampled values adjacent to the cursor are visible across
workstations).

PGEN (Product Generation) objects can only be generated within the National Centers Perspective.

Procedure for Creating a Shared Display Session

To create a Shared Display Session the Session Leader must perform the following steps, in the order listed
below.

Open the Collaboration Information tab with any perspective's Map Display (i.e., D2D Map tab) active.1. 

Select the clients to be invited to the session by highlighting the individual names from the list in the
Collaboration window.

Note 2: For multiple users, hold down the Ctrl key while selecting usernames. This highlights
more than one user.

2. 

Click on the Create Session button on the Collaboration Information toolbar, or right click and hold on
one of the highlighted usernames to select Create Session… from the pop up menu.  A Create Session
dialog opens, as shown in Exhibit 16.2.4-2.

3. 
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Exhibit 16.2.4-2. Create Session Dialog Box

In the Create Session dialog, enter the desired "Name," "Subject," and "Message" for the session.4. 

Make sure both the Create Shared Display Session and the Invite Selected Users checkboxes are
checked.

5. 

Click the Create button to initiate the Collaboration. A new tab opens with the desired "Session Name"
as the title on the tab and the CAVE window is transformed into a Shared Display Session.

6. 

The Session Leader's screen should now look like that shown in Exhibit 16.2.4-3.
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Exhibit 16.2.4-3. Session Leader's Collaboration Screen for a Shared Display Session

A Shared Display Session screen has the following features:

The Main Display Pane Map tab adds the "Session Name" in parentheses.

A colored border ONLY appears around the Session Leader's Main Display Pane when the Session
Leader's display is being shared. Invitees do not have the colored border around their Main Display
Pane.

Note 3: The colored border around the Main Display Pane indicates control of the Shared Display
Session and control of the display that is being shared. Only the Session Leader has this control.
Absence of a colored border around the Session Leader's Main Display Pane indicates the display
is not being shared.

Clients (Participants) that have joined the Shared Display Session have a new tab that opens on the
Collaboration Information pane, with the session name shown as the title on the tab.

The Collaboration Information toolbar is modified to accommodate the tools needed for the Shared
Display Session. The drawing tools added are shown in Exhibit 16.2.4-4.
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Exhibit 16.2.4-4. Shared Display Session Toolbar

The modified Collaboration Information toolbar for a Shared Display Session includes the following
ten tools; the first seven are drawing tools.

Draw: The Draw button looks like a pencil. When activated, the user is able to draw/telestrate
on the display.

Undo: The Undo button removes the user's most recent drawings.  This option may be executed
multiple times sequentially.

Redo: The Redo button restores the previous edits or drawings.  This option may be executed
multiple times sequentially.

Clear: The red X button clears all of the user's drawings from the display. The Clear button does
not clear other users' drawings.

Erase: The eraser allows the user to click and drag over their own drawings to erase portions of
the drawing. The Erase button does not erase other users' drawings.

Lock Collaborators: The Session Leader is the only person who can activate this button. It is
used to disable the drawing tools of all participants. When the button is activated, the iconified
drawing buttons are grayed out to indicate they are disabled.

Clear All: The double red XX button clears all of the user's drawings from the display including
drawings from the participants of the Shared Display Session.  This button is only available on
the Session Leader’s display.

Float: The Float button detaches the Collaboration Information pane from the main window
allowing users to drag the pane to a different location, or to minimize/maximize the pane as
desired.

Print Log: The Print Log button allows the user to print the text messages logged in the
Conversation window.

Search: The Search button allows the user to perform a word search within the Conversation
window.

Scroll Lock: When the Scroll Lock button is activated, the conversation window does not
automatically scroll or jump to the bottom to display any new incoming messages.  When
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deactivated, the conversation window jumps to the most recent message when that message
arrives.

Note 4: Each user is assigned a different color, which matches up with the color of the user's
drawings. The assigned color can also be identified within the Participant's window.
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16.2.5 Other Session Leader Capabilities

Collaboration Display Sharing

In a Shared Display Session, the Session Leader is able to display and share data with all guests invited to
the session. All data types (obs, radar, satellite, grib, etc.) may be shared within a session, including data that
may be foreign to other sites (e.g., local models and mesonets).  A border (the same color as that around the
Session Leader's Main Display pane) appears around the Main Display pane of all participants sharing the
Session Leader's display.

Only the Session Leader can pan and zoom within the shared display. These actions are duplicated
simultaneously on the each participant's workstation in view-only mode.

Swapping Panes

The Session Leader may swap the shared main display pane with one of the side display panes. The display
pane swapped into the side pane maintains the colored border, indicating the display pane was previously
shared. The display pane swapped into the Main Display pane inherits a colored border to indicate the display
pane is now being shared. The map and data displayed in the Main Display pane on the Session Leader's
workstation is also displayed on the participant's workstation.

Warning Icon

As noted in Subsection 16.2.4, the absence of a colored border around the Session Leader's Main Display
pane indicates the displayed pane is not being shared. Such instances occur when the Session Leader has
multiple Map tabs open.  The session leader may select one of the other existing map tabs on their display
that is not shared.  A white/blank pane displays in the Main Display pane on the clients’ workstations with
the following statement, "The session leader is not viewing a shared display." A Warning icon (triangle
symbol) also appears on the Drawing toolbar on all the Collaboration participants' workstations (Session
Leader and clients), visually informing all collaborators that the display is not being shared. Refer to Exhibit
16.2.5-1.
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Exhibit 16.2.5-1. Unshared Display (Participant's Screen)

For the Session Leader to share the display in the Map Editor, the user must right click (MB3) on the Map tab
and select Share with -> "Session Name" from the pop-up menu. A border then appears around the Session
Leader's main display pane, indicating the map/data is being shared with all clients.  The warning icon
disappears from the Drawing toolbar and data within the main pane appears on all displays within the Shared
Display Session.

Unsharing Displays

When the Session Leader determines that shared data in a particular map tab is no longer needed to be shared
in the Shared Display Session, the Session Leader right clicks (MB3) on the map tab and selects Unshare
from the pop-up menu. The colored border is removed from the Session Leader's display, and a gray screen
appears on all participants' screens with the message that the Session Leader is no longer viewing a shared
display. The Warning icon (triangle symbol) reappears on the Drawing toolbar on all collaborators' screens
as a visual cue that the active display is no longer shared.

Transferring Session Leader

.The Session Leader can transfer leadership to another participant within the Shared Display Session.  The
Session Leader is identified by the person icon wearing a top hat in the Participants List.  To transfer
leadership, the Session Leader clicks MB3 on the username that is to become the leader and selects Transfer
Leadership (Exhibit 16.2.5-2).  Once transferred, the top hat appears on the new leader’s icon.  The data
displayed in the new leader’s main pane appears on all participants’ displays.  The new leader also inherits all
of the drawing tools, including the Lock Collaborators and the Clear All tools.

Exhibit 16.2.5-2. Transfer Leadership MB3 Popup Menu
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16.3 AWIPS-2 Archiver

The AWIPS-2 Archiver is a permission-based application, meaning that the System Manager or User 
Administrator controls the user's access to the AWIPS-2 Archiver functionalities (see System 
Manager's Manual - Chapter 30). If granted permission to access this application, a user would be 
allowed to extract stored weather event data and copy it into a user-defined directory to be archived 
(e.g., burned to a DVD). The extracted data includes both raw and processed data (internally 
compressed HDF files (.h5) and corresponding extracts from the metadata database files (.bin 
or .bin.gz)). The archived data can be played back later for simulation of weather events. The 
AWIPS-2 Archiver was developed to support WES-2 Bridge and is viewable using the WES-2 
Bridge.

There are two parts to the application with two permissions involved, one for each GUI:

• Permission to access the GUI to generate a case (Archive Case Creation...), 

• Permission to configure the archive retention (Archive Retention...).

A user could be granted one permission without being granted the other. Permission to access the GUI 
to generate a case is an end-user functionality and is discussed in this Manual. Permission to 
configure the archive retention would be limited to the ITO and/or Archiver Focal Point at the office, 
and therefore discussed in the System Manager's Manual - Chapter 28. 

The AWIPS-2 Archiver is a Linux-based application that is accessed via the CAVE menu. This 
section introduces the AWIPS-2 Archiver application and describes how to navigate through the 
dialogs for archiving weather event data. The following topics are discussed:

• Starting the WES2Bridge Archiver Application - Subsection 16.3.1

• Archiving, Processed Raw and other data (configurable by the site)- Subsection 16.3.2

• Beginning the Archive Process - Subsection 16.3.3
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16.3.1 WES2Bridge Archiver Application

The Archive functionality is specifically designed to allow an end user to extract stored data and copy 
it into a user-defined directory to be archived (e.g., burned to a DVD).  This includes raw data or 
processed data -- internally compressed HDF files (.h5) and corresponding extracts from the metadata 
database (.bin or .bin.gz files).  This data is viewable using the WES-2 Bridge.  

Note: A user must have permissions to access the archiver functionality.  Refer to chapter 28 in the 
SMM.

The Archive Case Creation is located in the Archive dialog under the CAVE menu, as shown in 
Exhibit 16.3.1-1.

Exhibit 16.3.1-1. Archive Case Creation Menu Item in CAVE

16.3.1.1 Archive Case Creation

After selecting the Archive Case Creation…menu item undr Archive in the CAVE menu, the Archive 
Case Creation dialog opens as illustrated in Exhibit 16.3.1.1-1.
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Exhibit 16.3.1.1-1. Archive Case Creation Dialog

Once the Archive Case Creation dialog opens, users may select the time range of data to be archived.  
The Start Time defaults to a time 24 hours prior to the End Time.  The End Time defaults to the last 
completed hour set in D2D from when the Archive Case Creation dialog is opened.  For example, if 
the current time is 10:45 CDT, the End Time is set to 10:00 CDT.  If the user changes the time in 
CAVE to another hour using the Set Time dialog (opened by double clicking the time at the bottom of 
the CAVE window) prior to opening the Archive Case Creation dialog, the default Start and End 
Times are determined by the user-selected Set Time (also known as simulated time). 

The Start and End Times do not refresh at the top of the hour.  To update the Start and End Times, the 
user can close and reopen the dialog or the user can modify the date and times. To modify the dates 
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and times in the Archive Case Creation dialog, click on the Start Time… or End Time…button to 
open the Calendar dialog in Exhibit 16.3.1.1-2.   

Exhibit 16.3.1.1-2. Calendar Dialog for Start and End Times

The user then selects a date and time within the Calendar dialog to set the Start and End Times in the 
Archive Case Creation dialog.  Once a date and hour are selected, clicking the OK button dismisses 
the Calendar dialog and populates the Start or End Time based on the selections.  Clicking the Cancel
button dismisses the dialog without changing the Start or End time.

Note: GMT (Greenwich Mean Time) is commonly known as Z (Zulu) time, or Coordinated 
Universal Time (UTC). They are synonymous.
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16.3.2 Archiving Processed, Raw and other data (configurable by the site)

Processed data, Raw data, and other data (configurable by the site) can be archived.  These selections are found 
under the Archive Config dropdown menu in Exhibit 16.3.2-1.  

Exhibit 16.3.2-1. Archive Config: Dropdown Menu 

•

Selecting either option populates the Category dropdown menu with a list of data categories based on the data 
available in the database.  An example of a Category dropdown menu is illustrated in Exhibit 16.3.2-2

•
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Exhibit 16.3.2-2. Populated Table in the Archive Case Creation Dialog

The table in the bottom half of the Archive Case Creation dialog populates with a list of Data Sets and 
associated file size based on the selections made within the Archive Config and Category dropdown menus.  
Refer to Exhibit 16.3.3-3. 
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•

Exhibit 16.3.2-3. Populated Table in the Archive Case Creation Dialog

•

When a Data Set is selected, several values are updated in the Archive Case Creation dialog. These values 
include the Table Selected Items and Table Selected Size values at the bottom of the dialog, as well as the 
Uncompressed Case Size and Total Selected Items values in the upper right corner of the dialog.  The Table 
Selected Items and Table Selected Size values represent the selected Data Sets and associated sizes for only the 
displayed table, specific to the Archive Config and Category options selected.  The Uncompressed Case Size 
and Total Selected Items values represent all selected Data Sets and the cumulative size of the Archive Config 
and Category options selected.  An example with multiple Data Sets selected within multiple Archive Config 
and Category selections and their associated tables is found in Exhibit 16.3.2-4

• . 
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•

Exhibit 16.3.2-4. Multiple Data Sets Selected Across Multiple Archive Config and Category Selections

Users may click individual checkboxes to select or unselect data sets or click the options within the Mouse 
Button 3 (MB3) pop-up menu on the table to select or unselect one or more rows (Exhibit 16.3.2-5).  The row 
where the MB3 click is executed is the row that is affected when the Check selected rows or Uncheck 
selected rows options are selected.  

Exhibit 16.3.2-5. MB3 Pop-up Menu

• (Note: To select multiple rows, users can use Ctrl+MB1 click to select multiple individual rows, or 
Shift+MB1 click to select multiple rows in sequence.  Those selected rows become highlighted.  The 
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Check selected rows or Uncheck selected rows options from the MB3 popup menu are executed on all 
highlighted rows.)

The Check all rows and Uncheck all rows options are executed on all rows whether 
selected/highlighted or not.

Once the desired selections are made, the user selects the location in which archived files are stored.  The 
“Case Location” is populated with the default directory for saving cases: /data/archiver. If this directory 
does not exist then the field is left empty. The user must then select a “Case Location”. This step must be 
done prior to selecting a Case Name.  If the user clicks the Case Name… button before selecting a Case 
Location, the Error window in Exhibit 16.3.2-6 appears.  Simply click the OK button to close the Error 
window. 

Exhibit 16.3.2-6. Error Window 

• To select a Case Location, click the Browse… button.  The Case Location dialog in Exhibit 16.3.3-7
opens.

Page 5 of 12

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Exhibit 16.3.2-7. Case Location Dialog 

Navigate through the Case Location dialog to select the final destination for the archived files.  Click the 
OK button to set the location and close the Case Location dialog.  The Case Location section updates 
with the chosen case location directory as seen in Exhibit 16.3.2-8.  In addition, the Full – Available
section updates with the disk space percentage and the available disk space size to the right of the Case 
Location. 
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◦
Exhibit 16.3.2-8. Case Location Section Populated

Once the Case Location is selected, a Case Name needs to be entered.  Click on the Case 
Name… button to open the Case Name dialog in Exhibit 16.3.2-9.

Exhibit 16.3.2-9. Case Name Dialog

Once a Case Name is entered into the Name textbox, click the OK button to close the Case 
Name dialog.  The Case Name section updates to display the Case Location with the Case 
Name appended, as illustrated in Exhibit 16.3.3-10.  In addition, the Generate button at the 
bottom of the dialog becomes enabled.
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Exhibit 16.3.2-10. Case Name Populated/Generate Button Active

Users also have the option to compress files by selecting the Compress Files checkbox.  
This option compresses the archived data into multiple zip (.tgz) files (Exhibit 16.3.2-11).

Exhibit 16.3.2-11. Compress Files Option Selected
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Along with the files compression option the user can also create multiple files specifying the 
maximum size for each file.   This allows making images that can be burned to a single CD 
or DVD.

There are several buttons located at the bottom of the Archive Case Creation dialog, each 
one is discussed below:

Save – Save the current selections within the Archive Case Creation dialog to recall the 
saved Case Creation Template at a future time.  The selections are saved to the case name as 
labeled in the title bar of the Archive Case Creation dialog.  To maintain the default Case 
Creation Template (e.g., with no selections), click the Save As… button first and provide a 
new name for the Case Creation Template to be saved.  

Save As… – Opens the Save As Case dialog as shown in Exhibit 16.3.2-12 (left). Enter a 
case name in the textbox (Exhibit 16.3.2-12 (right)) and click the Save button to save the 
Case Creation Template within the Archive Case Creation dialog under the entered name.  
The Save As Case dialog closes.  In addition, the Archive Case Creation - <Case Name> 
title updates with the case name (Exhibit 16.3.2-13) and the Save button becomes inactive.

Page 9 of 12

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Exhibit 16.3.2-12. Save Case Dialog (left)/Save Case Dialog with Case Name entered (right) 
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Exhibit 16.3.2-13. Updated Title in the Archive Case Creation Dialog

If modifications (new selections/removed selections) are made to the Case Creation 
Template, the Save button becomes active once again.  When the Save button is selected, 
the updated modifications are saved to the case name displayed in the title bar (Exhibit 
16.3.2-13).

Load… – Opens the Load Case dialog with a list of the saved Case Creation Templates 
(Exhibit 16.3.2-14).  Users may select a case name and then click the Load button to load 
the Archive Case Creation dialog with the saved Case Creation Template’s selections.  The 
Load Case dialog closes. 

Exhibit 16.3.2-14. Load Case Dialog 

Delete… – Opens the Delete Case dialog (Exhibit 16.3.2-15).  To delete a Case Creation 
Template, select a case name within the list of saved Case Creation Templates and click the 
Delete button.  A Case Confirmation window opens to confirm the deletion of the selected 
Case Creation Template (Exhibit 16.3.2-16).  Clicking the OK button removes the selected 
Case Creation Template from the Load Case and Delete Case dialogs.  Clicking the Cancel
button returns the user to the Delete Case dialog without deleting the Case Creation 
Template. 
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Exhibit 16.3.2-15. Delete Case Dialog 

Exhibit 16.3.2-16. Case Confirmation Window 

If the selections for the deleted case name are actively displayed within the Archive Case 
Creation dialog, the selections persist with the case name in the title bar. 

◦
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16.3.3 Beginning the Archive Process

Generate – Selecting the Generate button begins the archiving process.  Additional details are found 
below.

Selected – Clicking the Selected button updates the table within the Archive Case Creation dialog 
displaying all the selected items made within that dialog (Exhibit 16.3.3-1).  When the Selected View 
is displayed, the Selected button toggles to the Category button.  When the Category button is 
selected, the table returns to the Category View and the Category button toggles back to the Selected
button.

Recompute Sizes – Clicking the Recompute Sizes button updates the size values for Uncompressed 
Case Size, Table Selected Size, and the sizes for all items within the table.
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Exhibit 16.3.3-1. Selected View

After all the selections are made, click the Generate button to begin the archive process.  This action 
opens the Generating - <Case Name> window with a progress bar (Exhibit 16.3.3-2).  The status 
message above the progress bar displays the files that are being copied into the Case Name directory.  
During this time, the Cancel button is active while the Close button is inactive.  Click the Cancel
button to cancel the archiving process.  In this case, the archiving process ceases copying files over to 
the directory identified in the Case Name section.  However, files that are copied prior to pressing the 
Cancel button are placed into the specified directory.  The Generating - <Case Name> window also 
closes.
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Exhibit 16.3.3-2. Generating <Case Name> Window - Archiving in Progress 

If the user allows the archive process to complete, the progress bar no longer displays and the status 
message updates to display Created: <Case Name> in the Generating - <Case Name> window 
(Exhibit 16.3.3-3).  The Cancel button becomes inactive and the Close button is activated.  Click the 
Close button to close the Generating - <Case Name> window.

Exhibit 16.3.3-3. Generating <Case Name> Window - Archiving Complete 

Note: If a user attempts to create an archive using an existing Case Name in the same Case Location, 
the Generating - <Case Name> window appears with the status message indicating the case already 
exists (Exhibit 16.3.3-4).  Click the Close button to close the Generating - <Case Name> window and 
enter in a unique Name in the Case Name dialog.

Exhibit 16.3.3-4. Generating <Case Name> Window - Existing Case
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Once the archive process is complete, users can open a terminal window or file browser window 
(Exhibit 16.3.3-5) and navigate to the directory set in the Case Location section.  A folder with the 
entered Case Name is present with all the data files for the selected time period found within

Exhibit 16.3.3-5. Location of Archived Data 

Exhibit 16.3.3-6 is an example of archived data that is compressed. 
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Exhibit 16.3.3-6. Compressed Archive Data

Exhibit 16.3.3-7 is an example of archived data that is not compressed.

Page 5 of 6

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Exhibit 16.3.3-7. Non-Compressed Archive Data

Users may then archive the data to another media source (e.g., CD, DVD, external hard drive, etc.).
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16.4 AWIPS Statistics

AWIPS Statistics is an option under the CAVE menu. It is a component within CAVE that offers two 
main functions: capturing system performance statistics; and analyzing system performance statistics. 
The captured data is viewable via a graph or a .csv file.

This section introduces the AWIPS Statistics application and describes how to navigate through the 
dialogs for data analysis. The following topics are discussed:

• Starting the AWIPS Statistics Application - Subsection 16.4.1

• Graphing Statistics - Subsection 16.4.2

• Statistics Graph Manipulation - Subsection 16.4.3
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16.4.1 Starting the AWIPS Statistics Application

The AWIPS Statistics application is accessed through the CAVE menu by selecting AWIPS Statistics. 
Selecting this option opens the Statistics Display Control dialog, shown in Exhibit 16.4.1-1.

Exhibit 16.4.1-1. Starting AWIPS Statistics - Statistics Display Control Dialog 

The Statistics Display Control dialog box includes the following options for displaying event 
attributes on a graph. 

• Date/Time - Select Date/Time..: Clicking the Select Date/Time... button opens the Calendar 
dialog, shown in Exhibit 16.4.1-2. The Calendar dialog allows you to select a date and hour as 
a starting point from which to display data.
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Exhibit 16.4.1-2. Calendar Dialog 

Note 1: The calendar defaults to a date/time 24 hours prior to the current time. 

If you select a date and time from which to display the statistical data and no data is available 
for that selected period, you are alerted by the pop-up message as shown in Exhibit 16.4.1-3.

Exhibit 16.4.1-3. No Data Pop-up 

• Graph Range: Graphs display data on a selected range value that extends from 1 hour up to 1 
month, as selected through the Graph Range dropdown menu. 

Note 1: The Graph range defaults to 24 hours.

• There are two other options associated with Graph Range — Start and Split (refer to Exhibit 
16.4.1-4). 

◦ Start: Selecting the Start radio button starts the graph at the selected Date/Time and 
extends the graph by the selected range to the right.

◦ Split: Selecting the Split radio button splits the selected range into two equal parts, 
placing the selected Date/Time in the center of the graph. Space to the left of the 
midpoint displays half of the range prior to the selected Date/Time; space to the right 
displays half of the range after the selected Date/Time.
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Exhibit 16.4.1-4. Start and Split Graph Range Options 

• Graph Data: Use this to select the specific data to display on a graph. Select entries from the 
following groups: 

◦ Category: Users select from any of the categories listed under this dropdown menu.  
Selecting different categories dynamically changes the options under the Event Type and 
Event Attribute dropdown menus. 

◦ Event Type: The options under this dropdown menu are dependent upon the Category 
selected.

◦ Event Attribute: The options under this dropdown menu are dependent upon the 
Category and Event Type selected. The selected Event Attribute is displayed on the 
graph's "Y" axis and as the graph's title. For example, Exhibit 16.4.1-4 indicates that 
Processing Time is the selected Event Attribute.

Note 2: Processing Time (default) is the time it takes to decode the data. Processing 
Latency is the time the file sits in the queue before being processed. 

• Groups: Select one or more groups listed in the Available Groups column and move the 
selected group(s) into the Selected Groups column using the available arrow buttons. Once the 
Selected Groups column is populated, the Display button becomes active.
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16.4.2 Graphing Statistics

Once the graph event and attributes are configured in the Statistics Display Control dialog, clicking 
the Display button displays the graph based on these selections. The graph is displayed within the 
Processing Events window. Exhibit 16.4.2-1 is an example of a Start - Processing Latency graph; 
Exhibit 16.4.2-2 is an example of a Split - Processing Time graph.

Exhibit 16.4.2-1. Processing Events Window - Example of a Start Range with Processing Latency Event 
Attribute 
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Exhibit 16.4.2-2. Processing Events Window - Example of a Split Range with Processing Time Event 
Attribute 
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16.4.3 Statistics Graph Manipulation

There are several ways to display alternate data on the graph within the Processing Events window. 
You can display the event attributes as an Average, Minimum, Maximum, Sum, or Count by selecting 
an option from the Graph dropdown list box at the lower left corner of the Processing Events window, 
as shown in Exhibit 16.4.3-1.

Exhibit 16.4.3-1. Options Available from the Graph Dropdown List Box 

The arrow buttons below the graph (refer to Exhibit 16.4.2-2) moves the chart one half or one whole 
period, where the period is determined by the Graph Range value set in the Statistics Display Control 
dialog.

The graph can be further manipulated by displaying or removing grid lines and/or data lines, and 
determining the display units. To access this function, select the Graph menu and check or uncheck 
the appropriate checkboxes, as shown in Exhibit 16.4.3-2. Unchecking both checkboxes removes the 
grid lines and data lines, leaving only the data points on the graph.

Exhibit 16.4.3-2. Graph Dropdown Menu with Grid Lines and Data Line s Displayed
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In addition, the data can be scaled based on the unit option selected under the Display Units dropdown 
menu (Exhibit 16.4.3-3).  Upon selection, the y-axis and displayed data is recalculated based on the 
chosen scale.  

Exhibit 16.4.3-3. Display Units Dropdown Menu

The color-coded data types are listed in the Groups panel on the right side of the Processing Events 
window, as shown in Exhibit 16.4.3-4. The data types, represented by the data points on the graph, 
can also be displayed or removed by checking or unchecking the checkbox adjacent to the data type.

Exhibit 16.4.3-4. Groups Panel Listing Color-coded Data Types 
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Note 3: There are many more data type checkboxes checked in Exhibit 16.4.3-5 than data points 
displayed on the graph. This indicates either that the data for those data types has not been 
ingested, the data has been ingested but is not yet decoded, or the data points are covered by the 
other data points with similar values. The 12 hr graph range of Exhibit 16.4.2-2 shows many 
more data types displayed on the graph. 

The data types can also be checked or unchecked from the Selection Manager dialog shown in 
Exhibit 16.4.3-5. This dialog is opened by clicking on the Selection Manager button at the bottom of 
the Groups panel.

Exhibit 16.4.3-5. Selection Manager Dialog 

The Selection Manager dialog box allows you to organize the data types into a specific group and 
then either contract the list or expand it to reveal all items within the group. This is a convenient way 
to select all, select none, or select individual items to display on the graph. Clicking the Apply button 
applies the selections to the graph. Clicking the OK button applies the selections to the graph while 
closing the Selection Manager dialog box. The Cancel button simply closes the Selection Manager 
window without applying any modifications made within the Selection Manager dialog.

To save all graphs displayed in the Processing Events window, select the Save option under the File 
menu, as shown in Exhibit 16.4.3-6. A dialog appears, allowing you to enter a "Name" for the saved 
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file and to select the "Location" for the file to be saved. Clicking the OK button saves the file to the 
selected location.

The Processing Events window can be closed by clicking on the "Close" iconified button (X) at the 
top right corner of the window, or by selecting the Quit option under the File menu, as shown in 
Exhibit 16.4.3-6, or by using the keyboard shortcut Ctrl + Q.

Exhibit 16.4.3-6. Processing Events Window File Dropdown Menu Option 

Page 4 of 4

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



16.5 GIS Data

The Geographic Information System (GIS) application enables users to import geospatial data from 
varying GIS data sources for display in CAVE. CAVE currently only supports shape data in WGS84 
unprojected latitude/longitude.

This section describes how to start the GIS application, configure the display attributes, and navigate 
through the various dialogs for importing map/map product shapefiles for display within CAVE. The 
following topics are discussed:

• Starting the GIS Application and Displaying a GIS Data Image - Subsection 16.5.1

• Setting the Attribute Values for Displaying GIS Data from within CAVE - Subsection 16.5.2

• Customizing and Using the GIS Application's Attributes Dialog - Subsection 16.5.3

• Displaying a Sample of GIS Data Attribute Values on the Main Display Pane - Subsection 
16.5.4

• GIS Data and Display Customization from within the GIS Application - Subsection 16.5.5
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16.5.1 Starting the GIS Application and Displaying a GIS Data Image

The GIS application is accessed through the CAVE menu by first selecting the Import option, and then 
choosing GIS Data from the Import submenu. The GIS DataStore Parameters dialog, shown in Exhibit 
16.5.1-1, opens.

Exhibit 16.5.1-1. Starting the GIS Application - GIS DataStore Parameters Dialog 

The GIS DataStore Parameters dialog is comprised of four sections. The process for browsing for a 
particular directory and selecting a Map shapefile is illustrated in Exhibit 16.5.1-2.

Page 1 of 6

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Exhibit 16.5.1-2. Process for Locating Connection Parameters and Selecting Available Map Shapefile 

Descriptions of the four sections follow. 

• DataStore Type: This section contains a data field where you select a file type from the dropdown 
list.

• Connection Parameters: This section contains a Directory data field where you can either select 
from a dropdown list or browse to a directory containing a set of map shapefiles. Clicking the 
Browse button opens the directory navigating/browser dialog, which allows you to navigate easily 
to the desired directory. After locating the desired directory, clicking the Connect button lists the 
available shapefiles.

• Load As: In this section the shapefiles can be loaded as a Map or as a Product. Descriptions of 
both follow.

◦ Map: When this radio button is selected, the selected shapefile (refer to Exhibit 16.5.1-2) 
displays as a map in the Main Display Pane, as shown in Exhibit 16.5.1-3. Click and hold 
mouse Button 3 (B3) on the Main Display Pane to open a pop-up menu and select Show 
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Map Legend to display the Map ID in the Legend area at the bottom of the display (see 
Exhibit 16.5.1-3).

Exhibit 16.5.1-3. GIS Data Displayed as a Map and Displaying Map ID in Legend 

Note 1: The map displayed in Exhibit 16.5.1-3 shows the GIS data displayed as 
contoured boundaries. 

◦ Product: When this radio button is selected, the start and end date/time data fields become 
enabled. You can select a start and end date/time from the Calendar dialog shown in 
Exhibit 16.5.1-4. Clicking on the Calendar icon opens the Calendar dialog.
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Exhibit 16.5.1-4. GIS DataStore Parameters Dialog with Calendar Open 

Loading a shapefile with the Product radio button selected will return a shaded (color-filled) 
image of the Map Product in the Main Display Pane, as shown in Exhibit 16.5.1-5. The 
Product ID will appear in the Legend area at the bottom of the display after selecting Show 
Product Legend from the B3 pop-up menu.

Exhibit 16.5.1-5. GIS Data Displayed as a Map Product Image

In Exhibit 16.5.1-6 GIS data is displayed as a Product overlaid on top of model data. The 
map product displays with the model data when the valid time of the model data falls within 
the start/end time range selected for the map product in the GIS DataStore Parameters

Page 4 of 6

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



dialog. When the valid time of the model data falls outside the start/end time of the map 
product, the map product image does not display, as shown in Exhibit 16.5.1-7.

Exhibit 16.5.1-6. GIS Data Map Product Image with Model Data Within Valid Time Range 

Exhibit 16.5.1-7. GIS Data Map Product Image with Model Data Outside Valid Time Range 

• Table: In this section you can select one of the shapefiles listed in the window for display (refer to 
Exhibit 16.5.1-2). Click mouse Button 1 (B1) on the selected file name. The selected file will be 
highlighted and the OK button at the bottom of the dialog will be enabled. Clicking the OK button 
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closes the GIS DataStore Parameters dialog box and displays the selected map or map product 
image in the Main Display Pane.
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16.5.2 Setting the Attribute Values for Displayed GIS Data from within CAVE

Using the Preferences dialog, you can modify certain GIS display attributes in CAVE without having 
the GIS application open. Access the GIS Viewer via CAVE > Preferences > GIS Viewer, as shown 
in Exhibit 16.5.2-1.

Exhibit 16.5.2-1. Accessing the Preferences Dialog - GIS Viewer 

Note: Exhibit 16.5.2-1 shows the default values for these four attributes. 

The attributes that can be modified within CAVE apply to the map/map product image displayed on 
the Main Display Pane. They are: color of the highlights; highlight line style; highlight line width; and 
map product opacity. The button next to the name of the attribute displays a swatch of the current 
value. Selecting this button opens a dialog for modifying that attribute and redefining the default 
value, as shown in Exhibit 16.5.2-2.

Page 1 of 3

9/11/2015file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users%20Manual/OB15.1.1/Source%...



Exhibit 16.5.2-2. Modifying GIS Viewer Preferences 

A description of each attribute follows.

• Highlight Color: This button opens a dialog that includes a color wheel and a color palette. 
Clicking the OK button after changing the color sets the new color for the highlight that 
appears around a selected area (via the Attributes dialog), and closes the dialog. The new color 
is then displayed on the swatch.

• Highlight Style: This button opens a menu displaying a set of lines of differing styles. Double-
clicking on the desired line style sets the new style for the highlight that appears around a 
selected area (via the Attributes dialog), and closes the menu. The new line style is then 
displayed on the swatch.

• Highlight Width: This button opens a menu displaying a set of lines of differing widths. 
Double-clicking on the desired line width sets the new width for the highlight that appears 
around a selected area (via the Attributes dialog), and closes the menu. The new line width is 
then displayed on the swatch.

• Product Opacity: This button opens the Set Opacity dialog for setting the default opacity level 
for GIS map product images. The dialog includes a swatch and a slider. Moving the slider 
increases or decreases the opacity level. Clicking the OK button sets the default level and 
closes the dialog.

Beneath the four attributes are two buttons: Restore Defaults on the left and Apply on the right. The 
function of the Restore Defaults button is to restore "all" the attributes to their initial (default) values. 
Click this button only if you want to restore all attributes to their default values. [Caution: If you 
accidentally click the Restore Defaults button, you will need to return to the attribute dialog(s) and 
redefine your desired values.]
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Use the Apply button to save any changes you make to the default attribute settings. Wait until you 
are satisfied with all the values you have set, and then click the Apply button once to save all the 
changes. The values you set here for the attributes will then be applied to the GIS application as the 
new defaults.
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16.5.3 Customizing and Using the GIS Application's Attribute Dialog

You have the ability to highlight specific areas of the displayed map or map product image, and to hide 
other areas. These functionalities are executed through the Attributes dialog, commonly referred to as 
the "Attributes Table" because of its tabular style. To access the Attributes dialog, click and hold mouse 
Button 3 (B3) on the Map ID in the Legend area to open the pop-up menu shown in Exhibit 16.5.3-1. 
From the pop-up menu select the Display Attributes option to open the Attributes dialog.

Exhibit 16.5.3-1. Pop-up Menu to Open the Attributes Dialog (Attributes Table) 

The Attributes dialog includes two menus, Annotation and Data, which allow you to control 
highlighting and visibility for both the displayed images and the information contained in the Attributes
dialog. For each row of information on the Attributes dialog there is an associated map/map product 
image displayed on the Main Display Pane.

• Highlighting

◦ Highlighting Selected Areas: To place a highlight around a selected area of the GIS display 
image and highlight the corresponding row on the Attributes dialog, click and hold B3 on 
the row you want to select. This opens the pop-up menu shown in Exhibit 16.5.3-2. Check 
the Highlighted checkbox in the pop-up menu to activate highlighting. Multiple rows can be 
selected using Ctrl + B1 to select each row, which will highlight the selected row in blue. 
Then click and hold B3 on one of the selected rows; this will turn all selected blue rows dark 
gray (refer to Exhibit 16.5.3-2) and open the pop-up menu. After checking the Highlighted
checkbox all selected rows will be highlighted yellow and a highlighted border surrounding 
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all the areas on the map corresponding to those selected rows will be highlighted with the 
color setup in the Preferences dialog box.

Exhibit 16.5.3-2. Attributes Dialog for Visibility Control 

Note 1: The highlight bordering the corresponding areas on the Main Display Pane 
shown in Exhibit 16.5.3-2 is purple, which is the color set up in the Preferences dialog 
within CAVE. The highlighted rows of the Attributes dialog corresponding to those 
areas will always be yellow. 

◦ Unhighlighting Selected Areas: To unhighlight selected rows and associated highlighted 
borders around the areas of the image, click and hold B3 on the row or select multiple rows 
via Ctrl + B1 and then click and hold B3 to open the pop-up menu and uncheck the 
Highlighted checkbox.

◦ Unhighlighting All Areas: To remove all highlighted borders around the areas of the image 
and remove all yellow highlighted rows on the Attributes dialog, select the Clear Highlights
option under the Annotation menu.

Note 2: If you are interested in a particular area but don't know the Feature ID, which 
is listed in the Attributes dialog, double-click on the area of interest on the image in 
the Main Display Pane and the corresponding row will be highlighted. Conversely, 
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double-clicking on a particular row will place a highlighted border around the 
corresponding area on the image. 

• Controlling Visibility of Image Areas

◦ Hiding Selected Areas: To hide an area of the image displayed on the Main Display Pane, 
simply click and hold B3 on the row in the Attributes dialog corresponding to the area of 
interest. This will open a pop-up menu where you will uncheck the Visible checkbox to 
deactivate visibility for the selected area. If you want to hide multiple areas of the image, 
preselect the rows using Ctrl + B1 to highlight in blue the multiple selections; then click and 
hold B3 on one of the rows to open the pop-up menu. The deactivation of visibility will 
affect all areas corresponding to the selected rows. The areas of the image will disappear 
from the display and the selected row(s) on the Attributes dialog box will be shaded light 
gray (refer to Exhibit 16.5.3-2).

◦ Unhiding Selected Areas: To return the hidden area(s) of the image to their original visible 
state, click and hold B3 on the corresponding gray-highlighted row to open the pop-up 
menu. On the pop-up menu, check the Visible checkbox. To return multiple areas to their 
original visual state, use Ctrl + B1 to select all corresponding gray-highlighted rows; and 
then click and hold B3 on one of the rows to open the pop-up menu. Checking the Visible
checkbox will affect all the selected rows and corresponding areas of the image. The 
previously gray highlighted rows will return to their orginal nonhighlighted state.

◦ Unhiding All Areas: The Make All Visible option under the Annotation menu enables you 
to return "all" hidden areas to their original visible state. All gray highlighted rows on the 
Attributes dialog will be returned to their original nonhighlighted state.

• Configuring Attributes Table

In the Attributes dialog ("Attributes Table"), the options under the Data menu allow you to 
customize the table based on which columns to display and how the table is to be sorted.

◦ Selecting Columns to Display: To select which columns to display, select Data > Select 
Columns... to open the Select Columns dialog shown in Exhibit 16.5.3-3.

Exhibit 16.5.3-3. Accessing the Select Columns Dialog 
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Note 3: By default, all available columns are displayed. 

Within the Select Columns dialog, you can select the column(s) you don't want displayed by 
first selecting the individual item(s) and then using the single arrow button to move the item
(s) from the Displayed window to the Available window. Clicking the OK button saves the 
change and removes the columns from the Attributes dialog. Use the double arrow button to 
move all the items listed in the Displayed window to the Available window.

◦ Sorting Column Information: Selecting the Sort option opens the Sort Order dialog 
shown in Exhibit 16.5.3-4.

Exhibit 16.5.3-4. Accessing the Sort Order Dialog 

Note 4: By default, all displayed columns are sorted in ascending order. 

Within the Sort Order dialog, you can select a column from the dropdown list of displayed 
columns and select how you want the information in that column sorted. The other columns 
will adjust accordingly. Clicking the OK button (hidden in the Exhibit under the dropdown 
list) closes the Sort Order dialog and saves the change according to your selection. Clicking 
the Cancel button closes the dialog without making any changes to the Attributes Table.
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16.5.4 Displaying a Sample of GIS Data Attribute Values on the Main Display Pane

Note: This feature is only available for a Map Product image. You cannot sample GIS data 
displayed as a Map. 

You can view a sample of a selected GIS data attribute directly on the Main Display Pane, as shown 
in Exhibit 16.5.4-1, without having to open the Attributes dialog.

To open the Select Sample Attribute submenu, click and hold B3 on the Map Product ID in the 
Legend area to open a pop-up menu and select the Select Sample Attribute option. On the Select 
Sample Attribute submenu select the value you want displayed and then click the OK button. Click 
and hold B3 anywhere on the Main Display Pane to open a pop-up menu and check the Sample
checkbox to activate the sampling functionality. Then, hovering your cursor over any area of the Map 
Product image will display the sample for the selected attribute.

Exhibit 16.5.4-1. Example of the Sampling Functionality 
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16.5.5 GIS Data and Display Customization from within the GIS Application

Once the GIS data is displayed, there are several ways to customize the displayed data from within the GIS
application. All customizations originate by selecting from the pop-up menu shown in Exhibit 16.5.5-1. To
open the pop-up menu, click and hold mouse Button B3 (B3) on the GIS displayed image or on the
Map/Map Product ID in the Legend area and move the cursor to the option you want to modify.

Exhibit 16.5.5-1. Pop-up Menu for GIS Data and Display Customization

Note 1: Numbers on Exhibit 16.5.5-1 reference the descriptions that follow.

A description of each customization follows.

Change Color: This option opens the Color Selection submenu shown in Exhibit 16.5.5-2, which
allows you to modify the color of the area borders for the map or the shading for the map product
image, and map labels.

Exhibit 16.5.5-2. Color Selection Submenu

You can select one of the set colors in the Color Selection submenu, or select the Choose Color option

1. 
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to open a dialog containing a color wheel and color palette (refer to Exhibit 16.5.2-2). The selected
color will also change the Map/Map Product ID in the Legend to the same color as the map labels, as
shown in Exhibit 16.5.5-3. Once you select a color, the color is applied to the display and the submenu
closes automatically after selection.

Exhibit 16.5.5-3. Results from Selecting a Color from the Color Selection Submenu

Rename: This option opens the Rename dialog shown in Exhibit 16.5.5-4, which allows you to
change the Map/Map Product ID name in Legend. Enter the new name into the Enter new name text
field and click the OK button to update the ID name in the Legend. Clicking the Cancel button will
restore the initial (or last saved) name.

Exhibit 16.5.5-4. Changing Map/Map Product ID in Legend Using Rename Dialog

2. 

Crop Shape: This option enables you to crop those areas of the display that you only want to view, and3. 
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remove all other areas from view. After selecting this option, a Drag to select message appears
adjacent to the cursor. Click and hold B1 at the corner of your area of interest and drag on the map to
create a green square across the desired area. Once you release the mouse button, the map updates to
display the areas encompassed by the green square. Notice that areas partially encompassed by the
green square will continue to display. Only areas completely outside the green square will be removed,
as shown in Exhibit 16.5.5-5.

Exhibit 16.5.5-5. Cropping the Displayed Image

Note 2: As of the release of this edition of the Manual, the Crop Shape function was still being
enhanced. The following two functionalities will be available in a future release: (1) Once you
crop an area, the rows on the Attributes dialog corresponding to the cropped out area will no
longer be listed on the table; and (2) when sampling a cropped image, the sampled values will
only be returned for data displayed on the Main Display Pane.

Line Style: This option opens the Line Style submenu shown in Exhibit 16.5.5-6, which allows you to
change the line style of the borders surrounding each area. A single-click on your choice changes the
line style and closes the submenu.

Exhibit 16.5.5-6. Line Style Submenu

4. 

Line Width: This option opens the Line Width submenu shown in Exhibit 16.5.5-7, which allows
you to change the line width of the borders surrounding each area. A single-click on your choice

5. 
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changes the line width and closes the submenu.

Exhibit 16.5.5-7. Line Width Submenu

Label: This option opens the Labels submenu shown in Exhibit 16.5.5-8. The Labels submenu lists
all the labels available. Select the desired label by clicking the radio button (as shown for
"FIRE_NAME"). Once a label is selected via the radio button, the label will appear within the Main
Display Pane (refer to Exhibit 16.5.5-3). Once you select a label, the label is applied to the display and
the submenu closes automatically after selection.

Exhibit 16.5.5-8. Labels Submenu

6. 

Label Offset: This option opens the Map Label Offset dialog shown in Exhibit 16.5.5-9, which
allows you to change the label position on the display. The default is X=0 and Y=0. To change the X
and Y values, click the up or down arrows, or manually type a value into the X and Y text fields. The
label shown on the display repositions automatically with each increment or change in the X or Y
value. Clicking the OK button closes the dialog. Clicking the Cancel button closes the dialog,
returning the label to its last updated X and Y position.

Exhibit 16.5.5-9. Map Label Offset Dialog with Default Values

7. 

Shade: This option opens the Shade submenu shown in Exhibit 16.5.5-10, which, as you can see, is
almost identical to the Label submenu. However, the Shade submenu is for Map Products, since it
includes the Set Opacity (XX%) value at the bottom of the submenu. When GIS data is displayed as a
product, you have the option to change the opacity value of the displayed map product image. The
default opacity, which was set via the Preferences dialog, is listed at the bottom of the Shade
submenu.

8. 
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Exhibit 16.5.5-10. Shade Submenu for Map Product Image with Default Opacity Value Shown

Clicking the Set Opacity (XX%) option at the bottom of the Shade submenu opens the Set Opacity
dialog shown in Exhibit 16.5.5-11. Use the Set Opacity dialog to change the desired opacity
percentage. The actual opacity percentage on your screen will match the default opacity set in the
Preferences dialog within CAVE.

Exhibit 16.5.5-11. Set Opacity Dialog with Default Setting Shown

You can increase or decrease the opacity value using the slider and watching the corresponding shading
of the GIS map product change in the Main Display Pane. Clicking the OK button will close the
submenu and set the opacity value with the new value shown at the bottom of the Shade submenu.
Clicking the Cancel button will close the submenu and revert the opacity value to its initial setting
(default or last saved value).

Magnification: This option opens the Magnification submenu shown in Exhibit 16.5.5-12, which
allows you to change the size of the labels displayed in the Main Display Pane. You can choose one of
the seven preset magnifications, which will update as soon as the radio button is selected, allowing you
to determine which magnification level is best. Once you select a magnification, the magnification
setting is applied to the display and the submenu closes automatically after selection.

Exhibit 16.5.5-12. Magnification Submenu

9. 

Density: This option opens the Density submenu shown in Exhibit 16.5.5-13.10. 
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Note 10: The Density option does not appear on the pop-up menu until after you have selected a
label from the Labels submenu. Once a label is activated, you can select the Density option.

Exhibit 16.5.5-13. Density Submenu

How Density Works: The density values listed on the Density submenu change the number of labels
displayed in D2D. For example, in Exhibit 16.5.5-8, the "Fire-Name" label was selected. If your
display area contains 100 Fire Names, and you have selected a density of "1," it may be that about 45
of the 100 Fire Names will display in D2D. If you change the density to "0.5," it is likely that only
about half of those 45 Fire Names will be displayed. If you change the density to "2," about 90 of the
100 Fire Names will be displayed. The "Max" option will display all the Fire Names, and "0" will
display no Fire Names.

Once you select a density, the density setting is applied to the display and the submenu closes
automatically after selection.
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17.1 Ensemble Tool

The Ensemble Tool provides capabilities to display and manipulate ensemble model data. The datasets and
the Tool are there to help forecasters assess uncertainty in the forecast, or lack thereof. This is intended to
assist forecasters with interactive decision support in two ways: estimates of event probability, and alternative
scenarios to the official (deterministic) forecast.

Before we start using the Ensemble Tool, it may be useful to see how CAVE handles ensemble data without it
as shown in Exhibit 17.1-1. Note how cluttered and unreadable the display is because there are too many
contours shown. Note also how the product legends stack up in the lower-right corner. Both of these types of
clutter are part of why the Ensemble Tools was developed.

Exhibit 17.1-1. GFS Ensemble without using the Ensemble Tool

Exhibit 17.1-2 illustrates the launching of the Ensemble Tool from the and Exhibit 17.1-3 illustrates the
Ensemble Tool on Start-up..
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Exhibit 17.1-2. Launching the Ensemble Tool
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Exhibit 17.1-3. Ensemble Tool on Start-up

Note the VB selector in the menu bar inside the Ensemble Tool. This is a shortcut to the Volume
Browser, and it works identically to the result from selecting Volume … Volume Browser from the
CAVE menu bar. We have modified the VB so that ensemble datasets are available from their own
selector as shown in Exhibit 17.1-4.
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Exhibit 17.1-4. Volume Browser showing Ensembles as a new source

The Preciptation output from the GFS Ensemble is shown in Exhibit 17.1-5.
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Exhibit 17.1-5. GEFS Precipitation display on the Ensemble Tool

The viewport for legend information takes up a lot of space, but it can be easily re-sized by dragging the
border between the main display and the legend viewport as shown in Exhibit 17.1-6.
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Exhibit 17.1-6. Ensemble Tool with re-sized legend viewport

An example is illustrated with the following four Exhibits.

1. Load the GEFS surface temperature (Exhibit 17.1-7)

2. Change its color presentation (Exhibit 17.1-8)

3. Calculate the ensemble mean (Exhibit 17.1-9)

4. Display it (Exhibit 17.1-10)
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Exhibit 17.1-7. GEFS Surface Temperature Forecast (The contours for 0F and 40F)

The dialog box to change the color presentation of the ensemble is accessed by right-clicking on the
ensemble selector. The re-colored results are shown in Exhibit 17.1-8.
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Exhibit 17.1-8. The dialog box to change the color presentation of the ensemble

The re-colored results are shown in Exhibit 17.1.-9. The menu for calculating the mean and other
statistics from the ensemble is accessed by the gear-shaped icon on the right side of the legend
viewport menu is shown below.
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Exhibit 17.1-9. The menu for calculating the mean and other statistics from the ensemble

The calculated result is shown below.
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Exhibit 17.1-10. Ensemble mean surface temperature forecast

Next we will calculate (Exhibits 17.1-11 and 17.1-12) and display (Exhibit 17.1-13) the ensemble
relative frequency, a (biased) proxy for probability. If you’re following along and replicating these
steps, right-click on the legend for the ensemble mean temperature and select “unload” (not shown).

Right-click on the lend for the ensemble and click Relative Frequency.
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Exhibit 17.1-11. Relative Frequency

The temperature ranges are inserted in the Relative Frequency dialog box, lower right as shown
in Exhibit 17.1-12. (Note the changed color table, only to enhance appearance in the next
figure.) Click on Compute ERF.
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Exhibit 17.1-12. Relative Frequency dialog box with tempearture ranges

Note: The changed color in the table (Exhibit 17.1-13) is for enhanced appearance. Click on
compute ERF.

The yellow contour is the ensemble relative frequency (fraction of the total number of ensemble
members) that have predicted surface temperature between 20F and 30F. The ensemble members
are contoured at 0F and 40F and is shown in Exhibit 17.1-13.
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Exhibit 17.1-13. The ensemble relative frequency (Yellow Contour) predicting the temperature

Time series displays, sometimes called plume diagrams, can be generated as shown in Exhibit
17.1.14. The GEFS surface temperature time series for Point A in central Nebraska . The point to
plot data for can be chosen in the Volume Browser, and can be moved using the Point Selector
(the 3-dot icon on the CAVE tool bar). Note: In the current version of the Ensemble Tool we
have not yet implemented such controls as changing colors, or color palette, or calculated fields.
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Exhibit 17.1-14. GEFS surface temperature time series for point A in Central Nebraska (point to
plot data)

Note: With the first release of the Ensemble Tool there is not yet a way to get data from the Short
Range Ensemble Forecast system (SREF). Exhibit 17.1-15 is an example of how it will be
presented, and gives a clue about why color-coding the ensemble members is useful.

file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users Manual/OB16...

14 of 15 1/28/2016 12:26 PM



Exhibit 17.1-15. 500mb field forecast from SREF

In the 500 mb field forecast from SREF above, the color palette option colors all contours from a
given forecast model, and its perturbations, in a similar color. The models are EM, NMM, and
NMB. Note how the green contours cluster, so do the blue contours. This is correlated model
error, and it is evidence that the SREF ensemble is underdispersed.
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18 Boundary Drawing Tool

18.1 Introduction

The primary functioms of the tool are

1.            Allow the forecaster to enter meso-scale and/or synoptic scale surface boundaries
2.            Allow the forecaster to set a boundary in motion after its creation
3.            Allow the forecaster to adjust location, shape and motion or delete any active boundary
4.            Save data: The data are saved via AWIPS II localization APIs

18.2 Forecastor Boundary Tool Interface

Under the “CAVE D2D Tools” pull-down menus, there is a new menu entry called “Boundary Tool” as
shown in Exhibit 18.2-1.

Exhibit 18.2-1. CAVE D2D Tools menu with “Boundary Tool” entry

18.3 Boundary Tool

Boundary Tool allows the forecaster to add new surface boundaries, adjust the positions of existing
boundaries, set a stationary boundary to motion, modify the speed of a moving boundary or end an active
boundary.

Selecting “Boundary Tool” menu button will launch the “Boundary Editor” GUI as shown in Exhibit 18.3-1.
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Exhibit 18.3-1. Boundary Editor GUI

18.3.1 Active Boundaries

Once the Boundary Tool's GUI is loaded, existing active boundaries will be displayed on D2D. Click the
arrow button of the “Edit Boundary”, a pull-down list of all active boundary ids will be shown.  Click on the
id for the boundary you want to edit, the selected number will be filled in the entry besides “Edit Boundary”
label. Please check this Boundary ID number every time before you do any further modifications of existing
active boundaries.

18.3.2 Create and Edit New Boundaries

To define a new boundary, select a D2D frame whose frame time will be this new boundary’s creation time,
click the “Insert Boundary” button, an editable boundary will be displayed on the center of D2D screen. Drag
and adjust the poly-line to the desired position to align it with the meteorological boundary as depicted in the
underlining data.  Adjust the length of poly-line to cover the full length of the meteorological boundary by
holding the right mouse button and pulling the tip of the poly-line to the end of the meteorological boundary. 
Add vertices as many you like and drag each vertex to align with the virtual point of the meteorological
boundary. The boundary id is automatically assigned.  The maximum boundary id found in the drop-down
boundary id list is incremented by 1. The boundaries may be modified by dragging them to a new position or
clicking the middle mouse button to add or delete a vertex. Please be aware that any updated or new
boundaries must be saved.  The label on the button “Save Boundary Data ” turns red after any updates to
remind you that this button must be clicked to save.  Note that you need to define “Boundary Type” before
clicking “Save Boundary data” button, otherwise you will be warned to define the boundary type before
saving the data. Once the data is saved, the boundaries on D2D will become un-editable as shown in Exhibit
18.3.2-1. If later you feel the need to adjust a boundary, select the boundary from the “Edit Boundary”
pull-down list and click the “Edit Boundary” button and the selected boundary will become editable.
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Exhibit 18.3.2-1. Active Boundaries

18.3.3 Boundary Duration Time

By default, the duration time of a boundary is set to 8 hours. The user can set the lifespan of any
boundary by clicking the arrow button of “Boundary Duration (hrs)” and selecting the desired number
of hours.

18.3.4 Set Boundary in Motion

By default, a new boundary is stationary with three vertices.  A boundary may be set to motion initially
when creating the boundary or after saving the stationary boundary. 

To assign motion vectors to a particular boundary after already saving the stationary boundary;
select the boundary id from the drop-down list, select the “Edit Boundary” button, then click the
arrow button of the “Boundary Mode” and select “Moving”, and choose a D2D frame other than
the one in which you edited the boundary, and drag and adjust the poly-line to the desired
position to align it with the meteorological boundary as depicted in the underlining data.

To assign motion vectors to a boundary prior to saving the boundary, click the “Boundary Mode”
button and select “Moving”, and choose a D2D frame other than the one in which you created
the boundary,  then drag and adjust the polyline to the desired position and shape to align it with
the meteorological boundary as depicted in the underlining data. Use the step forward and
backward buttons on D2D to loop through the frames and verify whether the boundary motion
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has been properly defined*.  Click the “SaveBoundary data” button once you are happy with the
positions.  The boundary will become un-editable.

*Please note that the boundary motion vectors are calculated for each point on the
boundary.  Dragging the entire boundary will result in a constant velocity for all points on
the boundary.

However, in real world the boundary shape is not constant because different parts of a
boundary have different velocities.  You can compute the motion of each vertex by
dragging one point at time or adjust the position of each vertex at the proper location after
dragging the entire boundary (e.g. Figure 4).  The velocities are calculated by determining
the displacement in space and time between the editable points on the boundary and the
position of the points on the original boundary.

Exhibit 18.3.4-1. Moving Boundary

18.3.5 Modify Boundary Position and Motion

Over time the boundaries are likely to get out of sync with the real boundaries. 

file:///U:/AWIPS/Projects/AWIPS-2/Documentation/Users Manual/OB16...

4 of 5 1/28/2016 12:26 PM



For stationary boundary, click “Edit Boundary” button and select the boundary id you want to adjust, and
reposition it to align with the real position as depicted in the underlying data.

For moving boundary, click “Edit Boundary” button to select the boundary id to be adjusted, then click
“Modify Boundary Motion” button. A confirmation window will pop up, allowing you to select “Yes” which
will make the boundary stationary.  Now you can adjust the boundary shape and location accordingly in the
current frame.  Then click the arrow button of “Boundary Mode” and select “Moving”, and choose another
D2D frame, and drag the polyline to the desired position to align it with the meteorological boundary as
depicted in the underlining data; this will compute the new motion of that boundary.

You can cancel the modification you just made before saving the data by clicking on “Cancel Modification”
button.   A confirmation window will pop up, allowing you to select “Yes”; which will restore the original
boundary before your modification.

18.3.6 End Boundary

If a boundary is obsolete, select the boundary id that you want to end from the “Edit Boundary” drop-down
list, and click the “Delete Boundary” button.  A confirmation window will pop up, allowing you to select
“Yes”; which will remove the boundary from the list of active boundaries, there is no need to click “Save
Boundary data”.
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Appendix A. Glossary

Aviation Weather Center (AWC) - One of NOAA's National Centers for Environmental Prediction. 
AWC provides aviation warnings and forecasts of hazardous flight conditions at all levels within 
domestic and international air space. 

AWIPS - Advanced Weather Interactive Processing System. 

AWIPS-2 Archiver - See WES-2 Bridge. 

AWIPS Statistics - An option under the CAVE menu for capturing, graphically displaying, and 
analyzing system performance statistics. 

Button - A button on a mouse pointing device; Mouse buttons can be mapped to the keyboard. Also, 
a graphical component on a window frame or in a dialog box that works by pressing it. 

Cascading Menu - A submenu of related menu options that is invoked when a menu item is selected 
from a parent menu. Usually, a cascading menu is designated by an arrow to the right of the menu 
item. 

CAVE - Common AWIPS Visualization Environment. 

Collaborative Convective Forecast Product (CCFP) - A strategic forecast of convection to guide 
traffic managers in their system-wide approach to managing traffic. 

Click - To quickly press and release the left mouse button. The term comes from the fact that pressing 
and releasing most Mouse buttons makes a clicking sound.

Close - A label given to a Push button in some dialog boxes that performs the action of closing the 
dialog box. Close is also used as a selection in Menus to close the window associated with the Menu. 

Coordinated Universal Time (UTC) - The primary time standard by which the world regulates 
clocks and time. It is the successor of Greenwich Mean Time (GMT). 

COTS - Commercial off-the-shelf. 

Cursor - A graphical image, usually a pipe (|) or block, that shows the location where text appears on 
the screen when keys on the keyboard are pressed or where a selection can be made. 

D2D - Display 2 Dimensions. 

Depictable - A method to retrieve data and display it using AWIPS and the D2D. 

Desktop - See "Workspace." 

Dialog Box or Dialog - A secondary window that the opens when a menu option includes an ellipsis 
(...) after its name. It contains application components. 
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Dimmed Selection - A selection that is not currently available. 

Double-click - To click and release a mouse button twice in rapid succession.

Extension - A depictable that allows user interaction with the D2D displays. 

Focus - A state of the system that indicates which component receives keyboard events. A component 
is said to have the focus if keyboard events are sent to that component. 

Geographic Information Systems (GIS) - An application that accepts many of the National Weather 
Service data set formats, including downloadable shapefiles, web services, and even KML files. 

GNU Object Model Environment (GNOME) - A windows-like desktop environment used with the 
Red Hat Enterprise Linux 6 operating system. 

Help - A label given to a Push button in some dialog boxes that performs the action of providing help 
for the dialog box. 

Highlight - A graphic technique used to provide a visual cue to the current selection or to the current 
location of the input focus. Highlighting is frequently accomplished by reversing the video of the 
selection. 

Icon - A small graphical image used to represent a window. Windows can be turned into icons or 
minimized to save room or unclutter the workspace (see "Workspace"). 

Insertion Cursor - The graphical symbol that provides the visual cue to the location of the insertion 
point. 

Isobar - A line of equal or constant pressure on a graph, plot, or map. 

K Desktop Environment (KDE) - A GUI primarily for Unix and Linux machines. 

Keyboard - An input device consisting of various keys that allows the user to input data, control 
cursor and pointer locations, and control the dialog with the workstation. 

Keyboard Focus - Indicates the window or component within a window that receives keyboard input. 
It is sometimes called the "Input Focus." 

Keyhole Markup Language (KML) - The KML file, when compressed forms a KMZ file that can 
be used in applications such as Google Earth. It is used by a variety of GIS and mapping applications. 

KMZ - File format when KML is zipped (compressed). Used in applications such as Google Earth. 

Label - The text part of an icon or graphical component. 

Legend - A line at the lower right corner of a graphical display window that notes the product ID and 
valid time. One legend is included for an image or combined image and one for each graphic overlay. 
The color of the latter matches that of the graphic. 

Left-click - To quickly press and release the left button (Button 1 as defined in Subsection 2.1.1) on 
the mouse. (See also Middle-click and Right-click.) 
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Location Cursor - A graphical symbol that marks the current location of the keyboard input focus for 
selection. Typically, this symbol is a box that surrounds the current object. 

Maximize - To enlarge a window to its maximum size. 

Menu - A list of available selections from which a user may choose. 

Message Box - The generic name for any dialog box that provides information, gives the current state 
of a work in progress, asks a question, issues a warning, or draws attention to an error. 

Middle-click - To quickly press and release the middle button or clickable scroll wheel (Button 2 as 
defined in Subsection 2.1.1) on the mouse. (See also Left-click and Right-click.)

Minimize (Iconify) - To turn a window into an icon. 

Mouse - A pointing device commonly used in conjunction with a keyboard in point-and-click object-
oriented user interfaces. 

Mouse Button - A button on a mouse pointing device. Mouse buttons can be pressed, released, 
moved, clicked, and double-clicked. 

Mouse Button 2 (or B2) - The center button on a three-button mouse or the scroll wheel on a two-
button mouse with a clickable scroll wheel.

Multiple-Radar / Multiple-Sensor (MRMS) - The MRMS allows users to access products related to 
the Multiple-Radar / Multiple-Sensor (MRMS) system that was initially developed by the National 
Severe Storms Laboratory (NSSL), and subsequently made operational at the National Centers of 
Environmental Prediction (NCEP).

National Polar-orbiting Partnership (NPP) - NPP, more precisely named Suomi NPP, is a polar-
orbiting environmental NASA satellite that orbits the Earth every 102 minutes, capturing data from 
the Earth's land, oceans, and atmosphere. Formerly known as the National Polar-orbiting 
Environmental Satellite System (NPOESS) Preparatory Project, the satellite was renamed Suomi NPP 
in January 2012, after Verner E. Suomi, a meteorologist at the University of Wisconsin.

Open - To start an action or begin working with a text, data, or graphics file. 

Pointer - The graphical image that appears on the workspace and represents the current location of a 
mouse or other pointing device. Also referred to as "Mouse Pointer." 

Pointing Device - A device such as a mouse, trackball, or graphics tablet that allows users to move a 
pointer about on the workspace and point to graphical objects. 

Pop-up Menu - A menu that provides no visual cue to its presence, but simply pops up when a user 
performs a particular action. Pop-up menus are associated with a particular area of the workspace, 
such as the client area of an application, and a user must memorize where these areas are. 

Press - To hold down a mouse button or a key.

Pull-Down Menu - A menu that extends downward from a client application's Title Bar.
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Push Button - A graphic component that simulates a real-life push button. When a user pushes the 
Push button, by pressing a key or a Mouse button, an action takes place.

Radio Button - A graphic component that simulates the buttons on a real-life car radio. Each button 
represents a mutually exclusive selection. Radio buttons are typically used for setting states or modes. 

Release - To let up on a Mouse button or key that has been pressed. Sometimes it is the press that 
initiates the action; sometimes it is the release.

Resize - To change the height or width of a window. 

Restore - To return an icon or maximized window to its normal size. 

Right-click - To quickly press and release the right button (Button 2 as defined in Subsection 2.1.1) 
on the mouse. (See also Left-click and Middle-click.)

Save - To write changes to a data file to a storage device for safekeeping. 

Scroll Bar - A graphical device used to change a user's view of the contents of a window. A scroll bar 
consists of a slider, a trough, and scroll arrows. A user changes the view by sliding the slider up or 
down in the scroll area or by pressing one of the scroll arrows. These actions cause the view to scroll 
up or down in the window adjacent to the scroll bar. 

Secondary Window - A child window of a primary window. 

Select - To choose an object to be acted upon or an action to be performed. 

Selection - The object or action that is selected. Menus are composed of selection items. Dialog boxes 
contain components, each of which represents a selection. 

Shapefile - A geospatial vector data format for geographic information systems software. Shapefiles 
spatially describe points, lines and polygons. 

Single Selection - A selection model that allows selection of a single element. 

Slider - One of the graphical components of a scroll bar or scale. The slider is the object that is 
dragged along the scroll area to cause a change. 

Submenu - A "cascading menu." 

Suomi NPP - See "National Polar-orbiting Partnership (NPP)." 

System Menu - See "Window Menu." 

Tear-off Menu - A menu that can be undocked from the location on the screen where it first opened, 
and manually moved around the workstation screen. 

Text Cursor - See "Insertion Cursor." 

Thin Client - The Thin Client component enables Incident Meteorologists to access baseline AWIPS 
capabilities on laptops in remote locations for gathering and analyzing localized weather information. 
Available in Windows and Linux versions. 
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Title Area - The area at the top of the window frame immediately beneath the resize border. The Title 
Area has two functions: it contains a title or name that identifies the window, and it can be grabbed 
and dragged to relocate the window. 

Title Bar - The bar across the top of a window manager window that consists of the Window menu 
button, the Title Bar, and the Window-Control buttons. 

WES-2 Bridge - Provides a bridge for current WES (Weather Event Simulator) capability into 
AWIPS II. In AWIPS, it is referred to as the AWIPS-2 Archiver. It is a Linux-based software package 
that allows the playback and simulation of weather events, viewable using the WES-2 Bridge. 

Window - A data structure that represents all or part of the display screen. Visually, a window is 
represented as a sub-area of the display screen. 

Window Frame - The area surrounding a window. A window frame can consist of a resize border, 
the Window menu button, the Title Bar, and the Window-Control buttons.

Window Menu - The menu that appears when the Window menu button is pressed. The Window 
Menu typically contains selections for restoring, moving, sizing, minimizing, maximizing, and closing 
the window. 

Window Menu Button - The Graphical Control button that appears at the left side of the Title Bar in 
the window frame. 

Workspace - The area on which the windows of a user's environment appear. The workspace is 
sometimes called the desk, desktop, or root window.
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Appendix B. AWIPS Acronyms and Abbreviations

0-9 | A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z

0-9

2D - Two Dimensions or 2 Dimensions 

A

ACT - Attribute Color Threshold
ADA - Urgent Administrative Message
ADM - Routine Administrative Message
AEV - AFOS-Era Verification
AFOS - Automation of Field Operations and Services
AGL - above ground level
AI - AWIPS Identifier
AMSU - Advanced Microwave Sounding Unit
ARD - AWIPS Remote Display
ASL - Above Sea Level
ASOS - Automated Surface Observing System
ASR - Airport Surveillance Radar
ATMS - Advanced Technology Microwave Sounder
AvnFPS - Aviation Forecast Preparation System
AVP - AWIPS Verification Program
AWC - Aviation Weather Center
AWIPS - Advanced Weather Interactive Processing System

B

B1 - mouse Button 1
B2 - mouse Button 2
B3 - mouse Button 3
BGAN - Broadband Global Area Network
BUFR - Binary Universal Form for the Representation of meteorological data 

C

CAPE - Convective Available Potential Energy 
CAVE - Common AWIPS Visualization Environment
CC - Correlation Coefficient
CCF - Coded Cities Forecast
CCFP - Collaborative Convective Forecast Product
CCL - Convective Condensation Level
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CDP - Cell Display Parameters 
CFC - Clutter Filter Control 
CGI - Common Gateway Interface
CIN - Convective Inhibition
CITR - Commerce Information Technology Requirement
CONUS - Conterminous/Contiguous/Continental United States
COOP - Continuity Of Operations Planning
COTS - commercial off-the-shelf
CPU - central processing unit
CRS - Console Replacement System
CRT - cathode ray tube
CrIMSS - Cross-track Infrared and Microwave Sounder Suite
CrIS - Cross-track Infrared Sounder
CSU - computer software unit
CSV - comma-separated value
CWA - County Warning Area
CWSU - Center Weather Service Unit
CZ - Composite Reflectivity

D

D2D - Display 2 Dimensions
DAT - digital audio tape 
DB - database
DCP - Data Collection Platform
DEF - Default
DFM - Digital Forecast Matrix 
DMD - Digital Mesocyclone Display 
DMS - Data Monitoring System 
DOC - Department of Commerce
DPA - Digital Precipitation Array 
DS - Data Server 

E

ECMWF - European Centre for Medium-Range Forecasts
EDEX - Enterprise Data EXchange
EMC - Environmental Modeling Center
EL - Equilibrium Level
ESA - Electronic Systems Analyst
ESRL - Earth System Research Laboratory
ETA - estimated time of arrival

F

FFG - Flash Flood Guidance 
FFFG - Forced Flash Flood Guidance
FFMP - Flash Flood Monitoring and Prediction 
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FFMPA - Flash Flood Monitoring and Prediction: Advanced
FFTI - Flash Flood Threat Index 
FFW - Flash Flood Warning
FM - Functional Manager
FSL - Forecast Systems Laboratory 
FTP - File Transfer Protocol 

G

GE - GOES East
GFE - Graphical Forecast Editor
GFS - Global Forecasting System
GHG - Graphical Hazards Generator
GIS - Geographic Information System
GMT - Greenwich Mean Time
GNOME - GNU Object Model Environment
GOES - Geostationary Operational Environmental Satellite 
GSD - Global System Division
GUI - Graphical User Interface
GW - GOES West 

H

HC - Hydrometeor Classification
HI - Hail Index
HM - Hydromet
HP - Hewlett-Packard 
HPC - Hydrologic Precipitation Center
HSB - Hue, Saturation, and Brightness
HWR - Hourly Weather Roundup

I

ICAO - International Civil Aviation Organization 
IFP - Interactive Forecast Program 
IFPS - Interactive Forecast Preparation System 
IHFS - Integrated Hydrologic Forecast System
IMET - Incident Meteorologist
IP - Internet Protocol 
IR - infrared 
ISS - Incident Support Specialist IST - Interactive Skew-T 

J

JMS - Java Messaging System

K
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KDE - K Desktop Environment
KDP - Specific Differential Phase
KML - Keyhole Markup Language
KMZ - KML zipped (compressed).

L

LAC - Listening Area Code
LAMP - Localized Aviation MOS Program
LAN - Local Area Network
LAPS - Local Analysis and Prediction System 
LARC - Local Automatic Remote Collector 
Lat - Latitude
LCL - Lifting Condensation Level 
LDAD - Local Data Acquisition and Dissemination 
LFC - Level of Free Convection 
Lon or Long - Longitude
LSR - Local Storm Report 

M

MAPS - Mesoscale Analysis and Prediction System 
mb - millibar; pressure 
MDCRS - Meteorological Data Collection and Receiving System
MDL - Meteorological Development Laboratory 
MDP - Mesocyclone Display Parameters 
MDPI - Microburst-Day Potential Index
MEF - Manually Entered Forecast
METAR - Meteorological Aviation Report 
MHS - message handling system
ML - Melting Layer
MND - Mass News Dissemination
MOS - Model Output Statistics
MPC - Marine Prediction Center
MPE - Multisensor Precipitation Estimator
MRD - Message Reference Descriptor
MRMS - Multiple-Radar / Multiple-Sensor 
MRU - Meso Rapid Update
MSAS - MAPS Surface Assimilation System
MSL - Mean Sea Level

N

NA - not applicable; North American 
NAM - North American Mesoscale model
NCEP - National Centers for Environmental Prediction 
NCF - Network Control Facility 
NDFD - National Digital Forecast Database
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NE-PAC - Northeastern Pacific
NESDIS - National Environmental Satellite, Data and Information Service
NH - Northern Hemisphere 
nMi - nautical miles 
NOAA - National Oceanic and Atmospheric Administration
NPN - NOAA Profiler Network
NPP - Suomi National Polar-orbiting Partnership
NUCAPS - NOAA Unique CrIS/ATMS Processing Systems
NWP - Numerical Weather Prediction
NWR - NOAA Weather Radio 
NWS - National Weather Service 
NWRWAVES - NOAA Weather Radio With All-Hazards VTEC Enhanced Software
NWSRFS - National Weather Service River Forecast System 
NWWS - NOAA Weather Wire Service 

O

OCP - Ocean Prediction Center
OH - Office of Hydrology
OPC - Ocean Prediction Center
OPSNET - Operations Network
ORPG - Open Radar Products Generator
OSD - One Hour Snow Depth
OSW - One Hour Snow Water
OTR - One Time Request

P

PID - Product Identification
PIL - Product Inventory List
PIREP - Pilot Weather Report
POES - Polar Operational Environmental Satellite
POSH - Probability of Severe Hail
POH - Probability of Hail
POP - Probability of Precipitation
PQPF - Probabilistic QPF
Precip - Precipitation
PRF - Pulse Repetition Frequency

Q

QC - quality control 
QCMS - Quality Control and Monitoring System 
QPE - Quantitative Precipitation Estimator
QPF - Quantitative Precipitation Forecast
QPS - Quantitative Precipitation Summary
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R

RAOB - Radiosonde Observation 
RAP - Rapid Refresh (Replaced RUC) 
RCM - Radar Coded Message 
RER - Record Report 
RFC - River Forecast Center 
RGB - Red, Green, Blue 
RHI - Range Height Indicator 
RMR - Radar Multiple Request 
RMS - root-mean square 
ROSA - Remote Observing System Automation 
RPG - Radar Product Generator 
RPN - Reverse Polish Notation 
RPS - routine product set 
RTD - Requirements Traceability Document; Routine, Delayed 
RTMA - Real Time Mesoscale Analysts 
RUC - Rapid Update Cycle (Replaced by RAP)

S

SAFESEAS - System on AWIPS for Forecasting and Evaluation of Seas and Lakes
SBN - Satellite Broadcast Network
SCAN - System for Convection Analysis and Nowcasting
SCD - Supplementary Climatological Data 
SCID - Storm Cell Identification Display 
SCP - Satellite Cloud Product 
SCTI - SCAN CWA Threat Index 
SDC - State Distribution Circuit 
SNOW - System for Nowcasting Of Winter Weather
SOO - Science and Operations Officer
SPC - Storm Prediction Center 
SPE - Satellite Precipitation Estimate
SREF - Short Range Ensemble Forecast
SRG - Supplemental Product Generator
SRM - Storm Relative Motion
SS - Storm Structure
SSD - Storm-Total Snow Depth
SSM/I - Special Sensor Microwave/Imager
SSW - Storm-Total Snow Water
STI - Storm Track Information
Suomi NPP - Suomi National Polar-orbiting Partnership
SW - Spectrum Width
SWEAT Index - Severe Weather Threat Index
SWP - Severe Weather Probability

T
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TAF - Terminal Aerodrome Forecast (international code) 
TAFB - Tropical Analysis and Forecast Branch
TCM - Marine/Tropical Cyclone Advisory
TCP - Public Tropical Cyclone Advisory 
TDWR - Terminal Doppler Weather Radio
TE-PAC - Tropical Pacific
TMI - Text Message Intercept
TRU - TVS Rapid Update
TT - Total Totals
TVS - Tornado Vortex Signature
TWB - Transcribed Weather Broadcasts 

U

UGC - Universal Geographic Code
ULR - User Selectable Layer Reflectivity
URL - Universal Resource Locator
USD - User Selectable Snow Depth
USW - User Selectable Snow Water
UTC -  Coordinated Universal Time 

V

VAD - Velocity Azimuth Display 
VCP - volume coverage pattern
VIIR - Visible Infrared Imager Radiometer Suite
VIL - Vertically Integrated Liquid
VTEC - Valid Time and Event Code
VWP - VAD Wind Profile

W

W-ATL - Western Atlantic
WAN - wide area network
WES - Weather Event Simulator
WFO - Weather Forecast Office
WINDEX - Wind Index
Win32 - Common 32-bit Microsoft Windows platform
WMO - World Meteorological Organization
WS - Workstation
WSFO - Weather Service Forecast Office 
WSO - Weather Service Office
WSOM - Weather Service Operations Manual 
WSR-88D - Weather Surveillance Radar-1988 Doppler 
WWA - Watch Warning Advisory
WV - water vapor

X
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Y

Z

Z - Reflectivity
ZDR - Differential Reflectivity
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Appendix C. Managing Your AWIPS User Account

Each AWIPS user must have an individual Linux account to use the AWIPS application. The System
Administrator creates the individual accounts for AWIPS users. Issues related to management of those
accounts are discussed in this appendix.

Password Management

The Department of Commerce (DOC) policy requires that passwords be changed at least every 90 days. You
must never share your password with other users, and you must change it immediately when you know or
suspect your password has been compromised. The incident should also be reported to your System
Administrator.

Password Criteria

Passwords must meet the following policy criteria:

Passwords for user accounts must have a least fourteen (14) non-blank characters.

Passwords must have a minimum one each of a digit, upper case, lower case and special characters as
shown below.

English upper case characters (A ... Z);

English lower case characters (a ... z);

Base 10 digits (0 ... 9); and

Non-alphanumeric characters (e.g., $#%).

Passwords must not contain common words, nouns, pronouns, acronyms, contractions, and geographic
locations (i.e., dictionary words).
The last 5 passwords will be remembered and cannot be reused.  Users may not change their password
for 7 days after a change. Users will be locked out temporarily after 5 unsuccessful logins in a row.
User accounts inactive for 35 days will be locked. Maximum SSH authentication attempts reduced
from 6 to 4.  SSH sessions will timeout after 30 minutes of inactivity.
World writable directories (777) will have the sticky bit set. The sticky bit prevents users from being
able to delete other user’s files from the directory as a security measure. Suggested resolution is to
make the directory 775 permissions, and add the users who should be able to delete files from the
directory to the group who owns the directory. For example, if the directory is ldad:ldad, then add the
user to the ldad group in /etc/group.

Changing Your Password

Because the Network Information Service (NIS) utility is used to manage AWIPS accounts, you cannot use
the usual Linux "passwd" command to change your password. Instead, use the "yppasswd" command. For
changing passwords, it has the same syntax and semantics as "passwd."
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Note 2: Users can also log into DX1 and run the "chage -l [username]" command to find out when
they last changed their password and when their current password will expire.

To change your password:

Log into your account on any workstation.1. 

Open a terminal window by clicking the terminal icon.2. 

In the window that appears, enter the command "yppasswd."3. 

Follow the prompts.4. 

There may be a delay of a few minutes before NIS updates the password files on all hosts.

Recovering from a Screensaver Lockout

If a locking screensaver is running on a workstation and the password holder is not available, there are two
ways to bring the workstation back into service:

Kill the X server and thereby force a logout, or

Kill the screensaver.

To Kill the X Server:

CAUTION: The method below for killing the X Server should not be used for routine logouts because
it may cause problems with the AWIPS application software (undeleted temporary files, open socket
connections, etc.).

Type ctrl-alt-backspace.

The X server and all its clients (e.g., D2D) will be killed. In a few seconds you will have a new
login screen.

To Kill the Screensaver:

CAUTION: The locking screensaver is meant to serve a security purpose. Killing the xscreensaver
process defeats the purpose of the locking screensaver. A locked screensaver should not be killed except
in cases of operational necessity.

If a locking screensaver is running on an AWIPS workstation, there will be one or more processes
called xscreensaver running. If you log in to the locked workstation from another workstation as the
root user and kill those processes, the screensavers will disappear and you will be able to shut down the
login session that was previously locked.
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Appendix D. AWIPS Applications / Interfaces

Table D-1 lists the AWIPS applications and interfaces that support AWIPS. Underlined highlighted text
indicates a link to a user's guide or additional information.

Table D-1. AWIPS Applications/Interfaces

AWIPS Applications/Interfaces Description

Aviation Forecast Preparation System (AvnFPS)

AvnFPS is designed to ease monitoring, improve production, and facilitate Quality Contr
Terminal Aerodrome Forecasts (TAF). The AvnFPS monitoring capability gives forecaste
continuous feedback on TAFs as well as associated observations. This monitoring capabil
color-coded scheme and is site configurable. The TAFs, surface observations, and guidan
accessible in either text or graphical form and can be enhanced to alert forecasters to wea
to aviation operations.

AWIPS Decision Assistance and Production Preparation
Tools (ADAAPT)

ADAPPT foundation software is composed of the foundation routines that support the IFP
Pre-LAMPS, and SCAN.

CLIMATE

The CLIMATE software provides the capability to automatically initiate (three times dail
monthly, seasonal, and annual climate reports. It also formats these reports for disseminat
HWR).

Additionally, it provides review and edit capability for products prior to dissemination.

Dam Catalog Reviewer and Estimating Tool
(DamCREST)

DamCREST is a Graphical User Interface (GUI) application available on both Linux and
operating platforms.

Distributed Hydrologic Modeling (DHM) DHM is the set of features integrated into NWSRFS for distributed hydrologic modeling.

Flash Flood Monitor and Prediction: Advanced
(FFMPA)

The FFMPA system is an integrated suite of multi-sensor applications which detects, anal
monitors precipitation and generates short-term warning guidance for flash flooding autom
AWIPS.

Fog Monitor (FM)

The FM is an AWIPS application which applies various algorithms to visible and infrared
in order to identify potential areas of fog. At night, the application primarily uses the well
"Fog Product" (the difference of the 10.7 micron and 3.9 micron brightness temps) to high
fog areas. During the daytime, several algorithms attempt to discern fog areas by brightne
other characteristics. Also applied are filters which help to distinguish fog from possible f
features such as snow cover and mid-level clouds.

Four-dimensional Stormcell Investigator (FSI)

FSI is an innovative base radar data 4-panel display application that is based on the Natio
Storms Laboratory Warning Decision Support System - Integrated Information GUI. This
allows users to create and manipulate dynamic cross-sections (both vertical and at constan
that one can "slice and dice" storms and view cross-section data in three-dimensions and 

Alert Visualization

Alert Visualization is an AWIPS utility that works as a communicator, primarily from sof
All communication traffic that used to funnel through the Announcer (Alert Visualization
Dialog and text messages in the D2D) and that used to funnel through the D2D Decision 
Monitor Buttons now goes through Alert Visualization. And, via Alert Visualization's pow
flexible configurations, users can now decide how they want Alert Visualization to comm

Gridded Forecast Environment Suite (GFE Suite)
The GFE Suite is a series of programs that provide an interactive gridded forecast prepara
Components derive surface sensible weather elements from model data, manage the forec
metadata in a database, and generate forecast products in a variety of formats.

Hourly Weather Roundup (HWR)

The HWR automatically receives and processes METAR surface observations, Satellite C
(SCP), Supplementary Climatological Data (SCD), and marine observations. Additionally
text portion of the data for dissemination over NWR, formats a text portion for the Conso
System (CRS), and formats a tabular product for dissemination over NWWS. Furthermor
provides review and edit capability for products prior to dissemination.

Hydro Database Manager (HydroBase)

HydroBase is the component of the AWIPS system which permits the management of the
portion of the database. Adding, deleting, and editing of hydrometeorological data collect
forecast data locations are handled within HydroBase. HydroBase consists of a series of p
which allow for interacting with the information within the reference database.
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HydroGen
HydroGen is a suite of software programs that collect data from the Integrated Hydrologi
System (IHFS) database and prepare eXtensible Markup Language (XML) files and hydr
(or simply "hydrographs") for the web.

HydroView/MPE

MPE_Persepctive_Users_Guide

MPE_Implementation_Guide

MPE_FieldGen_System_Guide

MPE_DailyQC_System_Guide

DualPol_Products_Processingfor_MPE_and_HPE>

DailyQC_Preprocessor_Guide

IHFS_Database_Purger

Generating_Areal_FFG

DPA Decoder

HPE_HPN_Operations_Guide

The Hydroview/MPE application is the result of an effort to consolidate the Hydroview a
Precipitation Estimator (MPE) programs into a single, versatile utility that can be used at 
WFOs. Hydroview's focus is primarily the display of point hydrometeorological data such
stream gage readings, precipitation amounts, and similar environmental information that i
observed and forecast for a specific location. It assists in the preparation of hydrologic for
allowing the user to display and edit this data as well as station reference information suc
and flood stages, historic river crests, emergency contracts, river crests, emergency contac
curves, and dam catalogs. In AWIPS Release 7.1, the Hydroview/MPE application was sp
separate applications, HydroView and MPE Editor.

Interactive Forecast Preparation System (IFPS)
IFPS enables the forecaster to generate and manipulate a digital database of observed and
meteorological variables, which then can be used to automatically generate various produ
different formats.

Localized Aviation MOS Program (LAMP)

LAMP is a statistical system which provides forecast guidance for sensible weather eleme
GFS-LAMP guidance is currently running operationally at NCEP. Guidance is available f
following cycles: 0000, 0300, 0600, 0900, 1200, 1500, 1800, and 2100 UTC. Effective Se
2007, the following cycles were added: 0400, 0500, 100, and 1100 UTC.

Local Analysis and Prediction System (LAPS)
The LAPS reads METAR, mesonet, satellite, radar, and profiler data stored at the WFO, a
analysis and generates forecasts.

Local Data Acquisition and Dissemination (LDAD)
The LDAD software system acquires and integrates data available from automated system
observers in the local WFO area. It also disseminates critical and non-critical AWIPS wea
to local users, particularly state and local government emergency management agencies.

Local Storm Report (LSR)
The LSR GUI is a standalone AWIPS application designed to provide forecasters with an
way to create, manage, and send the LSR public text product. This text product contains n
weather events for which the forecaster has either received or sought real-time observatio

NOAA Weather Radio With All-Hazards VTEC
Enhanced Software (NWRWAVES)

NWRWAVES was developed to replace all the existing formatter capabilities in WWA an
NWRWAVES utilizes VTEC coding found in an increasing suite of NWS products to bett
produce, and manage outbound CRS weather messages.

NWS River Forecast System (NWSRFS) NWSRFS is a comprehensive set of hydrologic techniques used by the National Weather 
Forecast Centers to perform their forecast functions.

River Product Formatter (RiverPro) The RiverPro application generates text products for the National Weather Service Hydro
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RiverMonitor
The RiverMonitor application is used for providing automatically updated tabular inform
summarizing river conditions. This initial version is delivered in part for RiverPro VTEC
provides general monitoring of river data.

System for Convection Analysis and Nowcasting
(SCAN)

SCAN is an integrated suite of multi-sensor applications which detects, analyzes, and mo
convection and generates short-term probabilistic forecast and warning guidance for seve
automatically within AWIPS.

System for Nowcasting of Winter Weather (SNOW)

SNOW is an AWIPS application suite which continuously monitors surface observations 
weather hazards. It automatically alerts the forecasters whenever such conditions are dete
provides capabilities to display observed winter weather threats in ways that help forecast
what they consider most important.

System on AWIPS for Forecasting and Evaluation of
Seas and Lakes (SAFESEAS)

SAFESEAS is a set of AWIPS applications which continuously monitor marine and adjac
conditions for specific marine weather hazards. It automatically alerts the forecasters whe
conditions are detected. SAFESEAS provides capabilities to display observed marine thre
help forecasters focus on what they consider most important.

Warning Generation (WarnGen)

WarnGen enables you to issue flash flood, severe thunderstorm, tornado, and other short-
for a single storm or a line of storms. In addition, you can issue text products (follow-up s
update the progress of the storm, cancel the warning if conditions change, reissue another
same storm, or note the expiration of the warning. WarnGen also enables you to provide w
support to neighboring sites.

WFO Archive Server (WAX)
The WAX CSCI is a member of the Data Server (DS) family, but is a standalone Linux PC
It has Level IV archiving functionality and supports the Weather element Simulator at the

NMAP
NMAP displays and animates different types of meteorological data on a geographic back
current version supports overlay of satellite, radar, model, METAR, ship, MOS, and uppe
Motif GUI controls the program functions.

Site Specific Hydrologic Prediction System (SSHPS)
SSHPS is a local hydrologic model provided to allow the WFO forecaster to supplement 
forecast guidance by generating forecast river stages for fast-response headwater and rive

Hydro Time Series

A subset of data within an Arc Hydro geodatabase which includes measurement values an
were collected. Also includes a description of the properties for a particular type of time s
visualizing time series have been developed. The tools allow the user to query the Arc Hy
time series records related to a particular feature, and plot one or more types of time serie
or more spatial feature.

Precipitation Processing (PP)

PP is an OHD "systems" application. Many (WFO Hydrologic Forecast System) WHFS a
compute precipitation totals. It is one of the prime considerations used in forecasting rive
a key indicator of flash flood potential. The WHFS applications which ingest and process
reports need to have consistent algorithms for tallying precipitation accumulator (PC) and
actual increment (PP) quantities. The PP and PC data also must be stored in the Integrated
Forecast System (IHFS) database in such a way as to avoid performance bottlenecks, espe
applications which must compute precipitation amounts on the fly for many stations over
time. They include 10+ applications that are non-interactive.

WFO Hydrologic Forecast System (WHFS) and
Integrated Hydrologic Forecast System (IHFS) Database

WHFS/IHFS is an OHD "systems" application. The WHFS/IHFS applications incorporat
comprehensive set of data quality operations. Associated with each observed and forecast
database is a quality control code which indicates the quality of the value based on extern
tests of the value. Depending on the value of the quality code, the data are handled in diff
within the IHFS data flow and applications may or may not use the data. They contain 10
that are non-interactive.

High-resolution Precipitation Estimator (HPE)

HPE provides frequent (by default) every 5-minutes) high-resolution (~1km x 1km) rain r
rain accumulations covering a Weather Forecast Office's (WFO) or River Forecast Center
responsibility. These gridded datasets can then be used by the Flash Flood Monitoring and
Advanced (FFMPA) system or can be displayed on D-2D. The mosaic uses data from mu
minimizing the distance from each radar. As a result, HPE reduces the need to run multip
FFMPA when convection covers more than one radar. HPE is an entirely separate program
Multi-sensor Precipitation Estimator (MPE) and will not replace it. HPE uses different da
different output grids more frequently and at high-resolution, and runs with little user inte
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Appendix E. The High-Resolution Rapid Refresh (HRRR)

The HRRR is a cloud-resolving atmospheric model implemented at NCEP as of 30 September 2014. The
13km Rapid Refresh is used as a background, with an additional data assimilation cycle that includes radar
data. HRRR runs once per hour every hour, providing hourly forecasts out 15 hours. Elements are output on
the NDFD 2.5km grid (grid 184) and distributed via the SBN. Forecasts from a given initial time begin to
arrive via SBN about :55 and take 35 minutes to fully arrive on AWIPS. Thus a 12 UTC HRRR model run is
fully available in AWIPS by 1330 UTC.

The HRRR Phase 1 Element List used in AWIPS II can be found at the following link

https://docs.google.com/a/noaa.gov/spreadsheets/d/1YUUO5x1dSEFOIZhuK1izZYiEfc6OhI6OVb_Zjeingkg
/edit?usp=sharing

HRRR data can be accessed from the Volume pull down menu as shown below.

Note: AWIPS II should be enhanced to handle the SBN ingest, GRIB2 decode, store, display, and ingest by
GFE software for grid preparation of HRRR model output for the following data elements:

Source: http://www.nco.ncep.noaa.gov/pmb/products/hrrr/
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Resolution: 15 minute resolution data out to 9 hours for the following data elements and levels.

Data elements

• #005 - Radar Reflectivity (refd) - Reflectivity at 1 km AGL for FHAG1000
• #001 - Composite Radar Reflectivity (refc) - Max refl in model column, dBZ
• #008 - Instantaneous Updraft Helicity - Instantaneous updraft helicity in layer 2-5 km above ground level
for FHAG20005000
• #003 - Radar VIL - Radar-derived vertically int. liquid, kg/m2
• #014 - u Wind Component - u-wind at height above ground for FHAG10
• #015 - v Wind Component - v-wind at height above ground for FHAG10
• #002 - Echo Top - Echo top height of 18dBZ surface
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Appendix F. Product Generation (PGEN)

The following is a reference guide to be utilized by NCEP users in the process of transitioning from 
N-AWIPS to the AWIPS II Common AWIPS Visualization Environment (CAVE). This guide 
specifically focuses on the Product Generation (PGEN) tool. There have been many changes made to 
PGEN in AWIPS II, compared to NMAP. This specific document will focus on the basic, high-level 
items and act as an introduction to PGEN in AWIPS II CAVE.

Product Generation(PGEN)
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Appendix G. Broadcast Message Handler (BMH)

BMH allows users at each WFO to create, process, and distribute messages that include weather observations
and
forecasts; watches, warnings and advisories, and hazards information. The AWIPS-II system simultaneously
accepts text, digitized voice, live voice, and other data from authorized sources. Capabilities include:

County codes processing,
Specific Area Message Encoding (SAME) and alert tones activation,
Text-to-speech synthesis,
Interrupt messages including Emergency Override and Live Voice Broadcast

Broadcast Message Handler (BMH)
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Appendix H: Damage Path Tool (Reserved)
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